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Player  

Overview of the QALoad Player 
The QALoad Player simulates one or more virtual users running C-based scripts. These scripts mimic user 
act ivi t ies to load test the appl icat ion, network, and server components of a cl ient-server system. 

The QALoad Player simulates mult iple cl ients sending middleware cal ls back to a server. General ly, these 
are database SQL cal ls — although other types of middleware layers can also be tested. When running 
virtual user simulat ion, QALoad Player can emulate mult iple users from a single platform using the mult i-
tasking features of 32-bit  Windows. The number of users that a single hardware system can emulate is 
determined by the processor speed, main memory size, middleware layer, and simulated transact ion rate. 
Please contact your QALoad distributor for further sizing in formation. 

Once started, QALoad Player funct ions ent irely in  the background without any direct user in teract ion. Al l  
commands to QALoad Player come from the QALoad Conductor. In  fact, once QALoad Player has been 
started, the only in teract ion you may have with i t  is to change startup parameters or to save the contents 
of the display window to a fi le. When the Conductor process closes for any reason during a load test, the 
associated Player processes terminate. 

Citrix and SAP scripts play back in  a virtual user window on the desktop. It  is possible to enable or disable 
the VU window from the Conductor's M iddleware Options dialog box.  

 

 

QALoad Player menus 
The fol lowing menus are avai lable from the QALoad Player:  

Fi le menu  

Edit  menu  

View menu 

Options menu  

Help menu  

 

Installing UNIX Players 
For in formation about instal l ing UNIX Players, please refer to the QALoad Installation and Configuration 
Guide.  

You can access th is guide by cl icking Start>Al l  
Program s>Com puw are>QALoad>Docum en tat ion>In stal l at i on  Guide. 

 

Transferring Scripts to a UNIX Player 
Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 
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Note: The machine where the QALoad Script Development Workbench is instal led must have 
Winsock-based TCP/IP to transfer a script  to the UNIX machine where you wish to run i t . 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the middleware session you want to start . 

3. In  the Workspace Pane, cl ick the Scripts tab. 

4. On the Scripts tab, select the script  you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the fi le name 
you selected to transfer appears in  the Fi l e to Transfer field. 

6. Enter the Host  Nam e, User Nam e, Passw ord, and Dest inat ion  Di rectory. 

7. Click Transfer to send the fi le to the system where your QALoad Player is instal led. 

8. If you want to save the in formation you have entered for subsequent transfers, cl ick Save Set t i ngs. 

9. Click Close/ Abort  to exit  the FTP Transfer dialog box.  

 

Validat ing Scripts in the Player 
Before adding a script  to a load test, val idate i t  to ensure that i t  runs without problems. The fol lowing 
procedure is only val id for Win32 scripts. To val idate a UNIX script , see Val idat ing a UNIX script . 

Note: During val idat ion of SAP scripts, do not min imize the SAP window. If the window is 
min imized, the val idat ion  may fai l . This problem does not occur i f you select  the Hide Graph ical  User 
In terface for SAP Users opt ion by cl icking Brow se [...] in  the Type column of the Script  Assignm en t  
tab in  the Conductor. This SAPGUI opt ion runs SAP on an alternate desktop that is not visible. 

To conf igure t he Player  f or  val idat ion: 

1. In  the Script Development Workbench, cl ick Opt ions>Workbench  and select the Script  
Val idat ion  tab. 

2. Select the Autom at i cal l y Recom pi le check box i f you want QALoad to compile a script  before 
attempting to val idate i t . QALoad l ists any compilat ion errors in  the editor after compil ing. 

3. (For Java and OFS) select Ask  for Autom at i c Val idat ion  of  Java and OFS Scripts. 

4. Select the On ly Display Player Output  on  Script  Fai lure check box to view only Player messages 
upon script  fai lure, i f appl icable. 

5. Type a value in  the W ai t  up to field. This is the number of seconds that the QALoad Script 
Development Workbench should wait  for a script  to execute before t im ing out. 

6. In  the Player Sett ings area, select the Abort  on  Error check box for QALoad to stop script  execut ion 
upon encountering an error. 

7. Select the Debug Data check box for the script  to display a debug message indicat ing which 
command the script  is execut ing. 

8. In  the Run As area, indicate whether the transact ion should be run as th read- or process-based. 
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Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are l im ited to process-based val idat ion 
only. 

9. In  the Num ber of  users field, type a number of virtual users to run th is script  for val idat ion. The 
default  is 1. 

10. Enter a value in  the Tran sact ions field. For val idat ion, Compuware recommends that you accept 
the default  value of 1 transact ion. 

11. In  the Sleep Factor % field, type the percentage of each DO_SLEEP (pause in the script) to 
maintain. For val idat ion, you may not need to run every pause in the script  at  i ts ful l  length. The 
value can be a percentage between 0 and 100. The default  is 0. 

12. Click OK to save your changes. 

To val idat e a scr ip t  in  t he Player : 

1. In  the Com pi led Script  field, browse for the compiled script  DLL you want to val idate. Compiled 
scripts are usual ly located in  the directory \Program Files\Compuware\QALoad\Scripts. 

2. Type a value in  the Num ber of  Users field. Compuware recommends one user for script  val idat ion. 

3. Type a value in  the Transact ions field. Compuware recommends one transact ion for script  
val idat ion. 

4. Select any appropriate opt ions to the right of the Compiled Script field. These opt ions determine 
the type and amount of data that wi l l  display in  the Player Main Window. For descript ions of each 
opt ions, see the topic QALoad Player Main Window. 

5. In  the Run  As area, select whether the transact ion should run as th read- or process-based. 

6. Click Start  to run the script . The Player M ain Window wil l  show the script 's progress. If the script  
runs successful ly, i t  is val id to use in  a load test.  

 

 

Dialog Box and Field Descript ions 

QALoad Player Main Window 

The QALoad Player Main Window is divided into two parts: 

!  The top port ion contains fields, buttons, and opt ions that help you configure the Player for script  
val idat ion. When an actual load test is in  progress, th is area displays the fol lowing in formation: 

 Version : The version of the QALoad Player. 

 Player Nam e: The network name assigned to the Player workstat ion. 

 Player Address: The network address of the Player workstat ion. 

 Player Port : The port  number on th is Player workstat ion being monitored by the QALoad 
Conductor. 

 Player i s runn ing… the type of virtual users th is Player is running. 

 The number of virtual users and transact ions th is Player is running. 

!  The bottom port ion of the Player M ain Window displays Player messages whi le a script  is running.  

This sect ion describes the configurat ion opt ions on the top port ion of the Main Window. 
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Fields and Buttons 

Com pi led Script  

Navigate to the compiled script  (.dl l ) to val idate. 

Users 

Type the number of users to emulate when val idat ing the selected script . Compuware recommends one 
user for script  val idat ion. 

Transact ions 

Type the number of t ransact ions to run when val idat ing the selected script . Compuware recommends one 
transact ion for script  val idat ion. 

Start  

Cl ick the Start  button to begin script  val idat ion. Player messages wil l  display below. 

Abort  

Cl ick the Abort button to stop al l  virtual users immediately. 

Ex i t  

Cl ick the Exit  button to exit  the load test graceful ly, when each virtual user is fin ished. 

Debug Data 

Select th is check box to have the Player display a debug message indicat ing which command the script  is 
execut ing and to generate WWW replay log fi les. 

RR__Fai ledM sg 

Select th is check box to view, in  the Player window, the point where a middleware command with in your 
script  fai ls. 

Check  Poin ts 

Select th is check box i f you want to display the Check Point command response t imes in the Player 
window.  

Auto Clear 

Select th is check box to automatical ly clear any messages from the bottom port ion of the window before 
running a new script . 

Abort  on  Error 

Select th is check box to abort  script  execut ion when an error is encountered. 

Create Tim ing Fi l e 

Select th is check box to create and save a Player t im ing fi le for th is Player to the default  QALoad t im ing fi le 
directory (normally \Program Files\Compuware\QALoad\TimingFiles). 

Run  As 

Select i f th is Player should run scripts as thread- or process-based. 
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Save As 

Use th is dialog box to save a text fi le of the messages reported by Player during a test, or to save an exist ing 
buffer with a different name. 

Access th is dialog box from the Fi l e menu by selecting Save Buf fer or Save Buf fer As. 

 

Player Configurat ion 

Use th is dialog box to set startup parameters for Player. 

Access th is dialog box from the Opt ions menu by select ing Player Con f igurat ion . 

Run t im e tab 

Player Nam e: (Read only) This is the name that the Player wi l l  report  to the QALoad Conductor during a 
request. It  may be any string of alphanumeric characters, provided that the length does not exceed 10 
characters and there are no embedded spaces. 

Com pi led Scripts: This field points to the directory which wil l  hold the compiled scripts. When a test is 
started, Player looks for scripts in  th is directory. The configurat ion screen wil l  veri fy that the directory 
exists. 

Compuware recommends that you use a directory on a networked drive to hold the compiled scripts. 
Otherwise you wil l  need to manually copy the script  fi les to each Player system whenever a script  changes. 

Tim ing Fi l e: (Read only) This field points to the default  directory where the t im ing fi les are located. 

Java tab 

jvm .dl l  di rectory: (opt ional) This is the directory where the JVM.DLL fi le is located. If specified, th is 
JVM.DLL wil l  be used to run the Java scripts from a standalone Player; otherwise, the entry specified in  the 
Compiler Sett ings tab of the Configure QALoad Script Development Workbench dialog box wil l  be used. 
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Scr ip t  Developm en t  Wor k bench  

Overview of the Script  Development  Workbench 
The QALoad Script Development Workbench is the QALoad component used to develop load test scripts. It  
contains the faci l i t ies you need for recording transact ions such as funct ion cal ls or request / response 
interact ions placed by your Windows appl icat ion. The recorded transact ion, cal led a capture fi le, contains 
raw data that must be converted to an editable test script  based on C, C++, or Java, depending upon which 
middleware environment is under test.  

After convert ing the recorded transact ion to a script , you can use the Script Development Workbench's 
script  editor and other funct ional i ty to make any necessary modificat ions to your script . For example, 
maybe you had to sign on to a Web server with a user name and password as part  of your recorded 
transact ion. At test t ime, when mult iple virtual users are running your test script , you might want each 
user to have a different user name/password combinat ion. You can use the Script Development Workbench 
to create a re-usable pool of user name/password combinat ions, saved as a datapool fi le, and edit  your 
script  to extract values from that fi le at test t ime. QALoad provides script ing commands for si tuat ions l ike 
that, and provides a Funct ion Wizard and onl ine language reference, both avai lable right from the editor, 
to help you locate and insert  the right commands.  

When you are sat isfied wi th your test script , you can compile i t  direct ly from the Script Development 
Workbench. And, final ly, add i t  to a load test in  the QALoad Conductor. 

In  shor t , t o p roduce a usable t est  scr ip t  you: 

1. Record a transact ion in to a capture fi le (.cap). 

2. Convert  the capture fi le to an editable script . 

3. Edi t  the script . 

4. Com pi le the script . 

 

The Script  Development  Workbench Main Window 
The QALoad Script Development Workbench main window is divided into dynamic panes that you can 
h ide or show as needed by select ing commands from the View menu.  

Hin t : Cl ick on a pane in the fol lowing graphic for a descript ion of that pane. Use your scrol l  bars to 
see the rest of the graphic. 



Using the Player, Script  Development Workbench, and Analyze 

8 

 

 

Menus and Toolbar But tons 
The QALoad Script Development Workbench menus and buttons change depending on whether you have 
an EasyScript Session open.  

Menus and Toolbars without  an Open EasyScript  Session 

The fol lowing menus and toolbars are avai lable when an EasyScript Session is not open. 

Fi le 
View 
Options 
Session 
Tools 
Help  
Toolbar Buttons 

  

Menus and Toolbars with an Open EasyScript  Session 

The fol lowing menus and toolbars are avai lable when an EasyScript Session is open. 
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File 
Edit  
View 
Options 
Session 
Tools 
Window 
Help 
Toolbar Buttons  
Recording Toolbar 

 

Accessing the QALoad Script  Development  Workbench 

To access t he Scr ip t  Developm ent  W orkbench: 

1. From the Windows taskbar, cl ick the Start  button. 

2. Choose Program s>Com puw are>QALoad>Script  Developm en t  Workben ch .  

 

Configuring the Script  Development  Workbench 
The first  t ime you use the QALoad Script Development Workbench, you should set opt ions to determine a 
working directory QALoad can use for temporary fi les, compiler sett ings, and other general opt ions related 
to the behavior of the QALoad Script Development Workbench. 

To set  a w ork ing d i r ect ory: 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the session you want to start . 

3. From the Opt ions menu, choose Workbench . 

4. Set any appropriate opt ions. For a descript ion of the avai lable opt ions, press F1 from the Configure 
Script  Development Workbench dialog box. 

Note: Compuware recommends that you always select Autom at i cal l y Convert  Capture on the 
Workbench Configurat ion tab and Autom at i cal l y Com pi le Scripts on the Compiler Sett ings tab. 

5. Click OK to save your sett ings.  

EasyScript  Sessions 

EasyScript  Sessions 

When you first  open the Script Development Workbench, you can set general opt ions related to which 
panes to display, your compiler, and so on, but you cannot begin any middleware-specific act ivi t ies, such 
as recording a transact ion, unt i l  you open an EasyScript Session. Opening an EasyScript Session tai lors the 
Script Development Workbench to a specific middleware environment, providing you with al l  the 
appropriate opt ions and funct ions for your script ing needs. 
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To open an EasyScript Session, choose your middleware type from the Session menu, or cl ick the 
appropriate toolbar button. Once a session is open, the Workbench interface changes. 

Note: The .NET session opens in M icrosoft  Visual Studio. For more in formation on .NET sessions, see 
Overview of the QALoad .NET Sessions. 

You can also open a Universal session to record cal ls from mult iple middlewares with in a single session. 

EasyScript  for Secure WWW 

Overview 

EasyScript for Secure WWW supports SSL/HTTPS requests when used in conjunct ion with the WWW 
middleware. This support must be purchased separately and is distributed in  a separately-instal led module. 

 

 

Importing a Client Certificate from a Web Browser (SSL) 

You can import and convert  a Cl ient Cert i ficate for any Web site you plan to visi t . 

To im por t  a cl ient  cer t i f icat e: 

1. Start  your Web browser. 

2. From the browser, select the Client Cert i ficate for the Web site you plan to visi t . 

3. Export the Client Cert i ficate (.p12 of .pfx fi le) to a directory where you can access i t  using the 
Script Development Workbench. 

Note: When the browser prompts you to enter a password, do not  enter a password. If you enter a 
password, QALoad cannot  process the fi le. 

4. Start  a WWW Session in  the QALoad Script Development Workbench. 

5. Click Tools>M ain tain  Cert i f i cates to open the SSL Cert i ficate Maintenance dialog box. 

6. On the Cl ien t  Cert i f i cates tab, cl ick the browse but ton [...] to browse for the Client Cert i ficate you 
want to convert . The Select the Exported Client Cert i ficate to Convert  dialog box opens. 

7. Make sure Fi l es of  Type specifies P12 fi les (*.p12) or PFX fi les (*.pfx). 

8. Select the appropriate Cl ient Cert i ficate and cl ick Open . The path and fi le name of the selected 
Client Cert i ficate appears in  En ter Cert i f i cate to Convert  on the Client Cert i ficates tab. 

9. On the Cl ien t  Cert i f i cates tab, cl ick Convert . 

10. Click Close to exit  the SSL Cert i ficate Maintenance dialog box.  

 

Creating a Client Certificate in QALoad (SSL) 

This procedure assumes you have a WWW session act ive. 

To creat e a cl ien t  cer t i f i cat e: 

1. From the Tools menu, select M ain tain  Cert i f i cates to open the SSL Cert i f i cate M ain tenance 
dialog box. 

2. On the Client Cert ificates tab, enter a name in the Cert i f i cate Nam e field. 
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3. Enter the number of cert i ficates to create. 

4. Click the Create button to create the QALoad Client Cert i ficate. QALoad stores i t  in  the 
QALoad\Certificates directory. 

Note: On the Unix player platform, you must create the Certificates sub-directory in  the QALoad 
directory. The directory name is case sensit ive. 

5. If necessary, configure your Web server to accept QALoad as the Cert i ficate Authori ty. Refer to your 
Web server documentat ion for more in formation.  

Creating an SSL Certificate Authority 

Note that creat ing a new CA inval idates al l  previously created cl ient cert i ficates. 

To creat e an SSL Cer t i f i cat e Aut hor i t y: 

1. Start  a WWW session. 

2. From the Tools menu, select M ain tain  Cert i f i cates. 

3. Click the Cert i ficate Authori ty tab. 

4. Click the Create button to create a new Cert i ficate Authori ty with the expirat ion date shown in the 
field.  

5. Exit  and re-start  the Script  Development Workbench. 

6. After creat ing a new Cert i ficate Authori ty, re-import the CA to your Web server and then create 
new Client Cert i ficates.  

 

Creating an SSL Server Certificate 

To creat e an SSL Server  Cer t i f icat e: 

1. Start  a WWW session. 

2. From the Tools menu, select M ain tain  Cert i f i cates. 

3. Click the Server Cert i ficate tab. 

4. Click the Create button to create a new Server Cert i ficate with the expirat ion  date shown in the 
field.  
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Using M iddleware Sessions 

Using the Universal Session 

The Universal session al lows you to record cal ls from mult iple middleware appl icat ions with in a single 
Script  Development Workbench session. You might use the Universal session in  cases where your 
appl icat ion accesses an addit ional appl icat ion that uses a different protocol. 

For example, your browser might download and open a Java applet which then communicates with a 
Winsock server. If you recorded that act ivi ty using a simple WWW session, the Script Development 
Workbench would only record the HTTP requests that downloaded and opened the Java applet. Recording 
that transact ion with the Universal session ensures that you record the HTTP requests from the browser as 
well  as the Winsock-based communicat ion between the Java applet and the Winsock server — al l  with in a 
single script . 

You start  and record from a Universal session exact ly l ike a single middleware session with one difference 
— after start ing a Universal session you must select which middleware appl icat ions to record.  

Opening a M iddleware Session 

To access t he Scr ip t  Developm ent  W orkbench and open a m iddlew are session:  

1. Click Start>Program s>Com puw are>QALoad\ Scri pt  Developm en t  Workben ch .  

2. Choose the middleware name from the Session  menu or by cl ick the appropriate button on the toolbar. The 
Defaul t  Session  Prom pt  opens.  

Note: If th is middleware type should be the default  every t ime you open the Script Development 
Workbench, select the check box M ake th i s m y defaul t  session . If you do not want to be prompted to 
set a default  m iddleware, clear the En able defaul t  session  check ing check box. You can also turn 
default  session checking on or off from the Configure Script  Development Workbench dialog box at any 
t ime. 

3. Click OK. 

Set t ing Conversion Opt ions 

Before you begin recording, you can set opt ions to automatical ly customize your script  during conversion. 
Compuware recommends you set conversion opt ions before recording, then use the opt ion to 
automatical ly convert  your capture fi les to scripts. Detai ls 

1. Access the Script Development Workbench. Detai ls 

2. From the Session  menu, select the appropriate middleware or start  a Universal session. 

3. Select Opt ions>Convert  to open the appropriate Convert  Options dialog box. 

4. In  the Session Options tree, cl ick Shared Convert  Opt ions and set any appl icable opt ions. This 
tree-view contains common opt ions that apply to al l  the middleware environments QALoad 
supports. 

5. Click the middleware-specific convert  opt ions in  the Session Options tree, and set any appropriate 
middleware-specific opt ions. 

Notes:  

 For the Citrix Web Interface environment, you must select opt ions in  both the Citrix Convert  
Options and the WWW Convert Options in  the tree view. 
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!  For WWW, refer to Using the WWW Convert Options. 

6. When you are fin ished, cl ick OK to save the current  sett ings. 

Hin t : Press F1 from any middleware opt ions tab for a descript ion of avai lable opt ions.  

 

Cit rix 

Overview 

Use QALoad's Citrix middleware to load test systems that run Citrix MetaFrame or Citrix MetaFrame XP.  

What  i s Ci t r i x? 

Citrix middleware is a communicat ion layer that provides remote access to Windows systems. The remote 
system appears in  a window on the local system.  

Connect ing to the rem ote system  

Once connected to a machine that is running the MetaFrame server, log in to the remote system and run 
appl icat ions. Alternat ively, specify an appl icat ion in  addit ion to a user name and password, which provides 
access only to the specified appl icat ion and min imizes user input that is necessary to access the appl icat ion 
under test. Test the environment using the Window Citrix Client to start  a Citrix session. 

Test ing in  l oad-balanced envi ronm en ts 

If test ing an environment that includes a server farm, use Citrix ICA fi les to support th is type of 
configurat ion. Specify the ICA fi le on the Citrix Record Options dialog box. ICA fi les are also necessary for 
encrypt ion. ICA fi les are generated on the MetaFrame server and can be obtained from your MetaFrame 
administrator. For more in formation about using ICA fi les, see Using ICA fi les.  

When ICA fi les are not provided by an appl icat ion, specify connect ion in formation using the Published 
Applicat ions or the Single Server opt ions in  the Citrix Record Options dialog box. These opt ions also 
enable you to specify l ists of publ ished appl icat ions and servers to invoke when you log on to the Citrix 
cl ient session. 

Test ing using the Ci t r i x  Web In terface 

When you in i t iate Citrix-publ ished appl icat ions using a web browser, you can capture and playback scripts 
in  QALoad using the Citrix Web Interface. The Citrix Web Interface starts a Universal session with the 
Citrix and WWW middlewares selected. The WWW middleware in tercepts the ICA fi le created by the web 
server. It  passes data to and from the Citrix Server during the capture process, enabl ing you to test the 
performance of appl icat ions that are avai lable through internet connect ions. 

 

About the Citrix Web Interface 

Capture and playback scripts for Citrix appl icat ions accessed through a web browser using the Citrix Web 
Interface. This starts a Universal session for both the Citrix and WWW middlewares, which enables the 
WWW middleware to pass in formation to and from the Citrix server. 

When select ing a publ ished appl icat ion through a web browser, the request is sent to the web server. The 
web server creates an ICA fi le for the requested appl icat ion and returns i t  to the web browser. When the 
web browser finds an associated appl icat ion to handle the ICA fi le, the Citrix cl ient starts the publ ished 
appl icat ion requested. The ICA fi le used during the capture process is saved in 
QALoad\Middlewares\Temp. 

Note: Only the first  ICA fi le received by the web browser is recorded. 
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The converted script  contains both Citrix and WWW funct ions. A new variable, char* 
strICAFileName[N], is declared at the top of the script . Al l  al located memory is released at the end of the 
script .  

Accessing a Citrix Session 

Use one of the fol lowing methods to begin recording a Citrix session. 

To access a Ci t r ix  Cl ien t  session: 

!  From the Session  menu, cl ick Ci t r i x>Window s Cl ien t . 

OR 

!  On the toolbar, select the down arrow next to the Ci t r i x  button on the toolbar, then select 
Window s Cl ien t . 

To access t he Ci t r ix  W eb Int er f ace w hen select ing a Ci t r ix  session : 

!  From the Session  menu, cl ick Ci t r i x>Web In terface.  

OR 

!  On the toolbar, cl ick the down arrow next to the Ci t r i x  button, then select Web In terface. 

The Universal session starts with both the Citrix and WWW middlewares selected. In  the Citrix tab, 
Web Interface is selected in  the Type field. 

To access t he Ci t r ix  W eb Int er f ace f rom  a Universal  session: 

1. On the toolbar, cl ick Sessi on>Un iversal  or cl ick the Un iversal  button on the toolbar. 

2. Click Opt ions>Record. The Universal Record Options dialog box appears. 

3. In  the M iddleware Select ion pane, select W WW, then select Ci t r i x . The Universal Record dialog 
box displays both a WW W tab and a Ci t r i x  tab. In  the Ci t r i x  tab, Web In terface is selected in  the 
Type field. 

 

Recording a Citrix Session 

To begin recording a Citrix session, select the down arrow next to the Ci t r i x  button on the toolbar, then 
do one of the fol lowing procedures below.  

Tips: Uppercase characters are not captured when the CAPS Lock key is on. Manually modify the 
script  to use uppercase characters or hold down the SHIFT key during recording. 
Similarly, the Windows Logo key is not supported. Do not use the Windows Logo key to start  
appl icat ions while recording a Citrix script . 

To begin r ecording a Ci t r ix  Cl ien t  session: 

1. Select Window s Cl ien t  to act ivate a new Citrix session.  

2. From the toolbar, select Opt ions>Record, and select the appropriate opt ions. 

3. Click Record on the Sessi on  toolbar.  
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The Citrix capture appl icat ion appears, as shown in the fol lowing image. Cl ick the three sect ions of the 
image to learn more about the fields and the in formation that is displayed in each area. 

 

To begin r ecording using t he Ci t r ix  W eb Int er f ace: 

1. Select Web In terface to act ivate Universal session for the Citrix Web Interface. 

2. Click Record on the Sessi on  toolbar. The Un iversal  Record Opt ions dialog box displays. 

3. Select the appropriate opt ions, then cl ick Start  Record. 

 

Setting Citrix Convert Options  

To set  conversion  opt ions f or  Ci t r ix  Cl ient  session:  

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions, then cl ick OK. 

To set  conversion  opt ions f or  Ci t r ix  W eb In t er f ace session:  
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1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears with both Citrix and WWW selected. 

2. Click the Session  Opt ions tab. 

3. Under Convert  Options, cl ick Ci t r i x  Convert  Opt ions. 

4. Select the appropriate opt ions, then cl ick OK. 

 Note: During the conversion process for both Cl ient and Web Interface sessions, cal ls to the 
CtxSetWindowTitle method are sometimes placed at an incorrect l ine in  the script . Determine 
the correct l ine by inspect ing the capture fi le and moving the cal l  to that posi t ion in  the script . 

The CtxSetWindowTitle method is added by QALoad during conversion and should otherwise not 
be modified or manually added to a script . 

 

Using ICA files 

ICA fi les, which are generated on the MetaFrame server, contain configurat ion opt ions for Citrix. You can 
specify an ICA fi le on the Citrix Record Options dialog box. 

ICA fi les are specified in  the script  with the CtxSetICAFile command. If an ICA fi le is specified, the cal l  is 
generated with an unquali fied fi le name. For example: 

CtxSetICAFile("customapp.ica"); 

Note: The fi le name is not ful ly-qual i fied because the fi le may not exist  in  the same locat ion among 
the remote Player machines. 

To val idate the script  on the same machine on which i t  was captured, copy the ICA fi le to the 
QALoad\BinaryFiles directory. 

To use the ICA fi le on remote Player machines, the ICA fi le should be specified as an Attached Fi le in  the 
External Data page of the Script Propert ies dialog box. This also displays in  the External Data area of the 
Script Propert ies dialog box in  the Conductor. 

Inserting Screenshots in the Citrix Script 

During the Citrix session, you can take a screenshot of the contents of the connect ion window. This inserts 
a wait  point in  the script  for the screenshot you select and saves the image as a bitmap. You can select: 

!  Insert  Wait  for Ful l  Screenshot - Inserts a wait  point based on a ful l  screenshot of the current 
display. 

!  Insert  Wait  for Part ial  Screenshot - Inserts a wait  point based on a part ial  screenshot of the current 
display. 

!  Save Current Screenshot - Saves a screenshot of the current display to a bitmap fi le. 

Note: Images are saved to \ QALoad \Middlewares\Citrix\Captures\screenshot.  

To inser t  a f ul l  screenshot  in t o t he Ci t r ix  scr ip t : 

1. In  the Citrix Capture dialog box, cl ick Screenshots>In sert  W ai t  for Ful l  Screenshot . The Screen 
Capture Preview screen displays the image. 

2. Click Fin i sh  to confirm the screenshot. The Specify Screenshot Name dialog box displays with a l ist  
of al l  previously saved screenshots.  

3. In  the Nam e field, type a descript ive name for the image.  

4. Click OK. The image is saved as a bitmap and a wai t  point for the screenshot is inserted in to the 
script . 
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To inser t  a par t ial  screenshot  in t o t he Ci t r ix  scr ip t : 

1. In  the Citrix Capture dialog box, cl ick Screenshots>In sert  W ai t  for Part i al  Screenshot . The 
selected screen displays wi th the message "Select a rectangular region of the screenshot you want to 
insert ." 

2. Hold down the left  mouse button and drag the cursor across the screen to select the region to save. 
The Screen Capture Preview screen appears with the image you selected. 

3. Click Fin i sh . The Specify Screenshot Name dialog box appears with a l ist  of al l  previously saved 
screenshots. 

4. In  the Name field, type a descript ive name for the image.  

5. Click OK. The image is saved as a bitmap and a wai t  point for the screenshot is inserted in to the 
script . 

To save t he cur rent  screen: 

1. In  the Citrix Capture dialog box, cl ick Screenshots>Save Curren t  Screenshot . The Screen Capture 
Preview screen displays. 

2. Click Fin i sh . The Specify Screenshot Name dialog box displays with a l ist  of al l  previously saved 
screenshots.  

3. In  the Name field, type a descript ive name for the image.  

4. Click OK. The image is saved as a bitmap. 

Citrix Command Reference 

QALoad provides descript ions and examples of the various commands avai lable for a Citrix script . For 
detai ls, refer to the Language Reference Help sect ion for Citrix. 

.NET 

Overview of the QALoad .NET Session  

QALoad provides performance test ing in  .NET environments not supported by a capture faci l i ty. It  creates 
a template C# script , or stub script ,  that you can edit  manually in  a M icrosoft  Visual Studio session.   

Note: You must instal l  M icrosoft  Visual Studio 2005, M icrosoft  .NET Framework v2.0 Service Pack 1, 
and the QALoad Add-In in  order to use the QALoad .NET session. 

Use the QALoad funct ions provided in the .NET session to create and edit  the C# script  from the script  
template. Al l  standard QALoad funct ional i ty is supported in  the .NET session, including datapools and 
checkpoints, VU-specific data, such as VU number, Transact ion number, and pacing values.  

Once you insert  custom code into the stub script , you compile i t , debug i t , and val idate i t  using the 
QALoad menu opt ions provided in the .NET session. You also can use the compiler opt ions and debugging 
capabi l i t ies avai lable in  Visual Studio.  

When the source fi le is created, a solut ion fi le and a project fi le also are created. The source fi le, solut ion 
fi le, and project fi le are stored together in  their own subdirectory in  
QALoad\Middlewares\DOTNET\Scripts.  

Note: You can have only one solut ion fi le open at a t ime. If a solut ion is loaded, you must save any 
changes and close the fi le before you create and load a new script .  

Execute compiled scripts using the QALoad Conductor. When you create a new Conductor session and 
select the DOTNET middleware type in the Test Configurat ion Wizard, your .NET scripts display for 
select ion. 
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Starting a .NET Session  

Use the fol lowing procedure to open a .NET session. 

To st ar t  a .NET session: 

From the workbench, cl ick Session>.NET. This starts a M icrosoft  Visual Studio session with the Manage 
QALoad Scripts dialog box displayed. From th is dialog box you can: 

!  Create a new script  

!  Edit  a script  

!  Delete a script . 

Notes:  
!  You must instal l  M icrosoft  Visual Studio 2005, M icrosoft  .NET Framework v2.0 Service Pack 1, and 

the QALoad Add-In before using the .NET session. 
!  In  M icrosoft  Visual Studio, you can have only one solut ion fi le open at a t ime. If a solut ion is 

loaded, you are asked to save any changes and close the fi le before the new script  is created and 
loaded. 

 

QALoad .NET Menu 

The fol lowing QALoad menu opt ions are avai lable from Tools>QALoad when a QALoad .NET Session is 
open in M icrosoft  Visual Studio. 

 

M an age QALoad Script s: Use th is opt ion to create a new C# script , edit  an exist ing script , or delete a 
script . Scripts are stored in  \ QALoad\Middlewares\DOTNET\Scripts. 
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Insert  Script  Statem en t : Displays the commands that you can insert  in to your script . Commands are 
grouped in logical categories. Refer to .NET in the Language Reference Commands folder in  the QALoad 
onl ine help for in formation on the individual commands avai lable for .NET sessions.  

Com pi le Script : Avai lable when a QALoad script  is open. The QALoad script  is C# based and therefore 
must be compiled before i t  can be used. Scripts are compiled using the current bui ld configurat ion (Release 
or Debug mode). If you make changes to an exist ing script , you must re-compile i t  before you can 
successful ly use i t  in  a test. Compiled scripts are stored in  \ QALoad\Scripts. 

Val idate Script : Avai lable when a QALoad script  is open. This opt ion compiles the script  using Release 
mode. When the compilat ion completes successful ly, the Val idate session begins with one Virtual User 
(VU) for one transact ion.  

Debug Script : Avai lable when a QALoad script  is open. This opt ion compiles the script  in  Debug mode so 
that you can place breakpoints in  your script . When the compilat ion completes successful ly,  the val idate 
session begins with one VU for one transact ion. 

Conductor: Opens the Conductor to set up and start  a test. 

QALoad Help: Opens the main QALoad onl ine help for .NET sessions. 

 

Managing QALoad .NET Scripts  

Once you open a .NET session in  Visual Studio, you can access, create, and update QALoad scripts using 
the Manage QALoad Scripts dialog box. 

To access t he Manage QALoad d ialog box in  Visual  St udio: 

With a .NET session open in Visual Studio, cl ick Tools>QALoad>M anage QALoad Scripts. The Manage 
QALoad Scripts dialog box appears. 

From  th is dialog box you can: 

Create a script  

Edit  an exist ing script  

Delete a script  

 

Compiling, Validating, and Debugging a QALoad .NET Script  

A QALoad .NET script  is a real C#-based script , and therefore needs to be compiled before i t  can be used. 
 Once compiled, you can debug and val idate the script . If you make changes to an exist ing script , you must 
re-compile i t  before you can successful ly use i t  in  a test. Use the QALoad menu in Visual Studio to: 

Compile a QALoad .NET Script 

Debug a QALoad .NET Script 

Val idate a QALoad .NET Script 

 

.NET Command Reference  

The QALoad Language Reference provides command reference information for general and middleware-
specific funct ions.  Refer to .NET in the Language Reference Commands folder in  the QALoad onl ine help 
for in formation on the individual funct ions avai lable in  .NET sessions. 
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Java 

Overview—About Java 

QALoad does not support recording of Java scripts. Instead, Java scripts are created from script  templates 
that you use to create a stub script  that you can then edit  manually. Templates are saved in the 
QALoad\Middlewares\Java\Templates directory. QALoad suppl ies four default  templates. QALoad uses 
a token name to represent  the classpath — when you create a new Java script , QALoad simply replaces the 
token <classnamehere> with the class/script  name you assign. You can also instal l  addit ional templates 
using the <classnamehere> token i f you wish.  

Fol lowing is an example of a Java template with the classname token (in  bold): 

import com.compuware.qacenter.qaload.EasyScript.*; 
public class <classnamehere> implements EasyScript 

{ 
/** optional - Class method runs once for each script when class is loaded */ 
public static void setup QALoad Test () throws Exception 
{ 
} 

Use the Script Development Workbench to create a new EasyScript for Java script  from the provided stub 
scripts. 

 

Accessing JavaDoc 

QALoad provides JavaDoc for your reference. To access i t  from the Script Development Workbench menu, 
choose Help>EasyScript  for Java: JavaDoc from a Java session. 

 

Creating a Java Script 

To creat e a Java scr ipt  f or  QALoad : 

1. With a Java session open, choose Fi le>New  from the menu. 

2. In  the Fi le area, cl ick on the M iddlew are tree i tem. 

3. In  the Fi lename field, type a name for your new Java script . Note that Java fi le names do have 
special requirements, and QALoad enforces those requirements. For example, Java fi le names 
cannot contain spaces. If you try to include a space in your fi le name, QALoad gives you an error 
prompt. 

4. Click OK. The Create Java Script dialog box opens. 

5. Under the Script field is a select ion box l ist ing al l  the templates avai lable in  your 
\QALoad\Middlewares\Java\Templates directory. QALoad provides four default  templates. If 
you cl ick on a template name, a sample is shown in the right pane. The four templates are: 

!  long format — Provides al l  required and opt ional methods. 

!  new class — Creates a class associated with the script . 

!  old format — Shows modi ficat ions needed to run legacy scripts. 

!  short  format — Provides only the min imum required methods. 

Select the template that best suits your needs and cl ick OK. QALoad creates a stub script  by the name 
you designated and opens i t  in  the Workbook pane for edit ing. 
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6. Edit  your script  as necessary. You can use QALoad's Java Script Options dialog box to edit  some 
script  at tributes. 

 Note: The main cal l  in  the script  is used for debugging proposes and is not executed in the 
Conductor. 
  

Setting Classpaths in QALoad Player for EasyScript for Java 

When loading a class by name in the QALoad Player during runt ime, do not use a class name on the 
Enterprise Java Bean (EJB) In it ialContext cal l . Instead, use a class instance or add a l ine of code before the 
JNDI lookup cal l . Refer to the fol lowing examples: 

Using a class instance 

Replace the In it ialContext propert ies and JNDI names in the fol lowing example with the values that are 
appropriate for your appl icat ion. 

Before: 
java.util.Hashtable ht = new java.util.Hashtable();  
ht.put(javax.naming.Context.INITIAL_CONTEXT_FACTORY, 
"org.jnp.interfaces.NamingContextFactory");  
ht.put(javax.naming.Context.PROVIDER_URL, "fh12623:1099");  
javax.naming.InitialContext ic = new javax.naming.InitialContext(ht);  
Object ref = ic.lookup("AddressMSvc"); 

After: 
org.jnp.interfaces.NamingContextFactory nf = new 
org.jnp.interfaces.NamingContextFactory();  
java.util.Hashtable ht = new java.util.Hashtable();  
ht.put(javax.naming.Context.PROVIDER_URL, "fh12623:1099");  
javax.naming.Context ic = nf.getInitialContext(ht);  
Object ref = ic.lookup("AddressMSvc"); 

Adding a line of code before the JNDI lookup call 

Add the fol lowing l ine before the JNDI lookup cal l : 
Thread.currentThread().setContextClassLoader(getClass().getClassLoader()); 

If i t  is a stat ic method, use the fol lowing sample, replacing CLASSNAME with the class name of the code. 
Thread.currentThread().setContextClassLoader(CLASSNAME.class.getClassLoader()); 

 

Executing a Java Applet 

Java applets are handled by the fol lowing process: 

1. The browser makes a request to a Web server for an HTML document that contains embedded Java 
applets. 

2. The browser downloads the Java applets, in  the order in  which they appear on the Web page, and 
immediately executes them. 

Exam ple Web Page 

The fol lowing Web page contains two sect ions that reference Java applets. Not ice the parameters that 
fol low the applet. The browser passes these parameters when invoking an applet. 

<HTML> 
<HEAD> 
<TITLE>Java Example</TITLE></HEAD> 
<BODY> 
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<center><h2>Java Applet Example</h2><hr> 
 
<applet code="LScrollText.class" width="500" height="20" > 
<PARAM NAME="MESSAGE" VALUE="Scrolling Text created by Java Applet... >>Click here to 
Download<< Use it FREE"> 
<PARAM NAME="FONTHEIGHT" VALUE="14"> 
<PARAM NAME="SPEED" VALUE="2"> 
<PARAM NAME="PIXELS" VALUE="1"> 
<PARAM NAME="FONTCOLOR" VALUE="0000FF"> 
<PARAM NAME="BACKCOLOR" VALUE="FFFF00"> 
<PARAM NAME="TARGET" VALUE="lscrolltext.zip"> 
</applet> 

<br><br><br> 

A scrolling message, with custom colors, font size, speed, and target URL.<br> 
The source (.ZIP) file can be downloaded by clicking the associated area in text window. 

<br><br><br><hr> 

<APPLET CODE="imagefader.class" WIDTH=80 HEIGHT=107> 
<PARAM name="demicron" value="www.demicron.se"> 
<PARAM name="reg" value="A00012"> 
<PARAM name="maxitems" value="3"> 
<PARAM name="width" value="80"> 
<PARAM name="height" value="107"> 
<PARAM name="bitmap0" value="anibal.jpg"> 
<PARAM name="bitmap1" value="jak.jpg"> 
<PARAM name="bitmap2" value="jan.jpg"> 
<PARAM name="url0" value=" "> 
<PARAM name="url1" value=" "> 
<PARAM name="url2" value=" "> 
<PARAM name="step" value="0.05"> 
<PARAM name="delay" value="20"> 
<PARAM name="sleeptime" value="2000"> 

</APPLET> 

<br><br><br> 

This applet is a very popular image fader that displays a series of images, and allows URLs 
to be associated with each image.<br><br><hr> 

</center> 
</BODY></HTML> 

Exam ple script  

QALoad does not evaluate Java applets. They appear as main requests. The example script  features the 
fol lowing elements: 

!  A DO_Http cal l  to retrieve the main page. 

!  A DO_Http cal l  to retrieve the scrol l ing text class. 

!  A DO_Http cal l  to retrieve the image fader class Java applet. 

How  I t  Works: QALoad interacts with the Web server without execut ion of the Java applet program wi th in 
the virtual browser. The browser accepts the pages that contain Java applets, but does not execute the 
applet as part  of the load test. The Java applets are not evaluated by QALoad and appear as main requests 
in  the script . 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
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... 

... 

DO_Http("GET http://www.host.com/java.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Example", TITLE); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/LScrollText.class HTTP/1.0\r\n\r\n"); 

/* Request: 3 */ 
DO_Http("GET http://www.host.com/imagefader.class HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/jak.jpg HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

 

OFS 

Setting Oracle Forms Convert Options 

Use the fol lowing procedures to set Oracle Forms convert  opt ions and advanced convert  opt ions. Use the 
advanced convert  opt ions to customize the post-capture steps taken before convert ing the capture fi le to a 
script , or to manually perform post-capture processing of a proxycap (hexadecimal encoded) fi le. This 
produces a new cap fi le, postcapweb fi le, longcap fi le, and sortedcap. This process overwrites these fi les 
when they already exist . 

To set  conversion  opt ions f or  Oracle Form s in a single session :  

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears. 

2. Select the appropriate opt ions, then cl ick OK. 

To set  conversion  opt ions f or  Oracle Form s in a Universal  session :  

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar. The Session Options 
dialog box appears with both Oracle Forms Server and WWW selected. 

2. Click the Session  Opt ions tab. 

3. Under Convert  Opt ions in  the tree view, cl ick Oracle Form s Convert  Opt ions. 

4. Select the appropriate opt ions, then cl ick OK. 

To set  Advanced conver t  op t ions: 

1. Choose Opt ions>Convert  in  the Script Development Workbench toolbar to open the Session 
Options dialog box. 

2. In  the Convert  Options tree view, cl ick Advanced Convert  Opt ions. 

3. Select the appropriate opt ions, then cl ick OK. 
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Recording Oracle Forms Server Sessions 

You can record an Oracle Forms session in  a single session, or in  a Universal session for Oracle E-Business 
Suite 11i (EBS-11i) and Oracle E-Business Suite 12 (EBS-12). Select the down arrow next to the Oracle 
Form s Server Session  but ton on the toolbar, then fol low one of the procedures below.  

To begin r ecording an OFS single session: 

1. Select Oracle Form s to act ivate a new OFS single session.  

2. From the toolbar, select Opt ions>Record, and select the appropriate opt ions. 

3. Click Record on the Sessi on  toolbar.  

To begin r ecording OFS in a Universal  session: 

1. Select E-Business Sui te 11i  or E-Business Sui te 12 to act ivate Universal session for Oracle Forms 
and WWW middlewares. 

2. Click Record on the Sessi on  toolbar. The Session  Opt ions dialog box displays with the M iddleware 
tab on top. Both WWW and Oracle Forms Server are selected. 

3. Click the Session  Opt ions tab.  

4. In   the tree view under Record Options, select Oracle Form s Record Opt ions. The Oracle Forms 
Record Options pane displays on the right. The session you in i t iated, either E-Business Suite 11i or 
E-Business Suite 12, automatical ly displays in  the Form s En vi ronm en t  field. 

5. Select the appropriate opt ions, then cl ick OK to begin recording. 

Note: When you record  EBS-12 using Internet Explorer 6, changing the Accessibi l i ty opt ion on the 
EBS-12 login page from the default  (None) requires modificat ions to your script  in  order for i t  to run 
properly. Refer to Changing Accessibi l i ty Options in  Oracle EB-12 for more in formation. 

 

Oracle Forms Recording Modes 

QALoad supports recording Oracle E-Business Suite (EBS) 12 and 11i, and Oracle Appl icat ions using Forms 
10g, 9i, and patched 6i (versions 6.0.8.14 and up). These appl icat ions may be recorded in HTTP mode (also 
cal led Servlet mode), SSL mode (also cal led HTTPS or Secure Servlet mode), and socket mode. These 
recording types are described briefly below. 

Recording Servlet  M ode 

Oracle Forms Applicat ions use HTTP to send Forms data across the network. To record in  Servlet mode, 
select Servlet in  the Connect ion Mode l ist  in  the Record Options dialog box before you start  recording your 
appl icat ion.  

Note: When using server-side recording, you must perform steps to configure the server. See Using 
server-side recording for more in formation. Server-side recording is not avai lable for EBS-12 or EBS-11i. 

Recording SSL M ode 

To record an OFS appl icat ion in  Secure Servlet (SSL) mode, select Secure Servlet in  the Connect ion Mode 
l ist  in  the Record Options dialog box. For non-EBS-12 appl icat ions, you must specify a certDB fi le by 
entering the Jin it iator certDB fi le that the appl icat ion uses. The certDB fi le veri fies the SSL Cert i ficate 
Authori ty on the cl ient side prior to the Forms connect ion. This field is not required for EBS-12. 

Note: SSL mode is not avai lable with server-side recording. 

Recording Socket  M ode 
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For Socket M ode recording, QALoad must start  your appl icat ion for you through your browser. Before 
recording, enter the URL of the Forms applet page in the URL field, and the Form s Server port  in  the Port  
field. If you leave the Port  field blank, or enter an incorrect port  number, your recording wil l  on ly result  in  
an empty capture fi le. You may leave the URL field blank, but wi l l  be prompted for the Forms applet page 
on the in i t ial  browser page. From the applet page, cl ick the l ink to your Forms appl icat ion. QALoad wil l  
take over recording at th is point. 

 

Checkpoints in Oracle Forms Server scripts 

EasyScript for Oracle Forms Server supports QALoad's automatic middleware checkpoint t im ings in  both 
HTTP and socket modes. Default  checkpoints (Begin/End Checkpoint pairs) are not supported.  

Automatic checkpoints are enabled from the Conductor on Timing Options page of the Script  Propert i es 
dialog box  and are enabled on a script-by-script  basis.  

At playback, automatic checkpoints are executed during the ofsSendRecv statement. 

Forms validation/playback debugging options 

Debug data 

When the Debug Data opt ion is enabled on the Configure Script  Development Workbench dialog box for 
val idat ion, or the Conductor's Debug Trace opt ion is enabled for playback, executed script  statements wi l l  
be displayed. For example:  

VU 0 : Line:90, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:91, ofsActivateWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 247 ) 
VU 0 : Line:92, ofsShowWindow( "WINDOW_START_APP" ,11, OFS_ENDMSG, 173 ) 
VU 0 : Line:93, ofsFocus( "BUTTON" ,51, OFS_ENDMSG, 174 ) 
VU 0 : Line:94, ofsSetWindowSize( "FORMWINDOW" ,6, OFS_ENDMSG, 137, 750, 600 ) 
VU 0 : Line:95, ofsSendRecv( 1 )  //ClientSeqNo=2|MsgCount=6 

 

 

Oracle Forms Server method reference 

QALoad provides descript ions and examples of the various methods and funct ions avai lable for an Oracle 
Forms Server script . For detai ls, refer to the Language Reference Help sect ion for Oracle Forms Server. 

 

Using the certDB File for OFS Replay 

In some Oracle Appl icat ion Server and Oracle E-Business Suite 11i environments, the cert i ficates needed for 
the SSL handshake with the server are not in  the default  wal let  used during replay. This causes the SSL 
handshake to fai l . 

You can use the certDB fi le used by JIn it iator for OFS replay. To do th is for Script  Val idat ion, place the 
certdb.txt  fi le in  the BinaryFi les directory. 

To use t he cer t DB f i le f or  OFS replay in  Conduct or : 

1. In  the Conductor's Visual Designer, select the script  icon for the appropriate script  to display the 
Script Propert ies panel on the right-hand of the window.  

2. In  the External Data area, cl ick the brow se [...] button in  the At tached Fi les field. The Attached 
Fi les page of the Script Propert ies dialog box appears. 

3. Click Add. The Choose a Fi le to Attach dialog box displays. 

4. From the BinaryFi les folder, select certdb.tx t , then cl ick Open . 
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5. Click OK. 

SAP 

Overview of SAP 

Use QALoad's SAP middleware to load test systems that run SAP 6.20, 6.40, and 7.10.  

What  i s SAP? 

The SAP GUI front-end is a middleware that al lows users to access SAP servers from Windows. The SAP 
servers run various SAP business appl icat ions, such as appl icat ions for customer relat ionship management, 
human resources, and supply chain management. 

Connect ing to the SAP Server 

Once you have connected to a machine that is running the SAP server, you can log on and interact with 
the SAP appl icat ions.  

 

Configuring an SAP Client for Load Testing 

Before you can record an SAP session, you must have an SAP cl ient that is configured to enable QALoad to 
access the SAP server. Configure the SAP cl ient through the SAP Logon appl icat ion. 

To conf igure an SAP cl ien t  f or  load t est ing: 

1. Start  the SAP Logon appl icat ion. From the taskbar, cl ick Start>Program s>SAP Fron t  
End>SAPlogon . 

2. Click New ... on the SAP Logon dialog box. The New Entry dialog box appears. 

 

3. Type values in  the Descri pt i on , Appl i cat ion  Server, and System  num ber fields.  

Note: QALoad uses the value in  the Descri pt i on  field to connect to the server. 

4. Click OK. The new SAP server entry appears in  the l ist  in  the SAP Logon dialog box. 

 

SAP Recording Options  

Save Server Descri pt i on : Select to specify and save the server descript ion (name) to which you want to 
connect during recording. If th is check box is not selected, you are prompted for a server descript ion 
during the log on process. 
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Recording an SAP Session 

An SAP server connect ion must be configured before you can connect with QALoad. See Configuring an 
SAP Client for Load Test ing for more in formation. Addit ional ly, your SAP administrator must set the 
SAPGUI/User_Scripting securi ty profi le parameter to TRUE to successful ly record a script . For more 
in formation about SAP securi ty sett ings, refer to the SAP publ icat ion t i t led "Sapgui Scripting Security". 

To record an SAP session: 

1. If you have not already chosen SAP as the session type, cl ick SAP Session  to act ivate a new SAP 
session.  

2. In  the Script Development Workbench, cl ick Record on the Session toolbar. 

3. If you have not selected the Save Server Descript ion Record opt ion, the SAP Server Descript ion 
dialog box appears. Type the name of the SAP server to which you want to connect. This value is 
the same as the Descri pt i on  field that displays in  the SAP Logon configurat ion appl icat ion. Press 
En ter. A logon dialog box appears. 

 

4. Type a user ID in the User field and the password in  the Passw ord field. Press En ter. The SAP 
appl icat ion starts.  
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5. In  the SAP appl icat ion, turn off the script ing and not i ficat ion opt ions. Cl ick Custom izing of  l ocal  
l ayout  and choose Opt ions. The Options dialog box appears. On the Script ing tab, select Enable 
Script i ng and clear the two Not i fy check boxes. 

6. Begin recording act ions in  SAP. 

 

SAP Convert Options 

Save Passw ord: Select to save the encrypted password. If th is check box is not selected, you are prompted 
for a password during conversion. 

VB Script : Select to generate Visual Basic Script  for debugging outside QALoad. If th is opt ion is not 
selected, you receive C++ scripts that can be used for playback with in QALoad. 

Insert  SAP con t rol  com m ents: Select one of the fol lowing to insert  SAP control l ists as comments in your 
script .  

!  None: There is no control  in formation shown as a comment in  the script . 

!  Tex t f i elds and Statusbars: Control types GuiTextField or GuiStatusbar wi l l  be in  the script  as 
comments with in formation: type, name, and id string. 

!  Al l  con t rol s: Al l  controls wi l l  be in  the script  as comments with in formation: type, name, and id 
string. 

Bui ld SAP Libraries: Cl ick Bui ld to generate the QALoad SAP l ibraries based on your version of SAP. If you 
receive l inking errors whi le val idat ing or compil ing, you should cl ick th is button.  

 

 

SAP Command Reference  

QALoad provides descript ions and examples of the various commands avai lable for an SAP script . For 
detai ls, refer to SAP Language Reference Commands. 

 

 

Viewing the SAP Control Log  

Assist  your script ing by using the SAP capture control log fi le to view the in formation that was present at 
capture . The log fi le is in  XML format.  

To open t he cont rol  log : 

1. In  the Script Development Workbench Workspace, cl ick the Captures tab or the Scripts tab, then 
right-cl ick on an SAP script  or capture fi le.   

OR 

Open an SAP script  or capture fi le, then right-cl ick on the open fi le. 

2. From the right-cl ick menu, choose View  Con t rol  Log. 

 

 



QALoad Online Help 

29 

UNIFACE 

Uniface recording options 

Un i face executable: Enter the ful l  path or browse to the Uniface 7 executable that is used by the 
appl icat ion you want to record. For example: c:\usys72\bin\UNIFACE.exe. 

Work ing di rectory: Enter or browse to the working directory of your Uniface appl icat ion or the directory 
of any addit ional fi les your appl icat ion may require that do not reside in  the appl icat ion’s path 
environment. 

In i t i al i zat ion  (.i n i ) f i l e: Enter or browse to the ful l  path to the Uniface appl icat ion 's in i t ial izat ion fi le. 

Assignm en t  (.asn ) f i l e: Enter or browse to the ful l  path to the appl icat ion 's assignment fi le. For example: 
c:\usys72\project\myapp.asn. 

Com m and l i ne statem en t : Type command l ine opt ions that should be used at appl icat ion startup, 
including the command that is used to start  the appl icat ion. For example:  warehouse 1 control 
use=control dnp=tcp: 

 

Uniface conversion options 

Includes: Type the ful l  path or browse to the directory that contains the database include fi les. 

Libraries: Type the ful l  path or browse to the directory that contains the database l ibrary fi les. 

Generate Un i face l i sts: Uniface can handle in ternal  l ist  structures. Select th is check box to convert  strings 
contain ing l ist  i tems to a succession of DO_URB_xxx cal ls that manipulate Uniface l ists. 

Show  output  param eters: Select th is opt ion for the converted script  to contain the output parameters of 
an operat ion as commented l ines. 

Insert  t race m essages as com m ents: Select th is opt ion for the converted script  to contain the recorded 
content of the message frame as commented l ines. 

 

 

Uniface command reference 

QALoad provides descript ions and examples of the various commands avai lable for a Uniface script . For 
detai ls, refer to the Language Reference Help sect ion for Uniface. 

Winsock 

How QALoad handles DO_WSK_Send commands 

QALoad displays the contents of a DO_WSK_Send command as a string in  a Winsock script . Some of these 
strings are very large, which can cause a compiler error (fatal error C1076: compiler l im it : in ternal heap 
l im it  reached) i f there are several large strings in  a single script . 

To avoid th is compilat ion  error, QALoad does not al low strings that are displayed in a Winsock script  to be 
more than 12,000 characters. If a DO_WSK_Send command has a send buffer larger than 12,000 characters, 
i ts buffer is broken into smaller strings during the conversion. These smaller strings are then copied in to a 
char buffer named "SendBuffer", which is sent in  the DO_WSK_Send command. The size of the SendBuffer 
variable, by default , is declared as the size of the largest DO_WSK_Send + 1000. For example: 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 
/* Declare Variables */ 
char SendBuffer[22139];  //Largest send is 21139 + 1000 
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    ... 
... 
... 

     strcpy(SendBuffer, "$$ ...."); //Assume a large string, shortened for this example 
strcat(SendBuffer, "$$ ...."); 

     /* 12675 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     strcpy(SendBuffer, "$$ ...."); //SendBuffer is reused 
strcat(SendBuffer, "$$ ...."); 
strcat(SendBuffer, "$$ ...."); 

     /* 21139 bytes */ 
DO_WSK_Send(S1, SendBuffer); 

     ... 
... 

     REPORT(SUCCESS); 
EXIT(); 
return(0); 
} 

 

Handling Winsock application data flow 

Frequently, server programs return unique values (for example, a session ID) that vary with each execut ion 
of the script  and may be vital  to the success of subsequent transact ions. To create scripts that include these 
values, you need to subst i tute the hard-coded values returned by the server with variables. The fol lowing 
original and modified code examples demonstrate th is technique. 

Original  code 

In th is script , the server sends a session ID in response to a connect ion by the cl ient. This session ID is 
required to successful ly complete subsequent transact ions. 

/* 
* wsk-AdvancedTechniques_original.c 
* 
* This script contains support for the following 
* middlewares: 
* - Winsock 
*/ 
 
/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 
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int rhobot_script(s_info) 
PLAYER_INFO *s_info; 
{ 

/* Declare Variables */ 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

///////////////////////////////////////////////////// 
// The session id returned by the server is 
// unique to each connection 
///////////////////////////////////////////////////// 

/* 21bytes: SessionID=jrt90847\r\n */ 

DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// This unique id is then used for subsequent 
// requests 
////////////////////////////////////////////////////// 

/* 34 bytes */ 

DO_WSK_Send(S1, "SessionID=jrt90847\r\n:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User %i:ABORTED.", S_task_id); 

EXIT(); 
} 

M odi f i ed code 

If the original script  (wsk-AdvancedTechniques_original.c shown above) is replayed, i t  wi l l  fai l  because the 
session ID wil l  not be unique; rather, i t  wi l l  be the session ID that is coded in the script . To use the unique 
session ID received from the server, variable subst i tut ion must be used. 

/* 
* wsk-AdvancedTechniques_modified.c 
* 
* This script contains support for the following 
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* middlewares: 
* - Winsock 
*/ 

/* Converted using the following options: 
* General: 
* Line Split : 80 characters 
* Sleep Seconds : 1 
* Auto Checkpoints : Yes 
*/ 

#define SCRIPT_VER 0x00000005UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_wsk.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL 0 
#endif 

int rhobot_script(s_info) 
PLAYER_INFO *s_info; 

{ 

/* Declare Variables */ 

char Buffer[64]; 
char SendBuffer[64]; 
int nBytesReceived = 0; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("wsk-AdvancedTech_1.c"); 

// Checkpoints have been included by the convert process 

DefaultCheckpointsOn(); 

DO_WSK_Init(s_info); 

SetTimeout(20); /* Wait up to 20 seconds for each expected pattern */ 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
DO_WSK_Connect(S1, "172.22.24.125", 2100, AF_INET); 

////////////////////////////////////////////////////// 
// The reply from the server is read into 
// the Buffer variable. We will then have 
// the unique Session ID for this connection. 
// Also need to null-terminate the buffer 
// after receiving. 
////////////////////////////////////////////////////// 

DO_WSK_Recv(S1, Buffer, 64, 0, &nBytesReceived); 
Buffer[nBytesRecieved] = '\0'; 

/* 21bytes: SessionID=jrt90847\r\n */ 

//DO_WSK_Expect(S1, "\n"); 

////////////////////////////////////////////////////// 
// Finally, substitute the Session ID received from 
// the server with the one coded in the script. 
////////////////////////////////////////////////////// 
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sprintf(SendBuffer, "%s:^B^@^@^@^B^@^@^@^A^@^@^@", Buffer); 
DO_WSK_Send(S1, SendBuffer); 

/* 34 bytes */ 

//DO_WSK_Send(S1, "SessionID=jrt90847:^B^@^@^@^B^@^@^@^A^@^@^@"); 

/* 15 bytes: ID Accepted#^@\r\n */ 

DO_WSK_Expect(S1, "\n"); 
DO_WSK_Closesocket(S1); 

END_TRANSACTION(); 

REPORT(SUCCESS); 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 
RR__printf("Virtual User %i:ABORTED.", S_task_id); 
EXIT(); 
} 

Winsock Recording Options 

User Started: Select th is opt ion i f you want to start  your appl icat ion manually for recording, either before 
or after you start  recording. Because th is method may fai l  to record your appl icat ion’s in i t ial  cal ls, 
Compuware recommends you use the Autom at i c opt ion instead. Select the User Started opt ion when you 
do not know the ful l  appl icat ion startup name and command opt ion parameters or when the appl icat ion 
spawns off processes that generate traffic that you want recorded. 

Notes:  
If you run a character-based appl icat ion in  a DOS window, the Script Development Workbench does not 
record the API cal ls. 
 
If you choose th is opt ion and the appl icat ion under test generates traffic before the first  Windows screen 
displays, you must also select the Capture In i t i al i zat ion  Phase check box on the Workbench 
Configurat ion tab of the Configure QALoad Script Development Workbench dialog box. 

Autom at i c: Select th is opt ion i f you want QALoad to automatical ly start  your Winsock-based cl ient, 
al lowing you to record early appl icat ion startup act ivi ty. This is the recommended method of recording 
because i t  takes advantage of QALoad’s enhanced abi l i t ies to handle various mult i-threaded programming 
techniques. When you select th is opt ion, the QALoad Script Development Workbench records the API cal ls 
that occur before the cl ient enters i ts message loop. Select th is opt ion to record traffic from just one 
appl icat ion. This opt ion l im its the recording output to just the traffic generated by the appl icat ion, not 
including the traffic that is generated by processes spawned by the appl icat ion. 

Com m and Line: Enter the command l ine of your Winsock-based cl ient. Note that i f you enter the ful l  
path, QALoad automatical ly enters the path in  the Work ing Di rectory field. 

Work ing Di rectory: Enter the working directory of your Winsock-based cl ient, i f necessary. 

Capture: Select the Winsock version to record. 

Set  IP Addresses: Cl ick th is button to open the Add/Delete IP Addresses dialog box, which you can use to 
specify the IP addresses and ports on which you want to record Winsock API cal ls or that you wish to 
exclude from recording.  

 

Winsock Conversion Options 

There are no special ized conversion opt ions for Winsock.  
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Winsock Command Reference 

QALoad provides descript ions and examples of the various commands avai lable for a Winsock script . For 
detai ls, refer to the Language Reference Help sect ion for Winsock. 

WWW 

Converting a WWW Script  

QALoad has been enhanced to enable you to control how much automated processing is performed during 
test execut ion by choosing HTML mode or HTTP mode for script  conversion. When going through the 
WWW convert  for the first  t ime, you are now prompted to choose between HTML mode and HTTP mode.  

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert  
between modes, rather than manually edit  the script . 

Typical HTML processing uses more processor cycles and memory during test execut ion, but requires less 
script ing. The Visual Navigator is generated using QALoad's Document Object  Mode (DOM) approach, 
which also is used for playback.  

HTTP processing instructs QALoad to disable most of i ts automatic HTML handl ing engine during replay, 
and i t  also affects how the script  is generated. In  th is mode, the convert  process uses some HTML parsing 
to generate the Visual Navigator. This parsing method also is used for playback instead of the DOM. The 
HTTP mode replaces M in imized Processor mode. Scripts converted before QALoad release 5.6 using 
M in imized Processor mode wil l  replay in  HTTP mode. 

Caut ion : Once you convert  a script  using HTTP mode or HTML mode, you must reconvert  the script  
to change the convert  mode. This is necessary so that the convert  and replay methods match. Fai lure to 
change modes by reconvert ing the script  can cause the script  to replay incorrect ly. 

Using the WWW Record Options 

Use the WWW Record Options to determine how QALoad handles captures web page transact ion data.  

To set  t he W W W  recording opt ions: 

1. With a WWW session open, cl ick Opt ions>Record. The Session Options dialog box appears with 
the WWW Record Options h ighl ighted in  the tree view control. The WWW Record Options dialog 
box appears on the right. 

2. Select the appropriate opt ions, then do one of the fol lowing: 

!  Click OK to save the select ions and return to the WWW session screen. 

!  Click Advanced Record Opt ions in  the tree view control. The Advanced Recording 
Options dialog box appears on the right. 

3. Select the appropriate opt ions.  

4. Click OK. The basic record opt ions and the advanced opt ions are saved and you return to the 
WWW session screen. 

Using the WWW Convert Options 

Use the WWW Convert Options to control how QALoad produces scripts from recorded transact ion data. 
You can also choose the convert  and playback mode for WWW middleware sessions. The convert  and 
playback mode determines the amount of memory and processor QALoad uses during replay. 
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To select  t he processing  m ode: 

1. With the WWW session open, cl ick Opt ions>Convert . The Session Options dialog box displays. 

2. Click WWW Convert  Opt ions in  the tree view control. The WWW Convert Options dialog box 
appears on the right side of the screen. 

3. Select the convert  mode to use for the WWW middleware sessions. You can choose: 

!  HTML Mode - to reduce the amount of script ing. 

!  HTTP Mode - to control processor and memory usage. 

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert  
between modes, rather than manually edit  the script .  

4. Click each of the fol lowing to display the associated dialog box and select the appropriate opt ions: 

Note: The opt ions avai lable for Parsing depend on whether you select HTTP or HTML mode.  

!  Parsing 

!  Verificat ion 

!  Caching 

!  Traffic Fi l ters 

!  Rule Fi l ters 

!  Connect ion Sett ings 

!  Content Type Handling 

!  General 

!  Siebel 

5. Click OK to save the sett ings and return to the main WWW session screen. 

Caut ion : Once you convert  a script  using HTTP mode or HTML mode, you must reconvert  the script  
to change the convert  mode. This is necessary so that the convert  and replay methods match. Fai lure to 
change modes by reconvert ing the script  can cause the script  to replay incorrect ly. 

Using the WWW Playback Options   

The WWW Playback opt ions you select affect the ent ire script . 

To select  t he W W W  Playback  Opt ions: 

1. With a script  open in a WWW session, double-cl ick Playback  Opt ions in  the tree view. The 
avai lable session opt ions display in  the tree view. 

2. Double-cl ick W W W Playback  Opt ions in  the tree view.  

3. Click each playback opt ion in  the tree view to display the associated dialog box on the right.  

4. Click each of the fol lowing to display the associated dialog box and select the appropriate opt ions: 

Note: The opt ions displayed for Parsing depend on the mode you select in  the WWW Convert 
Options dialog box.  

!  Parsing (HTML Mode or HTML Mode) 

!  Caching 

!  Traffic Fi l ters 



Using the Player, Script  Development Workbench, and Analyze 

36 

!  Connect ion Sett ings 

!  Proxy 

!  General 

!  Siebel 

 

Configuring a Web Browser (WWW) 

Before you record the WWW requests your Web browser makes, you must configure the browser to use 
QALoad’s proxy server. 

To conf igure a W eb brow ser : 

1. Start  your Web browser. 

2. Specify proxy sett ings: 

!  In  the field designated to specify the address of the proxy server, enter the machine name 
where QALoad Script Development Workbench is instal led. 

!  In  the Port  field, enter the port(s) that you specified on the Script Development Workbench’s 
WWW Record Options wizard (Capture Ports fields). 

3. Click OK.  

 

Best Practices 

Using the WWW Convert  Opt ions Dialog Box  

The fol lowing topics provide usage t ips and result ing script  examples for each of the opt ions that are 
avai lable on the WW W Convert  Opt ions dialog box: 

Convert Mode Selection 

HTML Mode 
HTTP Mode 

WWW Convert Options 

Parsing 
Veri ficat ion 
Caching 
Traffic Fi l ters 
Rule Fi l ters 
Connect ion Sett ings 
Content Type Handling 
General 
Siebel 

Com pari son  of  HTTP M ode and HTM L M ode  

Choosing HTML mode or HTTP mode for script  conversion enables you to control how much automated 
processing is performed during test execut ion. Typical HTML processing uses more processor cycles and 
memory during test execut ion, but requires less script ing. HTTP processing instructs QALoad to disable 
most of i ts automatic HTML handl ing engine during replay, and i t  also affects how the script  is generated.  
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Features Avai lable for 
Select ion  

HTTP 
M ode 

HTM L M ode Convert  Opt ions 
Page 

Parsing  Yes No (Always On) Parsing 

Dynamic Cookie Handling Yes No (Always On) Parsing 

Dynamic Redirects Yes No (Always On) Parsing 

Authent icat ion Yes Yes N/A 

HTTPS Yes Yes N/A 

Extracts Yes Yes N/A 

Tit le Veri ficat ion  Yes Yes Verificat ion 

Content Check Yes Yes Content Type 
Handling 

Chunked Data Yes Yes N/A 

Streaming Media Yes Yes General 

Traffic Fi l ters Yes Yes Traffic Fi l ters 

Parameterizat ion Rules Yes Yes Rule Fi l ters 

Al low JavaScript Execut ion Yes No Parsing 

Click_Ons No Yes N/A 

Fi l l  In  Forms No Yes N/A 

Caching Yes Yes Caching 

Expert User Yes Yes N/A 

Universal Mode Yes Yes N/A 

Represent CJK as Octal 
Characters 

Yes Yes General 

UTF-8 Yes Yes N/A 

XML Requests Yes Yes General 

Meta Refresh Yes Yes General 

Automatic Sub-request 
Processing 

Yes No (Always On) Parsing 

Set JavaScript Execut ion 
Level 

No Yes Parsing 

Set JavaScript Loop 
Timeout 

Yes Yes Parsing 
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Manually Select Sub-
requests 

Yes Yes Parsing 

Persistent Connect ions 
During Replay 

Yes Yes Connect ion Sett ings 

Graceful Socket Shutdown Yes Yes Connect ion Sett ings 

Baud Rate Emulat ion Yes Yes Connect ion Sett ings 

Reuse SSL Session ID Yes Yes Connect ion Sett ings 

Siebel Support Yes Yes Siebel 

Strip Al l  Cookies Yes Yes General 

 

Using HTM L M ode  

HTML mode converts and replays scripts using ful l  Document Object Model (DOM) and JavaScript engine. 
HTML documents are ful ly parsed in HTML mode. JavaScript can be executed at different levels, including 
NONE, LIMITED, and FULL. Because HTML mode uses ful l  DOM and JavaScript engine, i t  uses more 
processor cycles and memory during test execut ion, but requires less script ing.  

Use HTML mode to create load test ing scripts quickly and easi ly, and for load tests requiring fewer virtual 
users (VU) running on any player machine. You can use HTML mode to create scripts for heavier load 
test ing, but the scripts may require more player machines on which to run the VUs. 

Considerat ions 

!  Javascript  - Javascript  can be executed at different levels, including None, Limited, and Ful l . 

!  CPU usage - Uses more processor cycles during test execut ion 

!  M em ory - Uses more memory during test execut ion 

!  Param eteri zat ion  - Requires less script ing and less parameterizat ion than HTTP mode because 
QALoad is better able to in fer user act ions using i ts DOM. 

Use th is mode i f you are: 

!  test ing a web site that uses complex JavaScript with complex HTML pages that  contains a 
significant number of l inks, tables or HTML objects 

!  a novice tester and wish to work with scripts that more closely resemble the user's in teract ions with 
the appl icat ion under test  

!  only test ing with a low number of virtual users or have significant hardware resources avai lable for 
load test ing execut ion 

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert  
between modes, rather than edit  the script  manually. 

Sample Script  

The fol lowing shows a sample of a script  with HTML mode selected: 

… 
… 
SET_SCRIPT_LANGUAGE(SLID_English); 
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DO_WWWInitialize(s_info, HTML_MODE); 

... 

... 

BEGIN_TRANSACTION(); 

… 
… 

Using HTTP M ode  

HTTP mode converts and replays scripts using a simpli fied HTML parser and l im ited JavaScript engine. You 
can control the level of HTML document parsing, and whether JavaScript should be executed. HTTP mode 
does less processing during replay and uses less memory because i t  does not create Document Object 
Models (DOM) for each processed HTML page.  

HTTP mode may require more parameterizat ion than HTML mode. During conversion, act ions are 
represented in the visual script  by NavigateTo or PostTo tree i tems instead of Cl ickOn or Fi l l -In  Form tree 
i tems. This means that any dynamic variables passed from reply to request must be managed in the script . 
Use the Variable Replacement Wizard to develop rules to find parameters in  your script  and replace them 
with variables.  

Considerat ions 

!  JavaScri pt  — Because JavaScript execut ion is l im ited, some scripts may require customizat ion to 
emulate Javascript  operat ions not executed by QALoad. 

!  Autom at i c Sub-requests — When Parsing is selected, automatic Sub-requests are enabled. When 
not enabled, QALoad executes the same sub-requests made during the capture phase (instead of 
parsing the server responses). This makes playback h ighly scalable, but very dynamic web 
appl icat ions may require addit ional script ing. Al l  subrequests and addit ional  subrequests are 
selected by default  during the convert . 

!  Funct ions — Converted scripts use only the Navigate_To() and Post_To funct ions; the Click_On() 
funct ion is disabled.  

!  Param eteri zat ion  — May require more parameterizat ion than HTML mode. 

!  M em ory and CPU Usage — Does less processing and uses less memory during replay. 

!  Dyn am ic variables — Dynamic variables passed from reply to request must be managed in the 
script .  

Use th is mode i f you are: 

!  test ing a web site that makes l i t t le use of Javascript  and creates pages with few HTML opt ions on 
them 

!  an experienced load tester and wish to work with scripts that more closely resemble the 
appl icat ions HTTP interact ions with the server under test 

!  you are test ing for h igh virtual user throughput or simulat ing h igh numbers of concurrent virtual 
users from l im ited hardware resources 

Tip: Compuware recommends that you use the WWW Convert Options dialog box to convert  
between modes, rather than edit  the script  manually. 

Sample Script   

The fol lowing shows a sample script  with HTTP mode selected: 

… 
… 
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SET_SCRIPT_LANGUAGE(SLID_English); 

DO_WWWInitialize(s_info, HTTP_MODE); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

 

Parsing 

Using the Parsing Option 

When the Page Parsing opt ion is selected on the WWW Convert Options, QALoad performs l im ited 
parsing operat ions on incoming HTML pages. This opt ion only appl ies to HTTP mode, and is disabled i f 
HTML mode is selected as the convert  mode.  

You should disable th is opt ion i f you find that you need to fi t  more HTTP mode virtual users on a single 
player machine. Disabl ing th is opt ion can decrease the processor usage required by a virtual user.  

Considerations 

!  When selected, l im ited parsing is performed on incoming HTML pages. 

!  Must be selected to enable the Al low Javascript  execut ion opt ion. 

!  Must be selected to enable the Automatical ly process sub-requests opt ion. 

!  May increase processor usage required by a virtual user. 

Use this option to: 

!  Enable execut ion of Javascript  in  HTTP mode. 

!  Enable automatic sub-request ing in  HTTP mode. 

!  Enable document veri ficat ion in  HTTP mode. 

 

Al low JavaScript Execut ion 

This opt ion is only enabled when the Parse Pages opt ion is selected in  HTTP conversion mode. QALoad 
executes JavaScript in  replay as i f the LIMITED JavaScript Execut ion Level is used. Since JavaScript is always 
executed in HTML mode, th is opt ion is disabled i f HTML mode is selected as the convert  mode. 

Considerations 

!  The opt ion to turn on or turn off JavaScript execut ion is avai lable only in  HTTP mode. JavaScript is 
always executed in HTML mode. 

!  When enabled, QALoad executes JavaScript at  the Limited execut ion level.  

!  May decrease the amount of parameterizat ion required for certain scripts. 

!  May increase the processor t ime required by a virtual user. 

Use this option to: 

Decrease the amount of parameterizat ion required. 
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Automatical ly Process Sub-requests in  HTTP Mode 

When th is opt ion is selected, QALoad does not insert  sub-requests (such as .jpg, .gi f, .css, .js, etc.) direct ly 
in to the script  fi le, but automatical ly makes these requests during replay by parsing them out of the HTML 
pages. 

This opt ion is only enabled when HTTP mode is selected and the Parse Pages opt ion is enabled. HTML 
mode always processes sub-requests automatical ly.  

Considerations 

!  When th is opt ion is disabled, QALoad executes the same sub-requests made during the capture 
phase instead of parsing the server response. 

!  Very dynamic web appl icat ions may require addit ional script ing. 

!  All sub-requests and addit ional sub-requests are selected by default  during convert . 

!  Enabling th is opt ion requires more processing during playback. 

Use this option to: 

!  Allow QALoad to manage sub-requests. 

!  Reduce the length of .cpp script  fi les. 

!  Increase .cpp script  fi le readabi l i ty. 

Sample Script 

Example Web Page 

Script Example with Option Selected 

Script Example with Option Not Selected 

Example Web Page 

<html> 
<head> 
<title>Page Of Subs</title> 
</head> 
<body> 
<p>The page of subrequests</p> 
<p>.<img border="0" src="win2000.gif" width="456" height="124"><img border="0" 
src="APACHE.GIF" width="259" height="32"><img border="0" src="banner.gif" width="470" 
height="64"><img border="0" src="COLORS.GIF" width="200" height="100"></p> 
</body> 
</html> 

Script Example with the Automatically Process Subrequests Option Selected 

In the fol lowing example, the Autom at i cal l y Process Subrequests check box is selected. 

... 

... 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 
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DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script Example with the Automatically Process Subrequests Option Not Selected 

In the fol lowing example, the Autom at i cal l y Process SubRequests check box is cleared. 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_AutomaticSubRequests(FALSE); 

... 

... 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

/* Request: 2 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/win2000.gif HTTP/1.0\r\n\r\n"); 

/* Request: 3 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/web.gif HTTP/1.0\r\n\r\n"); 

/* Request: 4 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/APACHE.GIF HTTP/1.0\r\n\r\n"); 

/* Request: 5 From: Page Of Subs */ 
DO_Http("GET http://www.host.com/COLORS.GIF HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Dynamic Redirect Handling 

Select ing th is opt ion enables the QALoad replay engine to dynamical ly handle 3XX redirects. When a 3XX 
redirect page is returned during replay, QALoad processes the redirect and requests the redirected page as 
well . This opt ion only appl ies to HTTP mode, and is disabled i f HTML mode is selected as the convert  
mode. 

Considerations 

!  This opt ion should normally only be disabled i f you do not want the script  to fol low 3XX redirects. 

!  Dynamic redirect handl ing does not handle JavaScript redirects. 

!  Dynamic redirect handl ing does not handle meta refresh redirects.   

Use this option to: 

!  Dynamical ly handle 3XX redirects. 
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!  Process the redirect and also request the redirected page. 

Examples 

Consider a Web page with a l ink to 'Redirected Webpage' (http:/ /www.host.com/cgi-bin/dynredir.exe). 
When th is l ink is cl icked, the server generates a 302 return value with a new redirected locat ion of 
http:/ /172.22.24.39/cgi-bin/aperl_8.pl. 

Script  Example with Option Selected 

Script Example with Option Not Selected 

Script Example with the Dynamic Redirect Handling Option Selected 

When th is opt ion is selected, the script  contains only the request for http:/ /www.host.com/cgi-
bin/dynredir.exe. Replay handles the 302 return value and cal ls http:/ /172.22.24.39/cgi-bin/aperl_8.pl 
automatical ly. 

The fol lowing example has the Dynam ic Redi rect  Handl ing check box selected. 

... 

... 

/* Declare Variables */ 
int i; 
char *Anchor[1]; 

... 

... 

for(i=0;i<1;i++) 
Anchor[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_DynamicRedirectHandling(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/""1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 

... 

... 

DO_GetAnchorHREF( "Redirected Webpage", &Anchor[0]); 

... 

... 

DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of Dynamic Redirect Sample", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 
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... 

... 

Script Example with the Dynamic Redirect Handling Option Not Selected 

In th is example, the script  contains the request for http:/ /www.host.com/cgi-bin/dynredir.exe as well  as 
http:/ /172.22.24.39/cgi-bin/aperl_8.pl. The fol lowing example has the Dynam ic Redi rect  Handl ing check 
box cleared. 

... 

... 

/* Declare Variables */ 
int i; 
char *Anchor[1]; 

... 

... 

for(i=0;i<1;i++) 
Anchor[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicRedirectHandling(FALSE); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_GetAnchorHREF( "Redirected Webpage", &Anchor[0]); 
DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Document Moved", TITLE); 
DO_Http("GET http://www.host.com/redir/frm.pl HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of Dynamic Redirect Sample", TITLE); 
DO_SetTransactionCleanup(); 

/* Clear up some internal storage used for DO_SetValue() */ 
DO_HttpCleanup(); 
for(i=0; i<1; i++) 
{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 

... 

... 

 

Dynamic Cookie Handling 

 When you select  th is opt ion, QALoad automatical ly processes dynamic cookies during replay. This opt ion 
only appl ies to HTTP mode, and is disabled i f HTML mode is selected as the convert  mode. QALoad always 
handles dynamic cookies in  HTML mode. 

Considerations 

!  Not select ing th is opt ion hard codes cookie values from the capture fi le in to the script  fi le.  

!  When th is opt ion is not selected in  HTTP mode, QALoad places Set(NEXT_REQUEST, COOKIE) 
commands into the generated script  fi le.  
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!  When th is opt ion is enabled, and you st i l l  can insert  Set(NEXT_REQUEST_ONLY, COOKIE) 
statements. This can override the cookie value that QALoad sends for any cookie that is being 
dynamical ly handled. 

!  You should only disable th is opt ion i f you require more control over the cookies that QALoad 
sends during replay. 

Use this option to: 

!  Ensure that dynamic cookies are processed during replay. 

!  Ensure that dynamic cookies are not automatical ly inserted in to the script  during convert . 

Example Web Page 

Script Example with Option Selected 

Script Example with Option Not Selected 

Example Web Page 

The cookies for th is si te are: 
Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 
<html> 
<head></head> 
<body> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br> 
</body> 
</html> 
Script example with the Dynamic Cookie Handling option selected 
The following example has the “Handle Dynamic Cookies” check box selected. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, TRUE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
... 
END_TRANSACTION(); 
... 
... 

Script Example with the Dynamic Cookie Handling Option Selected 

The fol lowing example has the Dynam ic Cook ie Handl ing check box selected. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, TRUE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
... 
END_TRANSACTION(); 
... 
... 

Script Example with the Dynamic Cookie Handling Option Not Selected 
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The fol lowing example has the Dynam ic Cook ie Handl ing check box cleared. 
... 
... 
Set(EVERY_REQUEST, HTTP_MODE_HANDLE_DYNAMIC_COOKIES, FALSE); 
BEGIN_TRANSACTION(); 
... 
... 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
/* Request: 2 */ 
Set(NEXT_REQUEST_ONLY, COOKIE, "SaneID",  
"172.22.24.180-4728804960004"); 
Set(NEXT_REQUEST_ONLY, COOKIE, " SITESERVER ",  
" ID=f0544199a6c5970a7d087775f83b23af "); 
Navigate_To("http://www.host.com/cgi-bin/cookies5.pl "); 
... 
... 
END_TRANSACTION(); 
... 
... 

 

JavaScript Execut ion Level  

This opt ion controls the types of JavaScript statements that QALoad executes while running in  HTML 
mode. The levels are None, Limited, and Ful l . Limited is selected by default .     

This opt ion only appl ies when HTML is selected as the convert  mode. In HTTP mode, th is opt ion is 
disabled and there is only a single level of JavaScript  execut ion. 

Caut ion : Always make changes to the JavaScript Execut ion Level using the WWW Convert Options 
dialog box, then re-convert  the capture fi le to create a new script . Changing the JavaScript Execut ion 
Level direct ly in  the script  wi l l  affect script  replay.  

The fol lowing table explains each JavaScript Execut ion Level: 

Execut ion  Level  Descript i on  

None No JavaScript is executed during replay. 

Limited Only the fol lowing JavaScript statements are executed during replay: 

!  document.cookie = 

!  window.document.cookie =  

!  document.wri te() 

!  window.document.wri te() 

Images are also requested where the image.src statement occurs. 

Ful l  Al l  JavaScript statements are executed during replay. 

Considerations 

!  When using the Limited JavaScript Execut ion Level, you may need to do further parameterizat ion 
and edit  the script . 

!  In  HTTP mode, only the Limited level of JavaScript execut ion is avai lable. 

!  Using no JavaScript execut ion or a Limited level execut ion requires less processing t ime and 
memory usage than the Ful l  level of JavaScript execut ion. 

Use this option to: 
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Control the amount of processor and memory usage. 

 

JavaScript Loop Timeout 

This opt ion controls the amount of t ime that a JavaScript runs before QALoad terminates the JavaScript 
code. JavaScript can run in to in fin i te loops, or take a very long t ime to run. This opt ion appl ies to both  
HTML and HTTP mode. 

Considerations 

!  The t imeout value should be decreased i f you find that an unnecessary JavaScript is running longer 
than the t imeout value.  

!  The t imeout value should be increased i f you find that a necessary JavaScript is running longer 
than the t imeout value.   

!  Make sure that a necessary JavaScript is able to complete before the t imeout value of t ime is 
reached. 

Use this option to: 

Prevent JavaScripts from running into in fin i te loops or from running indefin i tely . 

 

Connect ion  Set t i ngs 

Connect ion Sett ings  

These opt ions control how QALoad handles connect ions to target servers during replay. You can select  
connect ion sett ings from the Convert  Options dialog box or by select ing Playback Options in  the Visual 
Navigator tree. 

Connection Options 

Persi sten t  connect ions during replay: Select th is check box to keep the connect ion to the server open for 
each request sent to the server. By keeping connect ions open (persistent), you can increase the speed at 
which requests are sent to the server. 

M ax  concurren t  connect ions: Type the maximum number of connect ions to the server QALoad 
should have open at a t ime. The min imum and default  number is 2. The maximum number of 
connect ions is 4. These simultaneous connect ions are only used i f sub-request ing is enabled. This field 
only accepts val id posit ive in tegers. 

M ax  connect ion  ret r i es: Type the number of t imes QALoad should attempt to connect to the Web 
server after t im ing out. This field only accepts val id posit ive in tegers. 

Connect ion  ret ry w ai t  t im e: Type the number of seconds during replay that QALoad waits before 
attempting to reconnect to the server after fai l ing to connect. This field only accepts val id posit ive 
in tegers. 

Server response t im eout : Type a length of t ime, in  seconds, QALoad should wait  for a reply from the 
server before t im ing out. 

Graceful Socket Shutdown  

On : Indicates that QALoad should attempt to terminate socket connect ions graceful ly in  the presence 
of unexpected condit ions.  

Of f : Indicates that QALoad should NOT attempt to terminate socket connect ions graceful ly in  the 
presence of unexpected condit ions.  
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Baud Rate Emulation  

Em ulate t ransm ission  baud rate: Select to simulate a specific baud rate for transmission of requests, and 
then select a rate from the Baud Rate drop-down field. QALoad then slows the transmission of requests 
appropriately in  order to emulate the transact ion rate to a web server, such as a 56 Kbps modem or DSL.  

Baud rate: The default  is 112000. Options include: 112000, 57600, 33600, 28800, 14400, and 9600. 

Em ulate recept ion  baud rate: Select to simulate a specific baud rate for recept ion of requests, and then 
select a rate from the Baud Rate drop-down field. QALoad then slows the recept ion of requests 
appropriately in  order to emulate the transact ion rate from a web server, such as a 56 Kbps modem or DSL.  

Baud rate: The default  is 112000. Options include: 112000, 57600, 33600, 28800, 14400, and 9600. 

SSL Session 

Reuse SSL session  id: Select to instruct QALoad to reuse the current session 's communicat ion 
in formation (session ID) for al l  page requests with in the transact ion. 

Restore defaul ts for th i s page: (Convert  only) Cl ick th is l ink to restore al l  control values on th is page to 
their default  values. 

 

Persistent Connect ions During Replay 

This is an opt ion placed in the script  to be used at replay t ime. Select ing th is opt ion keeps the connect ion 
to the server open for each request sent to the server.  

Considerations 

Keeping connect ions open (persistent) can increase the speed at which requests are sent to the server. 

Use this option to: 

Control processor and memory usage for requests. 

 

Max Concurrent Connect ions 

This opt ion indicates the maximum number of connect ions that a DO_Http or DO_Https command opens 
to the server at any t ime. These simultaneous connect ions are only used i f sub-request ing is enabled. 

Considerations 

!  Keeping the maximum number of connect ions open can increase the speed at which requests are 
sent to the server. 

!  In  HTTP mode, i f the Automatically process subrequests opt ion on the Parsing Options page is NOT 
selected, th is opt ion is disabled. 

Use this option to: 

Control processor and memory usage for requests. 

 

Max Connect ion Retries 

This opt ion specifies the number of t imes during replay that QALoad wil l  at tempt to connect to the server 
after t im ing out.  

Considerations 
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You must select Persistent connect ions during replay to enable th is opt ion. 

Use this option to: 

Control processor and memory usage for requests. 

 

Server Response Timeout 

This opt ion specifies, in  seconds, the length of t ime during replay that QALoad waits for data from the 
server before t im ing out.  

Considerations 

You must select Persistent connect ions during replay to enable th is opt ion. 

Use this option to: 

Control processor and memory usage for requests. 

 

 

Baud Rate 

Use th is opt ion to simulate slower connect ions to a Web server, such as 56 Kbps modem or DSL.  

Specify a baud rate when enabl ing baud rate emulat ion in  the Convert  Opt ions dialog box. 

Considerations 

!  The DO_SetBaudRate command is inserted in to the script  with the specified baud rate as i ts only 
parameter.  

!  If baud rate emulat ion must be asymmetric (the upload rate is different than the download rate), 
use the DO_SetBaudRateEx command.  

!  DO_SetBaudRateEx takes two parameters: the upload baud rate and the download baud rate.  

Use this option to: 

!  Simulate a specific baud rate for transmission of requests. 

!  Simulate a specific baud rate for recept ion of requests. 

 

General  

Proxy HTTP version  

A WWW script can be set to 1.1 or 1.0. When set to 1.1, al l  proxy HTTP requests and subrequests are sent 
as HTTP/1.1. When set to 1.0, al l  proxy HTTP requests and subrequests are sent as HTTP/1.0.  

Consideration 

HTTP 1.1 requests receive chunked repl ies.  

Use this option to: 

Specify the HTTP version of requests and sub-requests sent to the server.  
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META Refresh Threshold  

When th is opt ion is selected, the t ime value that you specify in  the seconds field is compared to a Web 
page’s META Refresh value (e.g. <META HTTP-EQUIV=Refresh CONTENT=” 10” ; 
URL=” http:/ /www.compuware.com” >).  

Considerations 

!  If the CONTENT field value is less than the t ime value you specify, the page is treated as a 
redirected page.  

!  If the CONTENT field value is greater than the t ime value you specify, the page is treated as a 
regular page. 

Use this option to:  

Avoid in fin i te loops in  the script . In fin i te loops can occur i f a page refreshes periodical ly to update data. 

Sample Scripts 

Script  Example with Option Selected 

Script Example with Option Not Selected 

Script Example with the META Refresh Threshold Option Selected 

The fol lowing example has the M ETA Refresh  Th reshold check box selected and is set to a value greater 
than 5. 

... 

... 

Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 

Set(EVERY_REQUEST, META_REFRESH_THRESHOLD, 5); 

BEGIN_TRANSACTION(); 

... 

... 

/ * Request: 1 */  

Navigate_To(“ http:/ /host/path/ to/page.pl"); 

Veri fy(PAGE_TITLE , "You have reached the final page!!"); 

Script Example with META Refresh Threshold Option Not Selected 

The fol lowing example has the M ETA Refresh  Th reshold check box cleared. The example also appl ies to 
having the opt ion selected and set to a value less than 5. 

... 

... 

/ /  WWW General Options 

Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 

BEGIN_TRANSACTION(); 
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... 

... 

/ * Request: 1 */  

Navigate_To(“ http:/ /host/path/ to/page.pl"); 

Veri fy(PAGE_TITLE, “ Just Wait” ); 

DO_SLEEP(5); 

/ * Request: 2 */  

Navigate_To(“ http:/ /host/path/ to/ realpage.pl"); 

Veri fy(PAGE_TITLE, "You have reached the final page!!"); 

 

Represent CJK as Octal Characters 

When th is opt ion is selected, the double-byte characters used for Chinese, Japanese, and Korean (CJK) 
scripts are converted in to octal format.  

Considerations 

!  Since CJK characters use Double Byte Character Sets (DBCS), encoding must be enabled for a 
capture with CJK characters, so that the double-byte characters can be viewed in a legible format. 

!  Data stays in  encoded format throughout the load test: from capture, through convert  and replay, 
to the analysis of the t im ing fi le.  

Use this option to: 

!  Enable the encoding of captured data from web appl icat ions contain ing Double Byte Character Sets 
(DBCS) such as Chinese, Japanese, or Korean.  

!  Encode al l  nat ive characters when nat ive character support cannot be used.  

Sample Scripts 

Example Web Page 

Example Script  with Option Selected 

Example Script  with Option Not Selected 

Example Web Page 

<html> 
<head> 

<title>  </title> 
<meta http-equiv="Content-type" content="text/html; charset=euc-kr"> 
<meta http-equiv="Cache-Control" content="no-cache"> 
<meta http-equiv="Pragma" content="no-cache"> 
<meta http-equiv="Expires" content="Wed, 04 Jul 1973 16:00:00 GMT"> 

<!--CSS--> 
<style type='text/css'> 
</style> 

<!--/CSS--> 
</head> 
<body onload="document.search.p.focus();" topmargin=8> 
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... 

... 

</body> 
</html> 

Script Example with the Represent CJK as Octal Characters Option Selected 

The fol lowing example has the Represen t  CJK as Octal  Characters check box selected. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("\276\337\310\304!\304\332\270\256\276\306", TITLE); 

... 

... 

Script Example with the Represent CJK as Octal Characters Option Not Selected 

The fol lowing example has the Represen t  CJK as Octal  Characters check box cleared. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 

DO_VerifyDocTitle( , TITLE); 
 
... 
... 

 

Streaming Media 

QALoad supports two types of streaming media: 

!  RealOne Player 

!  Windows Media Player 

Considerations 

!  Streaming media is not supported through firewalls and across proxies. 

!  When streaming media conversion is enabled and you record a transact ion that cal ls streaming 
media, an addit ional command is inserted in to the script  that requests the media.  

!  You do not have to l isten to or view the ent ire media you are request ing. Simply record i ts URL and 
ensure that the appropriate media player is instal led on the QALoad Player machines that wi l l  
execute playback of the script . 

!  At run t ime, the script  invokes the media player and requests the streaming media resource. 

Use this option: 

For audio and video download test ing of scripts with Windows Media Player or RealOne Player and 
their supported media formats through a WWW session.  

Sample Scripts 

Advanced RealOne Player Media Options 

Script Examples with Option Selected 
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Script Examples with Option Not Selected 

Advanced RealOne Player Media Options 

The fol lowing statements are examples of how addit ional RealOne Player streaming media commands can 
be used in a script . 

!  void ShowMediaRP(BOOL displayAudio, BOOL displayVideo); 

Enable/disable cl ient audio and video for RealNetworks Streaming Media. 

!  void EnableStatisticsRP(int statisticFlags, int interval, BOOL traceOutput); 

Enable cl ient-side performance stat ist ics for RealNetworks Streaming Media. 

!  void DisableStatisticsRP(void); 

Disable cl ient side performance stat ist ics for RealNetworks Streaming Media. 

Script Examples with Streaming Media Option Selected 

The fol lowing example has the St ream ing M edia check box selected and uses RealOne Player. 

... 

... 

#include "do_www.h" 
#include "RPLayer.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DownloadMediaRP("http://rm.host.com:8099/ramgen/demo.rm", 0); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

The fol lowing example has the St ream ing M edia check box selected and uses Windows Media Player. 

... 

... 

#include "do_www.h" 
#include "SMPLayer.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://www.host.com/wmp-test.asx HTTP/1.0\r\n\r\n"); 
DownloadMediaFromASX(0); 
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... 

... 

END_TRANSACTION(); 

... 

... 

Script Examples with Streaming Media Option Not Selected 

The fol lowing example has the St ream ing M edia check box cleared and uses RealOne Player. 

... 

... 

#include "do_www.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://rm.host.com:8099/ramgen/demo.rm HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

The fol lowing example has the St ream ing M edia check box cleared and uses Windows Media Player. 

... 

... 

#include "do_www.h" 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/index.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://www.host.com/wmp-test.asx HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Strip Al l  Cookies from Request 

When th is opt ion is selected, no cookies are sent wi th requests. 
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Use this option to: 

Specify whether cookies are sent with requests. 

Sample Scripts 

Script  Example with Strip Al l  Cookies from Request Selected 

Script Example with Strip Al l  Cookies from Request Not Selected 

Script Example with the Strip All Cookies from Request Option Selected 

The fol lowing example has the St r ip Al l  Cook ies From  Request  check box selected. 

... 

... 

DO_Http("GET http://qawebserv.compuware.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n\r\n"); 

... 

... 

Script Example with the Strip All Cookies from Request Option Not Selected 

The fol lowing example has the St r ip Al l  Cook ies From  Request  check box cleared. 

... 

... 

DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl HTTP/1.0\r\n Cookie: 
username=username\r\n\r\n"); 

... 

... 

 

Using the Veri f i cat ion  Opt ion  

Enables document t i t le veri ficat ion for main requests of type HTML or TEXT. 

Considerat ions 

There are three supported methods for veri fying a document t i t le: search for the En t i re Docum en t  Ti t l e, 
the Pref i x  of the document t i t le, or the Suf f i x  of the document t i t le.  

Use th is opt ion to: 

!  Create scripts that veri fy characters contained in document t i t les.  

!  Detect and handle error messages that are returned in an HTML page.  

Script  Samples 

The fol lowing are examples of a search for the Ent ire document t i t le. 

Example Web Page 

Script Examples with Option Selected 

Script Examples with Option Not Selected 

Example Web Page 

<HTML> 
<HEAD> 
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<title>Welcome to The Main Page</title> 
</head> 
<body> 
<p> 

<A href="index.htm">WWW Capture Examples</A> (relative link) 

</p> 
</body> 
</HTML> 

Script Example with the Document Title Verification Option Selected 

The fol lowing example has the Docum en t  Ti t l e Veri f i cat ion  check box selected and compares by the 
ent ire document t i t le. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

... 

... 

Script Example that Matches the First 5 Characters 

The fol lowing example compares by prefix. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welco", PREFIX); 
DO_SetTransactionCleanup(); 

... 

... 

Script Example that Matches the Last 4 Characters 

The fol lowing example compares by suffix. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page", SUFFIX); 
DO_SetTransactionCleanup(); 

... 

... 

Document Title Verification – No 

The fol lowing example has the Docum en t  Ti t l e Veri f i cat ion  check box cleared. 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_SetTransactionCleanup(); 

... 

... 

 

Using the Cach ing Opt ion  
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When a caching opt ion is enabled, requested images, .css, or .js fi les are cached at playback t ime.  

Considerat ions 

!  Types of documents that QALoad caches on the virtual user during replay are: None, Im ages, CSS, 
JS, and Im ages, or Al l .  

!  The caching level names denote the types of documents that QALoad caches on the virtual user 
during replay.  

!  If these documents are referenced after the virtual user has already requested and received the 
document once, they are not requested from the target server again by that virtual user. 

Use th is opt ion to: 

Select the type of caching you would l ike the WWW replay engine to use during playback. 

Script  Samples 

Caching Option: None  

Set(EVERY_REQUEST, CACHING, NO_CACHING); 

Caching Option: Images  

Set(EVERY_REQUEST, CACHING, IMAGES); 

Caching Option: CSS, JS, and Images 

Set(EVERY_REQUEST, CACHING, IMAGES_JS_AND_CSS); 

Caching Option: All  

Set(EVERY_REQUEST, CACHING, ALL); 

 

 

Using Traf f i c Fi l ters 

Traffic Fi l ters al lows you to fi l ter out certain requests whi le playing back a script .  

Considerat ions 

Traffic fi l ters do not affect  XML requests that are writ ten to the Visual Navigator tree when a capture fi le is 
converted.  

Use th is opt ion to: 

!  Determine which traffic should be: 

 included in your script  

 blocked from your script  

 converted to subrequests in  the script   

 Also block specific substrings in  the path of URLs, such as .jpg to block al l  JPEG images. 

Script  Samples 

Script Example with a Traffic Fi l ter Set 

Script  Example without a Traffic Fi l ter Set 
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Script Example with a Traffic Filter Set 

In  the fol lowing example, a traffic fi l ter has been set to exclude requests with URLs that contain the string 
“ www.host.com” . 

... 

... 

DO_InitHttp(s_info); 

... 

... 

/* Exclude requests with URLs containing */ 
DO_BlockRequestsFrom("www.host.com;"); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://rm.host.com:8099/ramgen/realmp3.mp3 " 
        "HTTP/1.0\r\n" 
        "Referer: http://www.host.com/index.htm\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

Script Example without a Traffic Filter Set 

The fol lowing example does not use traffic fi l ters. 

... 

... 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 
DO_Http("GET http://www.host.com/index.htm HTTP/ 1.0\r\n\r\n"); 
DO_VerifyDocTitle(" QALoad WWW Capture Examples", TITLE); 
DO_Http("GET http://rm.host.com:8099/ramgen/realmp3.mp3 HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

 

Using Rule Fi l ters 
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Selects the Rule Folders that are scanned for matching rules when convert ing a WWW capture fi le in to a 
Visual Navigator script . 

Considerat ions 

!  Rules are sets of parameters that are establ ished to subst i tute certain pre-establ ished variables for 
system generated variables.  

!  Parameters and Rules are establ ished using the Variable Replacement Wizard. 

Use th is opt ion to: 

Control the rules QALoad uses during the convert  process to help parameterize scripts. 

 

Enable Siebel  Support  Opt ion  

The Enable Siebel Support  opt ion al lows QALoad to ident i fy i f the capture fi le to be converted is a Siebel  
fi le.  

Considerat ions 

!  This opt ion results in  adding a new command in the script  cal led SiebelIn it ial ize, which ident i fies 
the script  as a Siebel script .  

!  Two addit ional commands are also inserted in to the script : SiebelUpdatePage and GetSiebelValue. 
These two commands are only added i f there were HTML responses in the capture fi le, which 
resulted in  generat ion of Siebel variables.  

!  When the convert  process is complete, al l  HTML pages with Siebel variables attached to them at 
the convert  process are output in to the script  fi le so playback can retrieve values from the Siebel 
Library. 

Use th is opt ion to: 

Record, modify, and play back scripts for the purpose of performance test ing against Siebel appl icat ions 
and environments. 

Script  Samples 

Example Script  with Option Selected 

Example Script  with Option Not Selected 

Script Example with the Enable Siebel Support Option Selected 

The fol lowing example has the Enable Siebel  Support  check box selected. 
CLoadString __Siebel_1 = "VRId-3"; 
CLoadString __Siebel_2 = ""; 
CLoadString __Siebel_3 = "SWERowId0=1-7BZ"; 
CLoadString __Siebel_4 = ""; 
CLoadString __Siebel_5 = "1-136"; 
CLoadString __Siebel_6 = "SWERowId0=1-7BZ"; 
CLoadString __Siebel_7 = ""; 
CLoadString __Siebel_8 = "1-1UY"; 
CLoadString __Siebel_9 = ""; 
CLoadString __Siebel_10 = "1-1UY"; 
CLoadString __Siebel_11 = ""; 
CLoadString __Siebel_12 = "1-1UY"; 
… 
…  
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// WWW General Options 
Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 
SiebelInitialize(); // Siebel support is enabled 
 
…. 
…. 
Post_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
// Get the Siebel parameters from this page 
SiebelUpdatePage(); 
__Siebel_5 = GetSiebelValue(" S_BC3_S09_R06_FID "); 
__Siebel_8 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
__Siebel_10 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
__Siebel_12 = GetSiebelValue(" S_BC3_S09_R05_FID "); 
…. 
…. 
// Original string was: 
//   "1-136" 
// Variablized string is: 
//   "{$ VAR:Siebel-5 $}" 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERowId", __Siebel_5); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEC", "7"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEMethod", "PositionOnRow"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEReqRowId", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERPC", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEApplet", "Contact Assoc Applet"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEView", "Account Detail - Contacts View"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWECmd", "InvokeMethod"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWESP", "false"); 
 
// Original string was: 
//   "1156341790828" 
// Variablized string is: 
//   "{$ DATETIME:MS1970 $}" 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWETS", TIME_SINCE_1970("milliseconds")); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEIgnoreCtrlShift", "0"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWEP", "1B_Account Contact List 
Applet9_NewRecord0_0_1_7"); 
 
// Original string was: 
//   "SWERowId0=1-7BZ" 
// Variablized string is: 
//   "{$ VAR:Siebel-7 $}" 
// 
//-- Update the Calculation Variable Siebel-7 -- 
// 
// Variablized string is: 
//   "SWERowId0={$ VAR: Siebel-6 $}" 
// 
__Siebel_7 = "SWERowId0="; 
__Siebel_7 += __Siebel_6; 
__Siebel_7 = __Siebel_7; 
Set(NEXT_REQUEST_ONLY, POST_DATA, "SWERowIds", __Siebel_7); 
Set(NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 20 - http://dtw-siebel78/callcenter"); 
 
Post_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
DO_SLEEP(1); 

Script Example with the Enable Siebel Support Option Not Selected 

The fol lowing example has the Enable Siebel  Support  check box cleared. 
Siebel_off 
extern "C" int rhobot_script(PLAYER_INFO* s_info) 
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{ 
// Declare Variables 
// 
                              
 
 
SET_ABORT_FUNCTION(abort_function); 
 
DEFINE_TRANS_TYPE("cap_siebel_on.cpp"); 
 
 
SET_SCRIPT_LANGUAGE(SLID_English); 
DO_InitHttp(s_info); 
 
// Playback Options 
// 
Set(EVERY_REQUEST, PROXY_MODE, PROXY_AUTOMATIC_CONFIGURATION); 
Set(EVERY_REQUEST, PROXY_SCRIPT, "http://proxyconf.compuware.com"); 
Set(EVERY_REQUEST, HTTP_VERSION, "1.1"); 
Set(EVERY_REQUEST, PROXY_HTTP_VERSION, "1.0"); 
Set(EVERY_REQUEST, JAVASCRIPT_LEVEL, FULL); 
Set(EVERY_REQUEST, USER_PATIENCE, 120); // Maximum time to wait for an HTTP Reply 
Set(EVERY_REQUEST, CONNECTION_RETRIES, 4);  // maximum attempts to connect 
Set(EVERY_REQUEST, BROWSER_THREADS, 2); // total browser threads to simulate 
Set(EVERY_REQUEST, CACHING, NO_CACHING);     // Enable/Disable cache 
Set(EVERY_REQUEST, REUSE_CONNECTION, TRUE);   // maintain socket connection if possible 
Set(EVERY_REQUEST, REUSE_SECURE_SESSION, TRUE); 
.. 
.. 
.. 
Navigate_To("http://dtw-siebel78/callcenter_enu/start.swe"); 
 
//---------  REQUEST # 6  --------- 
// 
//  current page url is http://dtw-
siebel78/callcenter_enu/start.swe?SWECmd=GetCachedFrame&SWEACn=..... 
// 
Set(NEXT_REQUEST_ONLY, HEADER, "Accept", "image/gif, image/x-xbitmap, image/jpeg" 
        ", image/pjpeg, application/x-shockwave-flash, */*"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_57_0", "Business"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_27_0", "sdfasdf"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "s_2_1_28_0", "sfdasfd"); 
} 

Script  Sam ples 

Overview — Best Pract ices Sample Scripts 

This sect ion shows samples of how the WWW convert  opt ions appear in  a script . Compuware recommends 
that you use the WWW Convert Options dialog box to convert  between modes, rather than edit  the script  
manually.  

Once you convert  a script  using HTTP mode or HTM L mode, you must reconvert  the script  to change the 
convert  mode. This is necessary so that the convert  and replay methods match. Fai lure to change modes by 
reconvert ing the script  can cause the script  to replay incorrect ly. 

 

Sample Scripts: Persistent Connect ions During Replay 

This is an opt ion placed in the script  to be used at replay t ime. Select ing th is opt ion keeps the connect ion 
to the server open for each request sent to the server.  
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Tip: The fol lowing samples show the opt ion as i t  appears in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between HTML and HTTP modes, rather than edit  
the script  manually. 

C Script Samples 

C++ Script Samples 

C Script Samples 

Script Example with the Persistent Connections During Replay Option Selected 

The fol lowing example has the Persi sten t  connect i ons during replay check box selected. 

... 

... 

BEGIN_TRANSACTION(); 
DO_UsePersistentConnections(TRUE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Script Example with the Persistent Connections During Replay Option Not Selected 

The fol lowing example has the Persi sten t  connect i ons during replay check box cleared. 

... 

... 

BEGIN_TRANSACTION(); 
DO_UsePersistentConnections(FALSE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

C++ Script Samples 

Script Example with the Persistent Connections During Replay Option Selected 

... 
// WWW Connection Settings 
Set(EVERY_REQUEST, REUSE_CONNECTION, TRUE); // maintain socket connection if possible 
... 

 

Script Example with the Persistent Connections During Replay Option Not Selected 

... 
// WWW Connection Settings 
Set(EVERY_REQUEST, REUSE_CONNECTION, FALSE); // maintain socket connection if possible 
... 
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Sample Scripts: Max Concurrent Connect ions 

This opt ion indicates the maximum number of connect ions that a DO_Http or DO_Https command opens 
to the server at any t ime. These simultaneous connect ions are only used i f sub-request ing is enabled. 

Tip: The fol lowing samples show the opt ion as i t  appears in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between HTML and HTTP modes, rather than edit  
the script  manually. 

The fol lowing examples have the M ax Concurrent Connect ions field set at 4. 

C Script Sample 

C++ Script Sample 

C Script Sample 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
DO_SetMaxBrowserThreads(4); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

C++ Script Sample 
... 
// WWW Connection Settings 
Set(EVERY_REQUEST, REUSE_CONNECTION, TRUE); // maintain socket connection if possible 
Set(EVERY_REQUEST, MAX_BROWSER_THREADS, 4); // total browser threads to simulate 
... 

 

 

Sample Scripts: Max Connect ion Retries 

This opt ion specifies the number of t imes during replay that QALoad wil l  at tempt to connect to the server 
after t im ing out.  

Tip: The fol lowing samples show the opt ion as i t  appears in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between HTML and HTTP modes, rather than edit  
the script  manually. 

The fol lowing examples have the M ax Connect ion Retries field set at 4. 

C Script Sample 

C++ Script Sample 

C Script Sample 
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... 

... 

BEGIN_TRANSACTION(); 

... 

... 

DO_SetMaximumRetries(4); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 

... 

... 

 

C++ Script Sample 
... 
// WWW Connection Settings 
... 
Set(EVERY_REQUEST, MAX_CONNECTION_RETRIES, 4); // maximum attempts to connect 
... 
Navigate_To("http://www.host.com/index.htm"); 
... 

 

 

Sample: Server Response Timeout 

This opt ion specifies, in  seconds, the length of t ime during replay that QALoad waits for data from the 
server before t im ing out.  

Tip: The fol lowing samples show the opt ion as i t  appears in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between HTML and HTTP modes, rather than edit  
the script  manually. 

The fol lowing examples have the Server Respon se Tim eout  field set at 120. 

C Script Sample 

C++ Script Sample 

C Script Sample 

... 

... 

DO_InitHttp(s_info); 
DO_SetTimeout(120); /* Maximum time to wait for HTTP Reply */ 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to QAWEBSERV", TITLE); 
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... 

... 

 

C++ Script Sample 
... 
// WWW Connection Settings 
... 
Set(EVERY_REQUEST, SERVER_RESPONSE_TIMEOUT, 120); // Maximum time to wait for an HTTP Reply 
... 
Navigate_To("http://www.host.com/index.htm"); 
... 

 

 

Sample Scripts: Baud Rate Emulat ion 

Use th is opt ion to simulate slower connect ions to a Web server, such as 56 Kbps modem or DSL.  

Tip: The fol lowing samples show the opt ion as i t  appears in  a script . Compuware recommends that you 
use the WWW Convert Options dialog box to convert  between HTML and HTTP modes, rather than edit  
the script  manually.  

C Script Samples 

C++ Script Samples 

C Script Samples  

Baud Rate Emulation – Yes 

In  the fol lowing example, the Baud Rate check box is selected and set to 57600. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
DO_SetBaudRate(57600); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Baud Rate Emulation – No 

In  the fol lowing example, the Baud Rate check box is cleared. 

... 

... 

BEGIN_TRANSACTION(); 
DO_SetTransactionStart(); 
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... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

C++ Script Samples 

In the fol lowing example, the Emulate transmission baud rate check box is selected and set to 112000. 
Set(EVERY_REQUEST, RECEPTION_BAUD_RATE, 14400); 
... 
// WWW Connection Settings 
... 
Set(EVERY_REQUEST, TRANSMISSION_BAUD_RATE, 112000); 
... 
Navigate_To("http://www.host.com/index.htm"); 
... 

In  the fol lowing example, the Emulate recept ion baud rate check box is selected and set to 14400. 

... 
// WWW Connection Settings 
... 
Set(EVERY_REQUEST, RECEPTION_BAUD_RATE, 14400); 
... 
Navigate_To("http://www.host.com/index.htm"); 
... 

 

 

Streaming Media 

St ream ing M edia Support  

QALoad includes support for audio and video download test ing of both Windows Media Player and 
RealOne Player and their supported media formats through a WWW session. When streaming media 
conversion is enabled and you record a transact ion that cal ls streaming media, an addit ional command 
that requests the media is inserted in to your script  . You do not have to l isten to or view the ent ire media 
you are request ing. You simply need to record i ts URL and ensure that the appropriate media player is 
instal led on the Player machines that plays back the script . At run t ime, the script  invokes your media 
player and requests the streaming media resource. Streaming media through a firewall  or proxy server is 
not supported. 

QALoad's streaming media support includes the fol lowing media player(s). The appropriate media player 
must be instal led on the machine you are recording from as well  as any QALoad Player machine that wi l l  
be execut ing the script . 

!  RealOne Player — The media download is in i t iated by request ing a fi le that is a data type 
supported by the RealOne Player. Supported data types are RealAudio, RealVideo, RealText, RealPix, 
and SMIL. As a result , the DownloadMediaRP command wil l  be inserted in to the script  at  the 
appropriate point. At runt ime, th is command in it iates and waits for complet ion of the download. 
RealOne Player scripts must be executed as process-based scripts. 
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!  Window s M edia Player — The media download is in i t iated by downloading a fi le with a content 
type of (audio|video)/ (x-ms-asf|s-ms-asf) in  the browser. Current ly, only .asx fi les are supported. As 
a result , the DownloadMediaFromASX command is inserted in to the script  at  the appropriate 
point.  

Note: QALoad does not support scripts that have both RealNetworks media and Windows Media in  
the same script . To test both types in  a single load test, use a different script  for each type. 

Please note that asynchronous cal ls may not be played back exact ly as they were recorded. For example, i f 
you cl ick on a l ink in  the browser whi le recording while the media is playing, during replay that l ink is not 
requested unt i l  the media cl ip has fin ished being processed. 

How do I configure QALoad to process streaming media? 

 

 

Recording St ream ing M edia 

To record st r eam ing m edia: 

1. With a WWW session open in the Script Development Workbench, choose Opt ions>Convert  from 
the menu. 

2. Under WWW Convert Options, select General . 

3. Under Other on the General opt ions page, select the Streaming Media opt ion, then cl ick OK. 

When you record your transact ion, make sure you invoke your media player through cl icking a l ink or 
typing a URL in your web browser. QALoad records the URL from your web browser; therefore, you must 
use your browser to access your media fi le or else the URL wil l  not be recorded in your script . 

 

St ream ing M edia in  Visual  Navigator 

If you selected the Streaming Media opt ion on the WWW Advanced conversion opt ions dialog box before 
recording your script , and the recorded transact ion contains RealOne Player or Windows Media streaming 
requests, your streaming media request wi l l  be presented as a Page in the tree-view, similar to the fol lowing 
graphic:  

The form-view (bottom pane) for a streaming media page shows the 
t i t le Real Media Request or Windows Media Request to indicate the type 
of request you recorded, and l ists the fol lowing fields: 

Requested URI: Lists the requested URI that invoked the media 
player. For Real M edia the fi le typical ly is an RM fi le, whi le for 
Windows Media i t  is typical ly an ASX fi le. 

Play M edia Request : Select th is check box for the virtual user to 
process the RM or ASX fi le that is received and make the necessary 
requests to dupl icate what  the cl ient performed while receiving the 
streaming media. If th is checkbox is not selected, then no further 
processing is performed after receiving the RM or ASX fi le. 

Play Requested M edia for N seconds: You can specify how much of the streaming media fi le the virtual 
user should play, in  seconds, before moving on to the next request. A value of zero indicates that the ent ire 
media stream should be played. 

Note: While a virtual user is playing a media request i t  wi l l  not make any other requests in  the 
transact ion loop. This may be different than what the user performed when recording the transact ion 
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because a browser is capable of spawning the streaming media player as a separate executable which can 
execute at the same t ime that the user cont inues to make further web requests in  the browser. 
 
 

 

CJK Support 

CJK Support  i n  QALoad  

QALoad supports load test ing of Chinese, Japanese, and Korean (CJK) Web appl icat ions that use Double 
Byte Character Sets (DBCS). DBCS is a character set that uses two bytes (16 bits) rather than one byte (8 
bits) to represent a single character. Some languages, such as Chinese, Japanese, and Korean, have writ ing 
schemes with many different characters and character sets that cannot be represented with single-byte 
characters such as ASCII and EBCDIC.  

QALoad supports the fol lowing: 

!  Simpli fied Chinese - People's Republic of China (PRC), Singapore 

!  Tradit ional Chinese - Taiwan, Hong Kong, Macau 

!  Japanese 

!  Korean 

Notes:  

CJK support only appl ies to the WWW middleware. Current ly, QALoad only supports the CJK Double 
Byte Character Sets; Web appl icat ions that host Bi-Direct ional (BiDi) characters (which includes Arabic 
and Hebrew languages) are not current ly supported. 
UTF-8-encoded characters are treated as an addit ional character set used on CJK platforms. They are 
supported when represented on their nat ive operat ing system. For example, Japanese characters are 
displayed properly on a Japanese operat ing system. 

QALoad provides two methods of support for CJK: nat ive character and encoding. Depending on your 
test ing requirements and environment, i t  may be necessary to use both mechanisms to support the load 
test ing of a Web site that contains CJK characters.  

!  Nat i ve Character: converts the CJK characters to their original characters in  Chinese, Japanese, or 
Korean. Nat ive character support is only possible when using a nat ive operat ing system (OS) such 
as load test ing a Japanese Web appl icat ion from a Japanese version of M icrosoft  Windows. QALoad 
supports one CJK language's characters in  a script  at  a t ime, plus ASCII/Engl ish. Nat ive character 
support is used with in test scripts, error messages (generated through system commands that use 
nat ive characters) and t im ing fi les, making script  edit ing easier and t im ing fi le analysis quicker. 

!  Encoding: encodes al l  CJK characters in to a sequence of prin table characters regardless of the 
language and exact character set in  use. Encoding support is used when load test ing mult iple 
language sites from the same OS, or when load test ing a CJK site from that of another CJK 
platform. For example, test ing a si te with Japanese characters from a Korean or Engl ish/ASCII OS. 
The encoding opt ion is used when nat ive character support cannot be used or when script  
portabi l i ty between different CJK language OS is required. 

 

Nat i ve Character CJK Support  

By default , QALoad translates Chinese, Japanese, and Korean (CJK) characters i f you are using the QALoad 
Workbench on the same CJK language operat ing system as the operat ing system on which the Web 
appl icat ion is being captured. There are no opt ions to enable, but you may wish to ensure that the 
Represen t  CJK as Octal  Characters opt ion check box is not selected.  
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To veri fy, th is opt ion is located on the WW W tab in the QALoad Workbench under 
Opt ions>Convert>W W W as shown below. 

 

If you capture a script  from a Web appl icat ion that contains CJK characters, QALoad converts the captured 
transact ion in to a test script  that looks similar to the fol lowing example.  
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QALoad used the nat ive characters in  the document t i t le to create DO_VerifyDocTit le() and 
BeginCheckpoint() funct ions meaningful to the native character set. The same character conversion logic is 
appl ied to DO_SetValue() and al l  DO_Get<xxx> funct ions such as DO_GetAnchorHREF(). 

When using nat ive characters with in QALoad test scripts, the result ing t iming fi les display checkpoints in  
their nat ive language. If you use nat ive characters in  any other system funct ion that produces an error 
message, you also see the nat ive characters displayed in QALoad Conductor's error message display as 
shown below. This appl ies to funct ion cal ls l ike DO_VerifyDocTit le and any DO_Get<xxx> funct ions that 
fai l  during test execut ion. 

 

Final ly, see an example of a t im ing fi le with nat ive characters displayed in QALoad Analyze below. 

 

 

 

Encoding CJK Support  
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QALoad uses the encoding opt ion when convert ing a capture fi le contain ing more than one set of Chinese, 
Japanese, or Korean (CJK) language characters. The encoding opt ion also is used when convert ing the 
script  on a CJK language operat ing system different than the one on which the appl icat ion was captured.  

To override QALoad's Nat ive Character Support and enable Encoded Support, select the Represen t  CJK as 
Octal  Characters opt ion. In  the QALoad Script Development Workbench, cl ick Convert>Opt ions. The 
Universal Convert  Options dialog box appears. Cl ick the WWW tab and select the Represen t  CJK as Octal  
Characters check box as shown below. 

 

If you then record a script  from a Web appl icat ion that contains CJK characters, QALoad converts the 
captured transact ion in to a test script  that looks similar to the fol lowing example.  
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In  the graphic above, QALoad encoded the nat ive characters in  the server-returned HTML and used i t  in  
the DO_Verify DocTit le and DO_Anchor HREF funct ions. The same encoding logic is appl ied to 
DO_SetValue and al l  DO_Getxxx funct ions.  

When using encoded characters in  QALoad test scripts, the result ing t im ing fi les do not display 
checkpoints in  their nat ive language. The fol lowing graphic of QALoad Analyze shows a t im ing fi le with 
encoded characters with in i t .  
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Represen t  CJK as Octal  Characters 

When th is opt ion is selected, the double-byte characters used for Chinese, Japanese, and Korean (CJK) 
scripts are converted in to octal format.  

Considerat ions 

!  Since CJK characters use Double Byte Character Sets (DBCS), encoding must be enabled for a 
capture with CJK characters, so that the double-byte characters can be viewed in a legible format. 

!  Data stays in  encoded format throughout the load test: from capture, through convert  and replay, 
to the analysis of the t im ing fi le.  

Use th is opt ion to: 

!  Enable the encoding of captured data from web appl icat ions contain ing Double Byte Character Sets 
(DBCS) such as Chinese, Japanese, or Korean.  

!  Encode al l  nat ive characters when nat ive character support cannot be used.  

Sample Scripts 

Example Web Page 

Example Script  with Option Selected 

Example Script  with Option Not Selected 

Example Web Page 

<html> 
<head> 

<title>  </title> 
<meta http-equiv="Content-type" content="text/html; charset=euc-kr"> 
<meta http-equiv="Cache-Control" content="no-cache"> 
<meta http-equiv="Pragma" content="no-cache"> 
<meta http-equiv="Expires" content="Wed, 04 Jul 1973 16:00:00 GMT"> 

<!--CSS--> 
<style type='text/css'> 
</style> 

<!--/CSS--> 
</head> 
<body onload="document.search.p.focus();" topmargin=8> 

... 

... 

</body> 
</html> 

Script Example with the Represent CJK as Octal Characters Option Selected 

The fol lowing example has the Represen t  CJK as Octal  Characters check box selected. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("\276\337\310\304!\304\332\270\256\276\306", TITLE); 

... 

... 

Script Example with the Represent CJK as Octal Characters Option Not Selected 
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The fol lowing example has the Represen t  CJK as Octal  Characters check box cleared. 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://kr.yahoo.com/ HTTP/1.0\r\n\r\n"); 

DO_VerifyDocTitle( , TITLE); 
 
... 
... 

 

CJK and Visual  Navigator 

The Visual Navigator handles both nat ive and encoded Chinese, Japanese, and Korean (CJK) characters. 
(See CJK Support in  QALoad for more in formation about CJK support.) 

The fol lowing graphic shows how the Visual Navigator provides nat ive character support. Both Engl ish and 
Chinese characters are displayed in the Workbook Pane. 

 

The same capture fi le, Shanghai.cap, is open in the graphic below. Here, the Visual Navigator displays the 
Chinese characters in  encoded format. 
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Siebel Support 

Capturing Siebel  Traf f i c  

Use the fol lowing procedure before convert ing a Siebel script  to enable Siebel support: 

To capt ure Siebel  t raf f ic: 

1. With a WWW session open in the Script Development Workbench, choose Opt ions>Convert  from 
the menu. 

2. Under WWW Convert Options, select Siebel . 

3. On the Siebel Options page, select En able Siebel  Support , then cl ick OK. 

 

TestPartner 

Creating a TestPartner Script 

To create a TestPartner script , insert  any number of TestPartner transact ions (TestPartner scripts) in to a 
QALoad template script  accessible from the QALoad Script Development Workbench. The template script  is 
a simple QALoad script  that can be compiled and run; however, i t  contains no funct ional i ty unt i l  you 
insert  the TestPartner transact ions appropriate for your test ing needs.   

Note: TestPartner must be instal led and properly configured on your machine to create a TestPartner 
script . 
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To create a QALoad script  to execute a TestPartner transact ion, fol low the steps below. 

To creat e a new  Test Par t ner  scr ip t : 

1. With a TestPartner session open, choose Session>Generate Script  from the menu. The Create New 
TestPartner Execut ion Script dialog box opens. 

2. In  the DSN drop-down l ist , select the DSN, which gets populated from the DSNConfigurat ion.in i  
fi le in  TestPartner. 

3. In  the Userid and Passw ord fields, type the user id and password associated with the DSN. Cl ick 
Connect . The TestPartner Script  Select ion fields are enabled. 

4. In  the Project  Nam e drop-down l ist , select a project  that exists in  the selected DSN. The Avai lable 
Scripts l ist  displays al l  the scripts and visual tests that belong to the selected project name.  

5. Select the Autom at i cal l y i nclude Checkpoin t  check box to automatical ly insert  checkpoints in  
the script  when i t  is created. If you do not want checkpoints inserted, clear th is check box. 

6. In  the Avai lable Scripts l ist , select a script  or visual test name to add i t  to the Selected Scripts l ist . 
Cl ick Add to add the selected script . Repeat th is step to cont inue adding individual scripts. To add 
al l  scripts at once, cl ick Add Al l .  

Tip: You can add mult iple scripts and visual tests to the Selected Scripts l ist . The scripts and tests can 
be from the same or different projects and also from different DSNs.  

7. (opt ional) In  the Selected Scripts l ist , move the script  up or down on the l ist  by select ing the script  
and cl icking Up or Down to execute scripts in  a certain order. To remove a script , select a script  and 
cl ick Rem ove to delete the selected script  from the l ist . To remove al l  scripts at once, cl ick Remove 
Al l . 

8. In  the QALoad Script  Nam e field, type a new script  name. To edit  an exist ing script , cl ick the 
...(Brow se) button to open the Choose Script Name dialog box and select an exist ing script . 

9. Click Create Script  to generate the QALoad script .  

10. To compile the script  for test ing, select Session>Com pi le.  

Caut ion : When val idat ing the script , you may need to increase the value in  the Wai t  up to field, 
which is the amount of t ime needed for the script  to execute before t im ing out.  

 

Inserting a TestPartner Script 

You can insert  any number of TestPartner transact ions (TestPartner scripts) in to a QALoad template script  
accessible from the QALoad Script Development Workbench. 

Note: TestPartner must be instal led and properly configured on your machine to insert  a TestPartner 
script . 

To inser t  a Test Par t ner  scr ip t : 

1. Start  the Script  Development Workbench and open a TestPartner session. From the Session  menu, 
choose New  Tem plate to create a new script  from the QALoad template script .  

2. In  the Choose Script  Nam e dialog box, type a name for the QALoad script  in  the Script  Nam e field 
and cl ick OK. The script  is saved in the directory \Program 
Files\Compuware\QALoad\Middlewares\TestPartner\Scripts, and the script  opens in the 
script  editor. 
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3. Edit  the script  as necessary. You can manually enter any transact ions or script ing commands 
direct ly in  the script .  

4. To insert  a TestPartner transact ion in  the script , posit ion your cursor anywhere after the 
SYNCHRONIZE() or before the TP_Unin it() command. 

5. From the Session  menu, choose In sert>TestPartner Script . The Insert  New TestPartner Execut ion 
Script dialog box appears. 

6. In  the DSN drop-down l ist , select the DSN, which gets populated from the DSNConfigurat ion.in i  
fi le in  TestPartner.  

7. In  the Userid and Passw ord fields, type the user id and password associated with the DSN. Cl ick 
Connect . The TestPartner Script  Select ion fields are enabled. 

8. In  the Project  Nam e drop-down l ist , select a project  that exists in  the selected DSN. The Avai lable 
Scripts l ist  displays al l  the scripts and visual tests that belong to the selected project name.  

9. Select the Autom at i cal l y i nclude Checkpoin t  check box to automatical ly insert  checkpoints in  
the script . If you do not want checkpoints inserted, clear th is check box. 

10. In  the Avai lable Scripts l ist , select a script  or visual test name to add i t  to the Selected Scripts l ist . 
Cl ick Add to add the selected script . Repeat th is step to cont inue adding individual scripts. To add 
al l  scripts at once, cl ick Add Al l .  

Tip: You can add mult iple scripts and visual tests to the Selected Scripts l ist . The scripts and tests can 
be from the same or different projects and also from different DSNs. 

11. (opt ional) In  the Selected Scripts l ist , move the script  up or down on the l ist  by select ing the script  
and cl icking Up or Down to execute scripts in  a certain order. To remove a script , select a script  and 
cl ick Rem ove to delete the selected script  from the l ist . To remove al l  scripts at once, cl ick Remove 
Al l . 

12. Click OK. When you are f in ished, save any changes. 

13. To compile the script  for test ing, select Session>Com pi le.  

Caut ion : When val idat ing the script , you may need to increase the value in  the Wai t  up to field, 
which is the amount of t ime needed for the script  to execute before t im ing out.  

 

Selecting Multiple TestPartner Scripts 

You can insert  any number of TestPartner transact ions (scripts) in to a QALoad template script  accessible 
from the QALoad Script Development Workbench. These TestPartner scripts and visual tests can have the 
same name and can be from the same or different projects or from different DSNs.  

The wrapping of each execute script  command in a QALoad checkpoint has the same script  name, but is 
automatical ly labeled by a dash (–) and a number. For example, i f the script  name cal led 'TestScript1' exists 
more than one t ime, QALoad assigns the names, checkpoint(TestScript1-1), 
checkpoint(TestScript1-2), and so on. 

Exam ple 
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Developing a Script  

Recording a Transact ion 

Recording Middleware Calls 

QALoad begins recording before start ing your appl icat ion, ensuring that any early startup act ivi ty is 
recorded. 

Hin t : You can save yourself some steps later by sett ing opt ions now to automatical ly convert  your 
recorded capture fi le and compile i t  in to a script . 

To record a m iddlew are cal l : 

(WWW only) If you are running your appl icat ion on Windows XP SP2, Compuware recommends you turn 
the 'pop-up blocker' feature off before recording a transact ion. The feature can be disabled via the browser 
window's Tools menu in In ternet  Opt ions>Pri vacy. 

1. Open an appropriate middleware session in  the QALoad Script Development Workbench. 

2. (Oracle Forms Server only) Choose Opt ions>Workbench , then cl ick the Com pi ler Set t i ngs tab. In  
the Java sect ion of the dialog box, set the locat ion of your Java fi les for recording. 

3. Select Session>Record>Start . QALoad launches your appl icat ion and any proxies, i f necessary, and 
begins recording any cal ls. 

4. Run the desired user operat ions using your appl icat ion. 

5. (WWW only) If you are capturing SSL requests using EasyScript for Secure WWW, the browser 
generates one or more prompts indicat ing the fol lowing: 

!  It  does not recognize the authori ty who signed the server cert i ficate. 

!  The server cert i ficate presented by the Web site does not contain the correct si te name. 
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When you receive these prompts, cl ick the browser’s Next or Cont inue button so you can connect to 
and exchange information with the desired Web site. 

6. (Optional) At any t ime during the recording process, you can insert  any necessary commands or 
comments in to the capture fi le.  

7. When you have recorded a complete transact ion, stop the appl icat ion from which you are 
recording. 

8. When you fin ish, cl ick Stop Record. You are prompted to save your capture fi le. By default , 
capture fi les (.cap) are saved in the QALoad\Middlewares\<middleware_name>\captures 
directory. 

Note: If QALoad is not able to record from your appl icat ion, try QALoad’s alternate procedure for 
recording.  

The Script Development Workbench automatical ly converts a capture fi le to a script  fi le when you stop the 
recording process. You are prompted i f a script  by the same name already exists, so that you can decide 
whether to overwrite an exist ing script  or to save your script  under a different name. 

 

Inserting Commands/Comments into a Capture File 

You can insert  commands or comments while recording a capture fi le. 

To inser t  com m ands/ com m ent s in t o a capt ure f i le: 

1. On the Recording toolbar, cl ick Insert  Com m and. The toolbar expands into a window where you 
can select opt ions for insert ing commands into your capture fi le. 

2. In  the Com m and Type area, select whether you want to insert  a comment or a begin/end 
checkpoint. 

3. In  the Com m and In fo area, type your comment or a descript ion of the checkpoint. 

4. Do one of the fol lowing: 

!  Click Insert  to insert  your comment or checkpoint command into your capture fi le. 

!  Click  Insert  Com m and again to close the expanded window without insert ing a 
command. 

5. Continue recording your t ransact ion as usual. 

 

 

Recording with Manual Program Startup 

Use th is procedure to manually start  your appl icat ion and the Record faci l i ty. You can start  your 
appl icat ion at any t ime before or after start ing to record. 

This procedure only appl ies to Winsock and SAP. 

To record w i t h m anual  program  st ar t up: 

1. Access the QALoad Script Development Workbench. Detai ls 

2. Choose the appropriate session from the Session  menu. 

3. From the Opt ions menu, choose Record to open the Record Options wizard. 

4. On your middleware tab, select the User Started Program  opt ion. Cl ick OK. 
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5. WW W On ly: Start  your browser. 

6. Click Start  Record. 

7. Start  your appl icat ion (SAP only: start  QALSAP.EXE, which is located in  the \QALoad directory). 

8. Run the user operat ions you want to record. As you execute the operat ions, QALoad records the 
operat ions in  a capture fi le (.cap). 

9. (Optional) At any t ime during the recording process, you can insert  any necessary commands or 
comments in to the capture fi le. Detai ls 

10. When you fin ish, cl ick Stop Record. You must stop recording before you shut down the appl icat ion 
from which you are recording. QALoad prompts you to save your capture fi le. By default , capture 
fi les are saved in the QALoad\Middlewares\<middleware_name>\Captures directory .  

 

Changing recording options without recording 

You can view and change recording opt ions at any t ime without recording a capture fi le. 

To change recording opt ions w i t hout  r ecording : 

1. Access the QALoad Script Development Workbench. Detai ls 

2. From the Session  menu, select the appropriate middleware or start  a Universal session. 

3. From the Opt ions menu, choose Record. The Record Options wizard opens, showing a tab of 
recording opt ions for the middleware you selected. 

4. On your middleware tab, select opt ions and enter in formation as appropriate. 

5. Click OK. 

For a descript ion of avai lable recording opt ions, see Record Options Wizard.  

 

Convert ing a Transact ion to a Script  

Converting 

A capture fi le contains al l  the raw data that was recorded, but i t  needs to be converted in to an editable 
script  fi le before you can proceed. The script  fi le can then be open in the Script Development Workbench 
editor and edited as needed. 

To conver t  a capt ure f i le t o a scr ipt : 

1. Access the QALoad Script Development Workbench. Detai ls. 

2. From the Session  menu, choose the session you want to start . 

3. If you have not already done so, set conversion opt ions. 

4. In  the Workspace Pane, cl ick the Captures tab. 

5. Click the capture fi le you want to convert  and cl ick Session>Convert . The capture fi le is converted 
to a script . In  the Workspace Pane, cl ick the Scripts tab to view the l ist  of scripts you have 
converted. 

Note: If an Error/Warning Summary opens in the Output  Pane, resolve any errors. 

6. Compile the script .  
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Note: You can set an opt ion to automatical ly convert  your recorded transact ions in to scripts. How? 

 

Setting Conversion Options 

Before you begin recording, you can set opt ions to automatical ly customize your script  during conversion. 
Compuware recommends you set conversion opt ions before recording, then use the opt ion to 
automatical ly convert  your capture fi les to scripts. Detai ls 

1. Access the Script Development Workbench. Detai ls 

2. From the Session  menu, select the appropriate middleware or start  a Universal session. 

3. Select Opt ions>Convert  to open the appropriate Convert  Options dialog box. 

4. In  the Session Options tree, cl ick Shared Convert  Opt ions and set any appl icable opt ions. This 
tree-view contains common opt ions that apply to al l  the middleware environments QALoad 
supports. 

5. Click the middleware-specific convert  opt ions in  the Session Options tree, and set any appropriate 
middleware-specific opt ions. 

 Notes:  
!  For the Citrix Web Interface environment, you must select opt ions in  both the Citrix Convert  

Options and the WWW Convert Options in  the tree view. 
 For WWW, refer to Using the WWW Convert Options. 

6. When you are fin ished, cl ick OK to save the current  sett ings. 

Hin t : Press F1 from any middleware opt ions tab for a descript ion of avai lable opt ions.  

 

Set Up Automatic Conversion and Compilation of a Script 

The Script Development Workbench automatical ly converts a capture fi le when you stop the recording 
process and compile the result ing script . You are prompted i f a script  by the same name already exists, so 
that you can decide whether to overwrite an exist ing script  or to save your script  under a different name. 

If the default  sett ings to automatical ly convert  a capture fi le have been changed, fol low the steps below to 
reset the automatic conversion and compilat ion. 

To set  up aut om at ic conversion and com pi lat ion: 

1. From the Script  Developm en t  Workben ch  menu, choose Opt ions>Workbench . 

2. On the Workbench Configurat ion tab, in  the Record Opt ions area, select the check box 
Autom at i cal l y Convert  Capture. 

3. Click the Com pi ler Set t ings tab. 

4. Select the check box Autom at i cal l y com pi le scri pts. 

5. Select the check box Prom pt  before overw ri t i ng script  to ensure that a script  is not overwrit ten 
accidental ly.  

6. Click OK to save your sett ings. 
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Edit ing a Script  

Editing a Script 

The Funct ion Wizard al lows you to quickly and easi ly edit  your script  by choosing from the QALoad 
commands avai lable to your script  and insert ing them with a cl ick of your 
mouse.  

The Funct ion Wizard is located in  the Script Development Workbench in a 
pane on the right side of the window. You can enable or disable the 
Funct ion Wizard from the View  menu or by cl icking the Show  or Hide 
Funct ion  Wizard button on the toolbar.  

The Funct ion Wizard l ists al l  funct ions that are val id to use in  your open 
script . Funct ions are grouped in logical sect ions with in the top window of 
the wizard. When you h ighl ight a funct ion in  the top window of the 
wizard, the lower window l ists a descript ion of that funct ion and i ts 
parameters.  

To insert  a funct ion in to your script , locate i t  in  the Funct ion Wizard and 
then simply drag-and-drop the funct ion in to your script .  

The funct ion wil l  be writ ten in to your script  at  the point you chose. When 
you insert  a funct ion using the wizard, a text box opens showing the 
proper syntax and parameter opt ions. (The text box may not appear i f an 
associated variable or object has not been declared in  the script .) As you 
edit  the funct ion 's parameters, the text box h ighl ights the parameter that 
is current ly being edited.  

 

 

 

 

Using Custom Counters and Messages 

QALoad al lows you to define your own counters and insert  messages into your script , where they are 
writ ten to your t im ing fi le and are viewable in  Analyze or at runt ime in the Conductor.  

Counters can be either cumulative or instance. This determines how they are graphed in Analyze: 

!  For a cumulat ive counter, Analyze keeps a running sum of the counter whi le graphing verses 
elapsed t ime. This type of counter is used for al l  the WWW error counters. Each t ime a WWW error 
occurs, a value of 1 (one) is wri t ten for that counter. When looking at a detai led view in Analyze, 
you can see at what t imes that error occurred. When you graph a counter in  Analyze, the graph 
shows the total number of occurrences verses the elapsed t ime.  

!  For an instance counter, Analyze graphs each value direct ly. No summing of previous values is 
done.  

Counters must be added manually using the QALoad commands DEFINE_COUNTER and 
COUNTER_VALUE. Messages must be added manually using the QALoad command SCRIPT_MESSAGE. 

The fol lowing sample script  i l lustrates both script  counters and messages: 

#include <stdio.h> 
#include "smacro.h" 
#include "do_www.h" 

int rhobot_script( PLAYER_INFO *s_info ) 
{ 
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char  buf1[256]; 
int   id1, id2, id3, id4; 

DEFINE_TRANS_TYPE( "ScriptCounters " );  
DO_InitHttp(s_info); 

// "Counter Group", "Counter Name", "Counter Units (Optional)",  
// Data Type, Counter Type. 

id1 = DEFINE_COUNTER( "Cumulative Group", "Cumulative long",  
                      0, DATA_LONG, COUNTER_CUMULATIVE); 
id2 = DEFINE_COUNTER( "Cumulative Group", "Cumulative float",  
                      0, DATA_FLOAT, COUNTER_CUMULATIVE); 
id3 = DEFINE_COUNTER( "Instance Group", "Instance long",  
                      0, DATA_LONG, COUNTER_INSTANCE); 
id4 = DEFINE_COUNTER( "Instance Group", "Instance float",  
                      0, DATA_FLOAT, COUNTER_INSTANCE); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

// add value to cumulative counter 1 
COUNTER_VALUE( id1, 1 ); 
DO_SLEEP( 2 ); 

// add value to cumulative counter 2 
COUNTER_VALUE( id2, 1.5 ); 
RND_DELAY( 6 ); 

// add value to instance counter 1 
COUNTER_VALUE( id3, s_info->nRndDelay ); 

// add custom message for this user 
wsprintf( buf1, "User %d slept for %d milliseconds during transaction %d", 
          s_info->nAbsVUNum, s_info->nRndDelay, s_info->s_trans_count ); 
SCRIPT_MESSAGE( "User Messages", buf1 ); 
DO_SLEEP( 2 ); 

// add value to instance counter 2 
// relative user number plus pi times the current transaction number 
COUNTER_VALUE( id4, s_info->nRelVUNum + ( 3.14159 * s_info->s_trans_count ) ); 

END_TRANSACTION(); 
DO_FreeHttp(); 
REPORT(SUCCESS); 
EXIT(); 

} 

 

Defining Checkpoints 

Checkpoint statements col lect t im ings of events, such as the execut ion of SQL statements. If you manually 
insert  checkpoint statements in to your capture fi le during the recording process, or i f you select the 
Include Defaul t  Checkpoin t  Statem en ts conversion opt ion before convert ing a script , your script  
includes checkpoints.  

Otherwise, you must manually insert  checkpoints in  your scripts to col lect t im ings. 

 

 

Defining Transaction Loops 

If you did not insert  begin-and end-transact ion commands into your capture f i le, QALoad’s Convert  faci l i ty 
automatical ly places begin-and end-transact ion commands at the start  and end of the recorded sequence. 
QALoad scripts execute the code between the begin-and end-transact ion commands in a loop according to 
the number of t imes you specify in  the QALoad Conductor when sett ing up a test. 
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Depending on how you completed your recording, you may want to move one or both of these transact ion 
commands to another place in  the script  to more accurately define the transact ion that runs during the 
load test. 

For example, let ’s say during the recording process you log in  and log out as part  of the procedure. 
However, during the load test you do not want to log in  and log out as part  of every transact ion. To avoid a 
login and logout with every procedure, move the begin- and end-transact ion commands so the login and 
logout commands are outside of the transact ion loop. 

 

Simulating User-Entered Data 

When you create a script , you probably have some constant data embedded in  the script , for example, an 
employee number, that automatical ly enters your appl icat ion’s input fields while recording. If you run a 
load test using th is script , the script  uses the same data for each transact ion. To run a real ist ic test, you can 
modify the script  to use variable data from a datapool fi le. By varying the data input over the course of a 
test, the behavior more real ist ical ly emulates the behavior of mult iple users. You can use the QALoad Script 
Development Workbench to create, maintain, and use datapool fi les (.dat) to insert  variable data in to your 
scripts. 

A datapool can be defined as either central or local: 

!  Cent ral : a datapool that resides on the same workstat ion as the QALoad Conductor, and is 
avai lable to any Player system on the network that requests i t  from the QALoad Conductor. A 
central datapool is control led by the QALoad Conductor, and you use the QALoad Conductor to set 
any opt ions relat ing to a central datapool. 

!  Local : a datapool that resides on a Player workstat ion, and is only avai lable to that Player. Because 
a local datapool resides local ly and is only avai lable to the local Player, i t  does not generate any 
network traffic. Use the QALoad Script Development Workbench to insert  local datapools in to a 
script . 

The fol lowing sect ions describe how to create and use central and local datapools. 

Creat ing a Datapool  Fi l e 

You can create a datapool fi le using the Script Development Workbench. 

To creat e a dat apool  f i le: 

1. Open a middleware session in  the QALoad Script Development Workbench. 

2. From the Fi l e menu, choose New . 

3. On the New  dialog box that opens, select New  from the Datapools tree i tem. 

4. In  the Fi l enam e field, type a unique name for your datapool fi le. 

5. In  the Row s: and Cols: fields, type the number of rows and columns your new datapool should 
have. 

6. Click OK. 

7. Enter your datapool records in  the grid that opens in the Workbook Pane. 

8. When you are fin ished entering datapool records, cl ick Fi l e>Save As to name your datapool fi le. 

9. Click OK to save the fi le. QALoad saves the fi le in  your \QALoad\Datapools directory. 

M odi fying a Datapool  Fi l e 

You can modify a datapool fi le using the Script Development Workbench. 



QALoad Online Help 

85 

To m odi f y a dat apool  f i le: 

1. In  the Workspace Pane, cl ick the Datapools tab. 

2. Double-cl ick the datapool  fi le you want to modify. The datapool fi le opens in the Workbook pane. 

3. Make the appropriate changes and save the fi le. 

Using a Cen t ral  Datapool  Fi l e i n  a Script  

You assign a central datapool fi le to a specific script  by select ing the datapool fi le and sett ing any 
appropriate opt ions using the Conductor. Each script  can use a single central  datapool. The central 
datapool is avai lable to al l  Player workstat ions running the test. The fol lowing procedures describe how to 
assign and extract data from a central datapool. These procedures assume you have already created the 
datapool fi le as described above. 

To assign a cent ral  dat apool  f i le: 

1. With a session ID fi le open in the QALoad Conductor, cl ick the script  icon  in  the Visual 
Designer to display the script  Propert ies panel on the right-hand side of the window. 

2. In  the Ex ternal  Data sect ion for the selected script , cl ick the brow se [...] button in  the Cen t ral  
Datapools field. The Central Datapools page of the Script  Propert ies dialog box appears. 

3. Click Brow se, select the correct datapool fi le, then cl ick Open .  

4. (Optional) If you wish to re-use the datapool records when the script  reaches the end of the fi le, 
select Rew ind. To only use each record once, and then discard i t , select St r i p. 

5. When you are done, cl ick OK. The Central Datapools field in  the Propert ies panel now displays the 
number of central datapool fi les you've attached to the script . 

Using Data Records from a Central Datapool Fi le 

To use data from a central  datapool in  your load test, you wil l  have to modify your script . Typical ly, you 
wil l  read one record per transact ion.  

To add dat apool  st at em ent s t o your  scr ip t : 

1. With your script  open in the QALoad Script Development Workbench, navigate to the place where 
you want to insert  a datapool variable and h ighl ight the text to replace. 

2. From the Session  menu, choose In sert>Datapool . The Insert  New  Datapool  dialog box appears. 

3. Select a datapool from the l ist  and cl ick OK, or cl ick Add to open the Select  Datapool  dialog box 
where you can choose a datapool fi le to add to your test. 

4. When you are fin ished, the QALoad Script Development Workbench places several datapool 
funct ions in to your script , denot ing them with markers so you can easi ly ident i fy them. 

Using Local  Datapool  Fi l es in  a Script  

You assign a local datapool fi le to a specific script  by select ing the datapool fi le and sett ing any appropriate 
opt ions using the QALoad Script Development Workbench. Each script  can use up to 64 local datapools. 
Use the fol lowing procedures to assign and extract data from a local datapool  fi le. These procedures assume 
you have created a datapool as described above. 

To assign a local  dat apool : 
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1. Open a session in  the QALoad Script Development Workbench. 

2. In  the Workspace pane, cl ick the Scripts tab, then double-cl ick a script  to open in the Workbook 
pane. 

3. From the Session  menu, choose In sert>Datapool . The Insert  Datapool  Com m ands dialog box 
appears. 

4. On the Insert  Datapool  Com m ands dialog box, cl ick Add. The Select  Datapool  dialog box opens. 

5. In  the Type field, select Local . Note that you can also choose to insert  a central datapool from th is 
dialog box. If you choose to insert  a central datapool from here, the QALoad Script Development 
Workbench places the Conductor command GET_DATA in to the script  just after the 
BEGIN_TRANSACTION command, bookmarks the command in the margin of the script , and uses 
any opt ions set for the specified datapool in  the QALoad Conductor. 

6. In  the ID field, give the datapool a unique ident i fier. The name can contain alphanumeric 
characters only. Use underscores ( _ ) for spaces. This ID wil l  help you ident i fy the datapool in  your 
script , for example “ACCOUNT_NUMS”. 

7. In  the Fi lename field, type (or browse for) the ful ly qual i fied path of your datapool fi le. For 
example: c:\Program 
Files\Compuware\QALoad\Workbench\<middleware_name>\Scripts\datapool.dat 

8. If you wish to re-use the datapool records when the script  reaches the end of the fi le, select Rew ind 
at  End of  Fi l e. To only use each record once, and then discard i t , clear th is opt ion. 

9. When you are fin ished, cl ick OK. The selected datapool is displayed on the Insert  New  Datapool  
dialog box. 

10. Click OK. The QALoad Script Development Workbench wil l  place a #define statement ident i fying 
the datapool fi le near the beginning of your script , and place the datapool commands 
OPEN_DATA_POOL, READ_DATA_RECORD, and CLOSE_DATA_POOL at  the defaul t  locat ions in  the 
script . These statements wi l l  be bookmarked in the margin for easy ident i ficat ion. 

11. When you are fin ished modifying the script , save any changes. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Using Data Records f rom  a Local  Datapool  Fi l e 

To use data from a local datapool fi le you wil l  have to modify your script  to read data records and fields at 
the appropriate place in  the script . Datapool fi les should typical ly be opened with the statement 
OPEN_DATA_POOL just before the BEGIN_TRANSACTION statement, then datapool fields can be cal led in to 
the script  to replace variable strings. The OPEN_DATA_POOL statement is automatical ly inserted in to your 
script  when you use the QALoad Script Development Workbench to insert  your datapool. 

1. Read a record from the datapool fi le using the fol lowing command, which reads a single record 
from the local datapool fi le you specify: 
READ_DATA_RECORD(<LOCAL DATAPOOL ID>); 

2. To access the fields of th is record, subst i tute GET_DATA_FIELD(ACCOUNT_NUMS, n) expressions in  
place of variable strings. 

3. After the END_TRANSACTION statement, close the local datapool fi le by using the fol lowing 
statement: 
CLOSE_DATA_POOL( LOCAL DATAPOOL ID ); 

Note that th is statement is added automatical ly i f you use the QALoad Script Development Workbench to 
insert  your datapool. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 
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Insert i ng Variable Data w i th  Act i veData Subst i tut i on  

The QALoad Script Development Workbench al lows you to transform string data from quoted constants or 
substrings into variables. Act iveData variable subst i tut ion lets you ident i fy and right-cl ick on a string to 
declare the selected string a variable with in the QALoad script . This faci l i ty also lets you select or edit  
datapool entries more dynamical ly, making script  development easier and more efficient.  

To subst i t ut e a dat apool  value or  a var iable in  p lace of  a select ed st r ing in  your  scr ip t : 

1. Start  the appropriate session in  the QALoad Script Development Workbench. 

2. In  the Workspace pane, cl ick the Scripts tab. 

3. On the Script  tab, double-cl ick the script  you wish to open. The script  opens in the Workbook 
pane. 

4. In  the script , h ighl ight the string you wish to replace. 

5. Right-cl ick anywhere in  the h ighl ighted string. 

a. To subst i tute a value from a datapool: 

b. — Click Act i veData>Datapool  Subst i tut i on  in  the shortcut menu that opens. The 
Act i veData Datapool  Subst i tut i on  dialog box opens. 

c. In  the Datapool (s) area, h ighl ight the datapool to use. The contents of the datapool fi le 
display below. If the datapool you want to use is not l isted, cl ick the Add button to add 
i t  to the l ist  of avai lable datapools. 

d. In  the Field: ID field, type the field number of the specific value to use from the 
datapool. 

e. When you are fin ished, cl ick OK. The QALoad Script Development Workbench wil l  
place a #define statement ident i fying the datapool  fi le at the beginning of your script . 
It  wi l l  also insert  the datapool commands OPEN_DATA_POOL, READ_DATA_RECORD, 
GET_DATA_FIELD and CLOSE_DATA_POOL at  the default  locat ions in  the script , and 
bookmark them in the margin for easy ident i ficat ion. Refer to the Language Reference 
sect ion for detai led in formation about any of those commands. 

f. To subst i tute a variable: 

g. Click Act i veData>Variable Subst i tut i on  from the shortcut menu that appears. The 
Act i veData Variable Subst i tut i on  dialog box opens. 

h. Assign a variable name for the selected string in  the Variable Nam e field. 

i . Click OK. The QALoad Script Development Workbench wil l  declare the variable at the 
beginning of your script  and subst i tute the named variable for the selected string. It  wi l l  
also bookmark both locat ions for easy ident i ficat ion. 

6. When you are fin ished, save your script  changes. Compuware recommends that you also compile 
your script  to check for any errors. 

 

Using Datapools 

Creat ing a Datapool  Fi l e 

To create a datapool fi le using the Script Development Workbench, fol low the steps below.  

To creat e a dat apool  f i le: 



Using the Player, Script  Development Workbench, and Analyze 

88 

1. Open a middleware session in  the QALoad Script Development Workbench. 

2. From the Fi l e menu, choose New . 

3. On the New  dialog box that opens, select New  from the Datapools tree i tem. 

4. In  the Fi l enam e field, type a unique name for your datapool fi le. 

5. In  the Row s: and Cols: fields, type the number of rows and columns your new datapool should 
have. 

6. Click OK. 

7. Enter your datapool records in  the grid that opens in the Workbook Pane. 

8. When you are fin ished entering datapool records, cl ick Fi l e>Save As to name your datapool fi le. 

9. Click OK to save the fi le. QALoad saves the fi le in  your \QALoad\Datapools directory. 

 

M odi fying a Datapool  Fi l e 

To modify a datapool fi le using the Script Development Workbench, fol low the steps below. 

To m odi f y a dat apool  f i le: 

1. In  the Workspace Pane, cl ick the Datapools tab. 

2. Double-cl ick the datapool  fi le you want to modify. The datapool fi le opens in the Workbook pane. 

3. Make the appropriate changes and save the fi le. 

 

Using a Cen t ral  Datapool  Fi l e i n  a Script  

Assign a central datapool fi le to a specific script  by select ing the datapool fi le and sett ing any appropriate 
opt ions using the Conductor. Each script  can use a single central datapool. The central datapool is 
avai lable to al l  Player workstat ions running the test. The fol lowing procedures describe how to assign and 
extract data from a central datapool. These procedures assume you have already created the datapool fi le. 

To assign a cent ral  dat apool  f i le: 

1. With a session ID fi le open in the QALoad Conductor, cl ick the Script  Assignm en t  tab. 

2. In  the Ex ternal  Data column for the selected script , cl ick Brow se. 

3. In  the Ex ternal  Data dialog box, navigate to the datapool you wish to use. Select i t  and cl ick 
Open . 

4. If you wish to re-use the datapool records when the script  reaches the end of the fi le, select 
Rew ind. To only use each record once, and then discard i t , select St r i p. 

5. When you are done, cl ick OK. 

Using Data Records from a Central Datapool File 

To use data from a central  datapool in  your load test, modify your script . Typical ly, you read one record 
per transact ion.  

To inser t  dat apool  st at em ent s t o your  scr ipt : 
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1. With your script  open in the QALoad Script Development Workbench, navigate to the place where 
you want to insert  a datapool variable and h ighl ight the text to replace. 

2. From the Session  menu, choose In sert>Datapool . The Insert  New  Datapool  dialog box appears. 

3. Select a datapool from the l ist  and cl ick OK, or cl ick Add to open the Select  Datapool  dialog box 
where you can choose a datapool fi le to add to your test. 

4. When you are fin ished, the QALoad Script Development Workbench places several datapool 
funct ions in to your script , denot ing them with markers so you can easi ly ident i fy them. 

Using a Local  Datapool  Fi l e i n  a Script  

Assign a local datapool fi le to a specific script  by select ing the datapool fi le and sett ing any appropriate 
opt ions using the QALoad Script Development Workbench. Each script  can use up to 64 local datapools. 
Use the fol lowing procedures to assign and extract data from a local datapool  fi le. These procedures assume 
you have created a datapool. 

To assign a local  dat apool : 

1. Open a session in  the QALoad Script Development Workbench. 

2. In  the Workspace pane, cl ick the Scripts tab. 

3. On the Scripts tab, double-cl ick on the appropriate script  name to open i t  in  the Workbook pane. 

4. From the Session  menu, choose In sert>Datapool . The Insert  Datapool  Com m ands dialog box 
appears. 

5. On the Insert  Datapool  Com m ands dialog box, cl ick Add. The Select  Datapool  dialog box opens. 

6. In  the Type field, select Local . You can also choose to insert  a central datapool from th is dialog 
box. If you choose to insert  a central datapool from here, the QALoad Script Development 
Workbench places the Conductor command GET_DATA in to the script  just after the 
BEGIN_TRANSACTION command, bookmarks the command in the margin of the script , and uses 
any opt ions set for the specified datapool in  the QALoad Conductor. 

7. In  the ID field, give the datapool a unique ident i fier. The name can contain alphanumeric 
characters only. Use underscores ( _ ) for spaces. This ID helps you ident i fy the datapool in  your 
script , for example “ACCOUNT_NUMS”. 

8. In  the Fi lename field, type (or browse for) the ful ly qual i fied path of your datapool fi le. For 
example: c:\Program 
Files\Compuware\QALoad\Workbench\<middleware_name>\Scripts\datapool.dat 

9. If you wish to re-use the datapool records when the script  reaches the end of the fi le, select Rew ind 
at  End of  Fi l e. To only use each record once, and then discard i t , clear th is opt ion. 

10. When you are fin ished, cl ick OK. The selected datapool is displayed on the Insert  New  Datapool  
dialog box. 

11. Click OK. The QALoad Script Development Workbench places a #define statement ident i fying the 
datapool fi le near the beginning of your script , and place the datapool commands 
OPEN_DATA_POOL, READ_DATA_RECORD, and CLOSE_DATA_POOL at  the defaul t  locat ions in  the 
script . These statements are bookmarked in the margin for easy ident i ficat ion. 

12. When you are fin ished modifying the script , save any changes. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Using Data Records from a Local Datapool File 
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To use data from a local datapool fi le you have to modify your script  to read data records and fields at the 
appropriate place in  the script . Datapool fi les should typical ly be opened with the statement 
OPEN_DATA_POOL just before the BEGIN_TRANSACTION statement, then datapool fields can be cal led in to 
the script  to replace variable strings. The OPEN_DATA_POOL statement is automatical ly inserted in to your 
script  when you use the QALoad Script Development Workbench to insert  your datapool. 

1. Read a record from the datapool fi le using the fol lowing command, which reads a single record 
from the local datapool fi le you specify: 
READ_DATA_RECORD(<LOCAL DATAPOOL ID>); 

2. To access the fields of th is record, subst i tute GET_DATA_FIELD(ACCOUNT_NUMS, n) expressions in  
place of variable strings. 

3. After the END_TRANSACTION statement, close the local datapool fi le by using the fol lowing 
statement: 
CLOSE_DATA_POOL( LOCAL DATAPOOL ID ); 

This statement is added automatical ly i f you use the QALoad Script Development Workbench to insert  
your datapool. 

For detai led in formation about any of these commands, refer to the Language Reference sect ion. 

Compiling a Script  

Compiling a Test Script 

A QALoad script  is a real C-, C++-, or Java-based script , and therefore needs to be compiled before i t  can be 
used. QALoad works with your exist ing compiler to compile usable test scripts. If you make changes to an 
exist ing script , you must re-compile i t  before you can successful ly use i t  in  a test. If you add an uncompiled 
or out-of-date script  to a load test, the QALoad Conductor wi l l  prompt you to compile the script . 

Set Up Automatic Conversion and Compilation of a Script 

The Script Development Workbench automatical ly converts a capture fi le when you stop the recording 
process and compile the result ing script . You are prompted i f a script  by the same name already exists, so 
that you can decide whether to overwrite an exist ing script  or to save your script  under a different name. 

If the default  sett ings to automatical ly convert  a capture fi le have been changed, fol low the steps below to 
reset the automatic conversion and compilat ion. 

To set  up aut om at ic conversion and com pi lat ion: 

1. From the Script  Developm en t  Workben ch  menu, choose Opt ions>Workbench . 

2. On the Workbench Configurat ion tab, in  the Record Opt ions area, select the check box 
Autom at i cal l y Convert  Capture. 

3. Click the Com pi ler Set t ings tab. 

4. Select the check box Autom at i cal l y com pi le scri pts. 

5. Select the check box Prom pt  before overw ri t i ng script  to ensure that a script  is not overwrit ten 
accidental ly.  

6. Click OK to save your sett ings. 
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Test ing a Script  

Validating Scripts in Workbench 

Before adding a script  to a load test, val idate i t  to ensure that i t  runs without problems. The fol lowing 
procedure is only val id for Win32 scripts. To val idate a UNIX script , see Val idat ing a UNIX script . 

Note: During val idat ion of SAP scripts, do not min imize the SAP window. If the window is min imized, 
the val idat ion may fai l . This problem does not occur i f you de-select the Show  Graph ical  User In terface 
for SAP Users middleware opt ion in  the Conductor. This SAPGUI opt ion runs SAP on an alternate desktop 
that is not visible. 

To conf igure t he Scr ip t  Developm ent  W orkbench f or  val idat ion : 

1. Click Opt ions>Workben ch  and select the Script  Val idat ion  tab. 

2. Select the Autom at i cal l y Recom pi le check box i f you want QALoad to compile a script  before 
attempting to val idate i t . QALoad l ists any compilat ion errors in  the editor after compil ing. 

3. (For Java and OFS) select Ask  for Autom at i c Val idat ion  of  Java and OFS Scripts. 

4. Select the On ly Display Player Output  on  Script  Fai lure check box to view only Player messages 
upon script  fai lure, i f appl icable. 

5. Type a value in  the W ai t  up to field. This is the number of seconds that the QALoad Script 
Development Workbench should wait  for a script  to execute before t im ing out. 

6. In  the Player Sett ings area, select the Abort  on  Error check box for QALoad to stop script  execut ion 
upon encountering an error. 

7. Select the Debug Data check box for the script  to display a debug message indicat ing which 
command the script  is execut ing. 

8. In  the Run As area, indicate whether the transact ion should be run as th read- or process-based. 

Note: Oracle Forms Server, Citrix, Java, and Uniface scripts are l im ited to process-based val idat ion 
only. 

9. In  the Num ber of  users field, type a number of virtual users to run th is script  for val idat ion. The 
default  is 1. 

10. Enter a value in  the Tran sact ions field. For val idat ion, Compuware recommends that you accept 
the default  value of 1 transact ion. 

11. In  the Sleep Factor % field, type the percentage of each DO_SLEEP (pause in the script) to 
maintain. For val idat ion, you may not need to run every pause in the script  at  i ts ful l  length. The 
value can be a percentage between 0 and 100. The default  is 0. 

12. Click OK to save your changes. 

To val idat e a scr ip t  in  W orkbench: 

1. In  the Workspace Pane, cl ick the Scripts tab. 

2. Double-cl ick on the appropriate script  name to open the script . 

3. From the Session  menu, choose Val idate Script . 

You receive a message and trace in formation in  the Output pane. When the script  executes successful ly, 
you receive a confirmation message. If i t  does not execute successful ly, use the trace in formation to help 
you ident i fy errors. 
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Debugging a Script  

Setting Debugging Options for a Script 

If you encountered errors whi le val idat ing or test ing a script , use QALoad's debugging opt ions to monitor 
the Player(s) that generated errors whi le they are running or after the test.  

You can watch a virtual user execute a script  on a Player Workstat ion while i t  is running. To monitor 
selected virtual users at runt ime, enable the Debug Trace opt ion before you run your test. Each virtual user 
for which you enabled Debug Trace displays messages on i ts assigned Player workstat ion indicat ing which 
commands are being executed. 

You can instruct the Conductor to generate and save detai ls about the script  execut ion of selected virtual 
users by enabl ing Logfi le Generat ion before you run your test. This appl ies to Citrix, ODBC, Oracle, Oracle 
Forms Server, SAP, Winsock, or WWW only.  

You can set the Debug Options using the Script Propert ies panel in  the Visual Designer, or using the Grid 
View window. 

To enable t he Debug opt ions: 

1. Do one of the fol lowing: 

!  In  the Visual Designer, cl ick the script  icon for the appropriate script  to display the Script 
Propert ies panel on the right-hand side of the window, then cl ick the brow se [...] button in the 
Debug Opt ions field. The Debug window of the Script  Propert ies dialog box appears. 

OR 

!  In  the Grid View window, select the Script  Assignm en t  tab, then cl ick the brow se  [...] button 
in  the Debug Opt ions column, for the appropriate script . The Debug window of the Script 
Propert ies dialog box appears. 

2. On the Debug Options dialog box, you can choose the fol lowing opt ions:  

!  To enable the Debug Trace opt ion: in  the Debug Trace Virtual User Range area, choose which 
virtual users (i f any) to monitor. You can choose None or Al l  Virtual Users, or choose Virtual 
User(s) and then type the numbers assigned to the virtual users you want to monitor. You can 
monitor individual virtual  users or ranges of virtual users.  

!  To enable Logfi le Generat ion: in  the Logfi le Generat ion Virtual User Range area, choose which 
virtual users (i f any) to monitor. You can choose None or Al l  Virtual Users, or choose Virtual 
User(s) and then type the numbers assigned to the virtual users you want to monitor. You can 
monitor individual virtual  users or ranges of virtual users.  

3. Click OK to save your changes.  

4. From the Conductor's main menu, cl ick Fi l e>Save to save your test session ID. 

5. Run your test as usual.  

Note: Some log fi les are generated automatical ly when you run a test in  the Script Development 
Workbench or Player.  
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QALoad Support Log Files 

The table below ident i fies the QALoad log (support) fi les that are generated automatical ly during a test. 

Note: Some log fi les are generated automatical ly when you run a test in  the Script Development 
Workbench or Player.  

Each virtual user for which you enabled Logfi le Generat ion in  Conductor creates a fi le contain ing 
in formation about their performance. After the test is fin ished, the Conductor requests al l  log fi les from 
the Players and save them in the directory \Program Files\Compuware\QALoad\LogFiles on the 
workstat ion where the Conductor is instal led.  

Log fi les are named <scriptname>_<middleware>_vu<AbsoluteVirtualUserNumber>.<ext>, where: 

!  <scriptname> is the name of the script  the virtual user ran 

!  <middleware> is the name of your middleware appl icat ion 

!  <AbsoluteVirtualUserNumber> is the ident i ficat ion number assigned to the virtual user 

!  <.ext> is the fi le extension, dependent upon which middleware appl icat ion you are test ing 

M iddlew are .RIP Fi le .CAP Fi le  
(Replay 

Capture) 

.TRC Fi le 
Player Trace 

.LOG Fi le 

Citrix Yes Yes Yes No 

ODBC No No Yes *Yes 

Oracle No No Yes *Yes 

Oracle 
Forms 
Server 

Yes Yes Yes No 

SAP No No Yes Yes 

Uniface No Yes Yes No 

Winsock No No Yes *Yes 

WWW Yes Yes Yes No 

Note: *This middleware also uses the .log fi le in  replay capture.   

Verifying script checkpoints 

You can quickly veri fy the syntax of the checkpoint commands BeginCheckpoint() and EndCheckpoint() 
in  your script  every t ime you compile your script  by sett ing a single opt ion, or on-the-fly with a single 
menu command. 

To aut om at ical ly ver i f y scr ip t  checkpoin t s, every t im e you com pi le a scr ipt : 

1. From the Script Development Workbench's main menu, cl ick Opt ions>Workbench . 

2. On the Configure Script  Development Workbench dialog box, cl ick the Com pi ler Set t i ngs tab. 

3. Select the Veri fy Checkpoin ts opt ion. 

4. Click OK. 
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Every t ime you compile your script , the Script  Development Workbench veri fies the syntax of your 
checkpoint statements, and ensures the parameters passed in each pair match . If any errors are 
encountered, an error message displays in  the Output pane. You can cl ick on any error l ine to go direct ly 
to that l ine in  the script . 

To m anual ly ver i f y scr ip t  checkpoint s, f or  t he open scr ip t  only: 

With your script  open in the Workbook pane, cl ick Session>Veri fy Checkpoin ts.  

The Script Development Workbench veri fies the syntax of your checkpoint statements, and ensures the 
parameters passed in each pair match. If any errors are encountered, an error message displays in  the 
Output pane. You can cl ick on any error l ine to go direct ly to that l ine in  the script . 

 

Visual Navigator (WWW) 

The Visual Navigator 

The visual script ing in terface, cal led the Visual Navigator, has three panes that represent different aspects 
of your script , and menu i tems that offer you addit ional funct ional i ty. Using the Visual Navigator to 
develop your scripts makes your job easier. For example, searching through l ines of code to locate a 
part icular button you cl icked on a part icular page can take a long t ime, but using the Visual Navigator you 
can simply cl ick through the pages to locate that button. In  fact, you can develop your whole script  – 
recording, variabl izing, convert ing, compil ing, and running i t  – al l  from the Visual Navigator's in terface 
without ever wri t ing a l ine of code. 

For a brief explanat ion of each Visual Navigator pane, cl ick on the panes in the graphic below. For more 
in formation about a pane, use the l inks l isted after the graphic. 

Note: To make the fol lowing graphic fi t  better in  th is help window, we've turned off the Script  
Development Workbench toolbars and panes that are not direct ly related to th is help topic. You can 
h ide/show many of the Script Development Workbench toolbars and panes using commands avai lable 
from the View  menu. 
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Visual Navigator Menus 

The Visual Navigator has a number of special menu commands to help you develop your script . 

Visual Navigator Menu 

Edit  Menu 

Tools Menu 

Visual Navigator Menu 

The Visual Navigator menu is the main menu for Visual Script ing. Access the Visual Navigator menu from 
the Script Development Workbench's main menu, or right-cl ick on any i tem in the Visual Navigator tree-
view (left  pane).  
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Datapools and Variables: Opens the Datapools and Variables dialog box, where you can add, delete, or 
modify datapool fi les or variables.  

View  Script  Fi l e: Opens a window showing the C++ (.cpp) fi le based on what is current ly showing in the 
Visual Navigator's tree-view. This is a read-only script .  

Create Edi table Script  Fi le: Creates an editable C++ (.cpp) script  based on the current Visual Script . You 
can modify th is script  direct ly; however, any changes made to the script  wi l l  not be reflected in  the tree 
and vise-versa.  

Show  Hidden  Fields: Displays form fields that are h idden by the browser.  

Show  Redi rected Pages (3xx ):Toggles whether or not redirected pages are displayed. These are pages that 
come back with a reply status code of 3xx, for example: 302 Not Found. 

Show  Authen t i cat ion  Pages (401 and 407): Toggles whether or not Authent icat ion pages are displayed. 
These are pages that come back with a reply status code of 401 Unauthorized or 407 Proxy 
Authentication Required. 

Insert  Tree I tem : Opens a sub-menu where you can choose to insert  certain tree i tems into your script . For 
detai ls, see Insert ing script  i tems. 

Delete Tree I tem : Deletes the current ly selected tree i tem. If the selected i tem may not be deleted from the 
script , th is command is unavai lable.  

View  Source: Opens a text window displaying the source code of the current ly act ive HTML Page or 
Subrequest in  the tree view. 

Edit Menu 

The Script Development Workbench Edit  menu provides special commands for Visual Navigator 
funct ional i ty as well  as common Edit  menu commands. Access the Edit  menu from the main menu, or 
right-cl ick on an edit  box that can be variabl ized in  the Visual Navigator form-view (bottom pane). Fields 
that can be variabl ized are denoted with a Var button.  

The commands on the Edit  menu are dynamic and the avai labi l i ty of certain commands depends upon 
whether you have text selected and where your cursor is. The fol lowing graphics i l lustrate the difference: 
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Insert  Variable/ Subst i tute w i th  Variable: Opens the Datapools and Variables dialog, al lowing you to 
insert  a variable or replace the selected text with a variable. Subst i tuted text wi l l  refer to a local variable or 
datapool variable and wil l  look similar to one of the fol lowing examples: 

{$ VAR:Customer Number $} 

{$ VAR:Last Name:Customer Data $} 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var or Var Wiz next to i t ).  

Insert  Random  Value/ Subst i tute w i th  Random  Value: Opens the Random Number Tag dialog box where 
you can specify a range wi th in which a random number should be generated for th is value. The subst i tuted 
text looks l ike th is:  

{$ RANDOM:0:100 $} 

and i t  produces a random number between the lower and upper l im it  each t ime i t  is executed. 

These commands are only avai lable when the cursor is placed in an edit  box on a tree-view i tem that can 
be variabl ized (you wil l  see Var next to i t ).  

Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Absolute): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  

{$ VU:ABS $} 

This is the virtual user number at runt ime. The absolute virtual user number is assigned depending on the 
number of Players in  use. For example, two Player machines with 50 virtual users on each, would assign 
numbers 0 through 49 for Player 1 and 50 through 99 for Player 2. Typical ly, the VU number is combined 
with other text to form a larger string, such as:  

Customer{$ VU:ABS $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer50 through Customer99. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var or Var Wiz next to i t ).  

Insert  VU Num ber/ Subst i tute w i th  VU Num ber (Relat i ve): Inserts or replaces the h ighl ighted text with 
the fol lowing text:  

{$ VU:REL $} 

This is the virtual user number at runt ime. The relat ive virtual user number is assigned to each Player in  
use. Each Player has relat ive numbers from 0 to N, where N is the total number of VUs run on that Player. 
For example, two Player machines with 50 virtual users on each, would assign numbers 0 through 49 to 
each Player. Typical ly, the VU number is combined with other text to form a larger string, such as:  

Customer{$ VU:REL $} 

In  th is example, Player 1 has values of Customer0 through Customer49, and Player 2 has values of 
Customer0 through Customer49. These commands are only avai lable when the cursor is placed in an edit  
box on a tree-view i tem that can be variabl ized (you wil l  see Var next to i t ). 

Revert  to Original  St r i ng: Rol ls the contents of the selected edit  box back to when i t  was first  created, 
usual ly when the recording was converted to a Visual Script .  

This menu i tem is enabled only i f the edit  box with in the form can be variabl ized and i t  has been changed 
at some point. 

Delete Variable Reference: Deletes the variable from the selected edit  box. Note that you can also 
h ighl ight a variable and press the Delete key to delete a variable with in an edit  box. 

This menu i tem becomes enabled when you h ighl ight a variable inside of an edit  box.  
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Tools Menu 

The Script Development Workbench Tools menu provides access to the Rule Library for parameterizat ion, 
the ZipFi le wizard for col lect ing fi les needed by the Technical Support team to analyze and resolve a 
problem, and common Tools menu commands. Access the Tools menu from the Script Development 
Workbench main menu. 

 
  

Rule Library: Opens the Rule Library dialog box, where you can add, delete, or modify saved Variable 
Replacement Rules. 

Visual Navigator's Find and Replace Feature 

Visual Navigator has an enhanced Find/Replace feature that al lows you to find occurrences of strings 
with in the tree-view, al lowing you to quickly locate and/or replace text. For example, you could find 
occurrences of Smith and replace them al l  with the datapool variable {$ Last Name:User Info $}. 

To access Visual  Navigat or 's Find f eat ure: 

1. Select  Edi t>Find in  the toolbar.  The Find and Replace dialog box displays with the Find tab on 
top. 

2. Enter the appropriate opt ions and cl ick Find Nex t . When al l  matches are found, close the dialog 
box or cl ick Repl ace to use the Replace feature. 

To access Visual  Navigat or 's Replace f eat ure: 

1. Select  Edi t>Replace in the toolbar.  The Find and Replace dialog box displays with the Replace tab 
on top. 

2. Enter the appropriate opt ions. 

3. Do one of the fol lowing: 

!  Click Find Nex t  to review each ident i fied variable before replacing i t . 

!  Click Replace Al l  to replace al l  variables without reviewing them. 

4. Close the Find Replace dialog box. 
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Developing a Script  Using the Visual Navigator (WWW) 

Recording a Visual Navigator Script 

Recording a Visual  Navi gator Script  

You record a Visual Navigator script  the same way you record a regular QALoad script  — by sett ing opt ions 
to determine the behavior of QALoad while recording, and then cl icking through a transact ion to mimic a 
user. QALoad wil l  record al l  sent and received HTTP and SSL cal ls using the Script Development 
Workbench's Web proxy and write the act ivi ty to a capture fi le.   

After recording, the capture fi le must be converted to an editable, C-based script . This is the point where 
Visual Scripting differs from a regular W WW script. By sett ing a single opt ion before convert ing the capture 
fi le to an editable script , you can turn your capture f i le data in to a Visual Script  that al lows you to view the 
actual Web pages you recorded in a browser-l ike in terface, where you can manipulate the transact ion and 
easi ly insert  variable in formation in to your script  wi thout direct ly edit ing a l ine of code. 

To record a Visual  Scr ip t : 

If you are running your appl icat ion on Windows XP SP2, Compuware recommends you turn the 'pop-up 
blocker' feature off before recording a transact ion. The feature can be disabled via the browser window's 
Tools menu in In ternet  Opt ions>Pri vacy. 

1. Open a WWW session in  the Script Development Workbench. 

2. Click Opt ions>Record. The WWW Record Options dialog box opens. Set any relevant opt ions. 

3. Click OK. 

4. For convenience, set conversion opt ions now also. (You can set conversion opt ions after recording 
your transact ion, i f you prefer, or even change pre-set opt ions at any t ime after recording and then 
re-convert  the capture fi le to apply the changes.): 

a. Click Opt ions>Convert . The Universal Convert  Options dialog box opens.  

b. Set any appl icable opt ions on the General Convert  and WWW tabs.  

c. On the WWW tab, select the Enable Visual  Navigator check box, which wil l  ensure your 
capture fi le is converted to a Visual Script  later.  

d. Click OK. 

e. From the toolbar, cl ick the Start  Record button. QALoad launches your appl icat ion and 
any proxies, i f necessary, and begins recording cal ls. 

5. Record the transact ion. 

6. When you are fin ished, cl ick the Stop Record button. You wil l  be prompted to save your capture 
fi le. By default , capture fi les (.cap) are saved in the directory 
QALoad\Middlewares\WWW\captures. 

7. If you previously set opt ions to prompt automatic conversion, your capture fi le wi l l  be converted to 
a Visual Script  and wil l  open automatical ly in  the editor. For more in formation about sett ing up 
automatic conversion, see Configuring the Script Development Workbench. 

If not, you wil l  be prompted to save and name your fi le. When you are fin ished, cl ick OK. 

8. Click the Script Development Workbench's Captures tab and locate the capture fi le you just saved. 

9. Right-cl ick the fi le and choose Convert . QALoad wi l l  convert  your capture fi le to a Visual Navigator 
script  and open i t  in  the editor. 
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Visual  Navigator Fi l es 

When you create a script  using Visual Navigator, QALoad saves important in formation about your script  in  
the fol lowing fi les. These fi les are saved in the directory \Compuware\QALoad\Middlewares\WWW in  the 
subdirectories \Scripts and \Captures. Some of these fi les can be modified, and can be opened from the 
Script Development Workbench's Workspace pane, i f necessary. 

Note: If you choose to enable support for Siebel wh i le convert ing a capture fi le, you must copy the 
ssdtcorr.hpp, ssdtcorr.l ib, and ssdtcorr.dl l  Siebel fi les from the Siebel instal lat ion folder to the 
C:\Program Files\Compuware\QALoad\BinaryFiles. If you do not modify the Siebel instance, you 
only have to move the ssdtcorr.dll file. 

Fi l enam e Descript i on  

Fi l es Generated From  Recording 

<filename>.cap A fi le 
contain ing al l  
of the 
requests and 
responses that 
were 
recorded. 

<filename>.rfd Replies to 
subrequests, 
which most ly 
consist  of 
images, style 
sheets, and 
javascripts. 
This data is 
used to 
visual ly 
recreate the 
pages as they 
appeared 
when 
recording. 

Fi l es Generated From  Conversion  
to a Visual  Script  

<filename>.vistree Contains 
most of the 
elements of 
the Visual 
Navigator 
tree, 
including any 
elements that 
you modify 
later or add to 
your script . 

<filename>.VisHtml Contains the 
HTML pages 
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of al l  the 
main requests 
as well  as 
images, 
stylesheets, 
and other 
subrequested 
pages. This 
data is used to 
visual ly 
recreate the 
pages as they 
appeared 
when 
recording. 

<filename>.VisXml Contains any 
XML/SOAP 
information 
that was 
recorded. 

<filename>.cpp A C++ 
representat ion 
of your script . 

 

 

Inserting Script Items 

Insert i ng t ree i tem s 

You can insert  a number of script  i tems into your converted script .  

To inser t  t ree i t em s: 

1. Do one of the fol lowing: 

!  From the Script Development Workbench main menu, choose  Visual  Navigator>Insert  Tree 
I tem .  

!  Right-cl ick in  the tree-view (left  pane) and choose Insert  Tree I tem .  

2. Choose the i tem to insert . 

Most of the inserted i tems can be moved up and down the tree using the Up/Dow n arrows in the form-
view (bottom pane) for that i tem. You can also delete an i tem highl ighted in  the tree-view by choosing 
Delete Tree I tem  from the menu. 

The fol lowing script  i tems can be inserted from the Visual  Navigator menu:  

Extract String 

Cookie 

Http Header 

Content Check 
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CGI Parameter 

Synch 

IP Spoof 

Read Datapool 

Checkpoint pair 

Increment Variable/Decrement Variable/Reset Variable 

Print Values (debugging) 

Comment 

 

Insert i ng cook ies in to a scri pt  

Cookie i tems can be added direct ly to the Html Page i tem they apply to, under the Act ion  i tem (for 
example, a Cl ick on Link i tem).  

To inser t  a cook ie i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Html Page i tem requiring the cookie 
and then cl ick on i t  to select i t .  

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Cook ie. A Cookie form-view opens in 
the bottom pane. 

3. In  the Nam e field, type a name for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

4. In  the Value field, type a value for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 

The Cookie i tem is added to the script  for the selected Html Page i tem.  

 

Insert i ng HTTP headers in to a Visual  Navigator script  

You can insert  HTTP headers under the Common Http Headers tree i tem. 

To inser t  a new  Ht t p  Header  i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Com m on Ht tp Headers script  i tem, 
and then cl ick on i t . 

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Ht tp Header. An Ht tp Header form-
view opens in the bottom pane. 

3. In  the Nam e field, type a name for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

4. In  the Value field, type a value for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 



QALoad Online Help 

103 

The header i tem is added to the script , and wil l  be used for al l  requests at playback unless i t  is overwrit ten 
by a header with the same name underneath an individual request act ion.  

 

XML Support 

XM L Support  

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, Compuware 
recommends you read through th is help topic as well  as the Visual Navigator help topics to become 
famil iar with the features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the fol lowing graphic fi t  better in  th is help window, the Script Development 
Workbench toolbars and panes that are not direct ly related to th is help topic are not displayed. You can 
h ide/show many of the Script Development Workbench toolbars and panes using commands avai lable 
from the View  menu. 

 

 

XM L Requests 

When an HTTP request is for an XML document, ei ther in  the form of an HTTP GET request, or an HTTP 
POST request with an XM L document as the post data, then an XML Request  tree i tem is displayed in the 
tree-view (left  pane). The form-view (bottom pane) for an XML Request i tem includes the fol lowing fields: 

Reply Status: The reply status code. The status code is 200 OK for most pages that return correct ly. 
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Request  URI: This read-only field shows the URI requested, which resulted in  th is page being displayed.   

Checkpoin t  Nam e: If the page has a t i t le, i t  is used as the checkpoint name. If not, the word Checkpoint is 
used. To make sure al l  checkpoint names are unique, QALoad adds a number to the beginning of the 
checkpoint name. 

XML Request Sub-i tems 

An XML Request i tem can contain the fol lowing sub-i tems.  

XML Reply  

The URI of the document returned as a result  of the XML request. XML data corresponding to the reply is 
displayed in the browser-view. 

HTTP Headers 

If a header exists under an act ion i tem, i t  is sent for that request only. If the header has the same name as 
one of the common headers, i t  overrides the common header for th is request only. The form-view (bottom 
pane) for an HTTP header l ists i ts name and value. Because there is no XML data recorded for a header, the 
browser-view remains empty. It  is possible to insert  addit ional HTTP Headers. 

Cookies CGI Parameter 

The Cookies tree i tem contains a l ist  of Cookie i tems that were sent in  the header of the request that th is 
i tem made while being recorded. Cookies are added automatical ly by the browser based on the URI that is 
being requested. They are either set as a result  of the previous reply (server returned a Set-Cookie 
command), or they are set by JavaScript contained in the previous reply. The form-view for a cookie i tem 
l ists i ts name and value. Because there is no XML data recorded for a header, the browser-view remains 
empty.  

 

XM L Docum en t -view  

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What i f no XML data is associated with a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document-view. 

How does the document-view relate to the form-view? 

Select ing an i tem in the XML document tree displays the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 
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XM L Form -view  

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view displays instead. For XML items, the form view 
display opt ions depend on two th ings: 

!  what type of XML item is selected in  the Visual Navigator tree-view (left  pane): an XML request or 
an XML reply 

!  what type of XML item is subsequently selected in  the XML document-view (top pane) 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — attribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an i tem is editable, the value in  the form-view can be changed and the new value is used during 
replay. 

!  If a value can be variablized, a variable can be subst i tuted for al l  or part  of the value. The variable's 
value is placed in the variable's locat ion at replay. An example is a value received from an i tem 
from a previous XML document reply. 

!  If a variable can receive a replay value, the return value for the i tem can be placed into a selected 
variable during replay. The variable can then be subst i tuted for an input value in  a later XML 
request. 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value be 
Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 
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PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable Receive 
Replay Val ue 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 

Attribute (Value) Yes 

Text Yes 

 

Visual Script ing Concepts 

Introducing Visual Scripting 

Visual Navigator for WWW is QALoad's easy-to-use visual in terface to QALoad's powerful script  
development tools. Visual  Navigator for WWW renders your recorded C++-based transact ion in  a tri -paned, 
browser-l ike environment  similar to popular visual ly-oriented development tools, with icons represent ing 
al l  the elements of your script . In  fact, you could set  up and run a WWW script without ever having to 
modify a C++-based script . 

With Visual Navigator's advanced edit ing features, you don't  have to know the syntax of QALoad's 
command set or your HTML requests or responses to customize your script . You can quickly and easi ly: 

!  See what URL cal ls were made and what type they were (for example a POST or GET statement) 

!  See what in formation was passed in a cal l  

!  See what repl ies/pages were returned 

!  Add checkpoints or comments in to your script  
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!  Move the begin/end transact ion statement 

!  Move the synchronize statement 

!  Edit  an HTTP header 

!  Set part icular flags and commands 

!  Add datapools 

!  Parameterizing your script  

!  Extract in formation from a reply to use in  subsequent cal ls 

!  Save your script  and go back to i t  at  any t ime for further edit ing 

!  Create a C++-based script  fi le, i f you l ike   

 

Looking at a Transaction Loop 

The transact ion loop is the port ion of your script  that is played back repeatedly, represent ing mult iple 
users making requests. The elements in  your transact ion loop depend on what  was original ly recorded on 
each page you requested. You can move the transact ion loop up or down in the tree-view using the arrow 
buttons, to al low certain requests to be moved in or out of the Transact ion Setup area, where they wil l  be 
executed before beginning the transact ion loop. 

Note: The fol lowing graphic does not show al l  the possible script  elements, but gives a good 
representat ion of what your transact ion loop might look l ike in  the Visual Navigator. 

 

High -level  script  i tem s 

There are three h igh-level script  i tems in the transact ion loop that represent the web pages you've 
recorded. NavigateTo, HTML Pages, and XML Requests:  

NavigateTo: This is always the first  i tem under the Transact ion Loop element , and is always denoted wi th 
an arrow icon. It  l ists the URL that was typed into the web browser at the start  of recording. This specifies 
the first  request to be made. The result  of th is request is the next i tem in the tree, which is general ly an 
HTML Page i tem.  

If the first  i tem is an HTTP request for XML data, i t  wi l l  appear as an XML Request i tem in the tree.  

Page (HTM L): Fol lowing NavigateTo there wil l  typical ly be a set of HTML Page i tems, which are always 
denoted with a globe icon underneath the Transact ion Loop element. These represent pages visi ted whi le 
the transact ion was being recorded. 

The form-view (bottom pane) l ists the request 's reply status, the requested URI, and the associated 
checkpoint name for the page returned. 

HTML Page i tems can be parent to a number of script  i tems in the tree-view, such as Act ion i tems. For 
more in formation about sub-i tems that can exist  under a Page i tem, see HTM L Page sub-i tems. 

XM L Request : Requests for XML documents are denoted by a document/arrow icon underneath the 
Transact ion Loop element . These represent the requests for XML data made during the transact ion that 
was recorded. XML Request i tems can be parent to a number of lower-level script  sub-i tems in the tree-
view, such as Header and Cookie i tems and the XmlReply document i tem. See XML requests to learn about 
sub-i tems that can exist  under an XML Request i tem. 

 

XML Support 

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, Compuware 
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recommends you read through th is help topic as well  as the Visual Navigator help topics to become 
famil iar with the features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the fol lowing graphic fi t  better in  th is help window, the Script Development 
Workbench toolbars and panes that are not direct ly related to th is help topic are not displayed. You can 
h ide/show many of the Script Development Workbench toolbars and panes using commands avai lable 
from the View  menu. 

 

 

Streaming Media in Visual Navigator 

If you selected the Streaming Media opt ion on the WWW Advanced conversion opt ions dialog box before 
recording your script , and the recorded transact ion contains RealOne Player or Windows Media streaming 
requests, your streaming media request wi l l  be presented as a Page in the tree-view, similar to the fol lowing 

graphic:  

The form-view (bottom pane) for a streaming media page shows the 
t i t le Real Media Request or Windows Media Request to indicate the type 
of request you recorded, and l ists the fol lowing fields: 

Requested URI: Lists the requested URI that invoked the media 
player. For Real M edia the fi le typical ly is an RM fi le, whi le for 
Windows Media i t  is typical ly an ASX fi le. 

Play M edia Request : Select th is check box for the virtual user to 
process the RM or ASX fi le that is received and make the necessary 
requests to dupl icate what  the cl ient performed while receiving the 
streaming media. If th is checkbox is not selected, then no further 
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processing is performed after receiving the RM or ASX fi le. 

Play Requested M edia for N seconds: You can specify how much of the streaming media fi le the virtual 
user should play, in  seconds, before moving on to the next request. A value of zero indicates that the ent ire 
media stream should be played. 

Note: While a virtual user is playing a media request i t  wi l l  not make any other requests in  the 
transact ion loop. This may be different than what the user performed when recording the transact ion 
because a browser is capable of spawning the streaming media player as a separate executable which can 
execute at the same t ime that the user cont inues to make further web requests in  the browser. 
 
 

 

CJK and Visual Navigator 

The Visual Navigator handles both nat ive and encoded Chinese, Japanese, and Korean (CJK) characters. 
(See CJK Support in  QALoad for more in formation about CJK support.) 

The fol lowing graphic shows how the Visual Navigator provides nat ive character support. Both Engl ish and 
Chinese characters are displayed in the Workbook Pane. 

 

The same capture fi le, Shanghai.cap, is open in the graphic below. Here, the Visual Navigator displays the 
Chinese characters in  encoded format. 
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Primary Script  Elements 

Primary Elements of a Visual Navigator Script 

When you open a Visual Navigator script , you'l l  see standard elements of your script  l isted in  the left  pane. 
Each element can contain  a number of script  i tems, which in  turn have attributes that are editable in  some 
cases. This topic l ists the major elements of a script , and l inks to addit ional help topics describing each 
element 's associated script  i tems:  

The main elements of a Visual Navigator script  are: 

WWW Playback Options 

Variables  

Parameterizat ion Rules 

Datapool Fi les  

Common Http Headers  

Common Content Checks  

Transact ion Setup  

Transact ion Loop  

Transact ion Cleanup  
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WWW Playback Options 

This i tem contains sett ings related to playback such as proxy sett ings, t ime out value, number of 
concurrent connect ions, baud rate emulat ion, and fi l ters.  

Parsing 

Caching 

Traffic Fi l ters 

Connect ion Sett ings 

Content Type Handling 

Proxy 

General 

Siebel 

Variables 

These are local variables that have been created for th is script .  When you h ighl ight a variable in  the tree 
view, the fields display data related to the variable type you selected.  For in formation about 
parameterizat ion, see Parameterizat ion. 

Parameterization Rules  

Lists Parameterizat ion Rules that you create when you define a variable to subst i tute for a value. Saving the 
variable as a rule enables you to reuse i t  for other instances of the variable. 

When you cl ick Param eteri zat ion  Rules in  the Visual Navigator tree-view, detai ls of the rules stored in  the 
Rule Library appears in  the right-hand pane.  

Notes:  

!  Propert ies for the rules are defined using the Rule Library Wizard or the Variable Replacement 
Wizard. 

!  An exclamation mark (!) in  the first  column, signifies that the rule matches the same parameter 
as another rule defined in the script . The rule appl ied first  prevents the other rules from being 
appl ied. Rules are appl ied in  the order they are displayed in the table. 

Rule Nam e: Name of the rule. 

M atch ing I tem : Name of the i tem with in the script  that matches the parameters defined in the rule and 
that wi l l  be replaced with the rule.    

M atch ing Type: The type of  i tem with in a script  that is replaced by th is rule. Item types include: 

!  CGI Parameter 

!  Cookie 

!  Header 

!  EditBox 

!  RadioButton 

!  TextBox 

Fields Replaced: Fields of the matching i tem that are replaced by th is rule. Fields may be: 

!  Name 

!  Value 

!  Both name and value 

Apply: Apply the selected rule. 
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Apply Al l : Apply the rule to al l  matching i tems in the script . 

Undo Apply: Remove the rule from matching i tems in the script . 

Edi t : Opens the Rule Library Wizard so you can edi t  the rule. 

Dupl i cate: Dupl icates the selected rule in  the l ist . 

Delete: Deletes the rule from the script . The rule remains in  the l ibrary. 

Add to Library: Adds the rule to the Rule Library. Only rules in  the Rule Library can be appl ied to future 
scripts. 

Note: You can create a rule using the Variable Replacement Wizard without adding i t  to the l ibrary.  

Goto Rule: Displays detai ls for the selected rule. 

Get  f rom  Library: Opens the Get Rule from Library dialog box. Select a rule to add to the visual t ree. 

 

Datapool Files 

Lists datapool fi les being cal led by the script . Each datapool l isted has a l ist  of variables under i t  
represent ing columns in the datapool fi le. Datapools can be Local (specific to a single Player) or Central  
(avai lable to al l  Players). 

Common Http Headers 

Lists headers that were recorded from at least 50% of your requests. These headers wi l l  be sent out with 
every request that is made at playback unless they are overwrit ten by a header of the same name 
underneath an individual request act ion.  

You can insert  new header i tems from the tree-view by cl icking Visual  Navigator>Insert  Tree I tem >Ht tp 
Header. In  addit ion, you can modify the values in  the Http Header form in the right pane.  

 

Common Content Checks 

Lists common content checks, which apply to al l  repl ies sent by the server. Content checks enable you to 
veri fy whether the correct  page was returned based on the existence or absence of a specific search string. 
You can also set content checks at the page level. Cl ick the Add New  Con ten t  Check  I tem  button in  the 
form-view to add new common content checks. 

Common content checks can include variables. Common content checks enable you to generate an error 
code on a set condit ion even i f no individual page-level content checks are enabled. The search string is 
compared to the raw HTML returned by the server, so you may need to include HTML tags in  your search 
to match the text that appears in  the browser. 

 

Transaction Setup 

Lists any act ions that occurred before the main transact ion loop. Any i tems/act ions that occur under th is 
heading wil l  be executed after the Synchronize but before the BEGIN_TRANSACTION(); statement at 
playback. For example, you may have logged in to a part icular Web site and do not want to log in  and out 
with every transact ion at playback. You can move the Transact ion Setup i tem in the tree-view by 
h ighl ight ing it  and cl icking the Move UP/M ove DOWN buttons. The Transact ion Setup can contain cl ient 
cert i ficate tree i tems. 
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Client Certificate Tree Item 

If the recorded transact ion contains a l ine with a ssl-clientcert command, then 
Visual Navigator wi l l  create a Cl ient Cert i ficate tree i tem and place i t  direct ly 
beneath the Transact ion Setup tree i tem. 

The Client Cert i ficate string can be modified or variabl ized in  the form-view. 

The Client Cert i ficate i tem can also be moved up and down the tree l ike other 
tree i tems, such as checkpoints. This al lows you to move i t  in to the Transact ion 
Loop area i f you wish to change the cert i ficate with each transact ion. 

A Client Cert i ficate i tem wil l  generate a script  l ine similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE, “qaload_cl”); 
If the Requi res Passw ord check box is selected, the generated script  l ine is similar to the fol lowing: 

Set (EVERY_REQUEST, CERTIFICATE_PASSWORD, "~encr~250F7641455876"); 

 

Transaction Loop 

Lists the requests in  your transact ion. Al l  i tems/act ions that occur under th is heading are placed between 
the BEGIN_TRANSACTION and END_TRANSACTION statements, causing them to be repeated for as many 
t imes as the Conductor tel ls them to be. The transact ion loop has a number of possible sub-elements, 
depending on the Web site you tested. For detai led descript ions of the elements that can be l isted in  a 
transact ion loop, see Looking at a transact ion loop. 

 

 

Transaction Cleanup 

Lists act ions that occur after the script  has fin ished execut ing the appropriate number of t ransact ions. Any 
i tems that occur under th is heading are placed after the END_TRANSACTION statement. For example, you 
may want to log out of a part icular Web site after complet ing the appropriate number of t ransact ions.  

M ove UP/ M ove DOW N: Click the arrow to move the selected transact ion cleanup i tem in the tree-view up 
or down.  

Transact ion Loop Items 

Transaction Loop Items 

The fol lowing i tems can exist  under a Transact ion Loop i tem in the tree-view:  

  Synch 

   IP Spoof 

   Read Datapool 

   Checkpoint pair 

   Increment/Decrement/Reset Variable 

    Debug Print 

    Comment 
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Synch 

Inserts a Synch  i tem immediately after the current ly selected HTML Page. A Synch  i tem represents a spot 
where al l  virtual users wi l l  pause during replay unt i l  al l  act ive virtual users have reached the same point . 
Once the virtual users are synchronized th is way, the Conductor wi l l  instruct them al l  to cont inue.  

A Synch  i tem can be moved up or down the tree using Up/Dow n in the form-view.   

 

 

IP Spoof 

Inserts an IP Spoof  i tem immediately after the current ly selected HTML page. 

In order for IP Spoofing to work with Visual Navigator, i t  is necessary to create or insert  an exist ing local 
datapool fi le cal led IPSPOOF.dat in  the Visual Navigator tree-view. For more in formation about creat ing 
th is datapool fi le and insert ing i t , see Sett ing Up IP Spoofing.  

 

 

Read Datapool 

Opens the Datapool and Variables dialog box, al lowing you to choose which datapool to use, and then 
inserts a Read Datapool  i tem immediately after the current ly selected HTML Page. 

You can move th is i tem up or down the tree-view by cl icking Up/Dow n in the form-view. 

 

 

Checkpoint Pair 

Inserts a Begin  Checkpoi n t  i tem before the current ly selected HTML Page and an End Checkpoin t  after 
the current ly selected HTML Page. 

Checkpoints are used to measure durat ion t imes for certain act ions to be completed. You can move ei ther 
the Begin  or End checkpoint i tem to encompass several requests, i f necessary. To move either i tem, 
h ighl ight i t  and then cl ick M ove Up/M ove Dow n in the form-view. 

 

Print Values (debugging) 

Inserts a Debug Prin t  i tem after the current ly selected HTML Page. This causes a string to be output to the 
Player window during playback. This can be useful for debugging a script  whi le you are trying to variabl ize 
i t  so that i t   replays correct ly with mult iple virtual users. 

 

Comment 

Inserts a Com m ent  i tem after the current ly selected HTML page. Type your comment in to the form-view 
(bottom pane). 
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HTML Pages 

HTML Page Form-view 

The form-view (bottom pane) for an 
HTML Page tree i tem contains the 
fol lowing in formation: 

Reply Status: The code designat ing 
the status of the reply. For most pages 
that were returned correct ly, th is wi l l  
be 200 OK. 

Requested URI: This read-only field 
l ists the URI which was requested that 
resulted in  th is page being displayed. 

Checkpoin t  Nam e: If the page has a t i t le, then i t  wi l l  be used as the checkpoint name. If not, the word 
Checkpoint wi l l  be used. To make sure al l  checkpoin t names are unique, a number may be appended to the 
end of the checkpoint name.  

M eta Ref resh  Requi red [  ] Seconds Before Redi rect ion : If the META refresh threshold opt ion was 
selected on the General page of the WWW Convert  Options dialog box, th is field displays the number of 
seconds that QALoad waits before i t  t reats a META refresh request as a normal  request. This field only 
appears when refresh t imeouts are enabled. 

 

HTML Page sub-items 

The fol lowing script  i tems can exist  under a Page (HTML) i tem in the Visual Navigator's tree-view. Each 
possible page sub-i tem is l isted below, along with descript ions for the fields that appear in  the form-view in 
the right pane when you select the i tem in the tree-view. 

In addit ion, a Page i tem can contain sub-i tems that you insert  manually after recording the transact ion.  

Content Check sub-i tem 

PageCheck sub-i tem 

Addit ionalSubRequests sub-i tem 

SubRequests sub-i tem 

Cookies Set by Server sub-i tem 

Sleep sub-i tem 

Fi l l  In  Form sub-i tem 

Act ion sub-i tems 
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Content Check Sub-item 

Inserts a Con ten t  Check  i tem for the current ly-selected HTML page. This veri fies that the correct page was 
returned based on the existence or absence of a part icular search string in  the server's reply for that page. 
Content checks can include variables. The search st ring is compared to the raw HTML returned by the 
server, so you may need to include HTML tags in  your search to match the text that appears in  the 
browser. 

The top pane displays the source for the HTML page. You can easi ly select text in  the top pane and add i t  
to the content check defin i t ion by cl icking the Copy f rom  Source button. 

 

 

PageCheck Sub-item 

Allows you to veri fy that the t i t le of the page that was requested is correct. 

 

AdditionalSubRequests Sub-item 

Some requests are contained in applets, Act iveX components, or other objects that are captured, but not 
played back by QALoad . These subrequests, which are not recognized as normal subrequests, are l isted in  
the Addi t i onalSubRequests tree i tem. 

Each addit ional subrequest i tem appears in  the script  as a pre-loaded subrequest just before the main 
act ion. As a result , the playback engine requests the main page, regular subrequests, and then the pre-
loaded subrequests. 

For example: 

//---------  REQUEST # 2  --------- 
// 
//  current page url is http://c96852d01/pda/ 
// 
// Pre-load the following image requests before the next request is made. 
// These requests seem to have been made by javascript or applets associated 
// with the next page but will not be made automatically by the replay engine, 
// hence they are here in the script. 
// 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/LeftBackgrnd.jpg"); 

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuopen.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/menuclose.gif"); 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST,  
     "http://c96852d01/pda/images/browsex.gif"); 

Click_On(IMAGE, 1, SRC_ATTRIBUTE, "http://c96852d01/pda/images/browse.gif"); 

 

 

SubRequests Sub-item 

Lists al l  subrequests (such as images) that the page performed in order to be ful ly rendered in the browser. 
Subrequests cannot be changed and are shown strict ly to provide detai led in formation about the requests 
that were made during the recording session. 
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Cookies Set by Server Sub-item 

If the reply from the server for the requested page contains a Set-Cookie command, i t  is l isted here. This 
i tem cannot be modified, i t  is l isted for your in formation only.  

 

Sleep Sub-item 

Every page has a Sleep i tem immediately before i ts Act ion  i tem. The sleep value specifies how many 
seconds were spent viewing th is page (or fi l l ing out a form) before an act ion was taken (such as cl icking on 
a l ink or button). 

 

 

 

 

 

 

 

Fill In Form Sub-item 

If a requested page contains a Form (html element) that was fi l led in  by the user, then a Fi l l  In  Form  item 
and i ts associated elements wi l l  be created in  the tree-view. When th is tree i tem is selected, a bl inking 
frame wil l  appear around the form in the browser-view (top pane).  

Form View Fields 

The form-view (bottom pane) for a Form element l ists the fol lowing in formation: 

Form  Act ion  St r ing: The Act ion String associated with th is form. For example, the URI which wil l  be 
requested. 
Form  Num ber: The number assigned to the form, indicat ing which form wil l  be used.  

A Fi l l  In  Form item in the tree-view can include a number of sub elements. For detai ls, see Form sub-i tems. 

 

 

Extract String Sub-item  

Inserts an Extract String i tem when you need to extract in formation from the script  and store i t  in  a 
variable to use later in  the script .  

When an Extract String i tem is inserted in to the tree-view, the browser-view displays the HTML source for 
the page in which the i tem is inserted. The string to extract is recognized by the text preceding i t  and the 
text fol lowing i t . The test string in  between is extracted and saved into a local variable. You must specify 
the local variable that receives the extracted string at run t ime by cl icking on Select  Var. 

 

Frames 

If an HTML page that is recorded contained frames, they wil l  be represented in the tree-view (left  pane) 
with a circle icon contain ing a capital F. A frame page wil l  be indented beneath the page that is i ts parent. 
If you cl ick on a frame icon in the tree-view, the corresponding frame wil l  be h ighl ighted in  the browser-
view (top pane) with a bl inking frame around i t  for ident i ficat ion. 
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Dupl i cated f ram eset  pages 

Sometimes when a user cl icks on a l ink or takes some other act ion inside of a frame, the new page that was 
requested simply replaces the contents of one of the frames already shown in the browser. To indicate that 
the frameset page (the main page that holds the frames) has not changed, Visual Navigator renames i t  
Duplicated Frameset n. Where n is an ident i fying number for the frameset that is incremented as more 
frameset pages are dupl icated. 

Act ion Sub-Items 

Action Sub-items 

An Act ion i tem appears under each HTML Page except the last one in the script . This represents the act ion 
that the user took to get to the next page. Act ion i tems include: 

!  NavigateTo – Visual Navigator could not determine how the user accessed the next page (they may 
have typed a URL direct ly in to the address bar, or a JavaScript may have caused the jump). 

Note: A NavigateTo i tem is the first  element that appears under the Transact ion Loop element. 
This is because when the browser is launched during recording, the user must specify a start ing 
address (typical ly by typing i t  in to the Address bar). 

!  Click On Link – The user cl icked on a text l ink 

!  Click On Image – The user cl icked on an image l ink 

!  Click On Button – The user cl icked on a Submit type button 

!  PostTo – Data was sent to the server with a POST command but a matching submit button was not 
found. This may have been caused by a JavaScript. 

Act ion i tems can contain various sub-elements. For detai ls, see Act ion i tem sub-elements. 

 

 

NavigateTo sub-item 

Specifies a URI to be requested. If the Script  Development Workbench cannot determine how the next 
page was requested (typical ly due to a JavaScript making the request) then i t  wi l l  use a NavigateTo tree 
i tem instead of something more specific such as a Cl i ck  On  Link . 

 

Click On Link sub-item 

When the user cl icks on a text l ink or an image l ink, then a Cl ick On Link action i tem is inserted under 
that page. This is used to describe the act ion that was taken while on th is page that resulted in  the next 
page being requested. 

When a Click On Link tree-view i tem is selected, the text or image in the browser-view (top pane) is 
h ighl ighted by a bl inking frame to make i t  easier to locate. There are several types of Cl ick On Links: 

 Tex t  Links – One of the more common l inks in  web pages are Text based l inks. These usual ly 
appear as underl ined text.  

 Im age Links – An image can have a l ink, similar to text. 

 Cl ien t -Side Im age M ap – A Client-Side Image Map is an image on a page that  has mult iple 
l inks associated with i t . Each l ink is associated with a region, which can be any shape. When 
the user cl icks on the image, the browser determines which region was cl icked on and requests 
the page l inked to that region. 

 Server-Side Im age M ap – A Server-Side Image Map is an image on a page that has mult iple 
l inks associated with i t . Unl ike Cl ient-Side Image Maps, these l inks are stored on the server 
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rather than the cl ient. When a user cl icks on the image, the browser sends the server the mouse 
coordinate relat ive to the top-left  corner of the image. The server then repl ies with the 
appropriate page. 

 

Click On Button sub-item 

Clicking on Subm i t  is usual ly associated with entering values in to a form (Fi l l  In  Form  item). When the 
Cl i ck  On  But ton  tree-view i tem is selected, the associated button in  the browser window (top pane) wi l l  be 
h ighl ighted with a bl inking frame, making i t  easier to locate. 

Form View Fields 

The form-view (bottom pane) for Cl i ck  On  But tons (submits) l ists the fol lowing in formation: 

Iden t i fy by: Cl ick the appropriate button to choose whether to ident i fy the button by Name (in ternal 
name as indicated in  the HTML), by Label (the text  on the button), by Occurrence (e.g. the 3rd button), or 
by Image Source (in  case th is submit button is real ly an image). The edit  Ident i fy by buttons wil l  change 
appropriately, depending upon which opt ion you choose.  

Prev But ton / Nex t  But ton : If there are other submit buttons on the page, use Prev Button/Next Button to 
choose to use one of those other submit buttons. The name, label, or occurrence wil l  be updated 
automatical ly. 

Label : The Label field (or Name, Occurrence, or Image Source field) can be modified or variabl ized. If you 
variabl ize the field, cl icking Next Button or Prev Button wil l  not affect i ts contents. However i f you choose 
to use one of the other opt ions, different text wi l l  be displayed because variabl izat ion is specific to each 
method of ident i ficat ion. 

I f  m ul t i ple m atches to URL are found, use m atch : If QALoad finds mult iple matches (for example, two 
buttons labeled Buy Me) then you can use th is field to specify which match to use. For example you could 
specify that you want to cl ick on the 4th button with a label of Buy Me when looking at a page with a lot  of 
i tems for sale. 

Original  Label : The original label associated with the button that was cl icked while recording. 

Original  Nam e: The original name (from the HTM L source) for th is button. 

Form  Act ion : The URL associated with a form. This is the address for the request that wi l l  sent when the 
submit button is cl icked. 

Subm i t  M ethod: Whether th is submit i tem was a GET or POST. 

Convert  Cl i ckOn : Converts the ClickOnSubmit act ion to a PostTo or NavigateTo act ion, depending on 
whether the ClickOnSubmit wi l l  be converted in to a PostTo or NavigateTo act ion.  

Caut ion : This act ion is not reversible. If you convert  the ClickOnSubmit act ion, i t  is permanently 
changed. You must create a new capture fi le with a Cl ickOnSubmit act ion i f you want th is act ion in  
your script .  

PostTo sub-item 

If the recorded request was a POST request rather than a GET request and the Script Development 
Workbench could not find a matching Submit type button, then a PostTo tree act ion i tem wil l  be inserted 
under the page. This can sometimes happen i f the request is in i t iated by JavaScript. 
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Act ion Item Sub-Items 

Action Item Sub-elements 

The fol lowing i tems can exist  under Act ion i tems in the tree-view:  

Http Headers sub-i tem 

Cookies sub-i tem 

CGI Parameters sub-i tem 

Integrated Windows Authent icat ion sub-i tem 

Basic Authent icat ion sub-i tem 

  

 

 

 

 

 

Http Headers sub-item 

If a header exists under an Act ion i tem, then i t  wi l l  be sent 
for that request only. If the header has the same name as one 
of the common headers, then i t  wi l l  override the common 
header for th is request on ly. It  is possible to insert  addit ional 
HTTP headers. 

 

Cookies sub-item 

When a Cookie i tem is a sub-element of an Act ion i tem, i t  contains a l ist  of cookie i tems that were sent  in  
the header of the request that the Act ion i tem made when recording. Cookies are added automatical ly by 
the browser based on the URI that is being requested. They are either set as a result  of the previous reply 
(the server returned a Set-Cookie command), or they are set by JavaScript contained in the previous reply. 

If the Cookie shown has a matching Set-Cookie i tem, then noth ing wil l  display in  the script  since the 
cookie is created automatical ly during playback. If there is no matching Set-Cookie i tem, then a Set-Cookie 
type statement wi l l  be generated in  the script . 

You can insert  addit ional cookies in to the Cookies sect ion of a page as another means of variabl izing the 
playback. How? 

 

CGI Parameters Sub-item 

Lists CGI parameters sent along with the request made by the Act ion i tem.  

 

 

Basic Authentication Sub-item 

Sometimes the pages being requested require Basic Authent icat ion, that is, the user is presented with a 
dialog box asking for a UserID and Password. This in formation is recorded and presented in the tree-view 
under the Act ion i tem that requires i t .   
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Forms 

Forms Sub-items 

Many pages that are used during a WWW load test ing session contain forms that a user must fi l l  out, and 
submit buttons that are cl icked. QALoad ident i fies forms and the elements with in them, as well  as 
determin ing which submit button was cl icked i f there is more than one. 

When a page contains a form that wi l l  be submitted, then a Fi l l  In  Form item is inserted in to that page’s 
l ist  of i tems in the tree-view (left  pane). When a Fi l l  In  Form item is selected in  the tree-view (left  pane), 
Visual Navigator h ighl ights the form with a bl inking frame in the browser-view (top pane).  

Underneath the Fi l l  In  Form item in the tree view are Form Element i tems, such as Edit  Boxes, Radio 
Buttons, and Check Boxes, represent ing elements that can appear in  forms on HTML pages. Fol lowing the 
Fi l l  In  Form item is either a Cl ick On Button i tem or a PostTo i tem.  

The fol lowing sub-i tems can appear under a Fi l l  In  Form item: 

Hidden sub-i tem 

Editbox sub-i tem 

Selectbox sub-i tem 

TextArea sub-i tem 

Checkbox sub-i tem 

Radio sub-i tem 

 

 

 

 

 

Hidden sub-item 

Forms can contain h idden fields that do not show up on the page. These 
fields are not visible to the end user in teract ing with the browser, but 
they may need to be variabl ized for a load test, for example a field that 
contains a session ID may need to be variabl ized.  

Form View Fields 

The form-view (bottom pane) for a Hidden Field element l ists the 
fol lowing in formation: 

Nam e: The name of the h idden field 
Value: The value of the h idden field. 
Al l ow  th i s h idden  f i eld to be variabl i zed: Select to variabl ize th is field. Cl ick the var... button to select a 
variable. 
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Editbox sub-item 

One of the more common elements in  a form is an edit  box. When th is tree item is selected, QALoad wil l  
draw a bl inking frame around the appropriate edit  box in  the browser-view (top pane). The edit  box in  the 
browser-view wil l  show the value that was original ly typed in when the transact ion was recorded.  

Form  View  Fields 

The form-view (bottom pane) for an Edit  Box element l ists the fol lowing in formation: 

General 

Nam e: The name of the edit  box. 
Value: The value of the edit  box. Any changes made to th is field wi l l  be reflected in  the edit  box in  the 
browser window. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

 

Selectbox sub-item 

A select box is often cal led a drop down select ion box or l ist  box. The form-view wil l  appear sl ight ly 
different depending upon whether the Select Box is capable of support ing mult iple select ions or not. 

Form View Fields 

The form-view (bottom pane) for a Select Box element l ists the fol lowing in formation: 

Nam e: The name (in  the HTML) of the select box. 
I tem s f rom  the Select  Box : Lists the i tems present in  the Select Box in  the browser-view. An i tem has a 
checkbox next to i t  to indicate i f i t  has been selected. To change a select ion, select or clear the checkbox. 
Your choices wil l  be reflected in  the browser. If the Select Box only supports one select ion, then only the 
most recent select ion is selected. 
Variabl i zed Select ions: Edit  boxes that al low the use of variables (local or from a datapool) to specify what 
opt ions are chosen from the Select Box. For a mult iple select ion Select Box, i t  is possible to add up to six 
variables in  addit ion to any i tem chosen using the check boxes.  

For a single select ion Select Box, a single edit  box is provided to al low you to use a variable (local or from a 
datapool) to specify the opt ion you want chosen from the Select Box.  
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TextArea sub-item 

A Text Area i tem is a multi-l ine text box. 

Form  View  Fields 

The form-view (bottom pane) for a TextArea element l ists the fol lowing in formation: 

General 

Nam e: The name of the Text Area field. 
Value: The value of the Text Area field. Any changes you enter in to th is edit  box are reflected in  the 
browser-view (top pane). To enter a l inefeed, press Ctrl+Enter. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

 

 

Checkbox Sub-item 

The form-view (bottom pane) for a Checkbox element l ists the fol lowing in formation: 

Nam e: Name of the Checkbox. 
Value: Value of the Checkbox. 
State: Reflects whether the box is checked (selected) or not. If the State is 1 (checked), then the Name and 
Value are passed along in the request to the server. If the State is 0 (not checked) then the Name and Value 
are not passed along. You can change the value of the State by cl icking on the checkbox control in  the 
browser-view (top pane). 

 

 

 

 

 

Radio sub-item 

Form  View  Fields 

The form-view (bottom pane) for a Radio Button element l ists the fol lowing in formation: 
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General 

Group Nam e: The Group Name is shared by al l  radio buttons that belong to the same group. 
Value: The Value field is what different iates one radio button from another. The group name and value of 
the selected radio button wil l  be sent along with the request to the server. The Value of a radio button can 
be, and often is, di fferent than the text shown in the browser. 
use th i s val ue but ton : When you select a radio but ton in  the browser-view (top pane) i ts value wil l  display 
in  th is text box. Cl ick th is button to transfer th is value in to the above Value field. 

Matching Parameter Rules 

Rule: Lists the rules that have been created for th is variable type. These rules may or may not have been 
placed in the Rule Library. 

Appl ied to I tem : Indicates whether the rule is appl ied to th is variable. 

GoTo Rule: Goes to the individual rule under the Parameterizat ion Rules tree i tem. In the right-hand pane, 
in formation in  the M atch ing I tem  tab of the Rule Detai ls dialog box displays. 

Previous M atch : Goes to the next matching variable immediately preceding the current i tem in the script . 

Nex t  M atch : Goes to the next matching variable immediately fol lowing the current i tem in the script . 

Apply: Appl ies the rule h ighl ighted in  the l istbox to th is variable. Only one rule can be appl ied to an 
instance of a  variable. 

Undo Apply: Removes appl icat ion of the rule h ighl ighted in  the l istbox from th is variable. Other 
matching variables to which th is rule is appl ied are not affected. 

 

 

 

 

XML Requests 

XML Document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What  i f  no XM L data i s associ ated w i th  a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document-view. 

How  does the docum en t -view  relate to the form -view ? 

Select ing an i tem in the XML document tree displays the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 
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XML Form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view displays instead. For XML items, the form view 
display opt ions depend on two th ings: 

!  what type of XML item is selected in  the Visual Navigator tree-view (left  pane): an XML request or 
an XML reply 

!  what type of XML item is subsequently selected in  the XML document-view (top pane) 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — attribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 

The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an i tem is editable, the value in  the form-view can be changed and the new value is used during 
replay. 

!  If a value can be variablized, a variable can be subst i tuted for al l  or part  of the value. The variable's 
value is placed in the variable's locat ion at replay. An example is a value received from an i tem 
from a previous XML document reply. 

!  If a variable can receive a replay value, the return value for the i tem can be placed into a selected 
variable during replay. The variable can then be subst i tuted for an input value in  a later XML 
request. 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value be 
Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 

PI (Processing 
Instruct ion) 

No No 



Using the Player, Script  Development Workbench, and Analyze 

126 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable Receive 
Replay Val ue 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 

Attribute (Value) Yes 

Text Yes 

 

Parameterizat ion in the Visual Navigator 

Parameterizat ion  

Parameterizat ion is the process of subst i tut ing certain values in  a script  with variables you define. 
Parameterizat ion is used in Visual Script ing for WWW scripts.  

When you modify QALoad scripts before replaying them, the modificat ions usual ly are repet i t ive and 
consistent. Parameterizat ion provides the means for replacing values with system-generated variables 
throughout your scripts. The values for variables are derived from a datapool, an extract string, or a 
calculated value.  

Methods for Parameterizing a Script 

Values in  a script  that you can parameterize are noted in  the form-view (bottom pane) with the var... 
button next to the field. This gives you access to the Datapool and Variables dialog box, where you can 
define values for variables.  

Certain values in  the script  support the Variable Replacement Wizard. The Variable Replacement Wizard 
simpli fies the process of parameterizat ion by taking you through the necessary steps for defin ing variables 
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for the fields you want to replace. Fields for which the Variable Replacement Wizard is avai lable are shown 
in the form-view with Var Wiz... button next to the field. 

Saving Parameters as Rules 

You can create and maintain a table of the variables you define by storing them as rules in  the Rule 
Library. Once stored, the script   looks for these rules and replaces the value wi th the parameters you assign 
to that rule.  

Using Variables with Visual Navigator 

Overview of Variables 

When you record a transact ion, the result ing script  is a recording of the act ions of a single end-user. When 
you play back that script  mult iple t imes during a load test, you probably want i t  to emulate the act ions of 
multiple users making differing requests of your server instead of the single user that was recorded. One way 
to achieve that is to replace certain data with a variable that draws i ts value from a l ist  of values that you 
provide. Here are some examples of why and how you might use variables in  a script : 

!  If your original script  recorded a user logging on to a si te using an ID and password, you can 
replace the ID and password with variables in  the script . At test t ime, those variables draw their 
values from a datapool fi le of acceptable values, using a different set of values for each transact ion 
run. In  other words, that one script  could emulate a number of different users by ut i l izing a 
different user ID/password combinat ion for each transact ion. 

!  If your script  inserted new records in to a customer database, you might want the names to be 
unique each t ime the script  is run (each transact ion). You could create a datapool fi le of names, 
and then insert  a variable in to the script  where the name was typed. At test t ime, the variable 
inserts a different name from the datapool fi le with each transact ion. 

!  If an ID string is returned from the server and that ID is then used as part  of future requests to the 
server, and each virtual user may get back a differen t ID from the server, you can use a variable to 
use a specific ID. You could extract an ID from the reply, place i t  in to a variable, and then use the 
value in  that variable in  place of the actual ID for future requests, ensuring you only use the ID you 
specify. 

There are a number of values in  your script  that can be replaced with variables. Those values are noted in  
the form view (bottom pane) with var.... Values that use the Variable Replacement Wizard are shown in 
the form view with Var Wiz. Typical ly variables derive their values from a datapool an extracted string, or 
a calculated value. 

 

Using Variables in a Visual Script 

This topic describes several methods of working with variable data in  a script .  

Using Variables in  a st r i ng 

Suppose you are test ing a si te where users must register themselves with a server. To register, they must 
type a name, password, address, and so on in to a form. The result ing Visual Script  contains a Fi l l  In  Form 
item in the tree-view under the appropriate Page i tem. Cl icking on a form item opens the i tem's form-view 
in the bottom pane, which might look l ike the fol lowing graphic:  

 

In  th is example, the edit  box requires the user to type their name. Assume that a second edit  box requires 
the user to type their password. Each edit  box on the form results in  a separate i tem under the Fi l l  In  Form 
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t ree i tem. At runt ime, you might want to parameterize the name and password edit  boxes, so that a 
different user name and corresponding password is entered for every transact ion. One way of variabl izing 
these two fields is to create a datapool fi le contain ing two variables (columns) named Name (user ID) and 
Password, populated with val id user names and passwords.  

To param et er ize t he nam e edi t  box: 

1. Highl ight the text in  the form-view. In th is example, that would be Kim Walker.   

2. Right-cl ick on the h ighl ighted text and choose Subst i tute w i th  Variable, or simple cl ick on the 
var... button. 

3. On the Datapools and Variables dialog box that opens, cl ick on the Name (user ID) variable and 
cl ick OK. 

4. The Value field in  the form-view for that part icular field wi l l  look something l ike the fol lowing: 

 

At run t ime, th is form field wi l l  be fi l led in  with a value from the User name column of the datapool fi le 
named User names and Passwords. 

Work ing w i th  an  inserted variable 

Here are some hints for working with variables: 

!  Clicking anywhere on an inserted variable selects the ent ire variable.   

!  You can delete a variable by cl icking on i t  to select i t , and then pressing the Delete key on your 
keyboard. Alternately, you can right-cl ick on a variable and choose Delete Variable Reference from 
the menu to delete i t . 

!  Rename a variable easi ly by double-cl icking on i t  to open the Datapools and Variables dialog box 
with that variable h ighl ighted. You can easi ly rename the variable from there.  

!  You can restore the contents of an edit  box to whatever i ts contents were immediately after being 
converted by right-cl icking on i t  and choosing Revert  to Original String… from the menu. This wi l l  
automatical ly delete any variables that have been inserted since the most recent conversion. 

M ix ing regular tex t  w i th  variables 

An edit  box can contain a combinat ion of regular text and any number of variables, depending upon how 
complicated the string needs to be.  

Using local  variables 

Another method of variabl izing data, for instance the user ID and password describe previously, is to use 
local variables to create a unique name and password on each pass through the transact ion loop with a 
format of User1 and Pass1, User2 and Pass2, and so on. 

You could accom pl ish t h is using a com binat ion  of  regular  t ex t  and a local  var iable: 

1. In  the edit  box for the User ID, type: User.   

2. Then while the cursor is st i l l  at  the end of the text you just typed, cl ick the var... button to open 
the Datapools and Variables dialog box. 
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3. On the Datapools and Variables dialog box, create a local variable by cl icking the New  Variable 
button. Name the variable User Number. In  the In i t i al  Value field, assign the variable an in i t ial  
value of 0 (zero).   

4. Click OK. The Value field in  the form-view wil l  now display th is value: User{$User Number$}  

At run t ime, QALoad wil l  create a value for that field that wi l l  be a concatenat ion of User and the value 
of the local variable named User Number.  

5. Assume that the value should be 1 (one) for the first  t ransact ion, 2 (two) for the second transact ion, 
and so on. To accomplish that, the value of User Number must be incremented before each 
i terat ion of the transact ion. To increment the value before each transact ion, insert  an Increment 
Variable i tem before the Page i tem that uses the User Number variable.  

Variabl i zing w i th  a random  value 

Another method of variabl izat ion is to insert  or subst i tute selected text with a Random Value tag.   

1. Select text or posit ion your cursor and then cl ick the var… button.  

2. On the Datapools and Variables dialog box, cl ick the Random  Num ber button. The Random 
Number Tag dialog box opens. 

3. Type values in  the Low er and Upper fields to specify a range from which the number should be 
drawn.  

4. Click OK. The Value field in  the form-view wil l  now display a value similar to the fol lowing: 
User{$Random:1:500$} 

5. At run t ime, th is variable wi l l  create strings similar to the fol lowing: User17, User394, and so on. 

To modify a range, double-cl ick on the Random tag to open the Random Number Tag dialog box where 
you can adjust the ranges as needed.  

Variabl i zing w i th  a VU num ber 

Another method of variabl izat ion is to insert  or subst i tute selected text with a virtual user number tag.  

1. Highl ight the text to replace or posit ion your cursor in  a field and then cl ick the var... button.  

2. On the Datapools and Variables dialog box, cl ick the VU Number (Absolute) or VU Number 
(Relat ive) button. The Value field in  the form-view wil l  be fi l led in  with something similar to the 
fol lowing: {$VU NUM ABS$} or {$VU NUM REL$}. 

At run t ime, the VU Number tag wil l  be subst i tuted with the number of the part icular virtual user that is 
running th is script . The string created wil l  look similar to th is: User45, User187, and so on.  

Find/ replace a variable 

Visual Navigator has a Find/Replace feature that al lows you to quickly find occurrences of strings with in 
the tree-view and replace them with other strings. For example, you could find al l  occurrences of Smith and 
replace them with the datapool variable {$Last Name:User Info$}. For detai ls about the find/ replace feature, 
see Visual Navigator's Find and Replace feature. 

 

 

Naming Variables 

When you first  create a datapool fi le, the included variables are automatical ly assigned the default  names 
Var1, Var2, Var3, and so forth.  
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QALoad al lows you to rename those variables with meaningful names that can even include spaces. This 
makes i t  much easier to work with datapools. For example, you could name a datapool variable something 
logical l ike City, rather than trying to remember that Var4 in  your datapool is the City variable. 

Renam ing Variables 

You can quickly and easi ly rename local or datapool variables from the tree-view. Simply h ighl ight the 
variable under the Datapool Fi les or Variables tree-view i tem, and then change the variable name in the 
result ing form-view (bottom pane). 

You can also edit  from the Datapools and Variables dialog box. To access i t , right-cl ick anywhere in  the 
tree-view and then choose Datapools and Variables from the shortcut menu. Highl ight the variable to 
rename and cl ick Renam e.  

 

 

Datapools and Variables 

Datapools and variables can be added or modified by several methods. To simply create, delete, or modi fy 
datapool fi les and variables at any t ime while a script  is open in the editor, choose Visual  
Navigator>Datapools an d Variables from the menu to access the Datapools and Variables dialog box.  

Alternately, the same dialog box wil l  open automat ical ly whenever you are asked to choose a variable or 
datapool fi le whi le working with the script , al lowing you to create the variables you need on-the-fly.  

Data that can be variabl ized is denoted in the form-view (bottom pane) by the var... button. Cl icking 
the var... button wil l  open the Datapools and Variables dialog box. 

Types of Variables 

Types of  Variables 

When values in  a script  are replaced with variables, the variables typical ly are derived from extract strings, 
datapools, or calculated variables. 

Extract Strings 

Insert  an Extract String i tem when you need to extract in formation from a reply and store i t  in  a variable to 
use in  future requests or simply for logging the in formation. For example, i f a string is located inside a 
JavaScript or in  a h idden tag that is not visible in  the browser, and i t  m ight change each t ime th is page is 
requested, use an Extract String to extract the value. Extract strings search on the text preceding and the 
text fol lowing the string you want to extract.  

Datapools 

Datapools draw values from a fi le of acceptable values and use a different set of values each t ime a 
parameter is replaced. You can select an exist ing datapool fi le or create a new datapool fi le to add to your 
script  from your datapool directory. Each datapool has a l ist  of variables under i t  represent ing columns in 
the datapool fi le. When you create a datapool, you specify the number of columns (variables) and rows 
(values) i t  contains.  

The datapool fi le you choose is added to your script  and is l isted under Datapool Fi les in  the Visual 
Navigator tree-view.  You can choose to add a central or local datapool to a script .  

Note: You can have only one central datapool fi le associated with a script , but can have any number 
of local datapool fi les.   

Central 
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Central datapools are Conductor-based. They reside on the same workstat ion as the QALoad Conductor, 
and are avai lable to any Player system on the network that requests i t  from the Conductor. You can apply 
only one central datapool  fi le to a script . 

Local 

Local datapools are Player-based. They reside on a Player workstat ion, and are only avai lable to that Player. 
You can apply any number of local datapool fi les to a script . 

Calculated Variables 

Calculated variables are generated dynamical ly at runt ime and are based on a formula you define. For 
example, you might want  each virtual user to have a unique string, such as Smith1, Smith2, and so forth, 
or you may want to calculate a new value each t ime through the transact ion loop.  

Calculated variables are strings bui l t  from one or more elements. These can include datapools, local 
variables, and text, as well  as the fol lowing:  

Date and Time 

Insert  the date and t ime in the format you select. 

Random Alphanumeric 

Subst i tutes the value with random alphanumeric characters at runt ime. Specify the type and length of 
characters to use. You can select: let ters only, numbers only, or both let ters and numbers. 

The value can be a fixed length, where you specify the number of characters, or variable length, where you 
specify the min imum and maximum number of characters. 

Random Numeric 

Subst i tutes the value with a random number at runt ime. You specify the min imum value, maximum value, 
the number of decimal places, and the number of leading digits. Numbers generated with fewer leading 
digits are padded with zeros.  

Local Variable 

A variable with a stat ic value that you set when you create i t . 

Virtual User Number 

The number used to ident i fy the virtual users during a test. You can include a virtual user number (VU) in  
the calculat ion. VUs may be absolute (assigned by the Conductor) or relat ive (assigned by the Player at 
runt ime). 

Absolute 

The absolute virtual user number is assigned by the Conductor based on the total number of virtual users 
on al l  Players. Each virtual user is assigned a number and no numbers are repeated. Insert  an absolute 
virtual user number when i t  is necessary to use a completely unique virtual user number in  place of a 
variable.  

Relat i ve 

The relat ive virtual user number is the number assigned to the virtual user by i ts Player. Because a test has 
mult iple Players and each Player assigns virtual user numbers from 0-n, a relat ive virtual user number is 
only unique on a single Player. 

Local Variable 
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A local variable is a stat ic value that you can subst i tute wherever variables can be used. You can quickly 
add local variables to your script  from the Visual Navigator tree-view. Insert  Increment Variable, 
Decrement Variable, and Reset Variable i tems into the tree-view to manipulate the value of any variables. 

 

About  Datapool  Variables  

Datapools are text fi les contain ing data records that you can use in place of variable data in  your script . 
Each datapool comprises a l ist  of variables represent ing columns in the datapool fi le.  

For data that you can parameterize, the var... button appears in  the form-view (bottom pane). Cl icking the 
var... button opens the Datapools and Variables dialog box. Datapools can be Local (specific to a single 
Player) or Central (avai lable to al l  Players).  

Note: You can parameterize certain variables using the Variable Replacement Wizard.  

Central Datapool 

A central datapool is a datapool that resides on the same workstat ion as the QALoad Conductor. It  is 
avai lable to any Player system on the network that requests i t  from the Conductor. A central datapool is 
control led by the Conductor, and you use the Conductor to set any opt ions relat ing to i t . You can apply 
only one central datapool  fi le to a script . 

Local Datapool 

A local datapool is a datapool that resides on a Player workstat ion, and is only avai lable to that Player. 
Because a local datapool resides local ly and is only avai lable to the local Player, i t  does not generate any 
network traffic. You can apply any number of local datapool fi les to a script . 

  

About  Ex t ract  St r i ngs  

Insert  an Extract String i tem in your script  when you need to replace a system-generated value or reuse a 
system-created value later in  a script . You can extract in formation from a reply and store i t  in  a variable to 
use in  future requests. For example, i f a system-created order number is assigned during a transact ion that 
must be used again later in  the transact ion, you can use an Extract String to store the value and insert  i t  
in to the script  at  the appropriate point. 

When you select text to store in  an extract string, Visual Navigator uses 10 or more characters on either 
side of the extracted text to make the search string unique and find th is copy of the extracted text. You can 
increase or decrease the size of the strings. You also can specify which occurrence of the search strings to 
find in  the responses before extract ing the text between them. 

 

About  Local  Variables 

A local variable has a constant value that you assign  when you create the variable. It  can be subst i tuted 
wherever variables can be used. You can quickly add local variables to your script  by right-cl icking in  the 
Visual Navigator tree-view and select ing Datapools and Variables.  

Note: You can insert  Increment Variable, Decrement  Variable, and Reset Variable i tems into the tree-
view to manipulate the value of any variables. 

Editing Variables 

Adding a Variable 

Add variables to the script  from the Visual Navigator tree-view. Types of variables are: 

!  Local variables 
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!  Datapools 

!  Calculated variables 

!  Extract Strings 

Note: You can insert  Increm en t  Variable, Decrem en t  Variable, and Reset  Variable i tem s into the 
tree-view to manipulate the value of any variables. 

 

Adding a Variable to a Datapool  

Add datapool variables to the script  from the Visual Navigator tree-view.  

Note: You can insert  Increment Variable, Decrement  Variable, and Reset Variable i tems into the tree-
view to manipulate the value of any variables. 

To add a var iable t o a dat apool : 

1. Right-cl ick anywhere in  the Visual Navigator tree-view.  

2. From the shortcut menu, select Datapools and Var iables. The Datapools an d Variables dialog 
box displays. 

3. Select a Datapool in  the tree-view.  

4. Click the New  Variable button. A variable with the default  name Var# is added to the l ist  of 
variables in  the selected datapool. Rename the new variable or accept the default  name. 

5. Click OK. In the Visual Navigator, the new variable is added to the datapool in  the tree-view,and a 
new column for the variable displays in  the form-view.  

6. Type a value for the variable in  each cel l  of the column. 

 

Creat ing Ex t ract  St r i ngs  

You can extract a value from the web page where i t  fi rst  occurs and place i t  in to a variable using an 
ExtractString tree i tem. When you insert  the tree i tem, the HTML source for the page appears in  the 
browser-view so that you can h ighl ight the text to extract. When you h ighl ight the string, some of the text 
preceding and fol lowing the string is selected to ident i fy where the string occurs during playback. 

To creat e an ext ract  st r ing by inser t ing a t r ee i t em : 

1. Right-cl ick in  the Visual Tree where you want to place the extract string. The HTML source for the 
page appears in  the right-hand pane. 

2. In  the shortcut menu, cl ick Insert  Tree I tem >Ext ractSt r ing.  

3. In  the form_view (bottom pane), type the text you want to extract in  the Search  for field. Select 
M atch  Case to make your search case-sensit ive. 

4. Click Find prev and Find nex t  to select the occurrence of the variable you want to replace.  

5. Click Select  var.... The Datapool  and Variable dialog box displays. 

6. Select the variable in  which to store the extract string, and cl ick OK. 

7. Do one of the fol lowing: 

!  Highl ight the desired text in  the HTML page (top pane) and cl ick Copy f rom  source. This 
copies the selected text from the source window into the edit  boxes. The text immediately 
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before the selected text appears in  the Preceded by field. The text immediately after the 
selected appears in  the Fol low ed by field.  

Note: Use the arrows next to the fields to include more or less of the preceding and fol lowing 
text. 

!  Click En ter st r i ngs m an ual l y and type the text before and after the string in  the Preceded by 
and Fol low ed by fields.  

8. In  the Ex t racted field, cl ick Nex t  to view each instance of the variable in  the page. The extracted 
string is added to the Visual Tree. 

9. In  the Ex t ract  Nth  Occurrence area, specify the occurrence of the search string to find in  the 
responses before extract ing the text between them. Do one of the fol lowing: 

!  Type the number of the occurrence in the occurrence edit  box. This is the occurrence of the 
search string to find in  the responses before extract ing the text between them. Cl ick Prev or 
Nex t  to find the previous and next occurrence of the search string in t  he source pane. This 
increments or decrements the occurrence number in  the edit  box. 

!  Click Ex t ract  Last  to search for the last occurrence of the search strings in  the source pane and 
place the keyword LAST in the edit  box. Cl ick Prev to change the occurrence in the edit  box to 
LAST-1, LAST-2, and so forth. 

Note: You cannot edit  the occurrence field manually when the LAST keyword is in  the field. 

!  Click Ex t ract  Random  to search for a random occurrence of the search strings in  the source 
pane and place the keyword RANDOM in the edit  box.  

!  Click Reset  to restore 1 in  the occurrence edit  box and find the first  occurrence of the search 
strings in t  he source pane. 

10.  Select Search  includes Redi rects and Addi t i onal  Subrequests to add the source for any Redirect 
pages preceding th is main page, and any Addit ional Subrequests i t  may contain to the source pane.  

Note: This is always selected for scripts generated in  HTTP mode. 
  

11. Click OK to return to the Replace Parameter with Variable page of the Variable Replacement 
Wizard. 

Adding a Local  Variable 

Add local variables to the script  from the Visual Navigator tree-view. A local variable can be subst i tuted 
wherever variables can be used.  

Note: Insert  Increment Variable, Decrement Variable, and Reset Variable i tems into the tree-view to 
manipulate the value of any variables. 

To add a local  var iable: 

1. Right-cl ick anywhere in  the Visual Navigator tree-view.  

2. From the shortcut menu, select Datapools and Var iables. The Datapools an d Variables dialog 
box displays. 

3. Select the Variables i tem in the tree-view.  

4. Click New  Variable. An unnamed variable is added to your l ist  of local variables.  

5. Type a name for the new variable. 

6. In  the In i t i al  Value field, type the value for the variable. 

7. Click OK. The local variable is added to the Visual Navigator tree-view under Variables. 
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Using the Rule Library 

Overview of the Rule Library 

You can save variable replacements you define as rules. These are stored in  the Rule Library, where you can 
use them in future recordings and reduce repet i t ive parameterizat ion tasks.  

When subsequent captures are converted, the Visual  Navigator scans the Rule Library for matching 
parameters. For example, i f a rule parameterizes the value of a CGI Parameter named SessionID, the Visual 
Navigator scans through the Visual Tree for any CGI Parameters that match the descript ion defined in the 
rule. If a match is found, the rule is added to the Visual Tree, where you can apply i t  to the script . 

From the Rule Library, you can create rules, edit  rules, and view detai ls of individual rules and the folders 
in  which they are stored. 

 

Elements of the Rule Library Dialog Box 

Create or modify parameter rules from the Rule Library dialog box. The dialog box contains the fol lowing 
areas:  

!  Menus 

!  Tree view 

!  Detai ls 

 

 

Rule Library Menus 

M en u Com m and Descript i on  

Fi l e New  Rule - Opens the Rule Creat ion Wizard. Use the wizard to 
define a rule that you can use to parameterize future scripts. 

New  Folder - Creates a new folder in  the tree-view.  

Edi t  Use the Edit  menu to cut, copy, paste, delete, or rename rules. 

Rule Edi t  Rule - Opens the Rule Creat ion Wizard so you can edit  a 
rule you select in  the Rule Library. 

Help Displays QALoad help. 

 

 

Rule Library Tree-View 

The Rule Library tree-view displays a h ierarchical view of al l  rules and folders with in the Rule Library.  
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Rule Library Dialog Box Details  

The Detai ls area of the Rule Library dialog box displays in formation on the rules defined in the Rule 
Library. There are two levels of detai l : 

!  Folder - When you select a folder name in the Rule tree, the Detai l s area of the dialog box displays 
in formation for each rule in  the folder.  

!  Individual Rule - When you select a rule in  a folder in  the Rule tree, the Detai l s area of the dialog 
box displays in formation for the individual rule in  three tabs.  

 

Applying a Rule  

When you define values to replace variables in  a script , you can save them as rules and apply them to other 
scripts. 

To apply a rule f rom  t he Visual  Tree: 

1. In  the Visual Navigator vistree, cl ick the Param eter i zat ion  Rules script  i tem and select the rule to 
apply. A descript ion of the rule displays in  the form-view. 

2. Click the M atch ing I tem s tab. The propert ies that determine the matching i tems and each 
matching i tem found in the script  display. 

3. Do one of the fol lowing: 



QALoad Online Help 

137 

!  Click Apply Rule on the left-hand side of the dialog box to apply the rule to al l  the 
matching i tems. 

!  Select an i tem or i tems in the table and cl ick Apply to I tem  on the right-hand side of the 
dialog box. 

 Note: When a different rule has been appl ied to an  individual i tem, a red exclamation mark (!) 
appears next to the i tem in the table. Only one rule can be appl ied at a t ime. Cl ick Go to I tem  and 
review the in formation in  the Matching Parameter Rules area of the form-view to view the rule appl ied 
to the i tem. 

To apply a rule f rom  t he f orm -view  f or  a var iable: 

1. In  the Visual Navigator vistree, select the variable to which you want to apply the rule. 

2. In  the M atch ing Param eter Rules area at the bottom of the form-view (right-hand pane), select 
the rule you want to apply. 

3. Click Apply. The rule is appl ied to the variable. 

 

 

Editing a Rule  

Fol low these steps to edit  rules stored in  the Rule Library. 

To edi t  a rule: 

1. Select a rule in  the Rule Library visual t ree, and cl ick Rule>Edi t  Rule. The Rule Creat ion Wizard 
opens and displays the in formation on the rule you selected. 

2. Follow the procedure for creat ing a rule to make changes to the rule elements. 

 

Middleware Script ing Techniques 

OFS 

Understanding the C++ Script 

Oracle Forms Server scripts are produced for al l  Oracle E-Business Suite and Oracle Appl icat ions recordings. 
The C++ script  executes OFS-related statements by passing the statements in  the script  DLL to the OFS Java 
engine that performs the cl ient act ivi t ies and the cl ient communicat ion with the server. Because the C++ 
script  statements are direct ly t ied to corresponding methods in the OFS Java engine, modificat ions to the 
script  statements are l im ited to changing the property parameter values through variabl izat ion. 

An OFS C++ script  contains three main sect ions: Connect ion, Appl icat ion Body, and Disconnect. The 
QALoad transact ion loop includes al l  three sect ions by default .  The transact ion loop can be moved using 
the guidel ines described in Moving the OFS transact ion loop. An internal auto checkpoint is created during 
connect ion statements and transmission statements. 

The C++ script  statements are a condensed version of the Java-style script  statements.  The C++ script  
statements show the GUI controls in  the OFS appl icat ion and the control propert ies, which are either 
control at tributes or act ivi t ies. For example: 

ofsClickButton( "BUTTON", 52, OFS_ENDMSG, 325 ); 
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In  th is example, the user cl icks (property 325) a button ( control ID 52).  OFS_ENDMSG is a flag that 
indicates that the GUI act ivi ty ends the current OFS Message.  

QALoad also al lows OFS and WWW statements from a Universal session to be scripted in  the C++ script , 
providing the abi l i ty to play back WWW and OFS statements. QALoad automatical ly extracts ICX t ickets 
and any necessary cookies from the WWW middleware traffic and passes them to the OFS middleware. 

 

Connection Statements 

The connect ion script  l ines in  the C++ script  vary depending on the type of Forms connect ion mode that is 
act ive. You choose the Forms connect ion mode on the Oracle Forms Record Options dialog box. Forms 
connect ion modes include server-side recording, HTTP, HTTPS, or socket. 

Server-side recording is l im ited to appl icat ions that  use Forms 9i (appl icat ions running in Oracle 9iAS 
Release 2 and above). HTTP connect ion mode is avai lable for appl icat ions using Forms 9i and for 
appl icat ions using the patched Forms 6i version configured with the HTTP servlet. HTTPS connect ion 
mode is strict ly for SSL-enabled appl icat ions that use Forms 9i. Socket connect ion mode is for appl icat ions 
that use Forms 6i and lower versions, such as Oracle 11i. 

Server-side recording connect ions 

Server-side recording mode contains only one connect ion statement. The funct ion that is used – 
ofsSetServletMode –  contains the l istener servlet value that you entered on the Oracle Form s Server 
Recording Opt ions dialog box. The first  parameter defines the HTTP or HTTPS configurat ion of the 
appl icat ion environment. The second parameter defines the name of the Forms Listener Servlet used by the 
appl icat ion. To connect, QALoad internal ly invokes Oracle’s dispatch cal ls using the two parameters. 
Oracle’s proprietary classes provide the implementat ion for the HTTP or HTTPS connect ion.  For example: 

ofsSetServletMode(OFS_HTTP, "http://ntsap45b:7779/forms90/l90servlet" ); 

HTTP connect ions 

HTTP connect ion mode contains mult iple connect ion statements. To connect, QALoad internal ly performs 
Java cal ls to accomplish the fol lowing tasks:   

!  Define HTTP header propert ies 

!  Connect to the Forms Servlet (an HTTP-GET request) 

!  Set the parameters of the Forms Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-GET request) 

!  Set addit ional HTTP header property for the Listener Servlet 

!  Connect to the Forms Listener Servlet (an HTTP-POST request). The last connect ion statement also 
in i t iates the required Forms “ handshake”  and determines the Forms encrypt ion used by the 
appl icat ion environment.  

For example: 

ofsHTTPSetHdrProperty("User-Agent", "Java1.3.1.9" );  
ofsHTTPSetHdrProperty("Host", "ntsap45b:7779" );  
ofsHTTPSetHdrProperty("Accept", "text/html, image/gif, image/jpeg, *; q=.2, "*/*; q=.2" 
);  
ofsHTTPSetHdrProperty("Connection", "Keep-alive" );  
ofsHTTPConnectToFormsServlet( 
"http://ntsap45b:7779/forms90/f90servlet?ifcmd=startsession"  ); 
ofsHTTPSetListenerServletParms( "?ifcmd=getinfo&ifhost=C104444D01&ifip= "192.168.234.1" 
); 
ofsHTTPConnectToListenerServlet( "http://ntsap45b:7779/forms90/l90servlet"); 
ofsHTTPSetHdrProperty("Content-type", "application/x-www-form-urlencoded" );  
ofsHTTPInitialFormsConnect(); 
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HTTPS connect ions 

HTTPS connect ion mode uses the same connect ion statements as HTTP mode.  

Socket  connect ions 

Socket mode contains only one connect ion statement.  The funct ion that is used – ofsConnectToSocket  – 
contains the port  number and the URL you entered on the Oracle Forms Record Options dialog box to start  
OFS capture. The port  value is the port  on which the Forms Server direct ly l istens for Forms traffic. To 
connect, QALoad uses Java cal ls to open a Java socket using the parameters, in i t iate the required Forms 
"handshake” , and determine the Forms encrypt ion used by the appl icat ion environment. For example: 

ofsConnectToSocket("10.10.0.167", 9002 ); 

 

Application Statements 

The appl icat ion statements in  the C++ script  consist of property statements and transmission statements. 
Property statements describe the attributes and act ivi t ies of GUI controls in  the appl icat ion. Transmission 
statements send the GUI controls and their propert ies as Forms Message data to the server. There is only 
one transmission statement: ofsSendRecv. QALoad creates an in ternal auto checkpoint when th is statement 
is executed. In  the fol lowing example, the first  two (property) statements set the locat ion and size of a 
FormWindow GUI control. The ofsSendRecv statement sends the GUI control  propert ies to the server. 

ofsSetWindowLocation( "FORMWINDOW", 6, OFS_ENDMSG, 135, 0, 0);   //Property  
ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500);   //Property 
ofsSendRecv(1 ); //Transmission 

Param eters of  a property statem en t : 

The parameters of a property statement are arranged in the fol lowing sequence: 

1. Captured con t rol  nam e.  If the name is not avai lable, th is value is the class name to which the 
control belongs. 

2. Captured con t rol  ID. 

3. Act ion  type. This flag indicates i f the property is to be added to the current Forms Message or i f the 
property ends the current Forms Message. During playback, each control is treated as a Forms 
Message. When the current Message ends, QALoad translates the control and i ts propert ies to 
binary format. The val id values are: 

 OFS_ADD –  add the property to the current Message. 

 OFS_ENDMSG – add the property to the current Message and end the Message. 

 OFS_STARTSUBMSG – add the property of the succeeding nested Message to the current 
Message. 

4. Property ID. The Forms version-specific ID of the property. 

5. Property value. Captured value of the property (opt ional) 

6. Property value. Captured value of the property (opt ional) 

For example: 

ofsSetWindowSize( "FORMWINDOW", 6, OFS_ENDMSG, 137, 650, 500); 

In  th is example, control ID 6, which belongs to GUI class FORMWINDOW, is resized (PROPERTY 137) 
to have coordinates 650 and 500. This marks the end of the current Message. 

Forms environment statements: 

The in i t ial  set of statements in  the Forms script  describes the Forms appl icat ion environment. In  th is set, 
the "version”  and the “ cmdline”  propert ies are the most important. The version property shows the Forms 
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Builder version used by the appl icat ion. The version  indicates the capabi l i t ies of the appl icat ion. For 
example, some versions cannot support HTTP connect ions. The cmdline property shows the Forms 
configurat ion parameters passed to the server by the Forms applet. The parameter “ record=names”  
indicates that the appl icat ion enables GUI control names to be captured. Control names are preferred in  
mult i-threaded playback. The “ ICX”   parameter indicates that the appl icat ion  uses a Personal Home Page. 

In the sample script  below, the Forms bui lder version is 90290 (the version used in Oracle 9iAS Release 2, 
unpatched). The cmdline property shows “ record=forms”  which defaults “ record=names” . The cmdline 
property does not have the “ ICX”  t icket parameter. 

ofsSetInitialVersion( "RUNFORM", 1, OFS_ADD, 268, "90290" ); 
ofsSetScreenResolution( "RUNFORM", 1, OFS_ADD, 263, 96, 96); 
ofsSetDisplaySize( "RUNFORM", 1, OFS_ADD, 264, 1024, 768); 
ofsInitSessionCmdLine("RUNFORM", 1, OFS_ADD, 265,  
 "server module=test1.fmx userid=  sso_userid=  debug=no buffer_records=no debug_" 
 "messages=no array=no query_only=no quiet=yes render=no host=ntsap45b.prodti.com" 
 "puware.com port= record=forms tracegroup=debug log=run1 term=" ); 
ofsSetColorDepth( "RUNFORM", 1, OFS_ADD, 266, "256" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "0" ); 
ofsColorAdd( "RUNFORM", 1, OFS_ADD, 284, "8421504" ); 
ofsSetFontName( "RUNFORM", 1, OFS_ADD, 383, "Dialog" ); 
ofsSetFontSize( "RUNFORM", 1, OFS_ADD, 377, "900" ); 
ofsSetFontStyle( "RUNFORM", 1, OFS_ADD, 378, "0" ); 
ofsSetFontWeight( "RUNFORM", 1, OFS_ADD, 379, "0" ); 
ofsSetScaleInfo( "RUNFORM", 1, OFS_ADD, 267, 8, 20); 
ofsSetNoRequiredVAList( "RUNFORM", 1, OFS_ADD, 291 ); 
ofsSetPropertyString( "RUNFORM", 1, OFS_ENDMSG, 530, "America/New_York" ); 
ofsSendRecv(1 ); 
//ClientSeqNo=1|CapTime=1086884188.281|MsgCount=1 

Sending messages to the server: 

The ofsSendRecv statement sends the accumulated GUI controls and their propert ies to the Forms Server as 
binary data. This statement represents the point at which the cl ient sends a Forms Terminal Message to the 
server. In  Oracle Forms, the cl ient and the server must end each data block with a Terminal Message before 
any transmission occurs. 

In ternal ly, QALoad varies the binary data transmission depending on the connect ion mode: 

!  For server-side recording mode, QALoad sends the binary data by invoking Oracle’s dispatch cal ls. 
Oracle’s own classes provide the implementat ion for the HTTP transmission.  

!  For HTTP or HTTPS mode, QALoad wraps the binary data inside an HTTP stream and invokes Java’s 
HTTP cal ls.  

!  For socket mode, QALoad sends the binary data direct ly to the Java socket opened at the 
connect ion point. 

The ofsSendRecv statement has one parameter: the response code of the captured Terminal Message. The 
possible values for th is parameter are 1 (add), 2 (update), and 3 (close). Typical ly, when the response code 
is 3, the Forms Server reacts by removing the GUI controls associated with the cl ient message from the 
server cache. 

A comment l ine appears after each ofsSendRecv statement that contains script-tracking in formation. The 
information on the comment l ine is also found in the capture fi le in  each ofsSendRecv capture l ine. The 
comment l ine shows the relat ive sequence of each cl ient request, as represented by a Terminal Message, 
from the start  of the appl icat ion (e.g. Cl ientSeqNo=1). The comment l ine also shows the t im ing mark of 
the captured Terminal Message (e.g. CapTime=1086884188.281) and the number of Forms messages 
contained in the request (e.g. MsgCount=1). The number of Messages can be veri fied by count ing the 
preceding ENDMSG and STARTSUBMSG flags in  the request block. The comment l ine is useful for 
debugging playback issues because i t  readi ly shows the cl ient request sequence number where the issue is 
occurring. 
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Gett ing the server reply: 

During the execut ion of ofsSendRecv, QALoad also obtains the server’s reply and translates the binary 
Forms data in to Forms control values and control propert ies. The values are also writ ten to the playback 
log fi le (in  capture fi le format) i f script  logging is enabled. The fol lowing sample is a server reply: 

VU 0 :   M|S|2|0|1 
VU 0 :   P|S|322|java.lang.Integer|0|151000320 
VU 0 :   P|S|279|java.lang.Boolean|0|false 
VU 0 :   P|S|525|java.lang.String|AMERICAN_AMERICA.WE8MSWIN1252 
VU 0 :   T|S|1|ServerSeqNo=1|MsgCount=76 

The first  l ine indicates the start  of a Forms Message from the server (M |S). The th ird parameter is an act ion 
code (1= add, 2= update, 3= delete, 4= get property value). The fourth parameter is the Class Code of the 
control (0 = root class). The fi fth  parameter is the Control ID (1= RunForm). 

The second, th ird and fourth l ines are property l ines related to the above Forms Message from the server 
(P|S).  The th ird parameter of each l ine is the property ID (322). The fourth parameter is the data type of 
th is property (java.lang.In teger). The fi fth  parameter is the data value. If the value is 0, the data value is in  
a sixth parameter (false).  

The th ird l ine is the terminal message l ine from the server (T|S). The th ird parameter is the response code 
associated with the terminal message (1= add, 2= update,  = close). The fourth parameter is the relat ive 
sequence of the server reply, as represented by a Terminal Message, from the start  of the appl icat ion (e.g. 
ServerSeqNo= 1). The fi fth  parameter is the number of Forms messages contained in the reply (e.g. 
MsgCount = 1). The number of Messages may be veri fied by count ing the preceding M|S flags in  the reply 
block.  The fourth and fi fth  parameters are script-tracking in formation, which can be useful for debugging 
a playback issue. If logging is enabled, the log fi le shows the tracking in formation, which can make the 
comparison between server responses and captured responses easier. 

Processing large data and delayed response scenarios: 

When HTTP or HTTPS connect ion mode is used, Forms data is wrapped inside the HTTP reply stream. 
QALoad checks the HTTP header of the reply before processing the Forms data.  The HTTP header 
sometimes indicates that the cl ient needs to perform addit ional HTTP POST requests to obtain the 
complete Forms data. This indicat ion occurs when the content-length of the reply is 64000 (a large data 
scenario), or the content-type is "text/plain”  and the HTTP header contains an  “ i ferror: ”  string (a delayed 
response/re-post scenario). QALoad performs the necessary POST requests to obtain the complete reply 
data, and then translates the accumulated reply data to Forms controls and propert ies. 

 

Disconnect statements 

The disconnect script  l ines vary depending on the Forms connect ion mode.   

!  In  server-side recording mode, the ofsServerSideDisconnect script  statement in ternal ly invokes 
Oracle’s dispatch cal ls to disconnect.  

!  In  HTTP mode, the ofsHTTPDisconnect statement in ternal ly makes Java cal ls to disconnect the 
main URL connect ion from the servlet.  

!  In  socket mode, the ofsSocketDisconnect statement  closes the socket on which the Forms Server 
l istens for traffic. 
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Using Script Logging as a Debugging tool 

You can debug a playback issue in a C++ script  by enabl ing replay logging. The opt ion for enabl ing replay 
logging is located on the Debug page of the Script Propert ies dialog box  of the Conductor. For more 
in formation about enabl ing log fi le generat ion, see Debugging a script .  

When logging is enabled, QALoad writes the cl ient requests and server repl ies to the playback log fi le in  the 
same format as the capture fi le. The playback log fi le is found in the \QALoad\LogFiles directory. When 
there is an issue during playback, such as the server not responding to a cl ient  request, you can compare 
the capture fi les and check the differences in  the server reply data. Both the capture fi le and the log fi le 
contain tracking in format ion appended to the server’s terminal messages. The tracking data contains the 
relat ive sequence number of the server reply from the start  of the Forms session and the t im ing mark. The 
tracking data also shows the number of Forms messages contained in the reply block. The number of 
messages are based on the number of  “ M |S”  l ines prior to the “ T|S”  l ines.  

In  the fol lowing example, the first  set of statements shows the logged statements and the second set of 
statements shows the captured statements. The ServerSeqNo value shows that th is is the 8th reply from the 
server. The MsgCount value of 1 shows that only one Forms Message is included in th is reply block. 

1087419810.000|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087419810.000|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087419810.000|MsgCount=1 
1087419810.000|M|S|2|0|30 
1087419810.000|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087419810.000|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087419810.000T|S|1|ServerSeqNo=8|CapTime=1087419810.000|MsgCount=1 

   

1087402349.296|ofsShowWindow|WINDOW_START_APP|11|OFS_ENDMSG|173|PROPERTY_VISIBLE|java.lang.B
oolean|true 
1087402349.296|ofsSendRecv|1|ClientSeqNo=8|CapTime=1087402349.296|MsgCount=1 
1087402349.296|M|S|2|0|30 
1087402349.296|P|S|135|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|P|S|137|java.awt.Point|0|java.awt.Point[x=706,y=464] 
1087402349.296|P|S|139|java.awt.Point|0|java.awt.Point[x=0,y=0] 
1087402349.296|T|S|1|ServerSeqNo=8|CapTime=1087402349.296|MsgCount=1 
  

 

 

Moving the OFS Transaction Loop 

To enable movement of the QALoad transact ion loop in the C++ script , you must fi rst  record a ful l  business 
transact ion and a part ial  business transact ion. The business transact ion is the act ivi ty that you would l ike 
to repeat during QALoad playback.  Insert  QALoad capture comments (using the Insert  Com m and button 
on the Recording toolbar) at the start  and end of a business transact ion. These comments wi l l  help you 
find the spots in  the script  where you would l ike to reposit ion the BEGIN_TRANSACTION() and 
END_TRANSACTION() statements. Then re-start  the business transact ion.  

QALoad's OFS script  presents a sequence of Forms GUI objects. The GUI objects contain context 
dependencies. For example, when a window is opened, the buttons, text fields and edit  boxes inside that 
window are logical ly dependent on the state of that window. When only one business transact ion is 
captured and the corresponding script ’s transact ion loop is moved, the sequence of the GUI objects is 
broken during the second i terat ion of the transact ion loop. The broken sequence results in  a broken 
context, which causes the server to respond unpredictably during playback on the second and subsequent 
i terat ions of the transact ion loop. When the business transact ion is restarted during capture, the Forms 
GUI objects that compose the new transact ion are used to anchor in to the new transact ion loop without 
breaking the context dependencies of  GUI objects. 
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When modifying the script , use the comment l ines as guides in  moving the END_TRANSACTION()  and 
BEGIN_TRANSACTION() statements. Ensure that there is a contextual flow from the new posit ion of the 
END_TRANSACTION() statement to the new posit ion of the BEGIN_TRANSACTION() statement. The set  of 
GUI objects that belong to the ofsSendRecv() statement just before the new END_TRANSACTION() 
statement must be the same as the set of GUI objects that belong to the ofsSendRecv() statement prior to 
the new BEGIN_TRANSACTION() statement. 

During playback, modify the Conductor sett ing for Script  Pacing to al low the database to process each new 
business transact ion. 

The fol lowing example shows a modified OFS transact ion loop: 

New posit ion of the BEGIN_TRANSACTION statement 

/* 
NewSales 
*/ 

DO_SLEEP(13); 
ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=31|MsgCount=2|1093981339.921 
BEGIN_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsRemoveFocus( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 174 ); 
ofsSetSelection( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ADD, 195, 0, 0); 
ofsSetCursorPosition( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 193, "0" ); 
ofsFocus( "ORDER_CUSTOMER_NUMBER_0", 564, OFS_ENDMSG, 174 ); 

DO_SLEEP(6); 
ofsSendRecv(1); //ClientSeqNo=32|MsgCount=4|1093981347.296 

New posit ion of the END_TRANSACTION statement 

/* 
EndTrans 
*/ 

DO_SLEEP(39); 
ofsSendRecv(1); //ClientSeqNo=61|MsgCount=4|1093981458.031 

ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsSelectMenuItem( "Sales Orders", 257, OFS_ENDMSG, 477, "MENU_11059" ); 

DO_SLEEP(26); 
ofsSendRecv(1); //ClientSeqNo=62|MsgCount=2|1093981485.265 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "B" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 1, 1); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "1" ); 
ofsIndexKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 175, 97, 0); 

DO_SLEEP(3); 
ofsSendRecv(1); //ClientSeqNo=63|MsgCount=2|1093981488.437 
END_TRANSACTION(); 

ofsEdit( "ORDER_SOLD_TO_0", 562, OFS_ADD, 131, "Business World" ); 
ofsSetSelection( "ORDER_SOLD_TO_0", 562, OFS_ADD, 195, 14, 14); 
ofsSetCursorPosition( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 193, "14" ); 
ofsIndexSKey( "ORDER_SOLD_TO_0", 562, OFS_ENDMSG, 176, 10, 0); 
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DO_SLEEP(13); 
ofsSendRecv(1); //ClientSeqNo=64|MsgCount=2|1093981502.640 

Tips:  
During capture, the OFS configurat ion parameter "record=names" must be enabled to produce control 
names that may be included in the converted script . Control names persist  throughout the Forms 
session, unl ike control IDs, whose values may change at runt ime. Add the “ record=names”  parameter in  
the Formsweb.cfg fi le or add th is parameter to the startup servlet URL.  
Control IDs can create problems when the transact ion loop is moved. Some of the control IDs that have 
been instant iated by the server prior to the new transact ion loop lose context during i terat ions of the 
new loop. For example, in  a second loop i terat ion, the server assumes that these cl ient controls are new, 
generates new control IDs, and eventual ly cannot find the proper context. Then the server stops 
responding. If control names are used, Forms objects that have been instant iated before the new 
transact ion loop are maintained through al l  i terat ions of the loop because the control name persists 
throughout the appl icat ion session. 
During playback, ensure that the sleep factor is at 100% and that the transact ion pacing is set to a large 
enough value for the server to process the business transact ion that is contained in the new loop. These 
opt ions can be set using the Script Propert ies panel of the Conductor's Visual Designer. 

 

Verifying OFS Window Creation 

The ofsWindowCreated command does two th ings. First , i t  ensures that for the ofsSendRecv() command 
preceding i t , the server includes in  the response that a FormWindow object with the t i t le specified is 
created. The script  returns FALSE if the object is not created. Second, the original (captured) control ID is 
associated with the object  represent ing the control in  OFS replay’s in ternal l ist  of controls, which is in  
addit ion to the (runt ime) control ID that is tracked.  

This al lows better tracking of FormWindow GUI controls that exist  at  runt ime by being able to match up 
both the control name and the original control ID.  

The ofsWindowCreated command only handles objects of type FormWindow.  

Using the ofsWindow Created Script  Com m and  

The fol lowing example shows an example from a modified OFS script : 

   ofsSendRecv(1); //ClientSeqNo=1|MsgCount=1|1137439721.484 

   if (!ofsWindowCreated(11, "WINDOW_LARGE_GRAPH")) 
{ 
  // Only fail if this window was not created 
  RR__FailedMsg(s_info, "WINDOW_LARGE_GRAPH was not created!"); 
} 
ofsWindowCreated(15, "WINDOW_START_APP"); 
ofsWindowCreated(20, "WINDOW_CONTROLSTEST"); 
ofsWindowCreated(24, "WINDOW_GRAPHICSTEST"); 
ofsWindowCreated(28, "WINDOW_DATABASETEST"); 

 

 

WWW 

Simulating Variable IP Addresses 

While QALoad can simulate mult iple virtual users from a single system, i t  general ly does so using a single 
source IP address. In  most  test ing situat ions th is isn ’t  a problem, but with a small  set of HTTP-based 
appl icat ions, i t  may not be the best way to simulate real-l i fe act ivi ty. For QALoad Player machines with  
more than one stat ic IP address, QALoad can direct each virtual user to use a di fferent source IP address.  
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To accomplish th is, a local datapool fi le contain ing a l ist  of local stat ic IP addresses must be created on 
each QALoad Player mach ine. When you enable IP spoofing in  the QALoad Conductor, the QALoad 
Conductor instructs each QALoad Player to create the appropriate datapool fi le at run t ime. The QALoad 
Player uses these addresses for connect ions to HTTP and SSL servers. Each virtual user receives one address 
for use with al l  i ts connect ions. If there are more virtual users than addresses, IP addresses are re-used 
start ing from the beginning of the datapool fi le. 

M odi fying a Script  to Use Variable IP Addresses 

In the Script Development Workbench, select Visual  Navigator>Insert  Tree I tem >IPSpoof  to insert  the 
IPSpoof i tem into the Visual Navigator tree-view. You can then use the var... button in  the form view pane 
to set the data record to use during playback.   

Creat ing a Datapool  of  IP Addresses 

Use the fol lowing procedure to create a datapool of val id IP addresses from the QALoad Conductor. This 
fi le is automatical ly created on the QALoad Player workstat ions (Windows and UNIX) at run t ime. 

To creat e a dat apool  of  IP addresses: 

1. Start  QALoad Conductor. 

2. In  the Visual Designer menu bar, select Tools>M an age Players. The Manage Players/Groups dialog 
box displays. 

3. Select a Player in  the Players pane. 

4. Expand the M ach ine Set t i ngs area on the right-hand side of the dialog box. 

5. Select the Generate IP Spoof  Data (m ach ines w i th  m ul t i ple IP addresses on ly) opt ion in  the 
Player Machine sett ings field. 

6. Click OK.  

At run t ime, the QALoad Conductor sends a command to each QALoad Player Agent to create the datapool 
fi le of IP addresses, and the script  is sent to the server using the different IP addresses. 

The Generate IP Spoof  Data check box is val id only for WWW scripts. 

Note: The machine on which the QALoad Conductor resides must have stat ic IP addresses assigned to 
i t . If no stat ic IP addresses are found, the QALoad Conductor displays a warning and the datapool fi le is 
not generated. The datapool fi le is named ipspoof.dat, and is saved in the 
\Compuware\QALoad\Datapools directory. 
 

Handling error messages from the Web server 

When a server returns an error message, i t  returns i t  in  one of two ways. It  ei ther returns an error message 
with a response code (for example, 404 Not Found) or returns an HTML page that contains an error 
message. The fol lowing sect ions provide examples of code that you can use in  your script  to handle errors 
that the Web server returns to the browser. 

Handl ing error m essages w i th  response codes 

The example below demonstrates how to write code to handle error messages that include response codes 
that the Web server returns to the browser. The code performs the fol lowing act ions: 

!  Checks for an error code using the DO_GetLastHttpError command 

!  Aborts or cont inues script  execut ion, based on the WWW_FATAL_ERROR statement 

Example 
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int error; 
char errorString[30]; 
 
DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

if((error = DO_GetLastHttpError()) > 399) 

{ 
sprintf(errorString, "Error in response: %d\n", error); 
WWW_FATAL_ERROR("Request-host", errorString); 
} 

Handl ing error m essages returned in  an  HTM L page 

The examples below demonstrate how to write code to handle error messages that the Web server returns 
to the browser in  an HTM L page. 

Using DO_VerifyDocTit le to veri fy page requests 

By insert ing the DO_VerifyDocTit le command into your script , you can compare the HTML document 
t i t les in  your load test script  with the document t i t les you original ly captured. The code performs the 
fol lowing act ions: 

!  Calls DO_Http to request an HTML page from the Web server 

!  Calls DO_VerifyDocTit le with the original HTML document t i t le. If the t i t les do not match, 
DO_VerifyDocTit le exits the script  

Exam ple 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Welcome to The Main Page", TITLE); 

Searching response text for error messages 

In some scripts, error messages are displayed as text  in  an HTML page. The fol lowing example 
demonstrates how to detect these messages in a script . The code performs the fol lowing act ions: 

!  Searches for errors returned as HTML from the Web server 

!  Branches to error handl ing code 

Exam ple 

int response; 
response = DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 
if (strstr (response, "200 OK") == NULL) 
   WWW_FATAL_ERROR("host", "Response did not have 200 OK"); 

 

Simulating JavaScript 

JavaScript is handled by the fol lowing process: 

1. The browser makes a page request to a server for a page that contains JavaScript. 

2. Because JavaScript is simply uncompiled code, the browser downloads and immediately executes 
th is code upon receipt of the page. 

Supported Objects 

QALoad supports the bui l t -in  JavaScript objects (global, object, funct ion, array, string, boolean, number, 
math, date, regexp, and error), document objects, and image objects. 

Supported Propert i es 
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The only document propert ies that QALoad supports are cookies, t i t le, and the images array. The only 
image property that QALoad supports is src. 

Evaluat ion Errors 

If an object, property, or funct ion used with in a block of JavaScript code is not defined, i t  causes a 
JavaScript except ion. The except ion stops evaluat ion of that block. 

Example Web Page 

The fol lowing Web page contains the JavaScript funct ion and an onLoad tag that cal ls the scrol l i t  funct ion. 
The onLoad tag tel ls the browser to execute the JavaScript immediately after loading the page. The scrol l i t  
funct ion displays a scrol l ing banner region on the Web page. 

<HTML> 
<HEAD> 
<TITLE>Java Script Example</TITLE></HEAD> 
 
<SCRIPT LANGUAGE="JavaScript" src="js_do_nothing.js"> 

function scrollit_r2l(seed) 
{ 

var m1 = " Welcome to Compuware's QALoad homepage."; 
var m2 = " Glad to see you."; 
var m3 = " Thanks for coming. "; 
var msg = m1 + m2 + m3; 
var out = " "; 
var c = 1; 

if (seed > 100) { 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 100 && seed > 0) { 
for (c=0 ; c < seed ; c++) { 
out+=" "; 
} 
out+=msg; 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
timerTwo=window.setTimeout(cmd,100); 
} 

else if (seed <= 0) { 
if (-seed < msg.length) { 
out+=msg.substring(-seed,msg.length); 
seed--; 
var cmd="scrollit_r2l(" + seed + ")"; 
window.status=out; 
timerTwo=window.setTimeout(cmd,100); 
} 

else { 
window.status=" "; 
timerTwo = window.setTimeout("scrollit_r2l(100)", 75); 
} 
} 
} 

</script> 

<BODY onLoad="timerONE=window.setTimeout('scrollit_r2l(100)',500);"> 
<!-- End scrolltext --> 
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<center><h2>Java Script Example</h2><hr>Check out the browser's scrolling status 
 bar.<br><br> 
</center> 

</BODY></HTML> 

Example script  

The fol lowing script  features a DO_Http cal l  to retrieve the JavaScript page.  

How  I t  Works: QALoad evaluates the JavaScript in  the context of script  blocks, onLoad tags, and src and 
then executes them. 

DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/js.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Java Script Example", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Simulating Cookies 

This sect ion describes how QALoad handles cookies. Cookies are handled by the fol lowing process: 

1. The browser makes a CGI request to a server for a dynamic page. 

2. When the server sends the page back to the browser, the page includes a cookie in  the header. The 
browser saves the cookie along with in formation that t ies i t  to the Web server. 

3. On al l  subsequent requests to that Web server, the browser passes the cookie along with the 
request. 

Exam ple Web page 

The fol lowing CGI Perl  script  generates a Set-Cookie header as a part  of subsequent HTTP requests. 

Set-Cookie: SaneID=172.22.24.180-4728804960004 
Set-Cookie: SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 

<html> 

... 

The cookies for this site are:<br><br> 

<B>SaneID=172.22.24.180-4728804960004; SITESERVER=ID=f0544199a6c5970a7d087775f83b23af 
</B><P> 

<b>Next cookie for this URL will be : 1</b><br> 
<br>RELOAD PAGE TO INCREMENT COUNTER<br><br><A HREF=http://www.host.com/index.htm>Return to 
previous homepage.</A> 

Exam ple script  w hen  Dynam ic Cook ie Handl ing i s turned on  

This is the default  method by which QALoad handles cookies. The example script  features the fol lowing 
elements: 
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!  Two CGI requests that return dynamic pages 

!  Cookies are handled by the replay engine 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(TRUE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

/* Request: 2 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl" 
        "HTTP/1.0\r\n\r\n"); 

... 

... 

END_TRANSACTION(); 

Exam ple script  w hen  Dynam ic Cook ie Handl ing i s turned of f  

The example script  features the fol lowing elements: 

!  A CGI request that returns a dynamic page 

!  Two DO_GetCookieFromReply cal ls to retrieve the cookie from reply 

!  Two DO_SetValue cal ls to set the cookie 

!  A free cookie 

How  I t  Works: For cookies that are set with CGI scripts, the script  stores incoming cookies in  a variable 
and passes them back to the Web browser in  the reply from the CGI script . The script  handles these 
cookies by execut ing a DO_GetCookieFromReply command after the CGI request. 
DO_GetCookieFromReply stores the cookie values in  variables, which the script  then passes back to 
subsequent CGI requests using the DO_SetValue command. 

int i; 
char *Cookie[4]; 

... 

... 

for(i=0;i<4;i++) 
Cookie[i]=NULL; 
DO_InitHttp(s_info); 

... 

... 

BEGIN_TRANSACTION(); 
DO_DynamicCookieHandling(FALSE); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl  
        "HTTP/1.0\r\n\r\n"); 

/*Set-Cookie: NUM=1 */ 
DO_GetCookieFromReplyEx("NUM", &Cookie[0], '*'); 

/*Set-Cookie: SQUARE=1 */ 
DO_GetCookieFromReplyEx("SQUARE", &Cookie[1], '*'); 
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/* Request: 2 */ 
DO_SetValue("cookie000", Cookie[0]); /* NUM=1 */ 
DO_SetValue("cookie001", Cookie[1]); /* SQUARE=1 */ 
DO_Http("GET http://www.host.com/cgi-bin/cookies5.pl " 
        "HTTP/1.0\r\n" 
        "Cookie: {*cookie000}; {*cookie001}\r\n\r\n"); 

... 

... 

DO_HttpCleanup(); 
for(i=0; i<4; i++) 
{ 
free(Cookie[i]); 
Cookie[i]=NULL; 
} 

END_TRANSACTION(); 

 

Executing a Visual Basic script 

QALoad does not evaluate a Visual Basic script . However, any Visual Basic script  request that occurs is 
inserted in to the script  as a main request. 

Simulating Frames 

Frames are handled by the fol lowing process: 

1. The browser makes a main page request to a Web server for a page that contains frames. 

2. The browser parses the frame pages and places them in sub-windows with in the browser, each of 
which displays the frame content. 

Exam ple Web Page 

The fol lowing Web page contains four frames. 

<HTML> 
<HEAD> 
<TITLE>FRAME Example</TITLE> 
</HEAD> 

<! -- Here is the FRAME information for browsers with frames --> 

<FRAMESET Rows="*,*"><!-- Two rows, each equal height --> 
  <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ul-frame"> 
     <FRAME Src="findex.htm" Name="ur-frame"> 
  </FRAMESET> 

   <FRAMESET Cols="*,*"><!-- Two columns, equal width --> 
     <FRAME Src="findex.htm" Name="ll-frame"> 
     <FRAME Src="findex.htm" Name="lr-frame"> 
  </FRAMESET> 
</FRAMESET> 

</HTML> 

Exam ple Script  

QALoad automatical ly generates al l  constructs necessary to request frames. The example script  features the 
fol lowing element: 

!  A DO_Http cal l  to retrieve the main page. 

How  I t  Works: The frames are treated as sub-requests and are evaluated and requested by QALoad . 
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BEGIN_TRANSACTION(); 
DO_AutomaticSubRequests(TRUE); 

... 

... 

DO_Http("GET http://www.host.com/frameset.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("FRAME Example", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Simulating Browser Caching 

Browser caching is handled by the fol lowing process: 

1. When the browser makes a request for stat ic HTML pages, i t  may include an opt ion to retrieve the 
page only i f i t  is newer than the one held in  the browser’s cache. 

2. If browser caching is enabled, the server returns only newer versions of the page. If browser caching 
is not enabled, the server always returns the page. 

How  I t  Works: The QALoad Script Development Workbench disables browser caching while recording, 
which means a page is always retrieved.  

 

 

Requesting Password-protected Directories 

Web developers use password-protected directories to protect access to some pages. When the browser 
requests a page in a password-protected directory, the server returns a special response that specifies the 
page is password-protected. When the browser receives th is type of reply, i t  gathers the user ID and 
password, encrypts them, and passes them back to the server in  a subsequent request. 

Exam ple Script  

QALoad automatical ly generates al l  the constructs that are necessary to execute a request of a password-
protected directory. 

The example script  features the fol lowing elements: 

!  DO_BasicAuthorizat ion, which takes the user ID and password as parameters 

!  DO_Http request to the password-protected directory 

BEGIN_TRANSACTION(); 
DO_BasicAuthorization("frank", "~encr~557A2549474E57444A"); 

... 

... 

DO_Http("GET http://www.host.com/access_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a Secured Page", TITLE); 

... 

... 

END_TRANSACTION(); 

Exam ple Script  

QALoad also handles Integrated Windows Authent icat ion (formerly NTLM). 

The example script  features the fol lowing elements: 
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!  A DO_NTLMAuthorizat ion cal l , which takes the domain, user ID, and password as parameters 

!  DO_Http request to the Integrated Windows Authent icat ion-protected directory 

BEGIN_TRANSACTION(); 
DO_NTLMAuthorization("dom1\\frank", "~encr~557A2549474E57444A"); 

... 

... 

DO_Http("GET http://www.host.com/ntlm_controlled/secure.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Successful Test of a NTLM Page", TITLE); 

... 

... 

END_TRANSACTION(); 

 

Reuse SSL session ID 

This opt ion is avai lable only on an SSL instal lat ion of QALoad . By default , th is opt ion is not selected and 
SSL session IDs are not re-used, which reflects standard browser behavior. If your appl icat ion re-uses SSL 
session IDs, consider select ing th is opt ion. 

The Reuse SSL session ID opt ion is used by the replay engine at replay t ime and the current session’s ID is 
re-used for al l  the requests with in the transact ion. 

Script  exam ple w i th  the Reuse SSL Session  ID opt ion  selected 

The fol lowing example has the Reuse SSL session  ID check box selected. 

... 

... 

SYNCHRONIZE(); 

/* Select following statement for reuse of Session ID with */ 
/* SSL. If session ID needs only to be reused within */ 
/* a transaction insert after the BEGIN_TRANSACTION */ 
/* statement */ 
 
/* DO_SSLReuseSession(TRUE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 
DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

Script  exam ple w i th  the Reuse SSL Session  ID not  selected 

The fol lowing example has the Reuse SSL session  ID check box cleared. 

... 

... 

SYNCHRONIZE(); 
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/* Select following statement for reuse of Session ID */ 
/* with SSL. If session ID needs only to be reused within */ 
/* a transaction, insert after the BEGIN_TRANSACTION */ 
/* statement */ 
 
/* DO_SSLReuseSession(FALSE); */ 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/subs.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Page Of Subs", TITLE); 

... 

... 

END_TRANSACTION(); 

... 

... 

 

CGI Requests 

Sim ulat ing CGI Requests 

The fol lowing topics describe strategies for simulat ing CGI requests: 

CGI Parameter Encoding 

CGI Get Requests 

CGI Post Requests 

CGI Forms 

 

CGI Param eter Encoding 

Common Gateway Interface (CGI) is widely used on World Wide Web sites to provide the abi l i ty to run 
server-side scripts that can take variable input from a Web browser. QALoad recognizes when the browser 
has communicated to a CGI si te and automatical ly creates variables for parameters whenever necessary. For 
example, many CGI submission forms contain h idden parameters that the user cannot modify, but are 
always sent in  the WWW request. Because these values can contain variable data, QALoad inserts 
statements in to the script  to store these h idden parameters in  variables and append them automatical ly to 
CGI requests. 

CGI requests also include parameters that the browser has al lowed the user to modify. For example, a CGI 
form might require a user to enter a name and address and cl ick a submit button to cont inue. QALoad does 
not automatical ly store these types of parameters in  variables, but instead provides an easy way to modi fy 
the content of the parameters that are being sent in  the CGI request using the DO_SetValue command.  

When you modify parameters that are passed into a QALoad CGI request, ensure that al l  CGI parameters 
contain ing characters that are not alphanumeric (a-Z, 0-9) are encoded before being sent to the server. CGI 
encoding entai ls insert ing the ASCII value of a character, prefixed with the “ %”  character, in to the 
parameter. QALoad automatical ly CGI-encodes any values that i t  detects during the recording and 
conversion process; however, to manually add or modify any CGI parameter strings after your script  is 
created, you must manual ly encode special characters to ensure that the CGI parameter data is sent to the 
Web server properly. For example, to insert  the “ =”  character in to a CGI parameter, fi rst  determine i ts 
ASCII hexadecimal value (3D), and insert  that value in to the CGI parameter prefixed with “ %” . In  the CGI 
parameter string, “ %3D”  would replace “ =” . Al l  CGI parameter encoding is handled by th is method, except 
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for spaces. Blank spaces must be specified in  the encoded CGI string by the character “ +” , rather than the 
ASCII value. 

QALoad provides an automatic way of performing th is encoding using the DO_EncodeString command.  

 

CGI Get  Requests 

Get requests are handled by the fol lowing process: 

1. The browser makes a request to a server for a URL that contains a cal l  to a Common Gateway 
Interface (CGI) program. 

2. The server cal ls the CGI program, which usual ly returns a Web page. The returned page is cal led a 
dynamic page because i t  is created by the CGI program. 

3. The browser accepts the result ing dynamic page and displays i t . 

Example Web Page 

The fol lowing Web page contains an anchor (l ink) that references a CGI program. The reference results in  a 
CGI Get request.  

The anchor cal ls the CGI program named perl_1.pl with some parameters. In  perl_1.pl?name=FRANK, the 
quest ion mark (?) denotes the start  of parameters that need to be passed to the program. The name/value 
pair being passed to the perl_1.pl program is name=FRANK. 

When you cl ick the anchor text (dynamic HTML page), the browser makes a CGI Get request. A Get 
request, when executed by the server, passes parameters in  an environment variable to the CGI program. 
This type of parameter handl ing is l imited to 255 characters. 

<HTML> 
<HEAD> 
<TITLE> QALoad WWW Capture Examples</TITLE> 
</HEAD> 
<BODY> 
<A HREF="/cgi-bin/perl_1.pl?name=FRANK">Dynamic HTML Page</A> 
</BODY> 
</HTML> 

Example Script  

QALoad automatical ly generates al l  constructs that are necessary for a CGI Get request. The fol lowing 
script  uses a DO_Http cal l  for the CGI Get request.  

How  I t  Works: The script  processes a CGI Get request the same way i t  processes URL l inks to a page. In  the 
example script  below, note that the parameters passed to the Web server on the CGI cal l  are recorded 
unchanged. The parameters do not change unless the page is dynamical ly generated. 

char *Anchor[1]; 
for(i=0;i<1;i++) 
Anchor[i]=NULL; 

DO_InitHttp(s_info); 

SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 

... 

... 

DO_Http("GET http://www.host.com/ HTTP/1.0\r\n\r\n"); 

/* 
* Anchor 'http://www.host.com/cgi-bin/perl_1.pl?name=FRANK' 
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* 'Dynamic HTML Page' 
*/ 

DO_GetAnchorHREF("Dynamic HTML Page", &Anchor[0]); 
DO_SetValue("Anchor000", Anchor[0]); 
DO_Http("GET {*Anchor000} HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Perl Example Page", TITLE); 

... 

... 

for(i=0; i<1; i++) 

{ 
free(Anchor[i]); 
Anchor[i]=NULL; 
} 

END_TRANSACTION(); 

 

CGI Post  Requests 

Post requests are handled by the fol lowing process: 

1. The browser makes a request to a server for an HTM L page that contains a form that uses an act ion 
statement with a Post cal l  to a CGI program. 

2. When you cl ick the Submit button on a CGI form, the browser makes a Post request and the server 
returns a Web page. 

3. The browser accepts the dynamic page and displays i t . Because i t  is a CGI Post  request, the browser 
passes the parameters of the program to the CGI script  as command l ine opt ions. 

Example Web Page 

The fol lowing Web page contains a form that cal ls a CGI script  with a Post Request. 

<html> 
<head><title> QALoad's Perl Example Page</title> 
</head><body><center> QALoad's Perl Example Page</center> 
<form name = myform method = POST action = perl_1.pl> 
<input type = text name = yourname size = 50><br> 
<input type = submit value = "Submit Request"> 
<input type = reset> 
</form> 
</body></html> 

Example Script  

QALoad automatical ly generates al l  the constructs that are necessary for a CGI Post request. The fol lowing 
script  features a DO_HTTP request that executes a CGI Post request : 

char *ActionURL[1]; 
... 
... 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 
... 
... 
BEGIN_TRANSACTION(); 
/* Request: 1 */ 
DO_SetValue("name", "FRANK"); 
DO_Http("GET http://www.host.com/cgi-bin/perl_1.pl?{name} " 
        "HTTP/1.0\r\n\r\n"); 
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DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 
/* ActionURL[0]="http://www.host.com/cgi-bin/perl_1.pl" */ 
DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

... 

/* Request: 2 From: QALoad's Perl Example Page */ 
DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("yourname", "PostFrank"); 
DO_SetValue("function", "View the log of previous visitors."); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 
        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{yourname}&{function}"); 

DO_VerifyDocTitle(" QALoad's Perl Example Page", TITLE); 

... 

... 

for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

 

CGI Form s 

CGI Forms 

Common Gateway Interface (CGI) forms are handled by the fol lowing process: 

1. The browser requests a page that contains a CGI form. It  displays the page and provides the 
in teract ion for input fields that the CGI form specif ies. 

2. A user enters data in to the CGI form and cl icks the submit button. This act ion causes the browser 
to process the CGI form’s act ion statement. 

3. The browser processes the act ion statement, gathers al l  input fields as name value pairs, and passes 
them to a CGI cal l  contained in the act ion statement. 

Example Web page 

The fol lowing Web page contains a CGI form with: 

!  An act ion statement 

!  Input fields 

!  Hidden fields 

<HTML> 
<HEAD><TITLE>Forms Example</TITLE> 
</HEAD> 
<BODY> 
<FORM ACTION="http://www.host.com/cgi-bin/perl_9.pl" method=post> 

<TABLE> 
<TR> 
<TD>Name: 
<TD><INPUT NAME="name" SIZE="20" MAXLENGTH=20> 
<TR> 
<TD>Password: 
<TD><INPUT TYPE =password NAME="password" SIZE="20" MAXLENGTH=20> 
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There is a hidden field containing data here: <INPUT TYPE=hidden NAME="hidden" VALUE="This 
rocks!"> 

Here is another hidden field: <INPUT TYPE=hidden NAME="hidden1" VALUE="Web testing is fun"> 

</FORM> 
</BODY> 
</HTML> 

Example script 

QALoad automatical ly generates al l  the constructs that are necessary to make a CGI form request. 

The example includes the fol lowing features: 

!  A DO_Http cal l  to retrieve the forms page. 

!  Commented descript ion of the input fields on the page. 

!  GetFormValueByName commands to retrieve the values of the h idden fields from the form. 

!  DO_SetValue cal ls to store the field names and their user-entered values. 

!  A DO_Http cal l  for the CGI get request. 

char *Field[2]; 
char *ActionURL[1]; 
 
... 
... 
 
for(i=0;i<2;i++) 
Field[i]=NULL; 
 
for(i=0;i<1;i++) 
ActionURL[i]=NULL; 

... 

... 

BEGIN_TRANSACTION(); 

... 

... 

/* Request: 1 */ 

DO_Http("GET http://www.host.com/forms.htm HTTP/1.0\r\n\r\n"); 
DO_VerifyDocTitle("Forms Example", TITLE); 

/* ActionURL[0]="http://www.host.com/cgi-bin/perl_9.pl" */ 

DO_GetFormActionStatement(FORM(1), &ActionURL[0]); 

/* Form:1 text Name: name, Value: , Desc: */ 
/* Form:1 text Name: password, Value: , Desc: */ 
/* Form:1 hidden Name: hidden, Value: This rocks! */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden", 1, &Field[0]); 

/* Form:1 hidden Name: hidden1, Value: Web testing is fun */ 

DO_GetFormValueByName(FORM(1), "hidden", "hidden1", 1, &Field[1]); 

/* Request: 2 From: Forms Example */ 

DO_SetValue("action_statement0", ActionURL[0]); 
DO_SetValue("name", "form-name"); 
DO_SetValue("password", "form-password"); 
DO_SetValue("hidden", Field[0]); 
DO_SetValue("hidden1", Field[1]); 
DO_Http("POST {*action_statement0} HTTP/1.0\r\n" 



Using the Player, Script  Development Workbench, and Analyze 

158 

        "Content-Type: application/x-www-form-urlencoded\r\n" 
        "Content-Length: {*content-length}\r\n\r\n" 
        "{name}&{password}"); 

DO_VerifyDocTitle("Forms Example - Results", TITLE); 

... 

... 

for(i=0; i<2; i++) 
{ 
free(Field[i]); 
Field[i]=NULL; 
} 

for(i=0; i<1; i++) 
{ 
free(ActionURL[i]); 
ActionURL[i]=NULL; 
} 

END_TRANSACTION(); 

 

Visual Navigator's Find and Replace Feature 

Visual Navigator has an enhanced Find/Replace feature that al lows you to find occurrences of strings 
with in the tree-view, al lowing you to quickly locate and/or replace text. For example, you could find 
occurrences of Smith and replace them al l  with the datapool variable {$ Last Name:User Info $}. 

To access Visual  Navigat or 's Find f eat ure: 

1. Select  Edi t>Find in  the toolbar.  The Find and Replace dialog box displays with the Find tab on 
top. 

2. Enter the appropriate opt ions and cl ick Find Nex t . When al l  matches are found, close the dialog 
box or cl ick Repl ace to use the Replace feature. 

To access Visual  Navigat or 's Replace f eat ure: 

1. Select  Edi t>Replace in the toolbar.  The Find and Replace dialog box displays with the Replace tab 
on top. 

2. Enter the appropriate opt ions. 

3. Do one of the fol lowing: 

!  Click Find Nex t  to review each ident i fied variable before replacing i t . 

!  Click Replace Al l  to replace al l  variables without reviewing them. 

4. Close the Find Replace dialog box. 

 

Creat ing a Visual Navigator Script  

Creating a Visual Navigator Script 

Using the Script Development Workbench, you can quickly and easi ly: 

!  Convert an old script  to a Visual Script  How? 

!  Record a new Visual Script  How? 
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Converting Previously-Recorded Scripts 

You can convert  an exist ing C-based script  to a Visual Navigator script . 

To conver t  a previously-recorded scr ip t : 

1. With a WWW session open, choose Opt ions>Convert . 

2. On the WWW tab, select the opt ion En able Visual  Navigator. 

3. Click OK. 

4. On the Workspace Pane's Capture tab, right-cl ick on the capture fi le to convert  to a script . From 
the context menu, choose Convert  (or Convert  As). 

5. You may be prompted to overwrite an exist ing script  fi le. Cl ick Yes. 

The Script Development Workbench converts your capture fi le to a Visual Navigator script , opening i t  in  
the Workbook Pane. 

What does a Visual Script  look l ike? 

 

Recording a Visual Navigator Script 

You record a Visual Navigator script  the same way you record a regular QALoad script  — by sett ing opt ions 
to determine the behavior of QALoad while recording, and then cl icking through a transact ion to mimic a 
user. QALoad wil l  record al l  sent and received HTTP and SSL cal ls using the Script Development 
Workbench's Web proxy and write the act ivi ty to a capture fi le.   

After recording, the capture fi le must be converted to an editable, C-based script . This is the point where 
Visual Scripting differs from a regular W WW script. By sett ing a single opt ion before convert ing the capture 
fi le to an editable script , you can turn your capture f i le data in to a Visual Script  that al lows you to view the 
actual Web pages you recorded in a browser-l ike in terface, where you can manipulate the transact ion and 
easi ly insert  variable in formation in to your script  wi thout direct ly edit ing a l ine of code. 

To record a Visual  Scr ip t : 

If you are running your appl icat ion on Windows XP SP2, Compuware recommends you turn the 'pop-up 
blocker' feature off before recording a transact ion. The feature can be disabled via the browser window's 
Tools menu in In ternet  Opt ions>Pri vacy. 

1. Open a WWW session in  the Script Development Workbench. 

2. Click Opt ions>Record. The WWW Record Options dialog box opens. Set any relevant opt ions. 

3. Click OK. 
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4. For convenience, set conversion opt ions now also. (You can set conversion opt ions after recording 
your transact ion, i f you prefer, or even change pre-set opt ions at any t ime after recording and then 
re-convert  the capture fi le to apply the changes.): 

a. Click Opt ions>Convert . The Universal Convert  Options dialog box opens.  

b. Set any appl icable opt ions on the General Convert  and WWW tabs.  

c. On the WWW tab, select the Enable Visual  Navigator check box, which wil l  ensure your 
capture fi le is converted to a Visual Script  later.  

d. Click OK. 

5. From the toolbar, cl ick the Start  Record button. QALoad launches your appl icat ion and any 
proxies, i f necessary, and begins recording cal ls. 

6. Record the transact ion. 

7. When you are fin ished, cl ick the Stop Record button. You wil l  be prompted to save your capture 
fi le. By default , capture fi les (.cap) are saved in the directory 
QALoad\Middlewares\WWW\captures. 

8. If you previously set opt ions to prompt automatic conversion, your capture fi le wi l l  be converted to 
a Visual Script  and wil l  open automatical ly in  the editor. For more in formation about sett ing up 
automatic conversion, see Configuring the Script Development Workbench. 

If not, you wil l  be prompted to save and name your fi le. When you are fin ished, cl ick OK. 

9. Click the Script Development Workbench's Captures tab and locate the capture fi le you just saved. 

10. Right-cl ick the fi le and choose Convert . QALoad wi l l  convert  your capture fi le to a Visual Navigator 
script  and open i t  in  the editor. 

 

Visual Navigator Files 

When you create a script  using Visual Navigator, QALoad saves important in formation about your script  in  
the fol lowing fi les. These fi les are saved in the directory \Compuware\QALoad\Middlewares\WWW in  the 
subdirectories \Scripts and \Captures. Some of these fi les can be modified, and can be opened from the 
Script Development Workbench's Workspace pane, i f necessary. 

Note: If you choose to enable support for Siebel wh i le convert ing a capture fi le, you must copy the 
ssdtcorr.hpp, ssdtcorr.l ib, and ssdtcorr.dl l  Siebel fi les from the Siebel instal lat ion folder to the 
C:\Program Files\Compuware\QALoad\BinaryFiles. If you do not modify the Siebel instance, you 
only have to move the ssdtcorr.dll file. 

Fi l enam e Descript i on  

Fi l es Generated From  Recording 

<filename>.cap A fi le 
contain ing al l  
of the 
requests and 
responses that 
were 
recorded. 

<filename>.rfd Replies to 
subrequests, 
which most ly 
consist  of 
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images, style 
sheets, and 
javascripts. 
This data is 
used to 
visual ly 
recreate the 
pages as they 
appeared 
when 
recording. 

Fi l es Generated From  Conversion  
to a Visual  Script  

<filename>.vistree Contains 
most of the 
elements of 
the Visual 
Navigator 
tree, 
including any 
elements that 
you modify 
later or add to 
your script . 

<filename>.VisHtml Contains the 
HTML pages 
of al l  the 
main requests 
as well  as 
images, 
stylesheets, 
and other 
subrequested 
pages. This 
data is used to 
visual ly 
recreate the 
pages as they 
appeared 
when 
recording. 

<filename>.VisXml Contains any 
XML/SOAP 
information 
that was 
recorded. 

<filename>.cpp A C++ 
representat ion 
of your script . 
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Insert ing Script  Items 

Inserting tree items 

You can insert  a number of script  i tems into your converted script .  

To inser t  t ree i t em s: 

1. Do one of the fol lowing: 

!  From the Script Development Workbench main menu, choose  Visual  
Navigator>In sert  Tree I tem .  

!  Right-cl ick in  the tree-view (left  pane) and choose Insert  Tree I tem .  

2. Choose the i tem to insert . 

Most of the inserted i tems can be moved up and down the tree using the Up/Dow n arrows in the form-
view (bottom pane) for that i tem. You can also delete an i tem highl ighted in  the tree-view by choosing 
Delete Tree I tem  from the menu. 

The fol lowing script  i tems can be inserted from the Visual  Navigator menu:  

Extract String 

Cookie 

Http Header 

Content Check 

CGI Parameter 

Synch 

IP Spoof 

Read Datapool 

Checkpoint pair 

Increment Variable/Decrement Variable/Reset Variable 

Print Values (debugging) 

Comment 

 

Inserting cookies into a script 

Cookie i tems can be added direct ly to the Html Page i tem they apply to, under the Act ion  i tem (for 
example, a Cl ick on Link i tem).  

To inser t  a cook ie i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Html Page i tem requiring the cookie 
and then cl ick on i t  to select i t .  

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Cook ie. A Cookie form-view opens in 
the bottom pane. 
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3. In  the Nam e field, type a name for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

4. In  the Value field, type a value for the new Cookie or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 

The Cookie i tem is added to the script  for the selected Html Page i tem.  

 

Inserting HTTP headers into a Visual Navigator script 

You can insert  HTTP headers under the Common Http Headers tree i tem. 

To inser t  a new  Ht t p  Header  i t em : 

1. In  the Visual Navigator tree-view (left  pane), navigate to the Com m on Ht tp Headers script  i tem, 
and then cl ick on i t . 

2. From the menu, choose Visual  Navigator>Insert  Tree I tem >Ht tp Header. An Ht tp Header form-
view opens in the bottom pane. 

3. In  the Nam e field, type a name for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

4. In  the Value field, type a value for the new header or cl ick Var Wiz... to access the Select Variable 
dialog box where you can select a value from a datapool fi le or create a variable for th is field. 

5. Click Save to save your changes. 

The header i tem is added to the script , and wil l  be used for al l  requests at playback unless i t  is overwrit ten 
by a header with the same name underneath an individual request act ion.  

 

XML Support 

XML Support 

QALoad's XML support is handled through the Script Development Workbench's Visual Navigator, which 
displays your script 's HTTP or XML requests in  an easy-to-use, visual ly-based interface that offers you 
point-and-cl ick script  edit ing. Although XML is supported through the Visual  Navigator, Compuware 
recommends you read through th is help topic as well  as the Visual Navigator help topics to become 
famil iar with the features that are unique to QALoad's XML support. 

When an HTTP request is made for an XML document, ei ther in  the form of an HTTP GET request or an 
HTTP POST request with an XML document as the post data, the data is displayed in the three Visual 
Navigator panes as i l lustrated below. Cl ick on a pane in the graphic for a descript ion of i ts contents and 
funct ional i ty. 

Note: To make the fol lowing graphic fi t  better in  th is help window, the Script Development 
Workbench toolbars and panes that are not direct ly related to th is help topic are not displayed. You can 
h ide/show many of the Script Development Workbench toolbars and panes using commands avai lable 
from the View  menu. 



Using the Player, Script  Development Workbench, and Analyze 

164 

 

 

XML Requests 

When an HTTP request is for an XML document, ei ther in  the form of an HTTP GET request, or an HTTP 
POST request with an XM L document as the post data, then an XML Request  tree i tem is displayed in the 
tree-view (left  pane). The form-view (bottom pane) for an XML Request i tem includes the fol lowing fields: 

Reply Status: The reply status code. The status code is 200 OK for most pages that return correct ly. 

Request  URI: This read-only field shows the URI requested, which resulted in  th is page being displayed.   

Checkpoin t  Nam e: If the page has a t i t le, i t  is used as the checkpoint name. If not, the word Checkpoint is 
used. To make sure al l  checkpoint names are unique, QALoad adds a number to the beginning of the 
checkpoint name. 

XML Request Sub-items 

An XML Request i tem can contain the fol lowing sub-i tems.  

XML Reply  

The URI of the document returned as a result  of the XML request. XML data corresponding to the reply is 
displayed in the browser-view. 

HTTP Headers 

If a header exists under an act ion i tem, i t  is sent for that request only. If the header has the same name as 
one of the common headers, i t  overrides the common header for th is request only. The form-view (bottom 
pane) for an HTTP header l ists i ts name and value. Because there is no XML data recorded for a header, the 
browser-view remains empty. It  is possible to insert  addit ional HTTP Headers. 

Cookies CGI Parameter 
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The Cookies tree i tem contains a l ist  of Cookie i tems that were sent in  the header of the request that th is 
i tem made while being recorded. Cookies are added automatical ly by the browser based on the URI that is 
being requested. They are either set as a result  of the previous reply (server returned a Set-Cookie 
command), or they are set by JavaScript contained in the previous reply. The form-view for a cookie i tem 
l ists i ts name and value. Because there is no XML data recorded for a header, the browser-view remains 
empty.  

 

XML Document-view 

When you cl ick on an XML Request i tem in the tree-view (left  pane) the right pane becomes a document-
view displaying a tree-view of detai ls about the XM L document requested or returned as the result  of an 
XML request. Each individual XML item appears as a node in the XML document tree. XML elements can 
have chi ld elements and these appear as chi ld nodes of the XML element. Attributes of an element appear 
as chi ld nodes of the element, with the attribute value appearing as a chi ld of the attribute name. 

What if no XML data is associated with a request? 

If there is no XML document associated with the XML request (for example, an HTTP GET) a message 
indicat ing that there is no XML to be displayed is shown in the XML document-view. 

How does the document-view relate to the form-view? 

Select ing an i tem in the XML document tree displays the form-view detai ls corresponding to that XML 
element type in the bottom pane. 

Fol lowing is an example of XML request data displayed in a port ion of the XML document-view: 

 

 

XML Form-view 

When an XML request is displayed in the document-view (top pane) — as a result  of an XML request i tem 
or XML reply chi ld i tem being selected in  the Visual Navigator tree-view — you can cl ick on i tems in the 
document-view to display in formation about each in the form-view (bottom pane). If no XML item is 
selected in  the document-view, the XML Page form-view displays instead. For XML items, the form view 
display opt ions depend on two th ings: 

!  what type of XML item is selected in  the Visual Navigator tree-view (left  pane): an XML request or 
an XML reply 

!  what type of XML item is subsequently selected in  the XML document-view (top pane) 

When an XML item is selected in  the XML document-view, the value of that XML item is displayed in an 
edit  box in  the form-view. Some values — attribute values and text values — can be edited or variabl ized 
(that is, subst i tut ing one or more variables for the value in  an XML request or select ing the return value 
from an XML reply i tem to be received by a variable for later use in  the script). Text i tems, which are values 
between element tags, and attribute values represent volat i le i tems in an XML document structure, used for 
passing values to and from Web Services, for example. 
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The fol lowing tables l ist  the possible act ions for XML items displayed in a form-view. Val id act ions are 
determined by the XML item type and whether the i tem is from an HTTP POST request or from an HTTP 
reply. 

In  the fol lowing tables: 

!  If an i tem is editable, the value in  the form-view can be changed and the new value is used during 
replay. 

!  If a value can be variablized, a variable can be subst i tuted for al l  or part  of the value. The variable's 
value is placed in the variable's locat ion at replay. An example is a value received from an i tem 
from a previous XML document reply. 

!  If a variable can receive a replay value, the return value for the i tem can be placed into a selected 
variable during replay. The variable can then be subst i tuted for an input value in  a later XML 
request. 

XM L Request  I tem s 

XM L Request  I tem  Edi table? Can  the Value be 
Variabl i zed? 

Declarat ion No No 

DTD (Document 
Type Defin i t ion) 

No No 

PI (Processing 
Instruct ion) 

No No 

Comment No No 

Element No No 

Attribute (Name) No No 

Attribute (Value) Yes Yes 

Text Yes Yes 

 
XM L Reply I tem s 

XM L Request  I tem  Can  Variable Receive 
Replay Val ue 

Declarat ion No 

DTD (Document Type 
Defin i t ion) 

No 

PI (Processing 
Instruct ion) 

No 

Comment No 

Element No 

Attribute (Name) No 
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Attribute (Value) Yes 

Text Yes 

 

Sample Scripts 

Overview — Sample Scripts 

This sect ion shows examples of how you can manipulate converted scripts to address specific si tuat ions or 
resolve certain problems. Samples include examples of variabl izat ion, changes to transact ion logic, and 
detai led descript ions of commonly used commands. Sample scripts are shown for these middlewares: 

Citrix 

Oracle Forms Server 

SAP 

Winsock 

WWW 

 

Cit rix Scripts 

Citrix Script Samples 

You can address specific si tuat ions or resolve certain  problems by modifying converted Citrix scripts.  

Tips: Uppercase characters are not captured when the CAPS Lock key is on. Manually modify the 
script  to use uppercase characters or hold down the SHIFT key during recording. 
Similarly, the Windows Logo key is not supported. Do not use the Windows Logo key to start  
appl icat ions while recording a Citrix script . 

The scripts l isted below include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script .  

Handl ing Citrix Server Farms 

Handling Dynamic Window Tit les 

Handling Intermit tent Windows 

Handling Unexpected Events 

Moving Citrix Connect and Disconnect Outside the Transact ion Loop 

Script ing Mouse Act ions 

Using the CtxWaitForScreenUpdate Command 

Flushing Past Events from the Internal Queue 

 

Citrix Server Farms 

Handl ing Ci t r i x  Server Farm s 



Using the Player, Script  Development Workbench, and Analyze 

168 

Citrix servers can be grouped in farms. When load test ing, you may want to connect to a Citrix server farm 
rather than to a specific server. Load test ing requirements may include connect ing to a Citrix server farm, 
where the load balancing feature supports dynamic redirect ion to a given server at connect ion t ime. This 
load tests the server farm and Citrix load balancing rather than a single server, which can provide a more 
real ist ic load test.   

To record a script  that connects to a farm, you must use an ICA fi le to connect. However, when a capture 
takes place, a specific server (in  the farm) must have a connect ion. Specify the correct ICA fi le to connect 
to the server farm as well  as a specific server with in that server farm.  

To veri fy that your script  is connect ing to a server farm and not a specific server, assign the server name to 
one blank space when val idat ing the script . In  order to record a script  that connects to a farm, you must 
use an ICA fi le specified in  the Citrix Record Options dialog. Since the ICA fi le should contain al l  the 
necessary connect ion in formation, the server field should be left  blank when recording.  

When converted, the CitrixServer variable has a blank space: 

. 

. 

. 

/* Declare Variables */ 
const char *CitrixServer   = " "; 
const char *CitrixUsername = "citrix"; 
const char *CitrixPassword = "~encr~657E06726F697206"; 
const char *CitrixDomain   = "qacitrix2"; 
const int CitrixOutputMode = OUTPUT_MODE_NORMAL; 

. 

. 

. 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("Orders.cpp"); 

CitrixInit(4); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(90); 
CtxSetDisconnectTimeout(90); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, Citrix-Domain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(TRUE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

 

The Citrix cl ient ignores th is value and uses the ICA fi le to dynamical ly retrieve the server name at 
playback t ime. 

Conclusion 

When you use these techniques to set up a Citrix server farm test script , you al low for dynamic server 
redirect ion at playback as part  of test ing a load balanced Citrix server farm.  

 

Sam ple Script  for Handl ing Ci t r i x  Server Farm s 
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The fol lowing sample shows a snippet of a Citrix script   that sets up a server farm test script .  

Sample Script  
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "8.100.29670" 
#define CITRIX_ICO_VERSION    "2.4" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/////////////////////////////////////////////////////////// 
     /// Convert sets the Citrix server name to a single blank 
/// space. This is only necessary to verify that the script actually is connecting to a 
server farm. 
/////////////////////////////////////////////////////////// 
const char *CitrixServer      = " "; 

const char *CitrixUsername    = "test"; 
const char *CitrixPassword    = "~encr~657E06726F697206"; 
const char *CitrixDomain      = "test"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 

/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_3 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_4 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
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CtxWI *CWI_5 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_6 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_8 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_9 = new CtxWI(0x2006c, "Calculator", 66, 66, 261, 253); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capCtxServerFarm.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetDomainLoginInfo(CitrixUsername, CitrixPassword, CitrixDomain); 
CtxSetICAFile("PRD desktop.ica"); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

…rest of script… 
Dynamic Window Titles 

Dyn am ic Window  Ti t l es 

Some appl icat ions create windows whose t i t les vary depending on the state of the window. For example, 
M icrosoft  Word creates a t i t le based on the default  document name at the t ime of the window creat ion. 
Other window t i t les may contain the user’s name, or the day or t ime. When a window name in the record 
session varies from the name in a val idat ion or playback session, the script  fai ls with a window t i t le 
mismatch error.   

When th is error occurs during val idat ion or playback, you must modify the script  to recognize the base 
pattern of the window t i t le name rather than an exact window t i t le. 

 

M odi fying the Script  to Handle Dyn am ic Window  Ti t l es 

Window t i t les can vary based on the state of the appl icat ion. For example, M icrosoft  Word windows may 
appear with the name of a default  document t i t le as part  of the window name. Other window t i t les may 
contain the user’s name, or the day or t ime. When a window name in  the record session varies from the 
name in a val idat ion or playback session, the script  fai ls with a window t i t le mismatch error.   

When th is error occurs during val idat ion or playback, you must modify the script  to recognize the base 
pattern of the window t i t le name rather than an exact window t i t le. You can do th is during conversion  by 
adding CtxWaitForWindowCreate cal ls to the script  for each named window creat ion event. 

When you modify a script  for these occurrences, you must: 

!  Modify the recording process 

!  Perform an in i t ial  val idat ion 

!  Ident i fy a Match Pattern  

!  Modify the script   

!  Revalidate the script   
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Note: You may need to configure the workbench and player for val idat ion.  
  

To m odi f y t he recording process: 

1. Record the Citrix session with the proper opt ions selected.  

2. Click Opt ions>Convert , then cl ick the Ci t r i x  tab.  

3. Ensure that the Enable W i ldcard Ti t l e M atch  check box is selected. 

4. Click OK to convert  the recording. 

To per f orm  an in i t ial  val idat ion af t er  scr ip t  record and conversion: 

1. Click Session>Val idate Script .  

2. When the val idat ion session generates the window t i t le mismatch error, compare the actual 
window t i t le name to the expected window t i t le name.  

Note:  Repeated val idat ions should generate a l ist  of one or more window t i t les that differ from the 
expected t i t le.   

To per f orm  a Mat ch Pat t ern ident i f icat ion: 

Ident i fy a match pattern that compares al l  actual window t i t les to original window t i t les using the l ist of 
window t i t les from val idat ions.   

Note: This regular-expression style match pattern uses the normal character set. Asterisks (*) denote 0 
to n wi ldcard characters. Quest ion marks denote one wildcard character. 

To m odi f y t he scr ipt : 

Make the script  changes when you ident i fy a workable match pattern for the dynamic window.   

1. In  the script , ensure that the CtxSetEnableWi ldcardM atch ing command exists before the 
SYNCHRONIZE command. 

2. Ensure that the CtxSetEnableWi ldcardM atch ing parameter value is set to TRUE.   

Note: This statement is inserted when you set the Enable Wi ldcard Ti t l e M atch  opt ion in  
Opt ions>Convert  before convert ing the recording.   

3. Insert  a CtxSetWindow M atchTi t l e command before the CtxWai tForWindow Create cal l  for each 
window creat ion wait  event for the dynamic window.  The parameters include the Citrix window 
ident i fier and the ident i fied match pattern for the dynamic window.  

To reval idat e t he scr ipt : 

1. Click Session>Val idate Script .  

2. If the CtxWai tForWindow Create wait  event cal l  fai ls, ident i fy the actual window t i t le returned.  

3. Perform the match pattern ident i ficat ion step and re-create a val id wi ldcard string to match al l  
expected window values.  

Conclusion 
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Following these techniques, you can modify window creat ion events to recognize dynamic window t i t les. 
The sample scripts i l lustrate how to determine a base pattern for the window t i t le by sequential  val idat ions 
of the script  and how to make relevant changes to the script . The first  example uses a substring match to 
recognize the dynamic window t i t le. The second example uses a wi ldcard match to accomplish th is. 

Example One: Script  Samples - Using a Substring Match 

Example Two: Script  Samples - Using a Wildcard M atch 

 

Script  Sam ples - Using a Subst r ing M atch  

Script Samples: Example One - Using a Substring Match 

In th is example, the M icrosoft  Word appl icat ion generates a dynamic t i t le. The dynamic name is a 
concatenat ion of the default  document that Word creates at appl icat ion startup with the name of the 
appl icat ion.  

Original Window 
Tit le (Record) 

 “ M icrosoft  Word”  

Actual Window 
Tit le (Val idat ion) 

“ document1 - M icrosoft  
Word”  

Actual Window 
Tit le (Val idat ion) 

“ document 2 - M icrosoft  
Word”  

The script  is altered to reflect the fact that the string “ M icrosoft  Word”  is always part  of the window t i t le. 
 The asterisk (*) wi ldcard is subst i tuted for the default  document name. 

“ Match Pattern”  
from window t i t les 

 “ * - M icrosoft  Word”  

 

Sample: Original Citrix Script   

This is an example of an original Citrix script  converted from capture. In  th is example, the M icrosoft  Word 
appl icat ion generates a dynamic t i t le. The dynamic name is a concatenat ion of the default  document that 
Word creates at appl icat ion startup with the name of the appl icat ion. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sample Script 
/* 
 *  dynamicwindow.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
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 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 
 
#include <stdio.h> 
#include "smacro.h" 
 
#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 
 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// Note the initial window title of “Microsoft Word” is set here in the script…  
CtxWI *CWI_12 = new CtxWI(0x2006e, "Microsoft Word", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
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CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

CtxConnect(CitrixServer, CitrixOutputMode); 

CtxPoint(164, 61);  //1113840775.516 

// Window CWI_1 ("Warning !!") created 1113840775.516 

CtxWaitForWindowCreate(CWI_1, 1969); 

DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 

DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 

// Window CWI_2 ("Log On to Windows") created 1113840777.817 

CtxWaitForWindowCreate(CWI_2, 93); 

DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 

CtxType(CWI_2, "citrix");  //1113840786.615 

DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 

DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 

DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 

DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 

DO_MSLEEP(438); 

DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 

DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 

CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 

CtxPoint(232, 325);  //1113840790.544 

// Window CWI_3 ("Please wait...") created 1113840790.544 

CtxWaitForWindowCreate(CWI_3, 204); 

// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 

// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 
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CtxWaitForWindowCreate(CWI_4, 46); 

DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 

// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 

CtxWaitForWindowCreate(CWI_5, 47); 

DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 

// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 

CtxWaitForWindowCreate(CWI_6, 46); 

DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 

// Window CWI_7 ("") created 1113840790.967 

DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 

CtxWaitForWindowCreate(CWI_8, 47); 

// Window CWI_9 ("Program Manager") created 1113840791.030 

CtxWaitForWindowCreate(CWI_9, 16); 

CtxPoint(347, 249);  //1113840793.080 

// Window CWI_10 ("") created 1113840793.080 

DO_MSLEEP(16); 

DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 

DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 

DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 

DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 

DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 

DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 

DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 

DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 

DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 
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DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 

// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 

DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 

DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 

CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 

DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 

DO_MSLEEP(359); 
CtxPoint(284, 205);  //1113840807.028 

// Window CWI_11 ("") created 1113840807.028 

DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 

// Window CWI_12 ("Microsoft Word") created 1113840807.326 

/// The window create wait event.  If the window title at replay 
/// is any different that “Microsoft Word”, this wait event will FAIL. 
CtxWaitForWindowCreate(CWI_12, 266); 

DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 

DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 

DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 

DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 

DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 

// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 

DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 

DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 

// Window CWI_7 ("") destroyed 1113840815.262 

// Window CWI_13 ("Please wait...") created 1113840815.513 

CtxWaitForWindowCreate(CWI_13, 0); 

DO_SetTransactionCleanup(); 

CtxDisconnect(); 

END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
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delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 

CitrixUninit(); 

EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 

CitrixUninit(); 

EXIT(); 
} 

Sample One: Modified Cit rix Script   

In  th is example, the M icrosoft  Word appl icat ion generates dynamic t i t le that is a concatenat ion of the 
default  document that Word creates at appl icat ion startup with the name of the appl icat ion. This script  is 
altered to reflect the fact that the string “ M icrosoft  Word”  is always part  of the window t i t le. The asterisk 
(*) wi ldcard is subst i tuted for the default  document name. Changes to the original script  are h ighl ighted in  
bold. 

Sample Script 
/* 
 *  dynamicwindow.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
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 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// The initial window title of “Microsoft Word” does not change 
CtxWI *CWI_12 = new CtxWI(0x2006e, "Microsoft Word", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
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CtxConnect(CitrixServer, CitrixOutputMode); 

CtxPoint(164, 61);  //1113840775.516 

// Window CWI_1 ("Warning !!") created 1113840775.516 

CtxWaitForWindowCreate(CWI_1, 1969); 

DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 

DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 

// Window CWI_2 ("Log On to Windows") created 1113840777.817 

CtxWaitForWindowCreate(CWI_2, 93); 

DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 

CtxType(CWI_2, "citrix");  //1113840786.615 

DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 

DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 

DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 

DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 

DO_MSLEEP(438); 

DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 

DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 

CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 

CtxPoint(232, 325);  //1113840790.544 

// Window CWI_3 ("Please wait...") created 1113840790.544 

CtxWaitForWindowCreate(CWI_3, 204); 

// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 

// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 

CtxWaitForWindowCreate(CWI_4, 46); 

DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 

// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 

CtxWaitForWindowCreate(CWI_5, 47); 

DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 

// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 
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CtxWaitForWindowCreate(CWI_6, 46); 

DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 

// Window CWI_7 ("") created 1113840790.967 

DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 

CtxWaitForWindowCreate(CWI_8, 47); 

// Window CWI_9 ("Program Manager") created 1113840791.030 

CtxWaitForWindowCreate(CWI_9, 16); 

CtxPoint(347, 249);  //1113840793.080 

// Window CWI_10 ("") created 1113840793.080 

DO_MSLEEP(16); 

DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 

DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 

DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 

DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 

DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 

DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 

DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 

DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 

DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 

DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 

// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 

DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 

DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 

CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 
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DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 

DO_MSLEEP(359); 
CtxPoint(284, 205);  //1113840807.028 

// Window CWI_11 ("") created 1113840807.028 

DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 

// Window CWI_12 ("Microsoft Word") created 1113840807.326 

//////////////////////////////////////////////////////////////////////  
/// The CtxSetWindowMatchTitle command is inserted before the  
/// CtxWaitForWindowCreate call. Note that the window identifier is the  
//  same for both calls, and the “match pattern” for the command is from  
/// Example One in the Match Pattern Identification section above.  
////////////////////////////////////////////////////////////////////// 

CtxSetWindowMatchTitle(CW1_12, "*Microsoft Word"" ); 
 
/// The window create wait event call does not change. 
CtxWaitForWindowCreate(CWI_12, 266); 

DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 

DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 

DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 

DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 

DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 

// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 

DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 

DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 

// Window CWI_7 ("") destroyed 1113840815.262 

// Window CWI_13 ("Please wait...") created 1113840815.513 

CtxWaitForWindowCreate(CWI_13, 0); 

DO_SetTransactionCleanup(); 

CtxDisconnect(); 

END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
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delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 

CitrixUninit(); 

EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 

CitrixUninit(); 

EXIT(); 

} 

Script  Sam ples - Using a Wi ldcard M atch  

Script Samples: Example Two - Using a Wildcard M atch 

In th is example, the Sample Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the 
appl icat ion fol lowed by the t ime the script  is created.  

Original Window 
Tit le (Record) 

 “ Sample Appl icat ion – 
09:01:23 AM”  

Actual Window 
Tit le (Val idat ion) 

“ Sample Appl icat ion – 
11:00:04 AM”  

Actual Window 
Tit le (Val idat ion) 

“ Sample Appl icat ion – 
12:20:52 PM”  

The quest ion mark (?) wi ldcard is subst i tuted for a given t ime. 

“ Match Pattern”  
from window t i t les 

“ Sample Appl icat ion – 
??:??:?? ?M”  

 

Sample Two: Original Citrix Script   

The fol lowing sample is an original Citrix script  converted from capture. In  th is example, the Sample 
Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the appl icat ion fol lowed by the 
t ime the script  is created. Points of in terest in  the script  are h ighl ighted in  bold. 

Sample Script 

/* 
 *  dynamicwindow2.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
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/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// Note the initial window title of “Sample Application 09:01:23 AM” is set here…  
CtxWI *CWI_12 = new CtxWI(0x2006e, "Sample Application 09:01:23 AM ", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
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DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(164, 61);  //1113840775.516 
 
// Window CWI_1 ("Warning !!") created 1113840775.516 
 
CtxWaitForWindowCreate(CWI_1, 1969); 
 
DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 
 
DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 
 
// Window CWI_2 ("Log On to Windows") created 1113840777.817 
 
CtxWaitForWindowCreate(CWI_2, 93); 
 
DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 
 
CtxType(CWI_2, "citrix");  //1113840786.615 
 
DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 
 
DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 
 
DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 
 
DO_MSLEEP(438); 
 
DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 



QALoad Online Help 

185 

 
CtxPoint(232, 325);  //1113840790.544 
 
// Window CWI_3 ("Please wait...") created 1113840790.544 
 
CtxWaitForWindowCreate(CWI_3, 204); 
 
// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 
 
CtxWaitForWindowCreate(CWI_4, 46); 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 
 
CtxWaitForWindowCreate(CWI_5, 47); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 
 
CtxWaitForWindowCreate(CWI_6, 46); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 
 
// Window CWI_7 ("") created 1113840790.967 
 
DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 
 
CtxWaitForWindowCreate(CWI_8, 47); 
 
// Window CWI_9 ("Program Manager") created 1113840791.030 
 
CtxWaitForWindowCreate(CWI_9, 16); 
 
CtxPoint(347, 249);  //1113840793.080 
 
// Window CWI_10 ("") created 1113840793.080 
 
DO_MSLEEP(16); 
 
DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 
 
DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
 
DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 
 
DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 
 
DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 
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DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 
 
DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 
 
DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 
 
DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 
 
DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 
 
DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 
 
DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 
 
DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 
 
CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 
 
DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 
 
DO_MSLEEP(359); 
 
CtxPoint(284, 205);  //1113840807.028 
 
// Window CWI_11 ("") created 1113840807.028 
 
DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 
 
// Window CWI_12 ("Microsoft Word") created 1113840807.326 
 

/// The window create wait event.  If the window title at replay 
/// is any different that “Sample Application 09:01:23 AM”, this wait event  
/// will FAIL. 
CtxWaitForWindowCreate(CWI_12, 266); 
 
DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 
 
DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 
 
DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 
 
DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 
 
DO_MSLEEP(218); 
CtxPoint(623, 40);  //1113840812.006 
 
// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 
 
DO_MSLEEP(2204); 
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CtxPoint(385, 1);  //1113840815.262 
 
DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 
 
// Window CWI_7 ("") destroyed 1113840815.262 
 
// Window CWI_13 ("Please wait...") created 1113840815.513 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Sample Two: Modified Citrix Script   

The fol lowing is an example of a Citrix script  modi fied to handle a dynamic window t i t le. In  th is example, 
the Sample Appl icat ion generates a dynamic t i t le. The dynamic name is the name of the appl icat ion 
fol lowed by the t ime the script  is created. The quest ion mark (?) wi ldcard is subst i tuted for a given t ime. 
Changes to the original script  are h ighl ighted in  bold. 

Sample Script 

/* 
 *  dynamicwindow2.cpp 
 * 
 *  Script Converted on April 18, 2005 at 12:13:47 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
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 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x1008c, "", 115, 0, 405, 457); 
CtxWI *CWI_11 = new CtxWI(0x20068, "", 112, 116, 416, 248); 

// The initial window title of “Sample Application 09:01:23 AM” does not change 
CtxWI *CWI_12 = new CtxWI(0x2006e, "Sample Application 09:01:23 AM", -4, -4, 649, 461); 
CtxWI *CWI_13 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("dynamicwindow.cpp"); 
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CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(164, 61);  //1113840775.516 
 
// Window CWI_1 ("Warning !!") created 1113840775.516 
 
CtxWaitForWindowCreate(CWI_1, 1969); 
 
DO_MSLEEP(2046); 
CtxPoint(332, 359);  //1113840777.629 
 
DO_MSLEEP(63); 
CtxClick(CWI_1, 94, L_BUTTON, NONE); //1113840777.723 
 
// Window CWI_2 ("Log On to Windows") created 1113840777.817 
 
CtxWaitForWindowCreate(CWI_2, 93); 
 
DO_MSLEEP(16); 
// Window CWI_1 ("Warning !!") destroyed 1113840777.833 
 
CtxType(CWI_2, "citrix");  //1113840786.615 
 
DO_MSLEEP(8547); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840786.678 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113840788.650 
 
DO_MSLEEP(1672); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113840788.713 
 
DO_MSLEEP(359); 
CtxType(CWI_2, "q");  //1113840789.683 
 
DO_MSLEEP(438); 
 
DO_MSLEEP(1078); 
CtxPoint(231, 325);  //1113840790.309 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 325);  // 1113840790.309 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 232, 325); //1113840790.388 
 
CtxPoint(232, 325);  //1113840790.544 
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// Window CWI_3 ("Please wait...") created 1113840790.544 
 
CtxWaitForWindowCreate(CWI_3, 204); 
 
// Window CWI_2 ("Log On to Windows") destroyed 1113840790.544 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113840790.591 
 
CtxWaitForWindowCreate(CWI_4, 46); 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") destroyed 1113840790.607 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113840790.654 
 
CtxWaitForWindowCreate(CWI_5, 47); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113840790.669 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113840790.716 
 
CtxWaitForWindowCreate(CWI_6, 46); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113840790.732 
 
// Window CWI_7 ("") created 1113840790.967 
 
DO_MSLEEP(234); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113840791.014 
 
CtxWaitForWindowCreate(CWI_8, 47); 
 
// Window CWI_9 ("Program Manager") created 1113840791.030 
 
CtxWaitForWindowCreate(CWI_9, 16); 
 
CtxPoint(347, 249);  //1113840793.080 
 
// Window CWI_10 ("") created 1113840793.080 
 
DO_MSLEEP(16); 
 
DO_MSLEEP(1203); 
CtxPoint(571, 256);  //1113840796.133 
 
DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
 
DO_MSLEEP(1828); 
CtxPoint(446, 208);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 
 
DO_MSLEEP(437); 
CtxPoint(311, 303);  //1113840798.935 
 
DO_MSLEEP(110); 
CtxClick(CWI_5, 109, L_BUTTON, NONE); //1113840799.045 
 
DO_MSLEEP(94); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113840799.138 
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DO_MSLEEP(390); 
CtxPoint(275, 1);  //1113840799.718 
 
DO_MSLEEP(188); 
CtxClick(CWI_8, 62, L_BUTTON, NONE); //1113840799.780 
 
DO_MSLEEP(703); 
CtxPoint(200, 187);  //1113840800.579 
 
DO_MSLEEP(94); 
CtxClick(CWI_8, 78, L_BUTTON, NONE); //1113840800.657 
 
DO_MSLEEP(110); 
CtxPoint(209, 192);  //1113840800.766 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113840800.766 
 
DO_MSLEEP(5328); 
CtxPoint(115, 175);  //1113840806.245 
 
DO_MSLEEP(140); 
CtxDoubleClick(CWI_9); // 1113840806.621 
 
CtxMouseUp(CWI_7, L_BUTTON, NONE, 114, 174); //1113840806.512 
 
DO_MSLEEP(16); 
CtxPoint(114, 174);  //1113840806.621 
 
DO_MSLEEP(359); 
 
CtxPoint(284, 205);  //1113840807.028 
 
// Window CWI_11 ("") created 1113840807.028 
 
DO_MSLEEP(16); 
CtxPoint(309, 208);  //1113840807.326 
 
// Window CWI_12 ("Microsoft Word") created 1113840807.326 

//////////////////////////////////////////////////////////////////////  
/// The CtxSetWindowMatchTitle command is inserted before the  
/// CtxWaitForWindowCreate call. Note that the window identifier is the  
//  same for both calls, and the “match pattern” for the command is from  
/// Example Two in the Match Pattern Identification section above.  
////////////////////////////////////////////////////////////////////// 

CtxSetWindowMatchTitle(CW1_12, "Sample Application ??:??:?? ?M" ); 
 

/// The window create wait event call does not change. 
CtxWaitForWindowCreate(CWI_12, 266); 
 
DO_MSLEEP(46); 
CWI_12->setTitle("Document1 - Microsoft Word"); //1113840807.388 
 
DO_MSLEEP(16); 
// Window CWI_11 ("") destroyed 1113840807.388 
 
DO_MSLEEP(4188); 
CtxPoint(626, 8);  //1113840811.693 
 
DO_MSLEEP(109); 
CtxClick(CWI_12, 94, L_BUTTON, NONE); //1113840811.787 
 
DO_MSLEEP(218); 
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CtxPoint(623, 40);  //1113840812.006 
 
// Window CWI_12 ("Document1 - Microsoft Word") destroyed 1113840812.006 
 
DO_MSLEEP(2204); 
CtxPoint(385, 1);  //1113840815.262 
 
DO_MSLEEP(1046); 
// Window CWI_9 ("Program Manager") destroyed 1113840815.262 
 
// Window CWI_7 ("") destroyed 1113840815.262 
 
// Window CWI_13 ("Please wait...") created 1113840815.513 
 
CtxWaitForWindowCreate(CWI_13, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
delete CWI_11; // "" 
delete CWI_12; // "Microsoft Word" 
delete CWI_13; // "Please wait..." 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Intermittent Windows 

In term i t ten t  Window s 

Windows that do not appear when a script  is recorded can appear in termit ten t ly during replay. One 
example commonly encountered with Citrix is the ICA Seamless Host Agent window. If an unexpected 
window appears at val idat ion or playback, you must modify the script  to handle the window event.  

To simpli fy the script ing process, record a temporary session and convert  i t  to a script . This should be a 
session where the unexpected window appears so that the user must in teract, for example, with a mouse 
cl ick or keyboard entry, to dismiss the in termittent window. Note the locat ion in  the playback script  where 
the presence of the in termit tent window prevented the script  from cont inuing. This is where code is added 
to the script .   
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When th is error occurs during val idat ion or playback, you must modify the script  to recognize the base 
pattern of the window t i t le name rather than an exact window t i t le. 

An intermit tent window, i f i t  appears, requires user act ion or the script  may fai l .  

 

M odi fying the Script  for In term i t ten t  Window s 

Windows that don't  appear when a script  is recorded can appear in termit tent ly during replay. One 
example commonly encountered with Citrix is the ICA Seamless Host Agent window.  If an unexpected 
window appears at val idat ion or playback, you must modify the script  to handle the window event.  

To simpli fy the script ing process, record a temporary session and convert  i t  to a script . This should be a 
session where the unexpected window appears so that the user must in teract, for example, with a mouse 
cl ick or keyboard entry, to dismiss the in termittent window. Note the locat ion in  the playback script  where 
the presence of the in termit tent window prevented the script  from cont inuing. This is where code is added 
to the script .   

Do the fol lowing i f a val idat ion or playback session indicates an unexpected window appeared that 
requires user in teract ion:   

!  Record a temporary script  where the unexpected window event appears.  

!  Convert the original session to a script . 

!  Modify the original script  with a sect ion of the temporary script . 

To record a t em porary scr ip t : 

Simpli fy  the script ing effort  required by doing the fol lowing: 

1. Record a temporary session of the transact ion. This should include the appearance of the 
in termit tent window and the subsequent user in teract ion that dismisses the window.   

2. Add a comment when the window appears and before the window is dismissed. 

3. Give the successful record session a temporary name.   

4. Click Opt ions>Convert , and cl ick OK to convert  the session to a script . 

To m odi f y t he or ig inal  scr ip t : 

Extract a small  sect ion of the temporary script  code and insert  i t  in to the original script . 

1. Ident i fy the locat ion in  the original script  where the unexpected window appeared.  You can do 
th is by not ing the last window that was successful ly created before val idat ion fai lure.  

Tip: Note the locat ion with a code-style comment. This is the locat ion where you paste in  code from 
the temporary script . 

2. Ident i fy the code in the temporary script  that creates the Citrix window object.  This code is in  the 
sect ion labeled /* Citrix Window Information Objects */  and can be ident i fied by the name 
parameter.   

3. Cut and paste th is l ine in to the corresponding sect ion in  the original script .   

4. Modify the l ine pasted in to the original script ,  giving the statement a unique Citrix window 
ident i fier.   

Note: This ident i fier, CWI_n, must be a unique value in  the original script  or the script  wi l l  not 
compile.   
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5. Find the l ine in  the temporary script  that deletes the Citrix window object. This code is after the 
END_TRANSACTION cal l .   

6. Copy th is l ine to the same locat ion in  the original script  and modify i t  with the unique Citrix 
window ident i fier from Step 4. 

7. Add a special version of the CtxSetWindowMatchTit le command in the original script  in  the 
locat ion where the original script  fai led because of the in termit tent window.   

This is where the window must be recognized and dismissed, i f i t  exists. The first  parameter is the Citrix 
window object ident i fier from Step 2. The second parameter is an asterisk enclosed in double quotes 
(“ *” ). This parameter ensures that commands l ike CtxClick work with any matched window, even i f the 
in termit tent window does not exist . 

9. Ident i fy the code that dismisses th is window in the temporary script  by scrol l ing to the comment 
you inserted during capture, and backtracking unt i l  you find the correct CtxWaitForWindowCreate 
statement. Usual ly th is code consists of either a set of CtxPoint and CtxClick or one or more 
keyboard entry cal ls after the window create event.    

Caut ion : Do not include the CtxWaitForWindowCreate statement. 

10. Copy the code from the temporary script  and paste i t  after the CtxSetWindowMatchTit le cal l  added 
in Step 5. Ensure that the Citrix window object parameter for these cal ls is the Citrix window 
object ident i fier from Step 2. 

Conclusion 

Fol lowing these techniques, you can modify a session to handle the appearance of in termit tent windows 
that require user act ion to dismiss. The sample scripts i l lustrate th is process. 

Sample original script  

Sample temporary script  

Sample modified script   

 

Sam ple: Original  Ci t r i x  Script  for In term i t ten t  Window s 

The fol lowing is an example of an original Citrix script  converted from capture. Points of in terest in  the 
script  are h ighl ighted in  bold. 

Sample Script  
/* 
 *  intermittent_original.cpp 
 * 
 *  Script Converted on April 18, 2005 at 03:23:41 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 
 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
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 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
CtxWI *CWI_8 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x100b8, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

/// A line will be copied and modified here to create the new Citrix window object 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("intermittent_original.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
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SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
// Window CWI_1 ("Warning !!") created 1113852175.329 
 
CtxWaitForWindowCreate(CWI_1, 2047); 
 
DO_MSLEEP(1203); 
CtxPoint(162, 161);  //1113852176.561 
 
DO_MSLEEP(31); 
CtxClick(CWI_1, 79, L_BUTTON, NONE); //1113852176.639 
 
DO_MSLEEP(718); 
CtxPoint(323, 362);  //1113852177.451 
 
DO_MSLEEP(94); 
CtxClick(CWI_1, 63, L_BUTTON, NONE); //1113852177.513 
 
// Window CWI_2 ("Log On to Windows") created 1113852177.638 
 
CtxWaitForWindowCreate(CWI_2, 125); 
 
// Window CWI_1 ("Warning !!") destroyed 1113852177.638 
 
CtxType(CWI_2, "citr");  //1113852180.291 
 
DO_MSLEEP(2625); 
CtxType(CWI_2, "ix");  //1113852180.790 
 
 
DO_MSLEEP(343); 
CtxPoint(324, 362);  //1113852180.790 
 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852180.868 
 
DO_MSLEEP(266); 
CtxType(CWI_2, "citrix");  //1113852182.194 
 
DO_MSLEEP(1078); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113852182.225 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "q");  //1113852183.692 
 
DO_MSLEEP(1078); 
 
DO_MSLEEP(844); 
CtxPoint(263, 324);  //1113852184.176 
 
DO_MSLEEP(31); 
CtxClick(CWI_2, 79, L_BUTTON, NONE); //1113852184.254 
 
DO_MSLEEP(109); 
// Window CWI_2 ("Log On to Windows") destroyed 1113852184.363 
 
// Window CWI_3 ("Please wait...") created 1113852184.394 
 
CtxWaitForWindowCreate(CWI_3, 16); 
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// Window CWI_4 ("Citrix License Warning Notice") created 1113852184.457 
 
CtxWaitForWindowCreate(CWI_4, 78); 
 
// Window CWI_3 ("Please wait...") destroyed 1113852184.472 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_5, 109); 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113852184.566 
 
CtxWaitForWindowCreate(CWI_6, 0); 
 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113852184.566 
 
DO_MSLEEP(31); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113852184.597 
 
// Window CWI_7 ("") created 1113852184.878 
 
// Window CWI_8 ("Program Manager") created 1113852184.941 
 
CtxWaitForWindowCreate(CWI_8, 0); 
 
CtxPoint(195, 192);  //1113852186.891 
 
// Window CWI_9 ("") created 1113852186.891 
 
DO_MSLEEP(516); 
CtxPoint(316, 271);  //1113852187.406 
 
CtxMouseDown(CWI_5, L_BUTTON, NONE, 316, 271);  // 1113852187.406 
 
CtxMouseUp(CWI_5, L_BUTTON, NONE, 317, 278); //1113852187.515 
 
DO_MSLEEP(219); 
CtxPoint(317, 287);  //1113852187.671 
 
DO_MSLEEP(46); 
CtxClick(CWI_5, 63, L_BUTTON, NONE); //1113852187.734 
 
DO_MSLEEP(62); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113852187.796 
 

/// Below is the last statement that executed prior to script failure 
/// This is where the code to identify and dismiss the window will be added. 
 
DO_MSLEEP(829); 
CtxPoint(555, 200);  //1113852188.639 
 
DO_MSLEEP(15); 
CtxClick(CWI_9, 94, L_BUTTON, NONE); //1113852188.732 
 
DO_MSLEEP(875); 
CtxPoint(555, 199);  //1113852189.934 
 
DO_MSLEEP(328); 
// Window CWI_9 ("") destroyed 1113852189.934 
 
DO_MSLEEP(19766); 
CtxPoint(337, 157);  //1113852210.000 
 
DO_MSLEEP(328); 
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// Window CWI_9 ("Program Manager") destroyed 1113852210.000 
 
// Window CWI_7 ("") destroyed 1113852210.016 
 
// Window CWI_10 ("Please wait...") created 1113852210.266 
 
CtxWaitForWindowCreate(CWI_10, 0); 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "Please wait..." 

/// A line will be copied here and modified to delete the Citrix window object. 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Sam ple: Tem porary Ci t r i x  Script  w i th  Window  Creat ion  and Dism issal  

The fol lowing is an example of a temporary Citrix script  with window creat ion and dismissal. Code to be 
ident i fied and copied from the temporary script  is h ighl ighted in  bold. 

Sample Script  

/* 
 *  intermittent_temporary.cpp 
 * 
 *  Script Converted on April 18, 2005 at 03:16:57 PM 
 *  Generated by Compuware QALoad convert module version 5.5.0 build 256 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Replay Output Mode              : Normal 



QALoad Online Help 

199 

 *   Enable Counters                 : No 
 *  Timeout Value Options            :  
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 *  Window Options                   :  
 *   Window Verification             : Yes 
 *    Window Max Retries             : 5 
 *    Window Wait Retries (ms)       : 5000 
 *   Enable Wildcard Title Match     : Yes 
 */ 

#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 
#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix"; 
const char *CitrixPassword    = ""; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 127); 
CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 

/// The code line to copy to the original script.  
CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_10 = new CtxWI(0x10084, "", 115, 0, 405, 457); 
 
SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("intermittent_temporary.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
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CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
CtxPoint(120, 159);  //1113851768.564 
 
// Window CWI_1 ("Warning !!") created 1113851768.564 
 
CtxWaitForWindowCreate(CWI_1, 2063); 
 
DO_MSLEEP(766); 
CtxPoint(313, 361);  //1113851769.344 
 
DO_MSLEEP(31); 
CtxClick(CWI_1, 62, L_BUTTON, NONE); //1113851769.407 
 
// Window CWI_2 ("Log On to Windows") created 1113851769.454 
 
CtxWaitForWindowCreate(CWI_2, 47); 
 
// Window CWI_1 ("Warning !!") destroyed 1113851769.454 
 
CtxType(CWI_2, "citrix");  //1113851774.556 
 
DO_MSLEEP(4891); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113851774.618 
 
DO_MSLEEP(281); 
CtxType(CWI_2, "citrix");  //1113851776.460 
 
DO_MSLEEP(1594); 
CtxTypeVK(CWI_2, VK_TAB, NONE);  //1113851776.522 
 
DO_MSLEEP(312); 
CtxType(CWI_2, "q");  //1113851779.627 
 
DO_MSLEEP(2469); 
 
DO_MSLEEP(953); 
CtxPoint(231, 322);  //1113851780.017 
 
DO_MSLEEP(78); 
CtxMouseDown(CWI_2, L_BUTTON, NONE, 231, 322);  // 1113851780.017 
 
CtxMouseUp(CWI_2, L_BUTTON, NONE, 231, 321); //1113851780.080 
 
DO_MSLEEP(16); 
CtxPoint(231, 321);  //1113851780.127 
 
DO_MSLEEP(94); 
// Window CWI_2 ("Log On to Windows") destroyed 1113851780.127 
 
// Window CWI_3 ("Please wait...") created 1113851780.236 
 
CtxWaitForWindowCreate(CWI_3, 109); 
 
// Window CWI_4 ("Citrix License Warning Notice") created 1113851780.298 
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CtxWaitForWindowCreate(CWI_4, 63); 
 
// Window CWI_3 ("Please wait...") destroyed 1113851780.298 
 
// Window CWI_5 ("Citrix License Warning Notice") created 1113851780.314 
 
CtxWaitForWindowCreate(CWI_5, 15); 
 
// Window CWI_6 ("UsrLogon.Cmd") created 1113851780.330 
 
CtxWaitForWindowCreate(CWI_6, 16); 
 
// Window CWI_4 ("Citrix License Warning Notice") destroyed 1113851780.330 
 
DO_MSLEEP(78); 
// Window CWI_6 ("UsrLogon.Cmd") destroyed 1113851780.408 
 
// Window CWI_7 ("") created 1113851780.766 
 
DO_MSLEEP(344); 
// Window CWI_8 ("ICA Seamless Host Agent") created 1113851780.766 
 
CtxWaitForWindowCreate(CWI_8, 15); 
 
// Window CWI_9 ("Program Manager") created 1113851780.766 
 
CtxWaitForWindowCreate(CWI_9, 0); 
 
DO_MSLEEP(891); 
CtxPoint(333, 300);  //1113851781.718 
 
DO_MSLEEP(62); 
CtxClick(CWI_5, 141, L_BUTTON, NONE); //1113851781.859 
 
DO_MSLEEP(156); 
CtxPoint(261, 250);  //1113851782.186 
 
DO_MSLEEP(172); 
// Window CWI_5 ("Citrix License Warning Notice") destroyed 1113851782.186 
 
CtxPoint(303, 251);  //1113851782.811 
 
// Window CWI_10 ("") created 1113851782.811 
 
DO_MSLEEP(625); 
 
DO_MSLEEP(2078); 
CtxPoint(518, 254);  //1113851785.760 
 
DO_MSLEEP(875); 
// Window CWI_10 ("") destroyed 1113851785.760 

/// The following code dismisses the “ICA Seamless Host Agent”.   
/// Copy the bold section below to the original script. 
/// The DO_MSLEEP comments can also be copied. 
 
DO_MSLEEP(14000); 
CtxPoint(178, 194);  //1113851799.788 
 
DO_MSLEEP(47); 
CtxClick(CWI_8, 63, L_BUTTON, NONE); //1113851799.866 
 

/// End of code section to copy. 

DO_MSLEEP(125); 
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CtxPoint(183, 197);  //1113851799.975 
 
// Window CWI_8 ("ICA Seamless Host Agent") destroyed 1113851799.975 
 
DO_MSLEEP(1250); 
CtxPoint(609, 12);  //1113851804.469 
 
DO_MSLEEP(3250); 
// Window CWI_9 ("Program Manager") destroyed 1113851804.469 
 
// Window CWI_7 ("") destroyed 1113851804.469 
 
DO_SetTransactionCleanup(); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "Citrix License Warning Notice" 
delete CWI_5; // "Citrix License Warning Notice" 
delete CWI_6; // "UsrLogon.Cmd" 
delete CWI_7; // "" 

/// Copy this code to the original script to delete the Citrix window object. 
delete CWI_8; // "ICA Seamless Host Agent" 
delete CWI_9; // "Program Manager" 
delete CWI_10; // "" 
 
CitrixUninit(); 
 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Unexpected Events 

Unexpected Even ts in  Ci t r i x  

The CtxWindowEventExists and CtxScreenEventExists commands can be used to handle unexpected 
window and screen events in  Citrix scripts. When there is a possibi l i ty of unexpected dialogs appearing or 
unexpected screen events occurring, you must modi fy the script  to respond to the changes and cont inue 
the load test. 

For example, i f a script  opens a M icrosoft  Word document that resides on a network, and that document is 
already open by another network user, an unexpected dialog box appears that prompts the user to choose 
between cont inuing to open the document in  read-only mode or to cancel i t . To prevent script  fai lure, 
modificat ions can be made in the script  to handle the dialog boxes that appear in  th is si tuat ion.  

General ly, to handle unexpected events, you record two scripts. The first  script  contains a recording of the 
expected events. The second script  should include the unexpected events. Using the 
CtxWindowEventExists and CtxScreenEventExists funct ions, create a condit ional block of code that 
handles the dialogs that may appear. 
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M odi fying the Script  to Handle Unexpected Even ts 

Unexpected Citrix events that were not recorded in the original script  can occur during a playback session . 
These can include Intermit tent Windows or appl icat ion windows that may appear based on the user’s 
session state. For example, the calculator appl icat ion may already be present when the Citrix user logs on a 
session, or the user may need to invoke the appl icat ion.  

When there is the possibi l i ty of unexpected events occurring, you must modi fy the script  to respond to the 
changes and cont inue the load test. Use the CtxWindowEventExists funct ion to create a condit ional block 
of code that handles the unexpected dialogs.   

When you modify a script  to handle unexpected events, you must: 

!  Perform an in i t ial  val idat ion of the script . 

!  Record a temporary script  to capture the unexpected event. 

!  Modify the original script  to include and handle the unexpected event. 

!  Re-val idate the script . 

Note: You may need to configure the workbench and player for val idat ion. 

To per f orm  an in i t ial  val idat ion: 

1. Click Session>Val idate to val idate the script . This is when an unexpected event can cause sporadic 
fai lure during val idat ion or playback.  

2. Ident i fy the sporadic event visual ly so that you can recognize i t  in  a later record session. 

To record a t em porary scr ip t : 

1. Click Opt ions>Record to record a second script  that recreates the unexpected event.  Successive 
sessions should be recorded unt i l  the unexpected event occurs.  

2. Insert  comments at two points:  

!  Where the event is fi rst  recognized. 

!  Where the event is acted on and the Citrix session state and any window states have returned 
to the state before the event occurred.  

Note: You may need to posit ion the mouse over a window or control, such as a button, before 
insert ing the second comment. (See Script ing Mouse Events.)  

3. Give th is capture a name to denote th is session’s temporary status. 

4. Click Opt ions>Convert , then cl ick OK to convert  the session to a script . 

To m odi f y t he or ig inal  scr ip t  w i t h code f rom  t he t em porary scr ipt : 

Fol low these steps to insert  script  code from the temporary script  that handles the unexpected event.  

1. Insert  a code comment in  the original script  where the unexpected event occurred. 

2. Copy the code between the two comments in  the temporary script  and paste i t  in to the original 
script  at  the locat ion of the unexpected event you ident i fied.  

Note: Comments ensure that the pasted code is clearly marked in the script .   

3. Ident i fy any Citrix window objects that exist  in  API cal ls in  the pasted code snippet. For each 
object, do one of the fol lowing: 
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!  If the window object is whol ly contained, both created and destroyed, in  the pasted code 
snippet: 

a. Ident i fy the Citrix window creat ion and delet ion l ines of code in the temporary script .   

b. Copy these l ines to the original script . This is the creat ion l ine in  the /* Citrix Window 
Information Objects */  sect ion and the delet ion l ine after the END_TRANSACTION cal l .   

c. Give the Citrix window object variable a unique variable name.   

d. Change al l  variable references to the Citrix window in the pasted code snippet API cal ls to 
the new variable name. 

!  If the window object referenced in a pasted API cal l  is an act ion on an exist ing window object 
in  the original script , modify al l  API cal ls in  the pasted cal ls to refer to the variable name of the 
Citrix window object in  the original script . 

4. Before the code snippet, add a condit ional check to see i f the unexpected window event has 
occurred. Use the CtxWindowEventExists API cal l  in  an If condit ional, where i f the result  is TRUE, 
a block of code is executed. Then add a BeginBlock on the next l ine. BeginBlock is logical ly 
ident ical to the C begin brace “ {“ . 

5. After the code snippet, add an EndBlock. EndBlock is logical ly ident ical to the C end brace “ }“ . 

Note: If there is code in the original script  that should not be executed i f the condit ion is TRUE, 
 put th is code in an Else block with in the BeginBlock and EndBlock cal ls. 

To re-val idat e t he scr ipt : 

1. Click Session>Com pi le to compile the script  after making script ing changes. 

2.  Cl ick Session>Val idate Script  to val idate the script .  Make sure that val idat ion succeeds when the 
unexpected event occurs and when the event does not occur. 

Conclusion 

Fol lowing these techniques, you can modify scripts to handle unexpected events that occur during 
playback.  Script ing around unexpected events al lows you to perform load test ing for complex user 
scenarios. The fol lowing sample scripts i l lustrate th is process: 

Sample original script  

Sample modified script   

 

Sam ple: Original  Ci t r i x  Scripts for Unexpected Even ts 

The fol lowing sample shows two examples of an unexpected Citrix event. In  the first  example, the 
calculator appl icat ion must be started in  the original script .  The second example has a session where the 
calculator appl icat ion is already present when the user logs on.  Points of in terest in  the script  are 
h ighl ighted in  bold.  

Example 1: Original Record Script with No Calculator Appl icat ion Present at Logon 
/* 
 *  CalculatorCreateNew.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:33:36 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
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/* Converted using the following options: 
 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001a, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001a, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x3002e, "Please wait...", 111, 112, 418, 145); 
CtxWI *CWI_4 = new CtxWI(0x40030, "UsrLogon.Cmd", 0, 456, 161, 25); 
CtxWI *CWI_5 = new CtxWI(0x3002c, "", 0, 0, 641, 481); 
CtxWI *CWI_6 = new CtxWI(0x20026, "", -2, 452, 645, 31); 
CtxWI *CWI_7 = new CtxWI(0x10052, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_8 = new CtxWI(0x10048, "Program Manager", 0, 0, 641, 481); 
CtxWI *CWI_9 = new CtxWI(0x10084, "", 115, 0, 405, 457); 
CtxWI *CWI_10 = new CtxWI(0x20058, "Calculator", 44, 44, 261, 255); 
CtxWI *CWI_11 = new CtxWI(0x5002e, "Please wait...", 111, 112, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorCreateNew.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
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SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
 
DO_MSLEEP(1172); 
CtxPoint(172, 214); 
 
DO_MSLEEP(250); 
// Window CWI_1 ("Warning !!") created 1084811574.696 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(906); 
CtxPoint(308, 359); 
 
DO_MSLEEP(156); 
CtxClick(CWI_1, 78, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811575.899 
 
CtxWaitForWindowCreate(CWI_2); 
 
// Window CWI_1 ("Warning !!") destroyed 1084811575.899 
 
Type(CWI_2, "citrix"); 
 
DO_MSLEEP(2547); 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(328); 
Type(CWI_2, "citrix"); 
 
DO_MSLEEP(3015); 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(282); 
Type(CWI_2, "q"); 
 
DO_MSLEEP(703); 
 
DO_MSLEEP(1343); 
CtxPoint(247, 322); 
 
DO_MSLEEP(110); 
CtxClick(CWI_2, 62, L_BUTTON, NONE); 
 
DO_MSLEEP(391); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811584.685 
 
DO_MSLEEP(16); 
// Window CWI_3 ("Please wait...") created 1084811584.701 
 
CtxWaitForWindowCreate(CWI_3); 
 
DO_MSLEEP(156); 
// Window CWI_3 ("Please wait...") destroyed 1084811584.857 
 
DO_MSLEEP(156); 
// Window CWI_4 ("UsrLogon.Cmd") created 1084811585.013 
 
CtxWaitForWindowCreate(CWI_4); 
 
DO_MSLEEP(63); 
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CtxPoint(259, 322); 
 
// Window CWI_4 ("UsrLogon.Cmd") destroyed 1084811585.076 
 
DO_MSLEEP(187); 
CtxPoint(449, 462); 
 
DO_MSLEEP(63); 
// Window CWI_5 ("") created 1084811585.326 
 
DO_MSLEEP(93); 
// Window CWI_5 ("") destroyed 1084811585.420 
 
DO_MSLEEP(16); 
// Window CWI_6 ("") created 1084811585.436 
 
DO_MSLEEP(219); 
// Window CWI_7 ("ICA Seamless Host Agent") created 1084811585.654 
 
CtxWaitForWindowCreate(CWI_7); 
 
DO_MSLEEP(15); 
// Window CWI_8 ("Program Manager") created 1084811585.670 
 
CtxWaitForWindowCreate(CWI_8); 
 
DO_MSLEEP(641); 
CtxPoint(135, 347); 
 
DO_MSLEEP(3359); 
// Window CWI_9 ("") created 1084811589.672 
 
DO_MSLEEP(3032); 
CtxPoint(192, 216); 
 
// Window CWI_9 ("") destroyed 1084811592.705 
 
DO_MSLEEP(921); 
CtxPoint(190, 199); 
 
DO_MSLEEP(63); 
CtxClick(CWI_6, 78, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_7 ("ICA Seamless Host Agent") destroyed 1084811593.784 

 
/// These methods are, by placement in the script prior to the creation  
/// of the calculator window, deduced to be the actions that result in the 
/// creation of the Calculator application window. Paying attention to actions 
/// performed while recording makes this task easier. 

DO_MSLEEP(3843); 
CtxPoint(112, 98); 
 
DO_MSLEEP(282); 
CtxDoubleClick(CWI_8); 
 
DO_MSLEEP(110); 
 
DO_MSLEEP(140); 
// Window CWI_10 ("Calculator") created 1084811598.255 

 
/// Scripting Step 1: 
/// The calculator window is created at this point  
/// Working backward, we deduce that the CtxPoint and  
/// CtxDoubleClick API calls created this window. 
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CtxWaitForWindowCreate(CWI_10); 
 
DO_MSLEEP(2672); 
CtxPoint(295, 48); 
 
DO_MSLEEP(672); 
CtxClick(CWI_10, 94, L_BUTTON, NONE); 
 
// Window CWI_10 ("Calculator") destroyed 1084811601.694 
 
DO_MSLEEP(1125); 
CtxPoint(256, 95); 
 
DO_MSLEEP(281); 
// Window CWI_8 ("Program Manager") destroyed 1084811603.101 
 
// Window CWI_6 ("") destroyed 1084811603.101 
 
// Window CWI_11 ("Please wait...") created 1084811603.601 
 
CtxWaitForWindowCreate(CWI_11); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "Please wait..." 
delete CWI_4; // "UsrLogon.Cmd" 
delete CWI_5; // "" 
delete CWI_6; // "" 
delete CWI_7; // "ICA Seamless Host Agent" 
delete CWI_8; // "Program Manager" 
delete CWI_9; // "" 
delete CWI_10; // "Calculator" 
delete CWI_11; // "Please wait..." 
 
CitrixUninit(); 
 
REPORT(SUCCESS); 
EXIT(); 
return(0); 
} 

void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Example 2: Original Record Script with Calculator Appl icat ion Present at Logon 
Points of interest in the script are highlighted in bold. 
/* 
 *  CalculatorUseExisting.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:35:29 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 
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 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x20026, "", -2, 740, 1029, 31); 
CtxWI *CWI_4 = new CtxWI(0x10136, "Calculator", 154, 154, 261, 253); 
CtxWI *CWI_5 = new CtxWI(0x10048, "Program Manager", 0, 0, 1025, 769); 
CtxWI *CWI_6 = new CtxWI(0x2017c, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x5002e, "Please wait...", 303, 208, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorUseExisting.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
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DO_MSLEEP(625); 
CtxPoint(130, 78); 
 
DO_MSLEEP(797); 
// Window CWI_1 ("Warning !!") created 1084811688.065 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(1813); 
CtxPoint(309, 365); 
 
DO_MSLEEP(203); 
CtxClick(CWI_1, 140, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811690.285 
 
CtxWaitForWindowCreate(CWI_2); 
 
DO_MSLEEP(15); 
// Window CWI_1 ("Warning !!") destroyed 1084811690.300 
 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(2375); 
CtxPoint(309, 364); 
 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(813); 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(1844); 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(328); 
CtxType(CWI_2, "q"); 
 
DO_MSLEEP(672); 
 
DO_MSLEEP(1281); 
CtxPoint(241, 317); 
 
DO_MSLEEP(125); 
CtxClick(CWI_2, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(406); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811698.289 
 
DO_MSLEEP(828); 
CtxPoint(514, 358); 
 
DO_MSLEEP(125); 
// Window CWI_3 ("") created 1084811699.258 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") created 1084811699.258 

 
/// The following comment inserted during record indicates that the 
/// calculator window has appeared in the script.   
/// Since it happens before any events after the Logon window 
/// was destroyed, we know that in this session, we will not have to  
/// start the calculator application – it is already present!  

/* 
The calculator has been created at this point in the modified script! 
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*/ 
/// Scripting Step 2:  
/// The code in bold is cut and pasted into the original script 

CtxWaitForWindowCreate(CWI_4); 
 
// Window CWI_5 ("Program Manager") created 1084811699.258 
 
CtxWaitForWindowCreate(CWI_5); 
 
DO_MSLEEP(640); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1084811699.899 
 
CtxWaitForWindowCreate(CWI_6); 
 
DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1084811701.962 
 
DO_MSLEEP(672); 
CtxPoint(200, 205); 
 
DO_MSLEEP(125); 
CtxClick(CWI_3, 109, L_BUTTON, NONE); 
 
DO_MSLEEP(719); 
CtxPoint(275, 316); 
 
DO_MSLEEP(31); 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 275, 316); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 274, 316); 
 
DO_MSLEEP(812); 
CtxPoint(349, 376); 
 
DO_MSLEEP(172); 
CtxClick(CWI_4, 110, L_BUTTON, NONE); 
 
DO_MSLEEP(1297); 
CtxPoint(259, 313); 
 
DO_MSLEEP(46); 
CtxClick(CWI_4, 79, L_BUTTON, NONE); 
 
DO_MSLEEP(843); 
CtxPoint(387, 374); 
 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 387, 374); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 387, 375); 
 
DO_MSLEEP(3782); 
CtxPoint(397, 160); 
 
DO_MSLEEP(1140); 
CtxClick(CWI_4, 125, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") destroyed 1084811712.045 

/// Scripting Step 2: 
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/// This is the end of the code snippet that will be cut and pasted into the  
/// original script. 
/// The following comment inserted during record indicates that the 
/// calculator window has been destroyed.   
/// Since it happens before any events after the Logon window 
/// was destroyed, we know that in this session, we will not have to  
/// start the calculator application – it is already present!  

/* 
The calculator has been destroyed at this point in the modified script! 
*/ 
DO_MSLEEP(1469); 
CtxPoint(235, 85); 
 
DO_MSLEEP(343); 
// Window CWI_5 ("Program Manager") destroyed 1084811713.858 
 
// Window CWI_3 ("") destroyed 1084811713.858 
 
// Window CWI_7 ("Please wait...") created 1084811714.359 
 
CtxWaitForWindowCreate(CWI_7); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 
delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "" 
delete CWI_4; // "Calculator" 
delete CWI_5; // "Program Manager" 
delete CWI_6; // "ICA Seamless Host Agent" 
delete CWI_7; // "Please wait..." 
 
CitrixUninit(); 
 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 

RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

Sam ple: M odi f i ed Ci t r i x  Script  for Handl ing Unexpected Even ts 

The fol lowing sample shows a Citrix script  that is modified to address whether the calculator appl icat ion is 
present is present at logon. Changes to Original script  are h ighl ighted in  bold. 

Sample Script  
/* 
 *  CalculatorUseExisting.cpp 
 * 
 *  Script Converted on May 17, 2004 at 12:35:29 PM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 33 
 * 
 *  This script contains support for the following middlewares:  
 *      - Citrix 
 */ 
/* Converted using the following options: 



QALoad Online Help 

213 

 * General: 
 *  Line Split                       : 80 characters 
 *  Sleep Seconds                    : 1 
 *  Auto Checkpoints                 : No 
 * Citrix 
 *  General Options                  :  
 *   Window Verification             : Yes 
 *   Session Timeouts                : Yes 
 *    Connect Timeout (s)            : 60 
 *    Disconnect Timeout (s)         : 60 
 *    Window Creation Timeout (s)    : 30 
 *    Ping Timeout (s)               : 20 
 *    Wait Point Timeout (s)         : 30 
 *   Include Wait Points             : Yes 
 *   Enable Counters                 : No 
 *   Include Unnamed Windows         : Yes 
 *   Output Mode                     : Normal 
 *  Input Options                    :  
 *   Combine Keyboard Input          : Yes 
 *   Combine Mouse Input             : Yes 
 */ 
#define CITRIX_CLIENT_VERSION "7.100.21825" 
#define CITRIX_ICO_VERSION    "2.3" 
#define SCRIPT_VER 0x00000205UL 
#include <stdio.h> 
#include "smacro.h" 
#include "do_citrix.h" 
/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
#ifndef NULL 
#define NULL  0 
#endif 
extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 
const char *CitrixServer      = "qaccitrix2"; 
const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 
 
/* Citrix Window Information Objects */ 
CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 
CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 
CtxWI *CWI_3 = new CtxWI(0x20026, "", -2, 740, 1029, 31); 
CtxWI *CWI_4 = new CtxWI(0x10136, "Calculator", 154, 154, 261, 253); 
CtxWI *CWI_5 = new CtxWI(0x10048, "Program Manager", 0, 0, 1025, 769); 
CtxWI *CWI_6 = new CtxWI(0x2017c, "ICA Seamless Host Agent", 0, 0, 391, 224); 
CtxWI *CWI_7 = new CtxWI(0x5002e, "Please wait...", 303, 208, 418, 145); 
 
SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("CalculatorUseExisting.cpp"); 
CitrixInit(1); 
/* Citrix replay settings */ 
CtxSetConnectTimeout(60); 
CtxSetDisconnectTimeout(60); 
CtxSetWindowTimeout(30); 
CtxSetPingTimeout(20); 
CtxSetWaitPointTimeout(30); 
CtxSetWindowVerification(TRUE); 
CtxSetEnableCounters(FALSE); 
CtxSetWindowRetries(5, 5000); 
CtxSetEnableWildcardMatching(TRUE); 
 
SYNCHRONIZE(); 
BEGIN_TRANSACTION(); 
CtxConnect(CitrixServer, CitrixOutputMode); 
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DO_MSLEEP(625); 
CtxPoint(130, 78); 
 
DO_MSLEEP(797); 
// Window CWI_1 ("Warning !!") created 1084811688.065 
 
CtxWaitForWindowCreate(CWI_1); 
 
DO_MSLEEP(1813); 
CtxPoint(309, 365); 
 
DO_MSLEEP(203); 
CtxClick(CWI_1, 140, L_BUTTON, NONE); 
 
DO_MSLEEP(63); 
// Window CWI_2 ("Log On to Windows") created 1084811690.285 
 
CtxWaitForWindowCreate(CWI_2); 
 
DO_MSLEEP(15); 
// Window CWI_1 ("Warning !!") destroyed 1084811690.300 
 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(2375); 
CtxPoint(309, 364); 
 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(813); 
CtxType(CWI_2, "citrix"); 
 
DO_MSLEEP(1844); 
CtxTypeVK(CWI_2, VK_TAB, NONE); 
 
DO_MSLEEP(328); 
CtxType(CWI_2, "q"); 
 
DO_MSLEEP(672); 
 
DO_MSLEEP(1281); 
CtxPoint(241, 317); 
 
DO_MSLEEP(125); 
CtxClick(CWI_2, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(406); 
// Window CWI_2 ("Log On to Windows") destroyed 1084811698.289 
 
DO_MSLEEP(828); 
CtxPoint(514, 358); 
 
DO_MSLEEP(125); 
// Window CWI_3 ("") created 1084811699.258 
 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") created 1084811699.258 

 
/// Here is where we can determine that either the Calculator application  
/// exists in this session or it needs to be created.    

/// Scripting Step  
if(CtxWindowEventExists("WindowCreate", 4000, "Calculator", ""))  

/// If the window exists, the block below will be  
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/// executed. 

 BeginBlock();  

/// Scripting Step 2: 
/// The following code was cut and pasted from the second script.  

/// Scripting Step 3:  
/// All Citrix window object name references have been reconciled with the 
/// correct Citrix window object definition. 
 

CtxWaitForWindowCreate(CWI_4); 
 
// Window CWI_5 ("Program Manager") created 1084811699.258 
 
CtxWaitForWindowCreate(CWI_5); 
 
DO_MSLEEP(640); 
// Window CWI_6 ("ICA Seamless Host Agent") created 1084811699.899 
 
CtxWaitForWindowCreate(CWI_6); 
 
DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 
 
DO_MSLEEP(16); 
// Window CWI_6 ("ICA Seamless Host Agent") destroyed 1084811701.962 
 
DO_MSLEEP(672); 
CtxPoint(200, 205); 
 
DO_MSLEEP(125); 
CtxClick(CWI_3, 109, L_BUTTON, NONE); 
 
DO_MSLEEP(719); 
CtxPoint(275, 316); 
 
DO_MSLEEP(31); 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 275, 316); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 274, 316); 
 
DO_MSLEEP(812); 
CtxPoint(349, 376); 
 
DO_MSLEEP(172); 
CtxClick(CWI_4, 110, L_BUTTON, NONE); 
 
DO_MSLEEP(1297); 
CtxPoint(259, 313); 
 
DO_MSLEEP(46); 
CtxClick(CWI_4, 79, L_BUTTON, NONE); 
 
DO_MSLEEP(843); 
CtxPoint(387, 374); 
 
CtxMouseDown(CWI_4, L_BUTTON, NONE, 387, 374); 
 
CtxMouseUp(CWI_4, L_BUTTON, NONE, 387, 375); 
 
DO_MSLEEP(3782); 
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CtxPoint(397, 160); 
 
DO_MSLEEP(1140); 
CtxClick(CWI_4, 125, L_BUTTON, NONE); 

/// Scripting Step 5: 
/// Here is the end of the code snippet, so an EndBlock goes here. 

EndBlock() 

/// Scripting Step 6: 
/// The original behavior has been put into the else 
/// section of the if conditional between BeginBlock 
/// and EndBlock commands. 

else  
BeginBlock(); 

DO_MSLEEP(1672); 
CtxPoint(200, 195); 
 
DO_MSLEEP(234); 
CtxClick(CWI_6, 141, L_BUTTON, NONE); 

DO_MSLEEP(3843); 
CtxPoint(112, 98); 
 
DO_MSLEEP(282); 
CtxDoubleClick(CWI_5); 

CtxWaitForWindowCreate(CWI_4); 
 
DO_MSLEEP(2672); 
CtxPoint(295, 48); 
 
DO_MSLEEP(672); 
CtxClick(CWI_4, 94, L_BUTTON, NONE); 

 
EndBlock();  

 
DO_MSLEEP(16); 
// Window CWI_4 ("Calculator") destroyed 1084811712.045 
 
DO_MSLEEP(1469); 
CtxPoint(235, 85); 
 
DO_MSLEEP(343); 
// Window CWI_5 ("Program Manager") destroyed 1084811713.858 
 
// Window CWI_3 ("") destroyed 1084811713.858 
 
// Window CWI_7 ("Please wait...") created 1084811714.359 
 
//CtxWaitForWindowCreate(CWI_7); 
 
CtxDisconnect(); 
 
END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 
delete CWI_2; // "Log On to Windows" 
delete CWI_3; // "" 
delete CWI_4; // "Calculator" 
delete CWI_5; // "Program Manager" 
delete CWI_6; // "ICA Seamless Host Agent" 
delete CWI_7; // "Please wait..." 
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CitrixUninit(); 
 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 
void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
 
CitrixUninit(); 
 
EXIT(); 

} 

 

Scripting Mouse Actions 

M odi fying the Script  for Con t rol l i ng M ouse Act ions  

Changes to screen resolut ion or server sett ings can cause the appearance, size, and locat ion coordinates of 
a window to differ from the expected behavior in  the recorded script . By sett ing Display coordinate 
tool t i p on  r i gh t -cl i ck  opt ion  in  val idat ion  w indow  in the Convert  Opt ions dialog box, you can right-
cl ick the mouse at the desired locat ion to extract screen coordinate values that correspond to buttons and 
other controls in  real t ime during val idat ion .  

To modify a script  to retrieve coordinate values, you must: 

!  Validate the sett ings. 

!  Modify the script . 

To val idat e t he set t ings: 

1. Click Opt ions>Convert , and cl ick the Ci t r i x  tab.  

2. Ensure that the Display coordinate tool t i p on  r i gh t -cl i ck  opt ion  in  val i dat ion  w indow  
checkbox is selected.  

3. Set Replay output  m ode to Normal. 

4. Click OK to convert  the script . 
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During val idat ion, a right mouse-cl ick results in  a toolt ip display of the screen coordinate values. You can 
use these values in  a manually added CtxPoint cal l  to ensure that the mouse is moved to these coordinates 
before any subsequent mouse cl ick act ions. 

Tip: Make a note of these coordinate values, since th is toolt ip is not logged. 
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To m odi f y t he scr ipt : 

Once you determine the correct mouse coordinates from val idat ion, modify the script .  

1. Add or modify the CtxPoint command. 

2. Insert  the new values in to the script . 

Conclusion 

Fol lowing these techniques, you can retrieve screen coordinates at val idat ion and insert  them into a script . 
This corrects mouse behavior as a result  of changes to the server sett ings or the user session environment. 
The sample scripts, showing added CtxPoint and CtxMouseClick, and modified CtxPoint, i l lustrate these 
techniques. 

Sam ple: Script  Sn ippet  w i th  M odi f i ed CtxPoin t  

The fol lowing sample shows a script  extract with a modified CtxPoint command. Comments and added 
script  l ines are h ighl ighted in  bold. 

Sample Script  
…beginning of script… 

DO_MSLEEP(1844); 
// Window CWI_10 ("") destroyed 1113840796.133 
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DO_MSLEEP(1828); 

/// Modifying a CtxPoint is easy once you have the 
/// target coordinates and have identified the  
/// CtxClick statement that was failing. Just 
/// insert the X and Y coordinates as the parameters. 

CtxPoint(200, 200);  //1113840798.309 
 
DO_MSLEEP(344); 
CtxClick(CWI_5, 78, L_BUTTON, NONE); //1113840798.387 

…end of script… 
 

CtxWaitForScreenUpdate Command 

Using the CtxWai tForScreenUpdate Com m and 

In some situat ions, a window may vary in  how long i t  takes to refresh on the screen. For example, the 
Windows Start  menu is an unnamed window that can take varying amounts of t ime to appear, depending 
on system resource usage. To prevent playback problems in which a mouse cl ick does not synchronize with 
i ts in tended window, insert  the CtxWaitForScreenUpdate command in the script  after the act ion that 
causes the window to appear. The parameters for the CtxWaitForScreenUpdate command correspond to 
the X and Y coordinates and the width and height of the window. This command ensures that the window 
has enough t ime to display before the mouse cl ick. 

 

M odi fying the Script  w i th  the CtxWai tForScreen Update Com m and 

Windows in a Citrix session can take varying amounts of t ime to complete screen updates. This can result  
in  keyboard and mouse events not synchronizing with the appropriate window.  

For example, the Windows Start  menu is an unnamed window. The amount of t ime i t  takes to appear 
depends on system resource usage. Adding a CtxWaitForScreenUpdate command before the keyboard entry 
or mouse cl ick can ensure that the window has enough t ime to display before any subsequent mouse cl icks 
or keyboard entries take place. You can add the command while recording a script  or after a script  has been 
recorded. 

Note: When recording a session with windows that load slowly, pay attent ion to the ScreenUpdate 
messages that scrol l  in  the message panel.  

Once the window has completed loading, add CtxWaitForScreenUpdate. 

To add Ct xW ait ForScreenUpdat e w hi le r ecording a session: 

1. Click  Insert  Wai tPoin t . An expanded l ist  of log entries appears.  

2. Select the last ScreenUpdate message in the log entry to h ighl ight the l ine. 

3. Click OK to insert  a statement in  the record session.  The statement is converted to a 
CtxWai tForScreenUpdate command in the script , which waits for the screen update before 
proceeding. 

Note: Anyt ime a window loads slowly or has the potent ial  to load slowly during a Citrix record 
session, such as when traffic is heavy, consider using th is technique before performing any keyboard or 
mouse act ivi ty on that window.  
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To add Ct xW ait ForScreenUpdat e t o an  exist ing scr ip t : 

Manually enter the CtxW ai tForScreenUpdate before the keyboard or mouse event that is fi ring 
prematurely.   

Note: To prevent playback problems in which a mouse cl ick does not synchronize with i ts in tended 
window, insert  the command in the script  after the act ion that causes the window to appear. You also 
can use CtxScreenEventExists to clear past events from the in ternal queue and ensure that the script  
waits for a specific screen update event. 

The parameters for the CtxWaitForScreenUpdate command correspond to the X and Y coordinates, and 
the width and height of the window. Determine the parameters from the Citrix window object declarat ion 
parameters. 

Conclusion 

Fol lowing these techniques, you can prevent problems with premature mouse cl icks and keyboard entry 
statements during replay. The fol lowing sample scripts i l lustrate th is process: 

Sample: Using the command while recording 

Sample: Using the command after recording 
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Clearing Events from the Internal Queue 

Clearing Even ts f rom  the In ternal  Queue 

In response to mouse and keyboard input, the Citrix server sends screen update events of the updated 
screen image to the Citrix cl ient appl icat ion. You can synchronize these screen update events with the text 
or graphic updates in  the appl icat ion by using CtxWaitForScreenUpdate to insert  waitpoints in  the Citrix 
script .  

When numerous matching screen update events occur, such as the flashing edit  cursor, they stay in  the 
in ternal queue indefin i tely. This can cause the CtxWaitForScreenUpdate funct ion to complete prematurely 
by matching events with previously stored screen updates. You can clear the in ternal queue by using the 
CtxScreenEventExists funct ion in  a simple loop. Th is flushes al l  past screen update events from the 
in ternal queue, so a fol lowing CtxWaitForScreenUpdate can successful ly wai t  for the next occurrence of 
the desired screen update event.  

 

M odi fying the Script  to Clear Even ts 

Synchronize keyboard and mouse events with the appropriate appl icat ion events in  a Citrix script , using 
CtxWaitForScreenUpdate to ident i fy specific screen events and CtxScreenEventExists to flush al l  past 
screen update events from the in ternal queue. This enables a fol lowing CtxWaitForScreenUpdate to 
successful ly wait  for the next occurrence of the desired screen update event. 

To m odi f y an exist ing  Ci t r ix  scr ip t  t hat  cont ains one or  m ore Ct xW ai t ForScreenUpdat e 
com m ands: 

1. Open the script  in  QALoad Script Development Workbench. 

2. If not already act ive, select View >Funct ion  Wizard. 

3. Copy the exist ing CtxWai tForScreenUpdate command from the script , and paste i t  immediately 
above the exist ing command. 

4. In  the Com m and Def in i t i on  pane, cl ick the plus (+) or double-cl ick the Ci t r i x  heading. The l ist  of 
Citrix commands appears. 

5. Click and drag the CtxScreenEven tEx ists command from the Com m and Def in i t i on  pane to the 
l ine above the first   CtxW ai tForScreenUpdate command. The CtxScreenEventExists funct ion 
prototype appears and the suggested parameter EVT_STR_CTXSCREENUPDATE displays in  a 
separate dialog box. 

6. Double-cl ick EVT_STR_CTXSCREENUPDATE. The parameter is inserted in  the command. 

7. After the EVT_STR_CTXSCREENUPDATE parameter, type:  

, 0, " ") 

8. Inside the quotat ion marks, type the four numeric values from the CtxWai tForScreen Update 
command. Separate the values by spaces instead of commas, for example:  

"66 66 457 336" 

9. Enclose the statement with the command:   

while (     ) 

In  th is example, the script  now appears as: 

while (CtxScreenEventExists(EVT_STR_CTXSCREENUPDATE, 0, "43 39 569 401")) 

CtxWaitForScreenUpdate(43, 39, 569, 401, 0); 

CtxWaitForScreenUpdate(43, 39, 569, 401, 3917); 



QALoad Online Help 

223 

Note: The t imeout value for both the CtxScreenEven tEx ists and CtxWai tForScreenUpdate 
commands is set to zero, since no actual wait ing occurs in  either command. 

Conclusion 

Use th is technique to prevent problems with extra screen update events causing premature matching when 
using a CtxWaitForScreenUpdate command during script  replay. The fol lowing sample scripts i l lustrate 
th is process. 

Sample: Original Citrix Script  

Sample: Modified Citrix Script  

 

Sam ple: Original  Ci t r i x  Script  using CtxW ai tForScreenUpdate 

The fol lowing sample shows a script  with the CtxWaitForScreenUpdate inserted during the script  capture. 
The relevant port ion of the script  is h ighl ighted in  bold. 

Sample Script  

/* 

 *  CtxScreenEventExistsScript.cpp 

 * 

 *  Script Converted on March 22, 2006 at 04:34:21 PM 

 *  Generated by Compuware QALoad convert module version 5.5.0 build 478 

 *  Generated From: C:\Program 
Files\Compuware\QALoad\Middlewares\Citrix\Captures\CtxScreenEventExistsScript.cap 

 * 

 *  This script contains support for the following middlewares:  

 *      - Citrix 

 */ 

/* Converted using the following options: 

 * General: 

 *  Line Split                       : 80 characters 

 *  Sleep Seconds                    : 1 

 *  Auto Checkpoints                 : No 

 * Citrix 

 *  General Options                  :  

 *   Replay Output Mode              : Normal 

 *   Enable Counters                 : No 

 *  Timeout Value Options            :  

 *    Connect Timeout (s)            : 60 

 *    Disconnect Timeout (s)         : 60 

 *    Window Creation Timeout (s)    : 30 

 *    Ping Timeout (s)               : 20 
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 *    Wait Point Timeout (s)         : 30 

 *  Input Options                    :  

 *   Combine Keyboard Input          : Yes 

 *   Combine Mouse Input             : Yes 

 *  Window Options                   :  

 *   Window Verification             : Yes 

 *    Window Max Retries             : 5 

 *    Window Wait Retries (ms)       : 5000 

 *   Enable Wildcard Title Match     : Yes 

 */ 

#define CITRIX_CLIENT_VERSION "9.150.39151" 

#define CITRIX_ICO_VERSION    "2.5" 

#define SCRIPT_VER 0x00000505UL 

#include <stdio.h> 

#include "smacro.h" 

#include "do_citrix.h" 

/* set function to call on abort*/ 

void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 

#define NULL  0 

#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 

{ 

/* Declare Variables */ 

const char *CitrixServer      = "qaccitrix"; 

const char *CitrixPassword    = ""; 

const int   CitrixOutputMode  = OUTPUT_MODE_NORMAL; 

 

/* Citrix Window Information Objects */ 

CtxWI *CWI_1 = new CtxWI(0x1001c, "Warning !!", 107, 43, 427, 351); 

CtxWI *CWI_2 = new CtxWI(0x2001c, "Log On to Windows", 111, 65, 418, 285); 

CtxWI *CWI_3 = new CtxWI(0x5001c, "Please wait...", 111, 112, 418, 145); 

CtxWI *CWI_4 = new CtxWI(0x30030, "Citrix License Warning Notice", 125, 198, 397, 
127); 

CtxWI *CWI_5 = new CtxWI(0x40030, "Citrix License Warning Notice", 125, 198, 397, 
127); 

CtxWI *CWI_6 = new CtxWI(0x4002e, "UsrLogon.Cmd", 0, 456, 161, 25); 

CtxWI *CWI_7 = new CtxWI(0x1003a, "", -2, 452, 645, 31); 
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CtxWI *CWI_8 = new CtxWI(0x10066, "ICA Seamless Host Agent", 0, 0, 391, 224); 

CtxWI *CWI_9 = new CtxWI(0x10052, "Program Manager", 0, 0, 641, 481); 

CtxWI *CWI_10 = new CtxWI(0x10054, "", 2, 49, 205, 408); 

CtxWI *CWI_11 = new CtxWI(0x20068, "Run", 5, 269, 348, 180); 

CtxWI *CWI_12 = new CtxWI(0x10116, "", 65, 369, 254, 30); 

CtxWI *CWI_13 = new CtxWI(0x20114, "Untitled - Notepad", 43, 39, 569, 401); 

CtxWI *CWI_14 = new CtxWI(0x30068, "", 47, 80, 151, 144); 

CtxWI *CWI_15 = new CtxWI(0x40068, "Open", 47, 81, 564, 348); 

CtxWI *CWI_16 = new CtxWI(0x10130, "", 249, 386, 226, 30); 

CtxWI *CWI_17 = new CtxWI(0x7001c, "Please wait...", 111, 112, 418, 145); 

 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("NotepadSampleForDoc.cpp"); 

CitrixInit(1); 

/* Citrix replay settings */ 

CtxSetConnectTimeout(60); 

CtxSetDisconnectTimeout(60); 

CtxSetWindowTimeout(30); 

CtxSetPingTimeout(20); 

CtxSetWaitPointTimeout(30); 

CtxSetWindowVerification(TRUE); 

CtxSetEnableCounters(FALSE); 

CtxSetWindowRetries(5, 5000); 

CtxSetEnableWildcardMatching(TRUE); 

CtxSetGracefulDisconnect(TRUE); 

 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

CtxConnect(CitrixServer, CitrixOutputMode); 

CtxPoint(341, 298);  //1143063207.863 

// Window CWI_1 ("Warning !!") created 1143063207.863 

CtxWaitForWindowCreate(CWI_1, 843); 

 

DO_MSLEEP(1094); 

CtxPoint(320, 366);  //1143063209.160 
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DO_MSLEEP(203); 

CtxClick(CWI_1, 157, L_BUTTON, NONE); //1143063209.316 

 

// Window CWI_1 ("Warning !!") destroyed 1143063209.395 

 

CtxPoint(320, 365);  //1143063209.473 

 

// Window CWI_9 ("Program Manager") created 1143063210.348 

 

CtxWaitForWindowCreate(CWI_9, 0); 

 

DO_MSLEEP(1437); 

CtxPoint(32, 469);  //1143063214.676 

 

DO_MSLEEP(94); 

CtxClick(CWI_7, 0, L_BUTTON, NONE); //1143063214.816 

 

// Window CWI_10 ("") created 1143063214.816 

 

DO_MSLEEP(125); 

 

DO_MSLEEP(1391); 

CtxPoint(52, 369);  //1143063216.332 

 

DO_MSLEEP(140); 

CtxClick(CWI_7, 125, L_BUTTON, NONE); //1143063216.457 

 

// Window CWI_11 ("Run") created 1143063216.488 

 

CtxWaitForWindowCreate(CWI_11, 31); 

 

DO_MSLEEP(16); 

// Window CWI_10 ("") destroyed 1143063216.504 

 

CtxType(CWI_11, "notepad");  //1143063218.051 
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DO_MSLEEP(1312); 

 

DO_MSLEEP(63); 

// Window CWI_12 ("") destroyed 1143063219.426 

 

DO_MSLEEP(16); 

CtxTypeVK(CWI_11, VK_RETURN, NONE);  //1143063219.582 

 

DO_MSLEEP(140); 

// Window CWI_13 ("Untitled - Notepad") created 1143063219.582 

 

CtxWaitForWindowCreate(CWI_13, 0); 

 

// Window CWI_11 ("Run") destroyed 1143063219.582 

 

DO_MSLEEP(31); 

 

DO_MSLEEP(3563); 

CtxPoint(55, 71);  //1143063223.316 

 

DO_MSLEEP(141); 

CtxClick(CWI_13, 16, L_BUTTON, NONE); //1143063223.441 

 

// Window CWI_14 ("") created 1143063223.426 

 

DO_MSLEEP(109); 

 

DO_MSLEEP(1156); 

CtxPoint(74, 111);  //1143063224.832 

 

DO_MSLEEP(234); 

CtxClick(CWI_13, 72, L_BUTTON, NONE); // 1143063224.832 

 

DO_MSLEEP(110); 

CtxPoint(74, 112);  //1143063225.004 

 

DO_MSLEEP(62); 
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// Window CWI_14 ("") destroyed 1143063225.004 

 

// Window CWI_15 ("Open") created 1143063225.176 

 

CtxWaitForWindowCreate(CWI_15, 172); 

 

CtxType(CWI_15, "bigfile.txt");  //1143063229.410 

 

DO_MSLEEP(4000); 

CtxPoint(151, 149);  //1143063229.410 

 

// Window CWI_16 ("") created 1143063229.410 

 

DO_MSLEEP(78); 

// Window CWI_16 ("") destroyed 1143063232.379 

 

DO_MSLEEP(63); 

CtxTypeVK(CWI_15, VK_RETURN, NONE);  //1143063234.441 

 

DO_MSLEEP(1906); 

 

DO_MSLEEP(15); 

// Window CWI_15 ("Open") destroyed 1143063234.363 

 

DO_MSLEEP(79); 

 

DO_MSLEEP(1218); 

CtxPoint(157, 1);  //1143063235.926 

 

DO_MSLEEP(266); 

 

CWI_13->setTitle("bigfile.txt - Notepad"); //1143063243.035 

 

DO_MSLEEP(5453); 

CtxPoint(594, 48);  //1143063244.441 
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/// 

/// This waitpoint was inserted during the Citrix session capture: 

/// 

CtxWaitForScreenUpdate(43, 39, 569, 401, 2406); 

 

DO_MSLEEP(657); 

CtxClick(CWI_13, 171, L_BUTTON, NONE); //1143063244.613 

 

DO_MSLEEP(94); 

// Window CWI_13 ("bigfile.txt - Notepad") destroyed 1143063244.707 

 

DO_MSLEEP(594); 

CtxPoint(567, 6);  //1143063247.582 

 

DO_MSLEEP(2281); 

// Window CWI_9 ("Program Manager") destroyed 1143063247.582 

 

// Window CWI_7 ("") destroyed 1143063247.645 

 

// Window CWI_17 ("Please wait...") created 1143063247.926 

 

CtxWaitForWindowCreate(CWI_17, 0); 

 

DO_SetTransactionCleanup(); 

 

CtxDisconnect(); 

 

END_TRANSACTION(); 

delete CWI_1; // "Warning !!" 

delete CWI_2; // "Log On to Windows" 

delete CWI_3; // "Please wait..." 

delete CWI_4; // "Citrix License Warning Notice" 

delete CWI_5; // "Citrix License Warning Notice" 

delete CWI_6; // "UsrLogon.Cmd" 

delete CWI_7; // "" 

delete CWI_8; // "ICA Seamless Host Agent" 
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delete CWI_9; // "Program Manager" 

delete CWI_10; // "" 

delete CWI_11; // "Run" 

delete CWI_12; // "" 

delete CWI_13; // "Untitled - Notepad" 

delete CWI_14; // "" 

delete CWI_15; // "Open" 

delete CWI_16; // "" 

delete CWI_17; // "Please wait..." 

 

CitrixUninit(); 

 

EXIT(); 

return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 

{ 

RR__printf("Virtual User ABORTED."); 

 

CitrixUninit(); 

 

EXIT(); 

} 

 

OFS Scripts 

Oracle Forms Server Script Samples 

You can address specific si tuat ions or resolve certain  problems by modifying converted Oracle Forms Server 
(OFS) scripts. The samples shown here include a descript ion of the problem, the procedure for 
implementing the modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Parameterizat ion of Login Credent ials 

Changing Accessibi l i ty Options in  Oracle EBS-12 

 

Parameterization of Logon Credentials 

M odi fying the OFS Script  to Param eteri ze Logon  Creden t ial s  
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If your load test ing environment for Oracle Forms Server prevents a user from being logged in multiple 
t imes concurrent ly, you may need to parameterize the logon information.  This means creat ing unique 
values for the username and password of each virtual user (VU) and transact ion. 

To scr ip t  param et ers f or  logon in f orm at ion:  

1. Create a datapool that contains user names and passwords for the system you are test ing. 

2. Modify the script  to open the datapool, read the username and password from the datapool, and 
use the values in  the ofsSetLogonUserName() and ofsSetLogonPassWord() script  commands.  

Conclusion 

The sample script  i l lustrates the parameterizat ion of logon credent ials. 

 

SAP Scripts 

SAP Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted SAP scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Script  modificat ions are discussed for: 

Checking and Handling SAPGuiCheckScreen Errors 

Checking the SAP Status Bar 

Extract ing a String from a SAP Control 

Extract ing a Unique String from a SAP Control 

Handling Mult iple SAP Logons in a Single Script  

Implementing Content Check of a SAP Control 

Required SAP Commands to Support Transact ion Restart  

Required SAP Script Commands 

Retrieving SAP Counter Data 

 

 

Checking and Handling SAPGuiCheckScreen Errors 

Overview : Handl ing SAPGuiCheckScreen  Errors 

The SAP screen returned from the SAP server during playback can differ from the screen status of the 
session during record. The SAPGuiCheckScreen cal l  returns a Boolean value that indicates whether the 
screen status is expected or unexpected.  By checking the status returned from th is cal l , you can bui ld more 
extensive error handl ing capabi l i ty in to the script .  

Create custom error handl ing code by placing the SAPGuiCheckScreen cal l  wi th in an If condit ional that 
checks the return value, then writ ing custom error handl ing code for the funct ions that fai l  with in that 
condit ional block.  

The sample script   shows the code for creat ing error code blocks to use with checking the status of a 
returned SAP screen. 
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Checking the SAP Status Bar 

Overview : Check ing the Status Bar 

The SAP status bar displays error and status messages. When running an SAP script , you can check the 
status bar to determine whether the script  is execut ing properly.  

 

Conclusion 

Use the SAPGuiCheckStatusbar command to test for certain status responses in the SAP environment and 
take act ions based on messages returned from the SAP server. The sample script  i l lustrates th is procedure. 

 

Sam ple Script : Check ing the SAP Status Bar  

The SAPGuiCheckStatusbar command is used in the fol lowing script  example to test for certain status 
responses. The code added to check the status bar is shown in bold. 

Sample Script  
... 
SAPGuiPropIdStr("wnd[0]");//1109615021.466 
SAPGuiCmd1(GuiMainWindow,SendVKey,4); 
SAPGuiCheckScreen("PA40","SAPMP50A","Personnel Actions");  //1109615021.481 
 
DO_SLEEP(15); 
 
SAPGuiPropIdStr("" 
   "wnd[1]/usr/tabsG_SELONETABSTRIP/tabpTAB001/ssubSUBSCR_PRESEL:SAPLSDH4:0220/sub:" 
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"SAPLSDH4:0220/txtG_SELFLD_TAB-LOW[0,24]" ); //1109615036.231 
SAPGuiCmd1(GuiTextField,PutText,"pan"); 
SAPGuiCmd1(GuiTextField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]");//1109615036.246 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("PA40","SAPLSDH4","Restrict Value Range"); //1109615036.246 
 
// Check to determine if the name we chose is found in db 
// If not stop the script should not continue 
BOOL bRetSts =  
SAPGuiCheckStatusbar("wnd[0]/sbar", "No values for this selection"); 
if (bRetSts) 
{ 
    RR__printf(" No such last name in Database"); 
    SAPGui_error_handler(s_info," End Now No such name in Database"); 
} 
... 

Extracting a String from a SAP Control 

Overview : Ex t ract ing a St r ing f rom  a SAP Con t rol  

When running an SAP script , you may want to get the control ’s text.  

For example, in  the fol lowing screen, after Chi ld1 Col. 2 is selected, the right table is fi l led in  with data by 
the SAP server. You can use the in formation as needed.  

 

Use the SAPGuiGetControlText command to extract  data from a SAP server returned control. The sample 
script  i l lustrates th is procedure. 

 

Sam ple: Ex t ract ing a St r ing f rom  a SAP Con t rol  

The fol lowing sample script  shows the SAP commands required  to extract a data string from a returned 
control in  an SAP environment. You can use SAPGuiGetControlText to get the content of the Even t  nam e 
textfield. Use convert  opt ion I nser t  SAP cont r ol  comment s:  al l  cont r ol s to output al l  controls as 
comment.  



Using the Player, Script  Development Workbench, and Analyze 

234 

Sample Script 
 

SAPGuiPropIdStr("wnd[0]/usr/cntlTREE_CONTAINER/shellcont/shell" 
        );//1152817068.134 

SAPGuiCmd2(GuiCtrlTree,SelectItem,"Child1","Column2"); 
SAPGuiCmd2(GuiCtrlTree,EnsureVisibleHorizontalItem,"Child1","Column2"); 
SAPGuiCmd2(GuiCtrlTree,PressButton,"Child1","Column2"); 
SAPGuiCheckScreen("DWDM","SAPCOLUMN_TREE_CONTROL_DEMO","SAP");//1152817068.321 
 

// *SAP* GuiMenubar   name="mbar"   Id="wnd[0]/mbar" 
// *SAP* GuiMenu   name="System"   Id="wnd[0]/mbar/menu[0]" 
// *SAP* GuiMenu   name="Create Session"   Id="wnd[0]/mbar/menu[0]/menu[0]" 
// *SAP* GuiMenu   name="End Session"   Id="wnd[0]/mbar/menu[0]/menu[1]" 
// *SAP* GuiMenu   name="User Profile"   Id="wnd[0]/mbar/menu[0]/menu[2]" 

                        ….. 
                      // *SAP* GuiLabel   name="%#AUTOTEXT004" 
  Id="wnd[0]/usr/lbl%#AUTOTEXT004" 

// *SAP* GuiTextField   name="G_EVENT"   Id="wnd[0]/usr/txtG_EVENT" 
// *SAP* GuiLabel   name="%#AUTOTEXT002"   Id="wnd[0]/usr/lbl%#AUTOTEXT002" 
// *SAP* GuiTextField   name="G_NODE_KEY"   Id="wnd[0]/usr/txtG_NODE_KEY" 
// *SAP* GuiLabel   name="%#AUTOTEXT005"   Id="wnd[0]/usr/lbl%#AUTOTEXT005" 

// *SAP* GuiTextField   name="G_ITEM_NAME"   Id="wnd[0]/usr/txtG_ITEM_NAME" 
// *SAP* GuiLabel   name="%#AUTOTEXT006"   Id="wnd[0]/usr/lbl%#AUTOTEXT006" 
// *SAP* GuiTextField   name="G_HEADER_NAME"   Id="wnd[0]/usr/txtG_HEADER_NAME" 
// *SAP* GuiStatusbar   name="sbar"   Id="wnd[0]/sbar" 
// *SAP* GuiStatusPane   name="pane[0]"   Id="wnd[0]/sbar/pane[0]" 
// *SAP* GuiStatusPane   name="pane[1]"   Id="wnd[0]/sbar/pane[1]" 
// *SAP* GuiStatusPane   name="pane[2]"   Id="wnd[0]/sbar/pane[2]" 
// *SAP* GuiStatusPane   name="pane[3]"   Id="wnd[0]/sbar/pane[3]" 
// *SAP* GuiStatusPane   name="pane[4]"   Id="wnd[0]/sbar/pane[4]" 
// *SAP* GuiStatusPane   name="pane[5]"   Id="wnd[0]/sbar/pane[5]" 

        // Check the event name 
char * strEvent = SAPGuiGetControlText("wnd[0]/usr/txtG_EVENT", "GuiTextField"); 
RR__printf(" The Event Name: %s", strEvent); 
free(strEvent); 

 

 

Extracting a Unique String from a SAP Control 

Overview : Ex t ract ing a Un ique St ring f rom  a SAP Con t rol  

When running an SAP script , you may want to get the unique string from the control ’s text between two 
strings. 
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Use the SAPGuiGetUniqueString command to extract data from an SAP server returned control that occurs 
between the left  and right input strings. The sample script  i l lustrates th is procedure.  

 

Sam ple: Ex t ract ing a Un ique St ring f rom  a SAP Con t rol  

The fol lowing sample script  shows the SAP commands required to extract a data string from a returned 
control in  an SAP environment. You can use SAPGuiGetUniqueString to get the unique string of the Even t  
nam e text field between ITEM and CLICK.  

Use convert  opt ion Insert SAP control comments: Textfields and Statusbars to output 
textfield and statusbar as comments in  the script .  

Sample Script  
 

SAPGuiPropIdStr("wnd[0]/usr/cntlTREE_CONTAINER/shellcont/shell" 
        );//1152820409.712 

SAPGuiCmd1(GuiCtrlTree,ExpandNode,"Root"); 
SAPGuiCmd1(GuiCtrlTree,ExpandNode,"Child1"); 
SAPGuiCmd2(GuiCtrlTree,SelectItem,"New1","4"); 
SAPGuiCmd2(GuiCtrlTree,EnsureVisibleHorizontalItem,"New1","4"); 
SAPGuiCmd1(GuiCtrlTree,PutTopNode,"Root"); 
SAPGuiCmd2(GuiCtrlTree,DoubleClickItem,"New1","4"); 
 

SAPGuiCheckScreen("DWDM","SAPTLIST_TREE_CONTROL_DEMO","SAP");//1152820409.915 
 

// *SAP* GuiTextField   name="G_EVENT"   Id="wnd[0]/usr/txtG_EVENT" 
// *SAP* GuiTextField   name="G_NODE_KEY"   Id="wnd[0]/usr/txtG_NODE_KEY" 
// *SAP* GuiTextField   name="G_ITEM_NAME"   Id="wnd[0]/usr/txtG_ITEM_NAME" 
// *SAP* GuiStatusbar   name="sbar"   Id="wnd[0]/sbar" 

 
DO_SLEEP(5); 
 

// Check the unique string  
char* strUniqueString = SAPGuiGetUniqueString("wnd[0]/usr/txtG_EVENT", "GuiTextField", 
"ITEM", "CLICK"); 
RR__printf(" the unique string between ITEM and CLICK is: %s", strUniqueString); 
free(strUniqueString); 
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Handling Multiple SAP Logons in a Single Script 

M odi fying the Script  for M ul t i ple Logons 

Load test ing requirements for SAP may include al lowing for mult iple logons in a script  session. When you 
incorporate mult iple logon funct ional i ty for an SAP script , you must add a code block to the script  to see i f 
the mult iple logon opt ion is avai lable, and whether the user has selected the radio button that al lows 
concurrent connect ions from the same user. 

To m odi f y a scr ip t  t o handle m ul t ip le logons: 

1. Find the fol lowing l ine of code in a script  you just captured.   

Tip: This l ine of code should be near the top of the script  after the logon commands.  

SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

2. After th is l ine of code, add the fol lowing code block. This shows whether the mult iple logon opt ion 
is avai lable and i f the user has pressed the Al low  Concurren t  Connect ions f rom  the Sam e User 
radio button on the SAP logon screen. 

SAPGuiPropIdStrExists("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

DO_SLEEP(20);  

SAPGuiCmd0(GuiRadioButton,Select); 

SAPGuiCmd0(GuiRadioButton,SetFocus); 

SAPGuiPropIdStr("wnd[1]/tbar[0]/btn[0]"); 

SAPGuiCmd0(GuiButton,Press); 

SAPGuiCheckScreen("S000","SAPMSYST","License Information for Multiple Logon"); 

SAPGuiPropIdStrExistsEnd("wnd[1]/usr/radMULTI_LOGON_OPT2"); 

SAPGuiPropIdStr("wnd[0]"); // sets focus back to wind[0] 

This code acts l ike an If condit ional that is not in  a control loop. It  can be stated as fol lows: 

!  IF the mult i-logon screen appears, select radio button opt ion 2. In  th is code snippet, radio button 
2 tel ls the server to al low concurrent connect ions from the same user.  

!  THEN check to make certain the script  is synced to the "License Information for Mult iple Logon”  
sect ion.   

!  ELSE do noth ing and cont inue with the script .  

Conclusion 

This technique enables support for mult iple SAP logon sessions in  a script . It  asks SAP whether the mult i-
logon radio button is selected and, i f i t  is, simulates select ing the button during replay. This al lows you to 
run the same script  with many virtual users under a single SAP logon ID. 

The sample original script  and sample modified script  i l lustrate th is process. 

 

Implementing Content Check of a SAP Control 

Overview : Im plem en t in g Con ten t  Check  of  a SAP Con t rol  

When running an SAP script , you may want to check content of a control ’s text property.  
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Conclusion 

Use the SAPGuiContentCheck command to compares data from an SAP server returned control with input 
string based on the comparison opt ions. The sample script  i l lustrates th is procedure.  

 

Sam ple: Im plem en t ing Con ten t  Check  of  a SAP Con t rol  

The fol lowing sample script  shows the SAP commands needed to val idate the in formation in  the SAP cl ient 
during replay. You can use SAPGuiContentCheck to check i f the text field for Even t  nam e contains the 
string double.  

The SAPGuiContentCheck command has the opt ion to check the ent ire string, prefix string, substring and 
suffix string. It  also has the opt ion to use a case-sensit ive comparison or case-insensit ive comparison. 

The fol lowing example uses the case insensit ive comparison and substring check opt ion. 

Use convert  opt ion Insert SAP control comments: Textfields and Statusbars to output 
textfield and statusbar as comments in  the script .  

Sample Script  
 

SAPGuiPropIdStr("wnd[0]/usr/cntlTREE_CONTAINER/shellcont/shell" 
        );//1152820409.712 
SAPGuiCmd1(GuiCtrlTree,ExpandNode,"Root"); 
SAPGuiCmd1(GuiCtrlTree,ExpandNode,"Child1"); 
SAPGuiCmd2(GuiCtrlTree,SelectItem,"New1","4"); 
SAPGuiCmd2(GuiCtrlTree,EnsureVisibleHorizontalItem,"New1","4"); 
SAPGuiCmd1(GuiCtrlTree,PutTopNode,"Root"); 
SAPGuiCmd2(GuiCtrlTree,DoubleClickItem,"New1","4"); 
 

SAPGuiCheckScreen("DWDM","SAPTLIST_TREE_CONTROL_DEMO","SAP");//1152820409.915 
 

int nResult = SAPGuiContentCheck("wnd[0]/usr/txtG_EVENT", "GuiTextField", "double", 
false, SUBSTRING); 
RR__printf("Does the textfield content contains string \"double\"? -- %s", 
nResult==0?"YES":"NO"); 
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Required SAP Commands to Support Transaction Restart 

Overview : Transact ion  Restart  Com m ands 

If your load test ing requirements include support ing transact ion restarts, review the fol lowing commands 
and ensure that those required to support t ransact ion restart  are present.  

Note: These are automatical ly added during the script  conversion process.   

Script ing 

Required commands and associated code statements for the SAP script  are:   

!  SAPGuiApplicat ion(RegisterROT) - This command sets or resets the SAP runt ime object l ibrary 
(ROT).  Execut ing th is command ensures the SAP environment is in  an in i t ial  state at the 
beginning of the script . 

!  SAPGuiApplicat ion(RevokeROT) - This command clears the SAP runt ime object l ibrary (ROT). 
 Execut ing th is command ensures the memory SAP environment is de-al located. 

!  SAPGui_error_handler(s_info, buffer) - When script ing an error code block, be sure to use the 
SAPGui_error_handler command instead of the RR__FailedMsg command i f the Transact ion Restart  
opt ion is used. 

Note: These funct ions are required, but addit ional SAP script  commands are also essent ial  to run an 
SAP script . 

Conclusion 

If unexpected playback errors occur when playing back an edited script  with Transact ion Restart  enabled, 
perform a review of the commands to ensure that those required to support t ransact ion restart  are present. 
  

The sample script  shows the commands used in the script .  

 

Required SAP Script Commands 

Overview : Requi red SAP Script  Com m ands 

Certain commands must be present in  an SAP script . These commands are created automatical ly during the 
conversion process. Most of the commands are before the BEGIN_TRANSACTION statement. Review th is 
sect ion i f you are having unexpected issues after script  edit ing. 

Note: If the SAP script  supports transact ion restart ing, review Required Commands for Support ing 
Transact ion Restart  in  SAP.   

Required Script Commands 

Required commands and associated code statements for the SAP script  are:    

SET_ABORT_FUNCTION(abort funct ion); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoIn it ial ize(0); 

i f( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info, "ERROR in it ial izing COM"); 

SAPGuiSetCheckScreenWildcard(‘*’); 

SYNCHRONIZE(); 
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Note: These funct ions are required, but addit ional SAP API script  commands are also essent ial  to run 
an SAP script . 

Conclusion 

When encountering unexpected compiler errors after script  edit ing, review the script  to ensure al l  required 
commands are present. This might reveal a problem created by the script  edits, especial ly when moving the 
transact ion loop. You must take care when doing extensive script  edit ing not to accidental ly remove 
cri t ical commands. Recording the transact ion again and doing a windiff comparison can also help when 
unexpected compiler errors occur. 

The sample script  shows the statements used in the script . 

 

Sam ple: SAP Script  w i th  Com m ands 

The fol lowing sample is a SAP Script with required commands. Required commands in the script  are 
h ighl ighted in  bold. 

Sample Script  

/* 
 *  capture.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 
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#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 
/* Declare Variables */ 

/// These script functions in bold must be present and  
/// before the SYNCHRONIZE command in every SAP script. 

ACTION(); 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 

    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 
 
SYNCHRONIZE(); 

BEGIN_TRANSDO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
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SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 
} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

Retrieving SAP Counter Data 

M odi fying the Script  to Ret rieve SAP Coun ter Data 

SAP scripts can retrieve customer counter in formation for each virtual user. By insert ing code snippets that 
use the SAPGui script ing API in to the SAP script , you can obtain and save SAP server in formation.  

To m odi f y t he scr ipt  t o ret r ieve SAP count er  dat a: 

1. Declare and in i t ial ize the counter ident i ficat ion (ID) variables using the in t  data type. You should 
declare a variable for each counter value to be extracted. The DEFINE_COUNTER macro in i t ial izes 
the declared counter ident i fier variable and creates a holder for the value in  the t im ing fi le. 

2. Declare and in i t ial ize the variable to hold the actual  SAP counter value. You should  declare the 
variable using a datatype that can hold any expected value for the counter. Usual ly a long is 
appropriate.  

3. Retrieve the counter in formation from the SAP server using the SAPGuiSessionInfo command. The 
value is placed in the variable you created in  Step 2. The first  parameter is the SAP property object 
corresponding to the counter. The second parameter is the variable to hold the value.  

4. Save the counter value to the t im ing fi le. The COUNTER_VALUE macro command extracts the 
value from the server.  The value is extracted to the variable created in  Step 2. It  is stored in  the 
t im ing fi le using the associated ID created in  Step 1.  

Conclusion 
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Following these techniques, you can obtain customer counter in formation from the SAP server, save i t  to 
the virtual user’s t im ing fi le, and view i t  in  Analyze. The sample original script  and sample modified script  
i l lustrate th is modificat ion.  

Sam ple: Original  SAP Script  w i th  Coun ters 

The fol lowing sample shows an original SAP script  extract with counters. Points of in terest in  the script  are 
h ighl ighted in  bold. 

Sample Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 

#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// Declare the SAP custom counter variable IDs 
/// Also declare any SAP counter value variables. 
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SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Initialize the SAP custom counter variable IDs. 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 

try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 

/// This is where we would like to retrieve the RoundTrips  
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/// and Flushes counter.  Here the SAPGuiSessionInfo command  
/// will be inserted to retrieve these SAP counter values from the server. 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 

/// Here is where the counter information will actually be  
/// written to the timing file.  
 
} // end try 

catch (_com_error e){ 
char buffer[1024]; 
sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 

REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

 

Sam ple: M odi f i ed SAP Script  w i th  Custom  Coun ters 

The fol lowing sample shows a modified SAP script  with SAP custom counters. Changes to Original script  
are h ighl ighted in  bold. 

Sample Script  

/* 
 *  counters.cpp 
 * 
 *  Script Converted on July 20, 2004 at 08:43:23 AM 
 *  Generated by Compuware QALoad convert module version 5.2.0 build 73 
 * 
 *  This script contains support for the following middlewares:  
 *      - SAP 
 */ 

/* Converted using the following options: 
 * General: 
 *  Line Split                       : 132 characters 
 *  Sleep Seconds                    : 1 
 *  Constants to Variables           : Yes 
 *  Remove Quotes                    : No 
 *  Tabs To Spaces                   : No 
 *  Auto Checkpoints                 : No 
 * SAP 
 *  Version                          : 6204.119.32 
 */ 

#define SCRIPT_VER 0x00000205UL 
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#include <stdio.h> 
#include <windows.h> 
#include <atlbase.h> 
#include <objbase.h> 
#include "do_SAPCCOM.h" 
#include <atlwin.h> 
#include <atlcom.h> 
#include <atlhost.h> 
#include "cscript.h" 
#include "do_SapGui.h" 
#include "mwCommon.h" 

extern "C" { 
#include "smacro.h" 
} 

/* set function to call on abort*/ 
void abort_function(PLAYER_INFO *s_info); 

#ifndef NULL 
#define NULL  0 
#endif 

extern "C" int rhobot_script(PLAYER_INFO *s_info) 
{ 

/* Declare Variables */ 

/// Scripting: Step 1 

int id1, id2, id3, id4; 
long lRoundTrips,lFlushes; 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("counters.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"SAP: ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

/// Scripting: Step 2 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, 
COUNTER_INSTANCE); 

 
SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

DO_SetTransactionStart(); 
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try{ 

SAPGuiConnect( s_info,"testsap620"); 

SAPGuiApplication(RegisterROT); 
 
SAPGuiVerCheckStr("6204.119.32");  
 
//Set SapApplication = CreateObject("Sapgui.ScriptingCtrl.1") 
//SapApplication.OpenConnection ("testsap620") 
//Set Session    = SapApplication.Children(0).Children(0) 
 
DO_SLEEP(18); 
 
SAPGuiPropIdStr("wnd[0]");//1057828784.513 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(16); 
 
SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME");//1057828800.786 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 
 
SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE");//1057828800.796 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~0000x_'9d"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 
 
SAPGuiPropIdStr("wnd[0]");//1057828800.836 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP");//1057828800.856 
 
DO_SLEEP(6); 
SAPGuiCmd3(GuiMainWindow,ResizeWorkingPane,92,34,false); 
 
DO_SLEEP(3); 
 
SAPGuiPropIdStr("wnd[0]/tbar[0]/btn[15]");//1057828809.839 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSMTR_NAVIGATION","SAP Easy 
Access");//1057828809.859 
 
 
DO_SLEEP(2); 
 
SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1");//1057828811.382 
SAPGuiCmd0(GuiButton,Press); 

/// Scripting: Step 3 

SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
SAPGuiSessionInfo(GetFlushes,lFlushes); 

SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off");//1057828811.402 
 
/// Scripting: Step 4 

COUNTER_VALUE( id1,lRoundTrips); 
COUNTER_VALUE( id2,lFlushes); 
COUNTER_VALUE( id3,lRoundTrips); 
COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
char buffer[1024]; 
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sprintf(buffer,"SAP: EXCEPTION 0x%x  %s for VU(%i)\n",e.Error(), (char 
*)e.Description(), S_task_id); 
SAPGui_error_handler(s_info,buffer); 

} // end catch 

DO_SetTransactionCleanup(); 

SAPGuiApplication(RevokeROT); 
 
END_TRANSACTION(); 
REPORT(SUCCESS); 
EXIT(); 
return(0); 

} 

void abort_function(PLAYER_INFO *s_info) 
{ 
RR__printf("Virtual User ABORTED."); 
EXIT(); 

} 

Adding Custom Counters to Retrieve Server Information 

The fol lowing example adds custom counters to obtain and save the SAP Server in formation that is 
avai lable through the SAP Gui Script ing API. Not ice that SAPGuiSessionInfo is cal led before logging off , 
because the data is not avai lable after logging off. 

int id1, id2, id3, id4; 

long lRoundTrips,lFlushes; 

// "Counter Group", "Counter Name", "Counter Units 
// (Optional)", Data Type, Counter Type. 

id1 = DEFINE_COUNTER("Cumulative Group", "Cumulative RoundTrips", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id2 = DEFINE_COUNTER("Cumulative Group", "Cumulative Flushes", 0, DATA_LONG, 
COUNTER_CUMULATIVE); 

id3 = DEFINE_COUNTER("Instance Group", "Instance RoundTrips", 0, DATA_LONG, 
COUNTER_INSTANCE); 

id4 = DEFINE_COUNTER("Instance Group", "Instance Flushes", 0, DATA_LONG, COUNTER_INSTANCE); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiConnect( s_info,"qacsapdb2"); 
   ... 
   SAPGuiSessionInfo(GetRoundTrips,lRoundTrips); 
   SAPGuiSessionInfo(GetFlushes,lFlushes); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen( "SESSION_MANAGER", "SAPLSPO1", "Log Off" ); 

   COUNTER_VALUE( id1,lRoundTrips); 
   COUNTER_VALUE( id2,lFlushes); 
   COUNTER_VALUE( id3,lRoundTrips); 
   COUNTER_VALUE( id4,lFlushes); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer,"SAP: EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), (char *)e.Description(), 
S_task_id); 

   RR__FailedMsg(s_info,buffer); 
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} // end catch 

END_TRANSACTION(); 

Error Handling and Reporting 

A try/catch block is automatical ly generated for the commands between the BEGIN_TRANSACTION and 
END_TRANSACTION statements. This construct provides error handl ing and report ing from the script . 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 

   //Set SapApplication = CreateObject("Sapgui.ScripingCtrl.1")    
   //SapApplication.OpenConnection ("qacsapdb") 
   //Set Session = SapApplication.Children(0).Children(0) 

   DO_SLEEP(3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd3(GuiMainWindow, ResizeWorkingPane, 83, 24, false); 

   DO_SLEEP(6); 

   SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
   SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

   SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
   SAPGuiCmd1Pwd(GuiPasswordField, PutText,"~encr~1211616261"); 

   SAPGuiCmd0(GuiPasswordField,SetFocus); 
   SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

   SAPGuiPropIdStr("wnd[0]"); 
   SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
   SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

   ... 

   DO_SLEEP(10); 

   SAPGuiPropIdStr("wnd[0]/usr/cntlIMAGE_CONTAINER/shellcont/shell/shellcont[0]/shell"); 
   SAPGuiCmd1(GuiCtrlTree, ExpandNode, "0000000003"); 
   SAPGuiCmd1(GuiCtrlTree, PutSelectedNode, "0000000004"); 
   SAPGuiCmd1(GuiCtrlTree, PutTopNode, "Favo"); 
   SAPGuiCmd1(GuiCtrlTree, DoubleClickNode, "0000000004"); 
   SAPGuiCheckScreen("SESSION_MANAGER", "SAPLSMTR_NAVIGATION", "SAP Easy Access"); 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf (buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
            (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on with in the transact ion loop, move the SAPGuiConnect  cal l  inside the try block as 
shown in the fol lowing example: 

SET_ABORT_FUNCTION(abort_function); 
DEFINE_TRANS_TYPE("capture.cpp"); 
RESULT hr = CoInitialize(0); 
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if( hr != ERROR_SUCCESS ) 
    RR__FailedMsg(s_info,"ERROR initializing COM"); 

SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

BEGIN_TRANSACTION(); 

try{ 

   SAPGuiConnect( s_info,"qacsapdb2"); 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
   SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
   SAPGuiCmd0(GuiButton,Press); 
   SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

} // end try 

catch (_com_error e){ 

   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(),  
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 

} // end catch 

END_TRANSACTION(); 

To include the log on outside the transact ion loop, move the log off sect ion so that i t  fol lows the 
END_TRANSACTION statement. However, ensure that the recording with in the transact ion loop begins 
and ends in the same locat ion in  the menu system. For example: 

SET_ABORT_FUNCTION(abort_function); 

DEFINE_TRANS_TYPE("capture.cpp"); 

HRESULT hr = CoInitialize(0); 

if( hr != ERROR_SUCCESS ) 
   RR__FailedMsg(s_info,"ERROR initializing COM"); 
SAPGuiSetCheckScreenWildcard('*'); 

SYNCHRONIZE(); 

SAPGuiConnect( s_info,"qacsapdb2"); 

SAPGuiPropIdStr("wnd[0]/usr/txtRSYST-BNAME"); 
SAPGuiCmd1(GuiTextField,PutText,"qaload1"); 

SAPGuiPropIdStr("wnd[0]/usr/pwdRSYST-BCODE"); 
SAPGuiCmd1Pwd(GuiPasswordField,PutText,"~encr~1211616261"); 
SAPGuiCmd0(GuiPasswordField,SetFocus); 
SAPGuiCmd1(GuiPasswordField,PutCaretPosition,3); 

SAPGuiPropIdStr("wnd[0]"); 
SAPGuiCmd1(GuiMainWindow,SendVKey,0); 
SAPGuiCheckScreen("S000","SAPMSYST","SAP"); 

BEGIN_TRANSACTION(); 

try{ 
   SAPGuiVerCheckStr("6204.119.32"); 
   ... 
} // end try 

catch (_com_error e){ 
   char buffer[1024]; 
   sprintf(buffer," EXCEPTION 0x%x %s for VU(%i)\n",e.Error(), 
           (char *)e.Description(), S_task_id); 
   RR__FailedMsg(s_info,buffer); 
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} // end catch 

END_TRANSACTION(); 

SAPGuiPropIdStr("wnd[1]/usr/btnSPOP-OPTION1"); 
SAPGuiCmd0(GuiButton,Press); 
SAPGuiCheckScreen("SESSION_MANAGER","SAPLSPO1","Log Off"); 

 

Object Life Span 

Whenever a script  is run, al l  objects on the SAP GUI window are deleted and re-created. These objects, 
which are created in  the SAP environment and can disappear without user in teract ion, can cause script  
fai lure i f the script  references the objects after they have disappeared. 

For more troubleshoot ing in formation, refer to SAP’s publ icat ion t i t led “ SAP GUI Scripting API for the 
Windows and Java Platforms” . 

Winsock Scripts 

Winsock Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted Winsock scripts. 
These samples show a descript ion of the problem, the procedure for implementing the modificat ion, and 
samples of a modified script . Script  modificat ions are discussed for: 

Handling Winsock Connect ion Problems 

Accessing Local and Remote Network Addresses 

Using Central Datapools with in a Winsock Script 

Using Local Datapools with in a Winsock Script 

Accessing Server Replies with DO_WSK_Read 

Accessing Server Replies with DO_WSK_Recv 

Receiving Winsock UDP Data with DO_WSK_Recvfrom 

Sending Variable Data with DO_WSK_Send 

Sending Variable Data using DO_WSK_SendAll  

Sending Variable Data using DO_WSK_SendTo 

Sending Variable Data using DO_WSK_Write 

Accessing Server Replies Using Response() and ResponseLength() 

Parsing Server Replies Using ScanFloat and ScanInt 

Parsing Server Replies Using ScanSkip and ScanString 

Parsing Server Replies Using SkipExpr and ScanSkip 

 

Understanding Data representation in the Script 

This sect ion describes how data that is sent and received is displayed in a Winsock script . Use th is sect ion 
as a reference when you examine a script . 

During the conversion process, QALoad determines how to represent each character in  the script . This 
conversion process uses the fol lowing rules: 

1. The character is compared to the “ space”  character in  the ASCII table, which has a decimal value of 
32. If the character’s value is less than 32, the fol lowing steps are taken: 
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a. If the character is “ \ r” , “ \ n” , “ \ t” , or “ \ f” , i t  is represented in the script  as a normal C escape 
character. 

b. If the character is either “ ^ \ ”  or “ ^^” , i t  is represented in the script  as an octal  character. For 
example, the values would be “ \ 034”  and “ \ 036” , respect ively. 

c. If the character’s value is less than 32 and i t  does not meet the descript ions in  a) and b) above, 
i t  is represented in the script  as a control character. For example, i f the character is a nul l  
character, i t  is represented in the script  as “ ^@” . 

2. If the character’s decimal value is between 32 (the “ space”  character) and 126 (~), i t  displays in  the 
script  as a standard readable ASCII character, with the fol lowing except ions: 

!  If the character is “ \ ” , which has a decimal value of 92, i t  is represented as “ \ \ ”  in  the script . 

!  If the character is “ “ “ , which has a decimal value of 34, i t  is represented as “ \ ” ”  in  the script . 

!  If the character is “ ^” , which has a decimal value of 94, i t  is represented as “ ^^”  in  the script . 

3. If the character has a decimal value of 127, which corresponds to Delete (DEL), i t  is represented as 
“ ^”  in  the script . 

The fol lowing table summarizes the results of rules 1-3. 

Code Octal  Decim al  Char 

^@ 000 0 NUL 

^A 001 1 SOH 

^B 002 2 STX 

^C 003 3 ETX 

^D 004 4 EOT 

^E 005 5 ENQ 

^F 006 6 ACK 

^G 007 7 BEL 

^H 010 8 BS 

\t 011 9 HT 

\n 012 10 LF 

^K 013 11 VT 

\f 014 12 FF 

\r 015 13 CR 

^N 016 14 SO 

^O 017 15 SI 

^P 020 16 SLE 

^Q 021 17 SC1 
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^R 022 18 DC2 

^S 023 19 DC3 

^T 024 20 DC4 

^U 025 21 NAK 

^V 026 22 SYN 

^W 027 23 ETB 

^X 030 24 CAN 

^Y 031 25 EM 

^Z 032 26 SIB 

^[ 033 27 ESC 

\034 034 28 FS 

^] 035 29 GS 

^_ 037 31 US 

 040 32 SP 

\" 042 34 " 

\\ 134 92 \  

^^ 136 94 ^  

^? 177 127 DEL 

4. If the character is not included in the groups defined in steps 1-3, i t  is represented as an octal 
character in  the script . These characters are often referred to as h igh ASCII characters (those with a 
decimal value greater than 128), and are represented in the script  as “ \ OOO” , where OOO is the 
octal value for the ASCII character. 

 

Handling Winsock Connection Problems 

Sam ple: Handl ing Winsock  Connect ion  Problem s  

The fol lowing script  sn ippet shows an example of how to handle connect ion problems. The code in bold 
shows how you can l im it  the ret ires and turn off the abort  flag. 

Sample Script  Snippet 

… 
/* Declare Variables */ 
//Declared nNumRetries to keep track of the number of retry attempts that are made 
int nNumRetries = 0; 
//Declared “ret” to store the return code from DO_WSK_Connect() 
int ret = -1; 
… 
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BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
 
//In order to handle the failure for the DO_WSK_Connect the script needs to 
// turn off the abort on error flag. After the connection is made the flag 
// should be turned back on. 
s_info->bAbortOnError = 0; 

//The example below will try to make a connection to the remote application, 
// and if it fails it will repeat the attempt up to 5 times. 
while( ret = -1 && nNumRetries < 5) 
{ 
//Attempts to connect to the remote application. 
ret = DO_WSK_Connect(S2, "10.4.26.24", 123, AF_INET); 
 
if(ret == -1) 
{ 

//pause between connection attempts 
DO_MSLEEP(500); 
//increment the counter for the number of retry attempts. 
nNumRetries++; 

} 
} 

//turning the abort flag back on. 
s_info->bAbortOnError = 1; 
//If the max number of retries has been met then this virtual user should fail. 
if(nNumRetries == 5) 
RR__FailedMsg(s_info,"ERROR: Max number of connection retries has been reached"); 
...  

DO_WSK_Closesocket(S2); 

 

 

Accessing Local and Remote Network Addresses  

You can retrieve the IP address or port  to which a socket handle is connected, or retrieve the IP address and 
port  to which a socket handle is bound. The sample script  i l lustrates how to retrieve and store socket 
address and port  in format ion. The required code is shown in bold. 

Sam ple Script  
... 
/* Declare Variables */ 

//Belows are two socket structs that will store the address and port information. 
struct sockaddr_in RemoteAddr; 
struct sockaddr_in LocalAddr; 
… 
BEGIN_TRANSACTION(); 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
/* Socket S2 was bound to address 0.0.0.0 on port 3320 (hibyte=12,lobyte=248) */   

//Called after the DO_WSK_Bind() to see which address the socket was bound to 
LocalAddr.sin_addr.s_addr = ntohl(GetLocalAddr(S1)); 

//Called after the DO_WSK_Bind() to see which port the socket was bound to 
LocalAddr.sin_port  = GetLocalPort(S1); 

DO_WSK_Connect(S1, "10.4.26.24", 80, AF_INET); 

//Called to retrieve the remote address that S1 is connected to. 
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RemoteAddr.sin_addr.s_addr = ntohl(GetRemoteAddr(S1)); 

//Called to retrieve the remote port that S1 is connected to. 
RemoteAddr.sin_port = ntohs(GetRemotePort(S1)); 

//The function below will print the remote and local address and port information 
// to the playerbuffer. Within the RR__printf() the script is using the socket function 
// “inet_ntoa()” to convert the IP from an unsigned long to a string 
// format, “XXX.XXX.XXX.XXX”. 
RR__printf("Remote: address=%s port=%d",inet_ntoa(RemoteAddr.sin_addr), 
RemoteAddr.sin_port); 
RR__printf("Local: address=%s port=%d",inet_ntoa(LocalAddr.sin_addr), LocalAddr.sin_port); 

DO_WSK_Closesocket(S1); 

… 

Conclusion  

When th is code is executed, a message is prin ted to the playerbuffer, such as: 

VU  0 : Remote: address=10.4.26.24 port=80 

VU 0 : Local: address=10.15.16.26 port=1125 

 

Parsing Server Replies Using ScanFloat and ScanInt  

Sometimes local appl icat ions must in terpret and act on numeric values sent from a remote appl icat ion. For 
example, remote appl icat ions may send a port  number to the local appl icat ion. The local appl icat ion parses 
the remote port  from the data i t  receives and attempts to connect to the remote machine on the new port .  

By using ScanInt(), you can parse the received buffer for numeric values, such as port  numbers, or use 
ScanFloat() to parse for larger numeric values. The sample script  i l lustrates how to use ScanFloat() and 
ScanInt(). The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//The variable "port" was declared to store the port# that the remote 

// application sends. The variable "nID" is used to store the unique 

// ID that is sent by the remote application. 

unsigned short port; 

float nID; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Connect(S1, "10.15.21.225", 33, AF_INET); 

 

/* 11 bytes: "port=\nA\0\0aB" */ 

 

//Since the end of the data that is being received is dynamic, the 

// script will use DO_WSK_Read() to receive the data instead 
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// using the DO_WSK_Expect() that was converted into the script. 

//DO_WSK_Expect(“B”); 
DO_WSK_Read(S1,11); 

//Calling ScanSkip to move the pointer to the first byte of the port 

ScanSkip(5); 

 

//Calling ScanInt to copy the next two bytes into a variable that will 

// store the port from the remote application. 

ScanInt(MyByteOrder(),2,(char*)&port); 

 

//Calling ScanFloat to copy the next four bytes into a variable that will 

// store the unique ID from the remote application. 

ScanFloat(MyByteOrder(),4,(char*)&nID); 

//Printing the port number to the playerbuffer window, and converting  

// the value from network byte order to host byte order. 

RR__printf("port=%d",ntohs(port)); 

//Printing the unique ID that the remote application sent to the  

// playerbuffer. 

RR__printf("float=%f",nID); 

DO_WSK_Closesocket(S1); 

//Below is the original DO_WSK_Connect that was converted into the script 

//DO_WSK_Connect(S2,”10.15.21.225”, 2526, AF_INET); 

//Uses the port that was returned above to reconnect to the remote application 

DO_WSK_Connect(S2, "10.15.21.225", ntohs(port), AF_INET); 

DO_WSK_Send(S2,"Hello World"); 

DO_WSK_Closesocket(S2); 

... 

Conclusion  

In th is example, the script  parses the port  number sent from the remote appl icat ion and uses th is to 
reconnect to the remote appl icat ion. The script  also uses ScanFloat() to parse a unique ID from the message 
sent by the remote appl icat ion. 

 

Parsing Server Replies Using ScanSkip and ScanString  

Data returned from the server may be too dynamic to base your parsing on actual characters. In  th is case, 
 you can base your search on character posit ions using ScanSkip() and ScanString().  

For example, you can save characters 20 through 25 that are returned from a server. The ScanSkip() skips 
the specified number of characters in  the in ternal buffer that stores the response received in the 
DO_WSK_Expect(). The ScanString() scans the number of characters you specify in to a character string 
from the current posit ion in  the buffer.  
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In  th is sample,  the buffer returned from the server is xxx123456789yyy. You are retrieving the value 
between xxx and yyy. The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//Variable to store the string that we are searching for. 

char temp[15]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

 

DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the actual data that was returned at capture time. 

/* 16 bytes: xxx0123456789yyy */ 

DO_WSK_Expect(S1, "yyy"); 

//making sure that all of the data within our variable has been initialized  

memset(temp,'\0',15); 

//skips 3 bytes within the buffer that was received. 

ScanSkip(3);  

 

//copies the next 10 bytes of the buffer that was received into our temp variable 

ScanString(10,temp); 

//Displays the string that was found to the playerbuffer window. 

RR__printf("string=%s",temp); 

DO_WSK_Closesocket(S1); 

... 

Conclusion  

In th is example, the message “ string=0123456789”  is prin ted to the player buffer window. 

 

 

Receiving Winsock UDP Data with DO_WSK_Recvfrom  

When the appl icat ion you are capturing is using the UDP protocol, you can use the DO_WSK_Recvfrom() 
to receive data from the remote appl icat ion. The sample script  i l lustrates how to use the Do_Wsk_Recvfrom 
(). The required code is shown in bold. 
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Sam ple Script  

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[256]; 

//RemoteAddr stores the remote applications address and port 

struct sockaddr_in RemoteAddr; 

//nBytes is used to stor the number of bytes that were received via DO_WSK_Recvfrom() 

int nBytes = 0; 

… 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_UDP); 

 

DO_WSK_Bind(S1, "10.15.16.26", 333); 

 

//Receives data via the UDP protocol 

DO_WSK_Recvfrom(S1,strBuf,(struct sockaddr*) &RemoteAddr, 256, 0, &nBytes);  

 

//Prints to the player buffer the number of bytes that were received and 

// the remote address and port that sent them. 

RR__printf("Received %d bytes from %s:%d", 

nBytes, inet_ntoa(RemoteAddr.sin_addr),  

ntohs(RemoteAddr.sin_port)); 

… 
DO_WSK_Closesocket(S1); 

Conclusion  

This example shows how to use DO_WSK_Recvfrom() to receive UDP protocol data. It  shows how to access 
the address and port  of the remote appl icat ion sending the data. 

 

Sending Variable Data with DO_WSK_Send  

Captured data may not be the data you want to use while running a test. For example, you might change 
the user name sent during capture t ime to a differen t value during replay. You can change the value in  the 
DO_WSK_Send() to make a stat ic value with in the funct ion. However, i f you want to subst i tute a different 
value each t ime, you can create a dynamic variable, such as a datapool value, to replace the user name.  

In  th is example, the script  includes a DO_WSK_Send() that sends “ name=Jim”  to the server as the user 
name. For test ing purposes, you want to change the name to include a variable that represents a different 
name, such as “ Mark” . The code required for th is is shown in bold. 

Sam ple Script  

…  

/* Declare Variables */ 
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//Below are variables needed for the dynamic data. The size of these 

//variables will depend upon how big the buffer is that you are replacing 

char buffer[65]; 

char sendbuffer[65]; 

… 
BEGIN_TRANSACTION(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

 

DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 

 

//Below is the original send based upon the capture file. 

// DO_WSK_Send(S1,"name=Jim"); 

//The script will now create a buffer that is different than what was captured, 

//and if we wanted the string “Mark” could also of been a datapool value. 
strcpy( buffer, "Mark"); 

sprintf( sendbuffer, "name=%s", buffer); 

//The script will now send the variable string that was created above 

DO_WSK_Send(S1, sendbuffer); 

/* 2 bytes: ok */ 

DO_WSK_Expect(S1,"ok"); 

DO_WSK_Closesocket(S1); 

Conclusion  

In th is example, the user name sent to the server is changed from “ name=Jim”   to “ name=Mark”  by 
modifying the buffer before the DO_WSK_Send() and passing the new buffer as the second parameter of 
the DO_WSK_Send(). 

 

Sending Variable Data using DO_WSK_SendAll  

When only a port ion of a string that the script  is sending must be modified to make i t  dynamic, using the 
DO_WSK_SendAll() can be easier than modifying the DO_WSK_Send().  

The fol lowing example sends the username “ Bob”  and the password “ CPWR”  to the server to logon. Since 
only one instance of th is user can be logged on to the server, you must modify the script  to read different 
user names and passwords from a datapool before sending i t . In  the sample script  sn ippet, the required 
code is shown in bold. 

Sam ple Script  

... 
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BEGIN_TRANSACTION(); 

//Reads in a datapool record to be used to make the username and password dynamic. 

GET_DATA(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Connect(S2, "10.0.6.32", 80, AF_INET); 

 

//In the string that was sent below "Bob" and "CPWR" both need to be modified 

// to allow for multiple users to execute this script. 

/* 20 bytes */ 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 

 

//Using DO_WSK_Sendall the message that is being sent can easily be modified, so 

// that the script can read in the username and password from a datapool file. 

DO_WSK_SendAll(S2,5, "^@user", VARDATA(1), "^@pwd=", VARDATA(2), "^@\377"); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

 

DO_WSK_Closesocket(S2); 

... 

Conclusion  

In the sample modified script , the user name and password are read in from a datapool fi le and the data is 
sent using the DO_WSK_SendAll(). 

 

Sending Variable Winsock UDP Data 

Captured data may not be the data that you want to use while running a test. For example, you may want 
to subst i tute a user name sent during capture with a different value each t ime during replay. You can do 
th is using a dynamic variable, such as a datapool variable.  

Note: Changing the value located in  the DO_WSK_Sendto() makes the value stat ic with in the 
funct ion.  

In  th is sample, the code in bold below shows how change data values. 

Sam ple Script  

... 

/* Declare Variables */ 

//The variable strBuf is used to formulate the dynamic data that is  

// sent in the DO_WSK_Sendto() below. 

char strBuf[24]; 

…  
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BEGIN_TRANSACTION(); 

//Reads in a row of data from a central datapool file, and this will be 

//used as part of the dynamic data that will be sent via the DO_WSK_Sendto() 

GET_DATA(); 

DO_WSK_Socket(S1, AF_INET, SOCK_DGRAM, IPPROTO_IP); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_BROADCAST, 1); 

 

DO_WSK_Bind(S1, "127.0.0.1", 5634); 

 

//Below is the original DO_WSK_Sendto() that was converted into the script 

//DO_WSK_Sendto(S1, "name=Brian", "10.25.26.24", 1234); 

//The example below reads a record in from a central datapool, and the value 

// is then sent as part of the DO_WSK_Sendto() buffer. 

memset(strBuf, 0, 24); 

sprintf(strBuf, "name=%s", VARDATA(1)); 

DO_WSK_Sendto(S1, strBuf, "10.25.26.24",  1234); 

… 
DO_WSK_Closesocket(S1); 

… 

Conclusion  

In th is example, the virtual user reads in  a row of data from a central datapool, which is used to create a 
dynamic message. This message is used in the DO_WSK_Sendto() to send i t  to the address “ 10.25.26.24” . 

 

Sending Variable Data using DO_WSK_Write  

You can use DO_WSK_Write() instead of DO_WSK_Send() when coding scripts by hand. DO_WSK_Write() 
does not expect strings that have certain control and nul l  characters encoded, as does DO_WSK_Send(). 
This al lows you to send data without using EscapeStr() to encode any possible control characters.  

The sample script  i l lustrates how to use DO_WSK_Write(). The required code is shown in bold. 

Sam ple Script  

... 

/* Declare Variables */ 

//Variable that will be used to send data to the server via DO_WSK_Write() 

char temp[24]; 

... 

BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 

DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 

DO_WSK_Connect(S2, "10.4.26.24", 60, AF_INET); 
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//The original data that was sent was... "^@user=Bob^@pwd=CPWR^@", and the 

// ^@ are encoded null characters. The function below constructs the same 

// data that was sent without the data being encoded. 

memcpy(temp,"\0user=Bob\0pwd=CPWR\0", 19); 

/* 19 bytes */ 

//The DO_WSK_Send() below was converted to the script from the capture file. 

//DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@"); 

 

//Since the script is now using DO_WSK_Write() to send the data it does not 

//need to call EscapeStr() to encoded the NULL characters within the string 

//that is being sent. 

DO_WSK_Write(S2,temp, 19); 

/* 15 bytes: SID=1234567890^@ */ 

DO_WSK_Expect(S2, "^@"); 

DO_WSK_Closesocket(S2); 

... 

Conclusion  

In the sample script , the data was sent using the DO_WSK_Write() instead of the DO_WSK_Send(). This 
al lows you to send data without encoding i t .  

 

Using Central Datapools within a Winsock Script  

You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions, you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a central datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 

Sam ple Script  

/* Declare Variables */ 

//Variable declared to store the central datapool record. 

char temp[40]; 

… 
BEGIN_TRANSACTION(); 

//Gets a row of data from the Conductor during the test. 

GET_DATA(); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
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DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the central datapool row that was  

//returned when the GET_DATA() was called. 

strcpy(temp,VARDATA(1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//central datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 
DO_WSK_Closesocket(S1);  

Conclusion  

In th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

 

Accessing Server Replies 

Accessing Server Repl ies Using Respon se and ResponseLength   

You can save the ent ire reply that a server returns using Response() and ResponseLength(). When you cal l  
Response() direct ly after the DO_WSK_Expect(), i t  returns a pointer to the data received by the 
DO_WSK_Expect(). To receive the length of the received reply, cal l  the ResponseLength(). This returns the 
number of characters received.  

The sample script  i l lustrates how to use these commands to save a server reply. In  th is sample, the code in 
bold shows how to use Response() and ResponseLength().  

Sample Script  
/* Declare Variables */ 
//Below are variables needed for this example 
int x = 0; 
char *temp; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the actual buffer that was returned at capture time. 
/* 21 bytes: You are now connected */ 
DO_WSK_Expect(S1, "d"); 

// used to store the data that was received by the DO_WSK_Expect 
temp = Response();  
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//used to get the size of the response that was received so far. 
x = ResponseLength(); 

//The line below will print the length of the response  to the playerbuffer 
RR__printf(“The size of the received buffer was %d bytes ",x,); 

DO_WSK_Closesocket(S1); 

Conclusion 

In th is example, Response() and ResponseLength() are used to prin t  the message “ The size of the received 
buffer was 21 bytes”  to the player buffer window. 

 

 

Accessing Server Repl ies w i th  DO_WSK_Read  

When data received is too dynamic and there is noth ing on which to base the unique string, you cannot 
use the DO_WSK_Expect() to access server repl ies. In  th is case, when the number of characters received is 
always the same, you can use DO_WSK_Read().  

In  the fol lowing example, the user sends a logon string to the server and the server sends back a unique 
key that is used for subsequent cal ls. Since the ending characters always change, DO_WSK_Read is cal led to 
receive a specified number of characters. You can parse th is data for any values you need. The required 
code is shown in bold. 

Sample Script  
... 
BEGIN_TRANSACTION(); 

DO_WSK_Socket(S2, AF_INET, SOCK_STREAM, IPPROTO_TCP); 
 
DO_WSK_Bind(S2, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Connect(S2, "10.4.26.24", 80, AF_INET); 
 
/* 20 bytes */ 
DO_WSK_Send(S2, "^@user=Bob^@pwd=CPWR^@\377"); 
 
//The data that is being sent from the server is dynamic and the ending 
// character is never the same. Since this is the case using 
// DO_WSK_Expect() will not work, so the script will use DO_WSK_Read() 
// to receive the same number of bytes that were originally sent. 
/* 14 bytes: SID=1234567890 */ 
//DO_WSK_Expect(S2, "^@"); 
 
//The script will now print the response that was received by 
// calling Response() to gain access to the received buffer. 

If ( DO_WSK_Read(S2,14) != -1) 
RR__printf("String = %s",Response()); 
... 

Conclusion 

Using DO_WSK_Read() instead of DO_WSK_Expect() al lows the virtual user to receive a specific number of 
bytes instead of a sequence of characters. 
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Accessing Server Repl ies w i th  DO_WSK_Recv  

When the data returned is too dynamic and the DO_WSK_Expect() fai ls, you can use DO_WSK_Recv() to 
store the reply returned from the server. This saves the response based on i ts size instead of on the unique 
character string used in the DO_WSK_Expect(). When you use DO_WSK_Recv(), you specify how much 
data you want to receive and where to store i t .  

The sample script  i l lustrates how to use DO_WSK_Recv  to store the reply from the server. The required 
code is shown in bold. 

Sample Script  

/* Declare Variables */ 
//Below are variables that were declared to use with DO_WSK_Recv, 
//and the size of temp will vary depending upon the buffers that your 
//application is returning. 
int size = 0; 
char temp[45]; 
… 
BEGIN_TRANSACTION(); 
… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 
 
DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 
 
DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 
 
DO_WSK_Connect(S1, "127.0.0.1", 90, AF_INET); 
 
//Below is the data that was received at capture time. 
/* 21 bytes: You are now connected */ 
 
//Initializing the temp variable 
memset(temp,'\0',45); 

//Instead of calling DO_WSK_Expect() to receive the data, the 
//script will now call DO_WSK_Recv(). This will allow the script to  
//receive a specified number of characters instead of looking at the data 
//to determine if the buffer has been received entirely or not. 

DO_WSK_Recv(S1,temp,45,0,&size); 

//Original function that was in the script 
//DO_WSK_Expect(S1, “d”); 
//Prints the size of the string that was received to the playerbuffer. 
RR__printf("Size of the received buffer was %d bytes", size); 

DO_WSK_Closesocket(S1); 

Conclusion 

In th is example, the message “ Size of the received buffer was 21 bytes”  is prin ted to the player buffer 
window.  

Caut ion : When using th is method instead of the DO_WSK_Expect(), veri fy that you receive the 
correct in formation before moving on to the next funct ion in  your script . 

 

 

Using Local  Datapools w i th in  a Winsock  Script   
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You can use dynamic data in  your script  by reading data from a datapool fi le. However, datapool fi les must 
be in  an ASCII string, and not al l  dynamic data are in  th is format. For example, when the string 
 “ \ 121\ 101\ 114\ 157\ 141\ 144”  appears in  a datapool fi le and is read in using a one of the datapool 
funct ions,  you receive \ \ 121\ \ 101\ \ 114\ \ 157\ \ 141\ \ 144 as the output.  

You can ensure that the output string you receive is accurate by using the OctalToChar() to convert  any 
octal sequences into their binary representat ion. In  th is sample script , the string 
“ \ 121\ 101\ 114\ 157\ 141\ 144”  is read in from a local datapool fi le and converted to i ts binary 
representat ion. The required code is shown in bold. 

Sample Script  

//This is used as an easy to remember descriptor for the datapool file. 

#define DP1 1/* Identifier for a datapool file*/ 

/* Declare Variables */ 

//Variable declared to store the local datapool record. 

char temp[40]; 

… 
//Opens the datapool file 

OPEN_DATA_POOL("datapool.dat", DP1, TRUE) 

BEGIN_TRANSACTION(); 

//Reads a row of data in from the datapool file that was opened above 

READ_DATA_RECORD(DP1); 

… 
DO_WSK_Socket(S1, AF_INET, SOCK_STREAM, IPPROTO_IP); 

 

DO_WSK_Bind(S1, ANY_ADDR, ANY_PORT); 

 

DO_WSK_Setsockopt(S1, SOL_SOCKET, SO_OOBINLINE, 1); 

//Read the first column from the local datapool row that was  

//returned when the READ_DATA_RECORD () was called. 

strcpy(temp, GET_DATA_FIELD(DP1, 1)); 

 

//used to convert octal strings to their binary format 

OctalToChar(temp);  

//The script is now setup to send the data that was read in from the 

//local datapool file instead of the hard coded values that were captured. 

DO_WSK_Send(S1,temp); 

//Below is the original send that was captured. 

//DO_WSK_Send(S1,”\121\101\122\165\156”); 

DO_WSK_Closesocket(S1);  

Conclusion 
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In  th is example, the DO_WSK_Send() sends the octal representat ion for the string “ QALoad” , 
 “ “ \ 121\ 101\ 114\ 157\ 141\ 144” , to the server.  

 

WWW Scripts 

WWW Script Samples  

You can address specific si tuat ions or resolve certain  problems by modifying converted WWW scripts. The 
samples shown here include a descript ion of the problem, the procedure for implementing the 
modificat ion, and samples of a modified script . Scripts modificat ions are discussed for: 

Extract ing a String from a WWW Response and Reusing i t  as a CGI Parameter 

Extract ing and Reusing Web Service XML Values 

Moving the Transact ion Loop 

Extract ing and Reusing Cookies 

Extract ing a String from a WWW Response for Val idat ion 

Forcing a Subrequest 

IP Spoofing with a Local Datapool 

Prevent ing Unwanted Subrequests 

 

Extracting and Reusing Cookies 

Overview : Ex t ract ing and Reusing a Cook ie 

In some load tests, you may need to extract a cookie and use i t  later in  the script .   

Script ing 

To extract the cookie, use the DO_GetCookie(). Reuse the value with DO_SetValue. 

Conclusion 

The sample script  sn ippet i l lustrates extract ing and reusing a cookie. 

 

Sam ple: Ex t ract ing and Reusing a Cook ie  

The fol lowing sample is a port ion of a script  that extracts and reuses a cookie. 

Sample Script  
char * userid;  
char * aspsessionid;  
...  
...  
BEGIN_TRANSACTION();  
...  
...  
/* Request: 1 */  
DO_Http ("GET http://company.com/ HTTP/1.0\r\n\r\n");  
/*  
 * Get a cookie named USER_ID  
 */  
DO_GetCookie ( "USER_ID", 1, &userid );  
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/*  
 * Get the second ASPSESSIONID cookie. ASPSESSIONID  
 * cookies always have extra characters on the end to make  
 * them unique.  
 *  
 * An example ASPSESSIONID: ASPSESSIONIDQQQGGQDO=EBOOONBBFH  
 * BBELAJIMEFAKAP  
 */  
DO_GetCookie ("ASPSESSIONID*", 2, &aspsessionid );  
DO_SetValue(“User”, userid) 
DO_Http("POST http://company.com/ HTTP/1.0\r\n\r\n” 
 “Content-Type: application/x-www-form-urlencoded\r\n" 
 "Content-Length: {*content-length}\r\n" 
        “{User}”);  
 

Forcing a Subrequest 

Overview : Forcing a Subrequest  that  i s not  Being M ade Autom at i cal l y 

Occasional ly, one of the necessary subrequests that is recorded is not requested automatical ly at playback 
t ime. This can be caused by complex javascript  code not execut ing correct ly, or by an Act iveX control that 
cannot be used at playback t ime. You can force th is subrequest by insert ing an 
ADDITIONAL_SUBREQUEST statement. 

Script ing 

To request an addit ional subrequest, insert  a command l ike the one below before the act ion statement 
(Cl ick_On, Navigate_To, or Post_To).   

Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 

This adds the specified URL to the l ist  of subrequests automatical ly generated when the requested page is 
parsed. 

Conclusion 

Using these techniques, you can modify a script  to force a subrequest. The sample modified script  
i l lustrates forcing a subrequest. 

 

 

Sam ple: M odi f i ed Script  for Forcing a Subrequest   

In  th is example, one of the pages has an Act iveX object associated with i t  that automatical ly generates a 
request for i tems that are on sale.  However, at  playback th is request is not made because Act iveX objects 
are not executed at playback t ime. To force th is subrequest, you can insert  an Addit ional Subrequest i tem 
just before the act ion statement. Relevant statements are shown in bold. 

Sample Script  
//---------  REQUEST # 5  (see action item on Page 4)  --------- 
// 
//  current page url is http://xyz.com/chairs.htm 
// 
Set (NEXT_REQUEST_ONLY, ADDITIONAL_SUBREQUEST, "http://xyz.com/onsale.aspx"); 
Click_On(LINK, 1, DESCRIPTION, "Nuts and Bolts"); 
Verify(PAGE_TITLE, "Nuts and Bolts"); 
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IP Spoofing with a Local Datapool 

IP Spoof ing w i th  a Local  Datapool  

Datapools can provide IP spoofing addresses to scripts on playback machines. By creat ing a special IP 
spoofing datapool for the part icular playback machine, you can spoof the correct addresses at runt ime.   

Note:  For the script  to execute properly, the IP addresses in  the local datapool must match the IP 
addresses bound to the network cards on the playback machine. 

Script ing 

When you modify a Visual Script  to al low for IP spoofing for a local playback machine, you must: 

!  Create a datapool fi le with the IP addresses associated with the network cards on the playback 
machine. 

!  Insert  the required script ing code for datapool access in to the script . 

!  Retrieve and use the spoofed IP address. 

Visual Navigator 

Visual Navigator provides GUI in terfaces in  the tree view for creat ing datapool fi les and using spoofed IP 
addresses. You can use the datapool variables as IP spoofing addresses in  the IP spoof in terface. 

Conclusion 

By fol lowing these script ing techniques, you can modify a Visual Script  to extract IP addresses from 
datapool fi les for use as  spoofed addresses. The modified script  sample i l lustrates the modificat ions 
required in  the script . 

 

Moving the Transaction Loop Statements 

M oving the Transact ion  Loop Statem en ts 

Load test ing a web site can require you to log on and log out when you want to perform mult iple 
transact ions during a single session. You can move the BEGIN_TRANSACTION statement and the 
END_TRANSACTION statement so that the virtual user does not log on and log out with every transact ion. 

To m odi f y t he scr ipt : 

1. Move the BEGIN_TRANSACTION and RESTART_TRANSACTION_TOP statements so that they are 
just below any statements that log the user onto the system. 

2. Keep the RESTART_TRANSACTION_BOTTOM, Clear(TRANSACTION), and END_TRANSACTION 
statements together and move them so that they are immediately above the Logout requests. 

Tip: When moving the transact ion loop, you often have to add addit ional code to clean up memory. 
This may involve using the Clear or DO_Clear statement to clear cookies, headers, values, cache, and so on. 
If a session ID cookie is set at login, i t  may need to be manually handled in  order to clear out the rest of 
the cookies set during the transact ion. 

Visual Navigator 

If you are using Visual Navigator, you can move the Transact ion Loop statements in  the tree view rather 
than in the C++ script .  Simply select the Begin Transact ion i tem and cl ick the Move Down button unt i l  i t  
moves below the Logon pages.  Do the same for the End Transact ion by select ing the Transact ion Cleanup 
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t ree i tem and moving i t .  Any pages after the Transact ion Cleanup, such as the Logout, take place after al l  
t ransact ion in  the main loop have fin ished execut ing. 

Sample Scripts 

The fol lowing original script  sample and modified script  sample show a script  that logs in to a newsgroup 
forum, performs act ions, such as reading threads and replying to them, and then logs out. The scripts 
ident i fy the Logon and Logout requests and show the old and new locat ions of the transact ion statements.  

 

Sam ple: Original  WWW Script  Show ing the Transact ion  Loop 

The fol lowing sample shows the original script . The sect ions in  i tal ics are the requests involved with the 
Login and Logout.  The original  locat ions of the transact ion statements are shown in bold. 

Sample Script  
SYNCHRONIZE(); 
BEGIN_TRANSACTION();  
RESTART_TRANSACTION_TOP(); // do not modify this statement 
 
//---------  REQUEST # 1  --------- 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 
 
Navigate_To("http://www.myforum.org/"); 
Verify(PAGE_TITLE, "My woodworking forum - powered by vBulletin"); 
 
DO_SLEEP(9); 
 
//---------  REQUEST # 2  (see action item on Page 1)  --------- 
// 
//  current page url is http://www.myforum.org/ 
// 
// The submit button for this form could not be positively identified so 
// an appropriate action has been added (Post_To or Navigate_To).  The 
// values for the form fields will be set using Set( ) statement. 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_username", "John Smith"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "cookieuser", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_password", ""); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "s", "3669625a913735e99e31ec9a866a2f28"); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "do", "login"); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "forceredirect", "1"); 
Set (NEXT_REQUEST_ONLY, APPEND_CRLF_AFTER_POST_BODY, TRUE); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "vb_login_md5password", 
       "df0349ce110b69f03b4def8012ae4970"); 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 2 - "); 
 
Post_To("http://www.myforum.org/login.php"); 
Verify(PAGE_TITLE, "My Woodworking Forum"); 
 
DO_SLEEP(3); 
 
//---------  REQUEST # 4  (see action item on Page 3)  --------- 
// 
//  current page url is http://www.myforum.org/ 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 4 - "); 
 
Click_On(LINK, 1, DESCRIPTION, "Tables and Chairs"); 
Verify(PAGE_TITLE, "My Woodworking Forum – Tables and Chairs"); 
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DO_SLEEP(2); 
 
//---------  REQUEST # 5  (see action item on Page 4)  --------- 
// 
//  current page url is http://www.myforum.org/forumdisplay.php?f=17 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 5 - "); 
 
Click_On(LINK, 1, DESCRIPTION, "Log Out"); 
Verify(PAGE_TITLE, "My Woodworking Forum"); 
 
RESTART_TRANSACTION_BOTTOM(); // do not modify this statement 
Clear ( TRANSACTION ); 
END_TRANSACTION(); 
 
DO_FreeHttp(); 
 
EXIT(); 
return(0); 

 

Sam ple: M odi f i ed WW W  Script  for M oving the Transact ion  Loop Statem en ts 

The fol lowing sample shows the script  modified to move the transact ion loop statements. The sect ions in  
i tal ics are the requests involved with the Logon and Logout.  The new  locat ions of the transact ion 
statements are shown in bold. 

Sample Script  
SYNCHRONIZE(); 
 
//---------  REQUEST # 1  --------- 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 
 
Navigate_To("http://www.myforum.org/"); 
Verify(PAGE_TITLE, "My woodworking forum - powered by vBulletin"); 
 
DO_SLEEP(9); 
 
//---------  REQUEST # 2  (see action item on Page 1)  --------- 
// 
//  current page url is http://www.myforum.org/ 
// 
// The submit button for this form could not be positively identified so 
// an appropriate action has been added (Post_To or Navigate_To).  The 
// values for the form fields will be set using Set( ) statement. 
// 
Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_username", "John Smith"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "cookieuser", "1"); 
Set(NEXT_REQUEST_ONLY, POST_DATA, "vb_login_password", ""); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "s", "3669625a913735e99e31ec9a866a2f28"); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "do", "login"); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "forceredirect", "1"); 
Set (NEXT_REQUEST_ONLY, APPEND_CRLF_AFTER_POST_BODY, TRUE); 
Set (NEXT_REQUEST_ONLY, POST_DATA, "vb_login_md5password", 
       "df0349ce110b69f03b4def8012ae4970"); 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 2 - "); 
 
Post_To("http://www.myforum.org/login.php"); 
Verify(PAGE_TITLE, "My Woodworking Forum"); 
 
BEGIN_TRANSACTION();  
RESTART_TRANSACTION_TOP(); // do not modify this statement 
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DO_SLEEP(3); 
 
//---------  REQUEST # 4  (see action item on Page 3)  --------- 
// 
//  current page url is http://www.myforum.org/ 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 4 - "); 
 
Click_On(LINK, 1, DESCRIPTION, "Tables and Chairs"); 
Verify(PAGE_TITLE, "My Woodworking Forum – Tables and Chairs"); 
 
DO_SLEEP(2); 
               All additional Requests that will occur every transaction 
RESTART_TRANSACTION_BOTTOM(); // do not modify this statement 
Clear ( TRANSACTION ); 
END_TRANSACTION(); 
//---------  REQUEST # 5  (see action item on Page 4)  --------- 
// 
//  current page url is http://www.myforum.org/forumdisplay.php?f=17 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 5 - "); 
 
Click_On(LINK, 1, DESCRIPTION, "Log Out"); 
Verify(PAGE_TITLE, "My Woodworking Forum"); 
 
DO_FreeHttp(); 
 
EXIT(); 
return(0); 

 

 

Preventing Unwanted Subrequests 

Overview : Preven t ing Unw an ted Subrequests 

Pages your script  requests may make a subrequest that causes the transact ion to abort . There also may be 
subrequests that skew the load test results. For example, one of the pages you visi t  may bring up random 
advert isements, some of which can take a long t ime to load. To prevent these subrequests, you can insert  
one or more Traffic Fi l ter commands. 

To m odi f y t he scr ipt : 

1. Ident i fy the URL of the offending subrequest.   

2. Insert  a Set command with the BLOCK_TRAFFIC_FROM keyword and a string that ident i fies the 
URLs to block. 

 Typical ly, you place th is statement near the top of the script  before the BEGIN_TRANSACTION statement, 
since you always want i t  in  effect.  For example, the fol lowing command prevents any subrequests to URLs 
contain ing “ AcmeAds” : 

Set (EVERY_REQUEST, BLOCK_TRAFFIC_FROM, "AcmeAds"); 

Note: The fi l ter string does not need to be a complete URL.   

You can also fi l ter the traffic by specifying a substring that must be present in  the requested URL.  For 
example, i f you are concerned with making subrequests only to pages on your company’s web site, you can 
insert  a ONLY_ALLOW_TRAFFIC_FROM traffic fi l ter command.  The fol lowing example only al lows 
subrequests whose URLs contain the substring “ myCorp” : 

Set (EVERY_REQUEST, ONLY_ALLOW_TRAFFIC_FROM, "myCorp"); 
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Visual Navigator 

If you are using Visual Navigator, you can specify fi l ters by h ighl ighting the Traffic Fi l ters tree i tem 
underneath the Playback Options at the top of the tree and type the commands in the top pane of the 
window.  

Conclusion 

By fol lowing these script ing techniques, you can modify a script  to prevent unwanted subrequests. The 
sample script  i l lustrates the modificat ions required in  the script . 

 

Sam ple: Preven t ing Unw an ted Subrequests 

The fol lowing sample uses a fi l ter string to prevent the unwanted subrequest. Points of in terest are 
h ighl ighted in  bold. 

Sample Script  
Set (EVERY_REQUEST, BLOCK_TRAFFIC_FROM, "AcmeAds"); 
SYNCHRONIZE(); 
 
BEGIN_TRANSACTION();  
RESTART_TRANSACTION_TOP(); // do not modify this statement 
 
//---------  REQUEST # 1  --------- 
// 
Set (NEXT_REQUEST_ONLY, CHECKPOINT_NAME, "Page 1 - "); 
 
Navigate_To("http://www.mystore.com/"); 
Verify(PAGE_TITLE, "Jack’s Hardware Store"); 
etc.  

 

NetLoad 

Using NetLoad 

NetLoad is QALoad’s suite of load generat ion scripts that al lows you to simulate load condit ions on your 
network using any of the fol lowing protocols: 

!  FTP 

!  HTTP 

!  PING 

!  LDAP 

!  POP3 

!  SMTP 

!  TCP 

!  UDP 

!  MSExchange 

NetLoad includes QALoad-provided scripts, which you can access from the Conductor to run in  a test, for 
each protocol. You can customize the act ivi ty of the script  by creat ing reusable datapools in  the QALoad 
Script Development Workbench to use during test ing. When you run a test, each virtual user requests a 
single datapool record. Once al l  the records have been read, the datapool fi le is rewound and the process 
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starts again. You can use QALoad’s components to run scripts and analyze the results as usual, or you can 
integrate your results with Compuware’s ServerVantage product. 

In  short , NetLoad al lows you to generate traffic on your network in  a control led manner and gather 
performance t im ings from the network. To faci l i tate test ing under TCP/IP and UDP, NetLoad provides you 
with a server module to simulate server act ivi ty — al lowing you to gather network t im ings without 
expending your actual server resources. 

Note: To use NetLoad for MSExchange to test on Outlook 2000, you must ensure that CDO support is 
instal led on your workstat ion before you cont inue. For instruct ions, see Verifying CDO Support for 
MSExchange. 

For more in formation on the NetLoad Server modules, see NetLoad Server Modules for TCP/IP and UDP. 

 

NetLoad server modules for TCP/ IP and UDP 

If you are load test ing a network running TCP/IP or UDP, you should use the appropriate NetLoad Server 
module to simulate server responses during your load test. This al lows you to load your network and 
col lect t im ings without expending your own server’s resources. The NetLoad Server modules are only for 
use i f you’re test ing on TCP/IP or UDP. You do not need to instal l  the Server modules to test any other 
NetLoad-supported protocol.  

You can instal l  or copy the NetLoad Server modules to any Windows workstat ion on your network. After 
start ing the appropriate Server module, you supply the QALoad Script Development Workbench with the 
host name of the machine where the Server module is running and the port  number that you specified 
when you started the Server module. When you are ready to run a test, start  the Server module fi rst . During 
the test NetLoad communicates with the NetLoad Server module, effect ively loading the network. If 
NetLoad does not find the NetLoad Server module at the specified port—for instance i f you mistyped the 
port  number—the test fai ls (TCP) or fai ls to in i t iate (UDP).  

Determining when to use the TCP server module 

If you are going to send TCP packets using NetLoad, you must have a QALoad TCP Server module running 
on each machine that you are sending packets to. Copy the TCP Server module fi le, Net loadTCPServer.exe, 
to each machine that wi l l  be receiving packets and double-cl ick on the fi le to start  the TCP Server module. 

Because the QALoad TCP Server module is a Windows-based program, you cannot use i t  to send NetLoad 
TCP packets to a UNIX machine.  

Determining when to use the UDP server module 

It  is not necessary to have a QALoad UDP Server module running at the dest inat ion machine for NetLoad 
to successful ly send packets to i t ; however, the Netload UDP Server can be useful to veri fy that the packets 
are being sent. To instal l  the UDP Server module on  a machine you are sending packets to, copy the 
program NetloadUDPServer.exe to that machine. Double-cl ick the fi le to start  the UDP Server module. 

Since i t  is not necessary to have the UDP Server module running, you can send NetLoad UDP packets to 
both UNIX and Windows workstat ions. 

Note: If you are test ing UDP in “ broadcast”  mode, i t  is not necessary to use the NetLoad Server 
module. 

Installing the NetLoad Server module 

If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol must be running on a Windows workstat ion on your network before you start  the test. The Server 
modules are instal led automatical ly i f you chose the opt ion to instal l  them during setup. However, once 
the Server module is instal led on one workstat ion, you can instal l  i t  on another workstat ion by simply 
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copying the program from one workstat ion to another. The NetLoad Server modules are instal led to the 
directory \Program Files\Compuware\QALoad\Middlewares\NetLoad\Server, and are named: 

!  NetLoadTCPServer.exe (for TCP/IP): If you are going to send TCP packets using NetLoad, you 
must have a TCP Server module running on each machine you are sending packets to. Because the 
TCP Server module is a Windows program, you cannot send NetLoad TCP packets to a UNIX 
machine. 

!  NetLoadUDPServer.exe (for UDP): It  is not necessary to have a UDP Server module running on the 
machines you are sending UDP packets to. However, the UDP Server is useful for veri fying that the 
packets are being sent. Since i t  is not necessary to have a UDP Server module instal led on the 
dest inat ion workstat ions, you can send NetLoad UDP packets to UNIX machines.  

 

Start ing the NetLoad server module 

You can configure and start  the NetLoad server module from the Start  menu.  

If you are load test ing a network running TCP/IP or UDP, the NetLoad Server module appropriate for your 
protocol should be running on a Windows workstat ion on your network before you start  the test. The 
Server modules are instal led with your QALoad product i f you chose to instal l  them during setup. If you are 
unsure i f you should be using a NetLoad Server module, see NetLoad server modules for TCP/IP and UDP. 

To st ar t  t he m odule: 

1. Point to Start>Program s>Com puw are> QALoad >NetLoad. Then cl ick on the appropriate Server 
module: TCP Server or UDP Server. 

2. When prompted, type the port  number of the host machine and cl ick OK. 

3. On the QALoad NetLoad Server window, under the Opt ions menu, select one of the fol lowing: 

!  Show  M essage Every Packet  — Displays a message, including byte size, after sending or 
receiving a packet. 

!  Show  M essage Every 100 Packets — Displays a message every 100 packets l ist ing the total 
number of packets received.  

Start ing a NetLoad session 

You can start  a NetLoad session from the workbench with an exist ing datapool fi le or a new one. 

To st ar t  a session: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 

2. Open an exist ing protocol datapool fi le or create a new one: 

!  To create a new datapool f i le, choose Fi le>New . The New NetLoad Fi le dialog box opens. 

!  To open an exist ing datapool fi le, choose Fi le>Open . The Open NetLoad Fi le dialog box opens. 

3. Select the protocol you wish to test on and cl ick OK. If you are opening an exist ing datapool fi le, 
navigate to the fi le and open i t . 

4. Enter or edit  the appropriate datapool in formation in  the Workbook  Pane. 
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The QALoad Script Development Workbench al lows you to have mult iple fi les open at the same t ime. 
Datapool fi les are located in  the directory \Program 
Files\Compuware\QALoad\Middlewares\NetLoad\Scripts.  

 

Creat ing a NetLoad datapool 

To creat e a Net Load dat apool : 

1. From the QALoad Script Development Workbench, cl ick Session>NetLoad. 

2. Click Fi l e>New  to open the New NetLoad Fi le dialog box. 

3. Select the protocol for wh ich you wish to create a datapool fi le and cl ick OK. 

A grid opens in the Workbook Pane. Each row on the grid represents a single data record. The column 
headings indicate the appropriate field in formation to enter. Note that the actual fields in  the grid vary 
by protocol. 

4. Enter the appropriate in formation for your datapool  fi le. 

Some fields on the grid contain pul l-down menus. To act ivate them, cl ick anywhere with in the field. 
Then make your select ion  from the menu that appears. 

5. When you are fin ished, select Fi l e>Save to name and save the datapool fi le. 

The datapool fi le is l isted in  the Workspace Pane Datapools tab. QALoad creates a script  with the same 
name and l ists i t  on the Scripts tab. Both fi les are saved to the \NetLoad\Scripts directory (for example, 
c:\Program Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat).  

 

To ent er  dat apool  dat a: 

1. From the QALoad Script Development Workbench, choose Session>NetLoad. 

2. Click Fi l e>New  to open the New  NetLoad Fi le dialog box. Select the protocol for which you wish 
to create a datapool fi le and cl ick OK. A grid similar to the one shown below appears in  the 
Workbook Pane. Each row on the grid represents a single data record. The column headings 
indicate the appropriate field in formation to enter. Note that the actual fields in  the grid vary by 
protocol. 
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3. Enter the appropriate in formation for your datapool  fi le. Note that some fields on the grid contain 
pul l-down menus. To act ivate them, cl ick anywhere with in the field. Then make your select ion 
from the menu that appears. 

4. When you are fin ished, cl ick Fi l e>Save to name and save the datapool fi le. Note that your datapool 
fi le is l isted in  the Workspace Pane Datapools tab. QALoad creates a C-based script  by the same 
name and l ists i t  in  the Workspace Pane Scripts tab. Both fi les wi l l  be saved to your 
\NetLoad\Scripts directory (for example, c:\Program 
Files\Compuware\QALoad\Middlewares\NetLoad\Scripts\datapool.dat). 

5. (Optional) Write a descript ion of th is datapool fi le for later reference by select ing 
Opt ions>NetLoad. Once a descript ion has been entered for a datapool fi le, you can review or edit  
the descript ion any t ime the fi le is open by select ing Opt ions>NetLoad again. 

Edit ing a NetLoad datapool 

You can edit  the NetLoad datapool to make changes or addit ions to the fi le. 

To edi t  a dat apool : 

1. With the appropriate NetLoad protocol session open, open the datapool by choosing Fi l e>Open  
and navigat ing to i t , or select i t  from the Workspace tab Datapools tab. 

2. Make any changes or addi t ions to the fi le. 

3. To delete an ent ire record (a single row), cl ick i ts row number and select Grid>Delete Row (s). 

4. To insert  a new record (a single row) above an exist ing record, cl ick a row number and select 
Grid>In sert  Row . NetLoad inserts a blank row above the selected row. 

5. Save any changes to the fi le by select ing Fi l e>Save.  

Adding or edit ing a NetLoad datapool descript ion 

You can add a meaningful descript ion, or edit  a previous one, for any NetLoad datapool. 

To edi t  a descr ipt ion: 
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1. With a datapool fi le open, select Opt ions>NetLoad. 

2. Enter a descript ion for the current datapool fi le.  

 

Datapool fields 

The fol lowing protocol-specific fields are provided with in a datapool: 

M SExchange 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Prof i l e Nam e: Type the name of your mail  profi le. For example, M icrosoft  Out look. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

FTP 

Send/ Receive: Specifies whether the script  wi l l  be sending or receiving a fi le. 

ASCII / Binary: Describes whether the fi le contains ASCII or binary data. 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host : The name of the host computer. 

User ID: A user ID for accessing the host computer. 

Passw ord: A password for accessing the host computer. 

Fi l e Size Opt ions: Describes whether the fi le being sent to the host is of fixed or random size. 

Fi l e Size (m in ): The min imum fi le size to send to the host or the size of the fixed fi le. 

Fi l e Size (m ax): The maximum fi le size to send to the host. 

Path : The path of the fi le to receive, or the dest inat ion of the fi le being sent. You must enter an absolute 
path. 

Fi l enam e: The name of the fi le to receive or of the fi le being sent. 

HTTP  

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

URL: The address of the page to receive. 

Proxy Server: The name of the proxy server (opt ional). Note that only proxy servers that do not require a 
user ID and password are supported. 

PING  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 
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Pkt  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pk t  Size (m ax): The maximum packet size to send. 

LDAP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Search  St r ing: The text string to search for. 

POP3  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

POP3 Server: The name of the POP3 server machine. 

User ID: A user ID for accessing the POP3 server. 

Passw ord: A password for accessing the POP3 server. 

Delete af ter read: Choose whether to delete the message after i t  has been read. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

SM TP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

SM TP Server: The name of the SMTP server machine. 

From : Enter an email  address or name. 

Send To: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Cc: Type the names of one or more mail  recipients, separated by commas (,) or semi-colons (;). 

Size of  Body: Select a fi le size from the drop-down l ist  for the body of the mai l  message. 

Fi l e Path : Select a fi le from the drop-down l ist  to use as the body of the mail  message. This field displays 
fi les in  the local directory only i f you selected Browse in the Size of Body field. 

At tached f i l e si ze: Select a fi le size for the attachment fi le from the drop-down l ist . 

At tached f i l e path : Select a fi le from the drop-down l ist  to use as an attachment. This field displays fi les in  
the local directory only i f you selected Browse in the Attached Fi le Size field. 

Connect ion : Describes whether the connect ion is regular (the connect ion is closed after the 
request/ response completes) or persistent (the connect ion remains open for subsequent requests). 

TCP  

Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: The name of the host computer. 

Port : The port  number of the host computer. 

Pk t  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pk t  Size (m ax): The maximum packet size to send. 

UDP  
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Checkpoin t  Descri pt i on : A descript ion of th is checkpoint. 

Host  Nam e: Type the name of the host computer that is to receive the packet. 

Port : The port  number of the host computer. 

Pk t  Size (Fixed/ Random ): Describes i f the packet being sent to the host is of fixed or random size. 

Pk t  Size (m in ): The min imum packet size to send, or the size of the fixed packet to send. 

Pk t  Size (m ax): The maximum packet size to send. 

Verifying CDO support  for MSExchange 

Before you can successful ly test with NetLoad for M SExchange using Outlook 2000, you must ensure that 
Col laborat ion Data Objects (CDO) support is instal led. 

To ver i f y CDO suppor t : 

1. From the Windows task bar, cl ick Start>Set t i ngs>Con t rol  Panel . 

2. Double-cl ick the Add/ Rem ove Program s icon. 

3. From the l ist  on the Instal l / Un instal l  tab, select M icrosoft  Office 2000 or M icrosoft  Out look 2000. 

4. Click the Add/ Rem ove button. 

5. Click Add or Rem ove Features. 

6. Click the plus sign (+) next to M icrosoft  Out look for Windows. 

7. Select Col laborat ion  Data Objects, and then cl ick Run  f rom  M y Com puter. 

 

UNIX 

Installing UNIX Players 

The necessary UNIX Player software is distributed with your QALoad Windows instal lat ion. 

Note: For updated UNIX system requirements and instal lat ion procedures, please refer to the QALoad 
Installation and Configuration Guide. You can access th is guide by cl icking 
Start>Program s>Com puw are>QALoad>Docum en tat ion>Instal l at i on  and Con f igurat ion  Guide. 
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Transferring Scripts to a UNIX Player 

Normally, the appropriate script  is automatically uploaded from the QALoad Conductor to the Players and 
compiled at runt ime. However, i f i t  is ever necessary to manually transfer a script , use the procedure that 
fol lows. 

Note: The machine where the QALoad Script Development Workbench is instal led must have 
Winsock-based TCP/IP to transfer a script  to the UNIX machine where you wish to run i t . 

To t ransf er  a scr ip t : 

The fol lowing procedure describes how to transfer a script  fi le from the Windows workstat ion where the 
QALoad Script Development Workbench resides to the system running the QALoad Player. 

1. Access the Script Development Workbench. 

2. From the Session  menu, choose the middleware session you want to start . 

3. In  the Workspace Pane, cl ick the Scripts tab. 

4. On the Scripts tab, select the script  you want to transfer. 

5. From the Tools menu, choose FTP to open the FTP Transfer dialog box. Note that the fi le name 
you selected to transfer appears in  the Fi l e to Transfer field. 

6. Enter the Host  Nam e, User Nam e, Passw ord, and Dest inat ion  Di rectory. 

7. Click Transfer to send the fi le to the system where your QALoad Player is instal led. 

8. If you want to save the in formation you have entered for subsequent transfers, cl ick Save Set t i ngs. 

9. Click Close/ Abort  to exit  the FTP Transfer dialog box.  

 

Packaging Scripts for ClientVantage 

Overview - Packaging Scripts for ClientVantage 

ClientVantage users must veri fy that versions of scripts and Player software located on each agent mach ine 
are compatible. When dispari t ies exist , for example, when product ion systems are upgraded, the test scripts 
used to monitor the end-user experience also must be updated.  

QALoad's Package Script funct ion enables you to select a QALoad script , veri fy that i t  is up-to-date, and 
then package i t  in  a zip fi le that you can transfer to Player machines in  any locat ion. The Package Script  
ut i l i ty automatical ly determines and includes al l  associated fi les, such as datapools and binary fi les, that 
are required to run the script . The zip fi le contains the script , i ts auxi l iary fi les, and a manifest fi le that l ists 
the packaged fi les and the middleware the script  uses.  

Note: You must compile scripts before placing them in the zip fi le. 

How to Package a Script   

Use th is procedure to select a QALoad script  and package i t  and al l  i ts associated fi les in to a zip fi le that you 
can transfer to a Player machine for use by ClientVantage. 

To select  a scr ip t : 

1. Open a session in  the Script Development Workbench. 



QALoad Online Help 

281 

2. Select a script  in  the Workspace pane and cl ick Fi l e>Package Scri pt . The Package Scripts dialog box 
appears with the script  you selected displayed in the Script  Fi l e field. 

Note: You can open the Package Scripts dialog box before choosing a script , then cl ick Brow se to 
open the Select Script  Fi le to Package dialog box and select the script .  

To package t he scr ip t : 

1. In  the Package Scripts dialog box, cl ick Package. The Select Package Directory and Name dialog box 
appears. 

2. Click the down arrow in the Save in  field to select the directory where you want to save the zip 
fi le. The default  directory provided is Program Files\Compuware\QALoad. 

3. In  the Fi l e nam e field, type a name for the zip fi le. The default  name provided is the name of the 
script . 

4. Click Save. The zip fi le is created and saved in the directory you selected. The Package Scripts 
dialog box displays. 

Note: You can only package compiled scripts. If you try to use the Package Scripts ut i l i ty on an 
uncompiled script , an error message appears. You must exit  the Package Scripts dialog box, compile the 
script , and start  the script  packaging process again.  

5. Select another script  to package, or cl ick Close. 

To unpackage t he scr ip t : 

To unpackage the script , access the Vantage Console in  Cl ientVantage where you can publ ish the script . 
For more in formation on how to use the Vantage Console, refer to the onl ine help in  Cl ientVantage. 

 

Troubleshoot ing 

ODBC Memory Error Crash 

Whenever a user-started capture is in i t iated, QALoad appears to begin capturing, but as soon as the 
program to capture against i t  is started, a memory except ion is encountered. 

The fol lowing error is not encountered immediately. It  may not occur unt i l  you attempt to cl ick on 
something or perform some sort  of act ivi ty on your machine.  

Application popup: explorer.exe - Application Error : The instruction at 
"0x1001ee30" referenced memory at "0x1001ee30". The memory could not be 
"written". 

To f ix  t he ODBC m em ory er ror  crash: 

If you are running Windows XP Pro SP2, perform the fol lowing steps: 

1. Right-cl ick on M y Com puter and select Propert i es. The System Propert ies dialog box appears. (If 
your My Computer is not avai lable, access Con t rol  Panel>System .) 

2. Select the Advanced tab, then cl ick Set t i ngs in  the Performance group box.  
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3. On the Performance Options dialog box, select the Data Execut ion  Preven t ion  tab. Make sure that 
Turn  on  DEP for al l  program s…”  is selected. 
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4. Click Add, then navigate to select the fol lowing appl icat ions:   

a. <systemroot>\explorer.exe  

b. <systemroot>\system32\rundll32.exe  

5. Click OK for any warnings that appear. 

6. Click OK on the Performance Options dialog box to save your changes and close the dialog box. 

 

The Default  Session Prompt  Did Not  Open? 

If the Default  Session Prompt fai ls to open when you start  a middleware session, then default  session 
checking was previously disabled. Do the fol lowing to enable default  session checking: 

1. From the Opt ions menu, choose Workbench . The Configure QALoad Script Development 
Workbench dialog box opens. 

2. On the Workben ch  Con f igurat ion  tab, select the Enable defaul t  Session  ch eck ing check box. 

The next t ime you open a QALoad Script Development Workbench middleware session, you are prompted 
to make i t  your default  session.  

 

Winsock Running Out of Socket  Resources 

You may encounter a problem running out of socket resources on NT or Solaris when there are large 
numbers of short-l ived connect ions. 

When TCP/IP connect ions are shutdown, they go in to a TIME_WAIT state wait ing for the specified in terval 
to expire. While in  that state the connect ion is looking for any stray packets that may have been sent to 
th is connect ion and remain unacknowledged. 

If th is process was skipped, i t  would be possible for a new connect ion to be opened using the same address 
and port  as the previous connect ion and to incorrect ly receive data that was intended for the previous 
connect ion. When QALoad is generat ing many short-l ived connect ions, during a Winsock or WWW load 
test, the default  sett ing for the t imed wait  delay may be so h igh that the driver machine wil l  run out of 
socket resources as al l  closed sockets wait  in  the TIME_WAIT state. 

To change the sett ing for the t imed wait  delay: 

Windows NT 

Set the registry key: 

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\tcpip\ 
Parameters\TcpTimedWaitDelay 

to a lower value. It  can be set to anyth ing between 30 and 300. Compuware suggests using the lowest 
possible value (30). 

Solaris 2.6 

Using "ndd" set the "tcp_close_wait_interval" to 30 seconds: 

ndd -get /dev/tcp tcp_close_wait_interval 

ndd -set /dev/tcp tcp_close_wait_interval 30000 

Solaris 2.7 

Use "ndd" as shown previously for Solaris 2.6, but subst i tute the "tcp_t ime_wait_interval"  
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Cit rix 

Performance issues with SAP or Citrix scripts 

If you experience performance issues with SAP or Citrix scripts, increase your system paging fi le size to a 
fixed size of at least four t imes the amount of RAM on the machine. 

 

Recording Citrix Scripts for Restricted Desktops  

When recording a Citrix script  on a restricted desktop, you must take extra steps to ensure proper playback. 
Dynamic windows may be created and destroyed with no user in teract ion at both logon and logoff. To 
prevent unexpected results during playback, do not cl ick on any of these dynamic windows. For example, 
the script  might attempt to cl ick on a destroyed window or a window that has not been created yet. The 
appearance of dynamic windows often depends on the speed of the server or the load on the farm during 
playback. 

 

 

Desktop Screen Resolution When Recording Citrix Scripts 

To ensure that the ent ire Citrix in terface is visible during recording, set the Resolut ion field in  the Citrix 
recording opt ions to a lower value than that of the desktop. Also, the screen resolut ion must be the same 
as the screen resolut ion specified in  the Citrix ICA fi le. 

 

 

Wait Points in Citrix Scripts 

When mouse move consol idat ion is enabled via the Combine Mouse Input opt ion on the Convert  Opt ions 
dialog box, not al l  events that were captured appear during replay. As a result , the placement of wait  points 
for window moves and window resizing is importan t. When a window is moved on the desktop, a window 
move event is created for each mouse move. However, during replay of a consol idated script , only one 
mouse move is made (to the final dest inat ion), and subsequently only one window move event occurs. 
Because of th is consol idat ion of consecut ive mouse and window moves, the CtxWaitForWindowMove 
command in your script  should target the final window move in the series. This issue also appl ies to the 
CtxWaitForWindowResize command and the resizing of windows on the desktop. 

If a window's t i t le changes while the window is being created (such as a browser window's t i t le bar 
changing once the default  Web page begins to load), the CtxWaitForWindowCreate command may t ime 
out. If th is occurs, remove the wait  point or insert  a CtxWaitForScreenUpdate command to preserve the 
wait  in  the script . 

 

SAP 

Performance issues with SAP or Citrix scripts 

If you experience performance issues with SAP or Citrix scripts, increase your system paging fi le size to a 
fixed size of at least four t imes the amount of RAM on the machine. 
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SAP Script Validation Fails 

If your SAP script  fai ls during val idat ion i t  perform any of the fol lowing procedures to resolve the problem.  

Disable Automatic Proxy Configurat ion in  Internet Explorer 

To d isable aut om at ic p roxy conf igurat ion: 

You may need to disable automatic proxy configurat ion in  Internet Explorer. 

1. In  Internet Explorer, cl ick Tools>In ternet  Opt ions. 

2. On the Connect ions tab, cl ick LAN Set t i ngs. 

3. Ensure that the Use autom at i c con f igurat ion  scri pt  check box is cleared. 

Increase the Script Execut ion Timeout Value 

To increase t he t im eout  value: 

If disabl ing the automatic proxy configurat ion does not solve the problem, consider increasing the script  
execut ion t imeout value to 100 seconds or to the length of the capture fi le (in  seconds), whichever is 
greater. 

1. With an SAP session open in the Script Development Workbench, cl ick Opt ions>Workbench . 

2. On the Script  Val idat ion  tab, type the new value in  the Wai t  up to field. 

3. Click OK. 

Do Not M in imize the SAP Window 

To m axim ize t he SAP w indow : 

During val idat ion of SAP scripts, do not min imize the SAP window. If the window is min imized, the 
val idat ion may fai l . This problem does not occur i f you do the fol lowing: 

1. In  Conductor, select the script  icon to display the Script Propert ies panel on the right-hand side of 
the Visual Designer window.  

2. In  the M iddleware Options area, cl ick the arrow in the Hide Ci t r i x / SAP GUI f ield, and select True. 

 

 

Linking Errors During Validation or Compilation of SAP Scripts 

When you re-record SAP scripts, you must cl ick Bui ld SAP Libraries on the SAP Convert  Options dialog 
box. This button generates new l ibraries based on the version of SAP that is current ly instal led. If you have 
upgraded to a newer version of SAP and do not update the l ibraries, you may experience various l inking 
errors during val idat ion or compilat ion. 

 

Compiler Errors with SAP Scripts 

If you receive a type mismatch error when compil ing an SAP script , you must remove the quotat ion marks 
around the last parameter of the affected command. For example: 

error C2664: '<FuncName>' : cannot convert parameter n from 'char [n]' to 'long' 



Using the Player, Script  Development Workbench, and Analyze 

286 

This compiler error, which can occur in  commands that manipulate column widths, indicates a data type 
error and can be corrected by removing the quotat ion marks around the last parameter.  

The fol lowing example shows the l ines in  a script  that could cause an error, and the corrected version of 
the same l ines: 

Script  that  produces the error: 
   SAPGuiPropIdStr("wnd[0]/shellcont[1]/shell"); 
   SAPGuiCmd2(GuiCtrlTree, SetColumnWidth, "REPNAME", "218"); 

Corrected scri pt : 
   SAPGuiPropIdStr("wnd[0]/shellcont[1]/shell"); 
   SAPGuiCmd2(GuiCtrlTree, SetColumnWidth, "REPNAME", 218); 

 



QALoad Online Help 

287 

Analyze 

Overview of Analyze 
QALoad Analyze is the QALoad component used to create summary stat ist ics and graphs from t im ing data 
col lected during a load test. Set cri teria for col lect ing and displaying test data in  Analyze before or after 
opening a test ’s t im ing fi le (.t im). For example, alter output opt ions, t ime ranges, and graphics display 
opt ions.  

Analyze stores the state of a t im ing fi le when i t  is closed so that next t ime you open i t , you see the same 
reports and graphs that were present last t ime you viewed i t . You also have the abi l i ty to easi ly create 
templates, which enable you to specify the reports and graphs that are automatical ly generated for any 
new t im ing fi le you open. 

In addit ion, Analyze generates a working folder where al l  fi les and reports related to the t im ing fi le are 
stored. Analyze provides pre-defined reports as well  as the abi l i ty to create custom reports using XML fi le 
(.xml), XSL translat ion fi le (.xsl), and HTM fi le (.h tm) formats. View these reports in  Analyze or in  a web 
browser.      

Analyze displays a t im ing fi le tab in  the Workspace, with each tab contain ing groups. Use Analyze’s 
in teract ive view to sort  test data, produce detai led checkpoint data, produce a variety of graphs and reports 
(with drag and drop funct ional i ty), export  data to different formats, and emai l  test results and pre-defined 
reports. 

 

Accessing Analyze 
The fol lowing procedures describe how to start  QALoad Analyze. 

To access Analyze f rom  t he QALoad Conduct or : 

1. In  the QALoad Conductor, cl ick Tools>Opt ions. The Options dialog box appears. 

2. Click the General  tab. In  the General Options area, select the Launch  An alyze Af ter Test  check 
box. 

At the end of each test run, QALoad Conductor automatical ly launches QALoad Analyze and opens the 
most recent t im ing fi le. If you did not select the Launch Analyze After Test check box before the test, 
fol low the steps below.  

1. Click Tools>Analyze. 

2. In  QALoad Analyze, cl ick Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le 
to work with by double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

To access Analyze f rom  t he W indow s St ar t  m enu: 

Cl ick Start>Program  Fi les>Com puw are> QALoad >Analyze. 
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Understanding Durat ions 
When you begin to analyze your test results, i t  is important to understand how durat ions are calculated by 
QALoad.  

Transact ion Durat ion 

Transact ion durat ion is the t ime that the script  being tested takes to complete a transact ion, from the 
BEGIN_TRANSACTION command to the END_TRANSACTION command. 

Three factors comprise transact ion durat ion: 

!  The script  processing t ime including, but not l im ited to, added script  logic, QALoad processing of 
server repl ies, and other QALoad processing. 

!  Sleep t ime. 

!  The response t ime of the appl icat ion under test including, but not l im ited to, the appl icat ion 
server, database access, and network. 

Checkpoint  Durat ion 

Checkpoint durat ion is the amount of t ime between begin and end checkpoint statements. The fol lowing 
factors comprise checkpoint durat ion and apply to both automatic checkpoints and user-defined 
checkpoints. 

If you select the Conductor's Enable t im ing of  autom at i c m iddlew are checkpoin ts opt ion or use the 
BeginCheckpoint and EndCheckpoint funct ions in  the script , the fol lowing factors comprise checkpoint 
durat ion: 

!  The response t ime of the appl icat ion under test, including, but not l im ited to, the appl icat ion 
server, database access, and network. 

!  Sleep t ime, i f the Conductor's Incl ude sleep t im e w hen  calculat ing checkpoin t  t im ings opt ion is 
selected in t  he Timing page of the Script Propert ies dialog box. For more in formation, see Sett ing 
Options for Timing Data 

!  QALoad processing t ime is not included with in these checkpoints in  order to provide a more 
accurate value of server, database, and network response t imes. 

Checkpoint durat ions do not always sum to the same value as the transact ion durat ion. For more 
in formation, see comparing checkpoint durat ions to transact ion durat ion. 

 

QALoad Analyze Menus and Toolbar But tons 
Click a menu or toolbar name in the fol lowing l ist  for a descript ion.  

Fi le 

Edit  

View 

Template 

Tools 

Window 

Help 

Analyze Toolbar Buttons 
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Graph Toolbar Buttons  

 

Accessing Test  Data 

Using Timing Files 

When you run a test using a part icular session ID fi le (set up in  the Conductor), each Player compiles a 
local t im ing fi le comprised of a series of t im ing records for each checkpoint of each script  run on that 
Player. Each t im ing record in  the fi le consists of a response t ime/elapsed t ime pair of values specifying the 
amount of t ime i t  took a certain checkpoint to fin ish (response t ime) at a specific t ime in the test (elapsed 
t ime). 

At the end of a test, Player t im ing fi les are sent to the Conductor and are merged into a single t im ing fi le, 
cal led the Primary t im ing fi le, for analysis. If you set  up in tegrat ion with Compuware's ServerVantage 
product, the Conductor col lects t im ing data from the ServerVantage central console and merges that data 
in to the t im ing fi le as well . 

Primary t im ing fi les are saved in the \Program Files\Compuware\QALoad\TimingFiles directory, and 
are name <sessionID>_date_time.tim. 

The Primary t im ing fi le created by the Conductor after a test run contains al l  of the t im ing records of al l  
Players in  that test run. Use QALoad Analyze to view, sort , graph, and create reports using the test data in  
the t im ing fi le. 

Hin t : In  the event that something goes wrong on the network and a Player t im ing fi le is not passed 
to the Conductor, i t  is st i l l  possible to analyze results from a Player t im ing fi le. Player t im ing fi les are 
saved in the \Program Files\Compuware\QALoad\TimingFiles directory and are named 
tim_yyyymmdd_hhmmss_xxx.ptf, where yyyymmdd_hhmmss is the date/ t ime the test was started, and 
xxx is the Player number. 

Accessing Test  Data 

When you open a t im ing fi le, QALoad ’s Analyze program summarizes the checkpoints recorded in the fi le 
during the load test and presents the data in  a report  format cal led the Summary report .  

You can access QALoad Analyze and open a t im ing fi le contain ing test results from each of the QALoad 
components. 

To access a previously-creat ed t im ing f i le in  Analyze f rom  t he W indow s St ar t  m enu: 

1. Click Start>Program  Fi les>Com puw are> QALoad >Analyze. 

2. Click Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le to work with by 
double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 

3. Select the template to use for viewing the t im ing fi le. 

To access a previously creat ed t im ing f i le in  t he Scr ip t  Developm ent  W orkbench: 

1. In  the QALoad Script Development Workbench, cl ick Tools>Analyze. 

2. In  QALoad Analyze, cl ick Fi l e>Open . The Open Timing Fi le dialog box appears. Select a t im ing fi le 
to work with by double-cl icking the fi le name in the l ist  of avai lable t im ing fi les. 
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3. Select the template to use for viewing the t im ing fi le. 

Accessing Test  Data via Groups 

The QALoad Analyze Workspace displays t im ing fi le data in  groups. Each group displays different aspects 
of the data from a t im ing fi le. The data displayed and the groups avai lable may vary, depending on the 
type of data col lected during the load test. 

Cl ick a group name below to view the type of data displayed in each group. 

Reports Top Processes 

Checkpoints RIP Fi les 

Counters Appl icat ionVantage 

Player Performance Counters Expert  User 
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Using Templates 

Using Timing File Templates  

Timing fi le templates enable you to save current views of an open t im ing fi le. Al l  open views, such as 
reports, graphs, and thresholds are stored in  the template. When you reopen a t im ing fi le or open a new 
t im ing fi le and apply a template, i t  appears with the set of views defined for the template.  

Every t ime you close a t im ing fi le in  Analyze, a Last Viewed State template for the t im ing fi le is created. 
This fi le stores the reports and graphs that are open, their posit ions and sizes, and any thresholds you 
defined. You can use an opt ion in  the Open  menu or in  the Tools>Opt ions menu to choose to reopen a 
t im ing fi le in  the same state i ts last viewed state.   

Use the Tem plate menu to: 

!  Save the current views of a t im ing fi le to create a template. 

!  Select an exist ing template and apply i t  to the open t im ing fi le. 

!  Remove the template from the current t im ing fi le or from disk. 

!  Create system-wide thresholds for counters and checkpoints. 

You can apply a template to any t im ing fi le you open. If any part  of the template cannot be appl ied to the 
t im ing fi le, for example, i f the template references a script  that doesn't  exist  in  the current fi le, a dialog box 
displays with the name of the report  or graph that doesn't  apply. The default  name for the template is the 
SessionID port ion of the f i le name of the open t im ing fi le.  

Note: Only one t im ing fi le is saved to a template. If more than one t im ing fi le is open, the opt ion to 
define a template is disabled. 

 

Creating a New Template 

Create a template to save the views of an open t im ing fi le. This saves reports and graphs that are open, as 
well  any thresholds that have been defined. When you open other t im ing fi les using the template, the fi les 
display in  the views saved to the template.  

To creat e a new  t em plat e: 

1. Click Tem plate>Save curren t  view s. The Speci fy Tem plate to Save curren t  view s and 
th resholds dialog box appears. 

Note: This menu opt ion is avai lable only i f a single t im ing fi le is open. 

2. Select a folder in  the Save in  field. By default , al l  templates are stored in  the Tem plates folder. The 
default  template name is the Session ID port ion of the t im ing fi le name.  

3. Do one of the fol lowing: 

!  Click Create to accept the Session ID as the template name. When you use th is name for the 
template, al l  future t im ing fi les created by th is Conductor session automatical ly open with the 
views specified in  the template. 

!  Type a name for the new template in  the Fi l e nam e field, and cl ick Create.  

Note: You can choose template opt ions that global ly set how t im ing fi les open using the opt ions 
in  the Analyze Options dialog box . 
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Opening a Timing File in a Template 

When you open a t im ing fi le, you can select how it  displays by opening i t  in  a template. Specifying a 
template opens the reports, graphs, and thresholds defined in the template. 

To open a t im ing f i le in  a t em plat e: 

1. Click Fi l e>Open . The Open  Tim ing Fi l e dialog box displays. 

2. In  the Fi l e nam e field, select the t im ing fi le to open. 

3. Select one of the fol lowing: 

!  Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views that 
were displayed when you last closed i t .  This restores al l  reports and graphs that were open, 
their posit ions and sizes, as well  as any defined thresholds for graphs. If there is no last viewed 
state or i f you do not select th is opt ion, the fi le opens using the opt ion you select in  the 
Tem plate area below. 

!  In  the Tem plate area, cl ick one of the fol lowing opt ions: 

o Do NOT use a tem plate w hen  open ing t im ing f i le - No template is appl ied and only 
the Summary report  for the t im ing fi le displays. 

o Use tem plate associated w i th  Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future 
t im ing fi les created by th is Conductor session with the views specified in  the template. 
If no match is found, only the Summary report  displays. 

o Use th i s tem plate for open ing the t im ing f i l e - Enables the Brow se (...) button. Select 
a saved template to apply to al l  t im ing fi les when they are opened.  

Note: By default , both the Open  in  l ast  view ed state i f  avai lable and Use tem plate associated w i th  
the Session  ID f i l e nam e are selected. This way i f there is no last viewed state, the template associated 
with the Session ID fi le name is appl ied to the t im ing fi le. 

4. Click Open . The t im ing fi le you selected appears in  the views defined for the selected template. 

 

Applying a Template to an Open Timing File 

You can select an exist ing template and apply i t  to al l  open t im ing fi les. This closes al l  reports and graphs 
that are open and displays the t im ing fi le in  the views defined in the template.  

To apply a t em plat e t o an open t im ing f i le: 

1. Click Tem plate>Use ex ist i ng. The Select Template to Use for Open Timing Fi les dialog box 
appears. 

2. Select a template and cl ick Apply.  

Al l  open reports and graphs are closed and those specified in  the template are opened.  

Note: If any part  of the template cannot be appl ied to the t im ing fi le, for example, i f the template 
references a script  that does not exist  in  the current fi le, a dialog box appears with the name of the 
report  or graph that cannot be displayed. 
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Applying Templates Globally with the Options Dialog Box 

Use the Analyze Options dialog box to select template opt ions that global ly set how t im ing fi les open. 
Using a template saves the reports, graphs, and thresholds defined in the template.  

Note: Use Tem plate>Use Ex ist i ng to apply a template to an individual open t im ing fi le.   

To speci f y a t em plat e: 

1. Click Tools>Opt ions.   

2. Click the Tem plates tab and select one of the fol lowing: 

!  Open  last  view ed state i f  avai lable - (Default) Opens the t im ing fi le in  the same views that 
were displayed when you last closed i t . This restores al l  reports and graphs that were open, their 
posit ions and sizes, as well  as any defined thresholds for graphs. If there is no last viewed state 
or i f you do not select th is opt ion, the fi le opens using the opt ion selected in  the Tem plate area 
below.  

!  In  the Tem plate area, select one of the fol lowing: 

o Do NOT use a tem plate w hen  open ing t im ing f i les - No template is appl ied. The 
Summary report  for the t im ing fi le displays.  

o Use tem plate associated w i th  the Session  ID f i l e nam e - (Default) Appl ies the template 
with the same Session ID name as the t im ing fi le. Use th is opt ion to open al l  future t im ing 
fi les created by th is Conductor session with the views specified in  the template. If no match 
is found, only the Summary report  displays.  

o Use th i s tem plate for open ing t im ing f i l es - Enables the Browse (...) button. Select a saved 
template to apply to al l  t im ing fi les when they are opened.  

Note: By default , both Open  in  l ast  view ed state i f  avai lable and Use tem plate associated w i th  the 
Session  ID f i l e nam e are selected. This way i f there is no last viewed state, the template associated with 
the Session ID fi le name is appl ied to the t im ing fi le. 

 

Displaying Detail Data 

Displaying Detail Data 

Display detai led stat ist ics from a t im ing fi le such as checkpoints, counters, in  the QALoad Analyze Data 
window. View stat ist ics for not only the act ive t im ing fi le, but also for other t im ing fi les and drag and drop 
onto the act ive t im ing fi le detai l  view. 

To d isplay det ai led st at ist ics: 

1. In  the workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which you want 
to view stat ist ics.  

2. Select the appropriate checkpoints or counters (depending on which group you choose).  

3. From the Analyze toolbar, cl ick the Detai l  button or right-cl ick on a selected checkpoint or counter 
and choose Detai l .  

Detai l  in formation is presented in the Data window in both a summary and data table. The information  
displayed varies based on the group selected.  

Note: If the test aborts, complete data for al l  the checkpoints and counters may not display. 
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The fol lowing detai l  views are avai lable: 

Checkpoints Detai l  Data 

Counters Detai l  Data 

Player Performance Counters Detai l  Data 

RIP Fi le Detai l  Data 

Expert  User Detai l  Data 

ServerVantage Detai l  Data 

Detail Views 

The detai l  view displays data from a t im ing fi le. You can view detai l  data by right-cl icking a script  or group 
and select ing Detai l . The data displayed and the groups avai lable may vary, depending on the type of data 
that was col lected during the load test. Detai l  data is displayed in two panes: a summary table and a data 
table.  

You can view detai ls for the fol lowing groups: 

Checkpoints 

Counters 

RIP Fi le 

Player Performance Counters 

Expert  Users 

ServerVantage Detai l  Data 

Sort ing Test  Data 

A Detai l  view potent ial ly contains a large number of checkpoints, counters, and so forth, especial ly i f a 
load test had many virtual users. To make information manageable, specify up to three levels of cri teria to 
sort  by, in  ascending or descending order. 

For example, i f a test ran using five scripts on 100 virtual users, sort  the data by script  name. Suppose each 
virtual user ran more than one transact ion using a part icular script , then sort  by both script  name and by 
virtual user. Or, to quickly locate any t im ing bott lenecks, sort  by response t ime. 

Use the Sort  Detai ls dialog box to sort  a detai l  view. To access th is dialog box, select Tools>Sort  from the 
Analyze menu or cl ick Sort  on the Analyze toolbar. 

Graphing QALoad Timing Data 

Start ing in  the Workspace of the Analyze spl i t  window view, you can graph t im ing data in  a number of 
formats and styles.  

Tip: A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  
an unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single 
graph. Detai ls 

Select  t he group t o graph: 
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In  the Workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which to create a 
graph.  

Note: If the test aborts, complete data may not be avai lable for al l  checkpoints and counters. 

The fol lowing groups are avai lable, depending on the t im ing fi le: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Expert  User 
Note: For each Group except Checkpoints and Expert User, the graph type is a l ine graph. For 

graphing mult iple checkpoints or expert  users, the graph type is either a l ine or bar graph. For graphing 
a single checkpoint only, in  addit ion to l ine and bar graphs, you can also create Response Time 
Distribut ion and Cumulat ive Response Time Distribut ion graphs. 

Displaying ServerVantage Agent  Data 

If you set opt ions to in tegrate ServerVantage resource ut i l izat ion data before running a test, that data is 
included in the result ing t im ing fi le. It  can be sorted and displayed in QALoad Analyze in  much the same 
way as QALoad t im ing data. ServerVantage data provides a summary of al l  the Agents that ServerVantage 
monitored during the load test and detai ls aggregate stat ist ics for Agent data points including min imum, 
maximum, and mean data values.  

When you open a t im ing fi le contain ing ServerVantage Agent data, QALoad Analyze displays test data with 
QALoad t im ing data two ways: 

!  ServerVantage Agent workstat ions are l isted in  the Server M onitoring group in the Workspace tree-
view, under the Resource Trends (ServerVantage) branch. From the Workspace, select Agen t  
w orkstat ions to create detai l  or graphical views of the Agent data points. Specifical ly, you can: 

!  Display Agent data point detai ls.  

 Graph Agent data point detai ls.  

!  Detai led data point in formation is displayed in the Data window. The ServerVantage detai l  view 
includes data such as the name of the machine where you ran the ServerVantage Agent; the Agent 
name; and the min imum, maximum, and mean data values for the Agent. 

Note: ServerVantage resource ut i l izat ion data is avai lable only i f you set the ServerVantage 
integrat ion opt ions on the QALoad Conductor’s Test In formation window before execut ing a load test.  

Displaying Vantage Analyzer Agent Data and Reports 

If you set opt ions to in tegrate Vantage Analyzer performance test ing data before running a test, that data is 
included in the result ing t im ing fi le. It  can be sorted and displayed in QALoad Analyze in  much the same 
way as QALoad t im ing data.  

You can access Vantage Analyzer canned reports and metrics that correlate to a specified performance 
test ing t ime period. The metrics are displayed in the Vantage Analyzer Performance Console, which is 
launched through QALoad Analyze and the Vantage Analyzer reports can be viewed in Analyze.  

Note: Vantage Analyzer performance test ing data is avai lable only i f you set the Vantage Analyzer 
in tegrat ion opt ions in  the QALoad Conductor’s before execut ing a load test.  

There are two types of data you can retrieve from Vantage Analyzer: t ransact ion data and reports. 
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To display Vant age Analyzer  t r ansact ion dat a and repor t s: 

Your input on the Retrieve Vantage Analyzer Data dialog box is saved and displays again when you re-open 
the dialog box.  

1. Start  Analyze and open a t im ing fi le contain ing Vantage Analyzer agent data. 

2. From the Tools menu select Van tage Analyzer. The Retrieve Vantage Analyzer Data dialog box 
displays. 

3. In  the COS server field, type the name of the machine where the Compuware Open Server resides.  

4. In  the Port  field, type the port  number where the COS server l istens to incoming requests. The 
default  port  is 18080.   

5. Click Connect . In  the Connect ion table, Vantage Analyzer agents that are avai lable through the 
COS display.  

6. Select the check box next to the Vantage Analyzer agent you want to retrieve data from. You can 
now edit  the Date/Time Range Select ion field. The Act ive data source field displays the data source 
name associated with the agent name. 

7. In  the Date/Time Range Select ion field select either Use QALoad Test ing Tim e Range or Use 
Custom  Data/ Tim e Range to set your start  and end t imes for Vantage Analyzer data fal l ing with in 
the t ime range specified. 

!  Use QALoad Test ing Tim e Range: Select to use a sl ider to set your start  and end t imes for 
Vantage Analyzer data fal l ing with in the t ime range specified. 

a. Use the sl i ders below  to set  your start  and end t im es: Select and drag the start  or end 
arrow to change the Start  t ime and End t ime for the durat ion of the test.  

b. Reset : Cl ick to restore to the t ime range previously selected.  

!  Use Custom  Data/ Tim e Range: Select to specify exact start  and end t imes.  

a. Start  t im e: Cl ick the drop-down arrows to display a calendar where you can navigate to 
specify a date when the transact ion started. To change the t ime, h ighl ight the text in  the 
field and type a new t ime. 

b. End t im e: Cl ick the drop-down arrows to display a calendar where you can navigate to 
specify a date when the transact ion ended. To change the t ime, h ighl ight the text in  the 
field and type a new t ime. 

8. Select the Transact ion  data check box to access Vantage Analyzer detai led metrics from the server 
displayed in the Act ive data source field.  

9. Select Report  data to access the l ist  of Vantage Analyzer reports from the reports l isted on the 
right. Select the check box next to the report  type you want to generate. 

10. In  the Top N coun t  field, type a number or use the arrows to select the number to specify the top 
N (number) count represented in the report(s) selected. Top N range is 3-15, with a default  value of 
10. 

11. In  the Steps field, type a number or use the arrows to determine how many sets of throughput and 
response data are retrieved between start  t ime and end t ime. The h igher the steps, the more 
accurate the graph is, but more t ime is used for retrieving the data and generat ing the report . Steps 
range is 5-100, with a default  value of 30. 

12. Click OK.  

!  If you selected the Transact ion data check box, the Vantage Analyzer Performance Console 
opens. Refer to the onl ine documentat ion for Vantage Analyzer for more in formation. 
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!  If you selected the Report data check box, the VA Reports dialog box appears and displays the 
data in  graph format. Tabs display each type of report  you selected with the name of the report  
on the tab.  

Note: After you close a Vantage Analyzer report , you can re-open the report  you just generated by 
select ing Tools>Load VA Reports. 

Thresholds 

Using Thresholds 

Thresholds are user-defined values that show the expected warning and cri t ical l im its for a counter or 
checkpoint. Thresholds help ident i fy problem areas in  the test, such as checkpoints or counters that go 
above or below a specified number. They act ively monitor response t imes by indicat ing whether data 
records are surpassing user-defined expected warning and cri t ical levels.  

Thresholds are saved in the Template fi le. The information displays in  graphs and detai l  reports in  the 
detai l  data view.  

Graphs 

The selected data is displayed in a l ine graph format in  the Data window. Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

 

Detai l  Reports 
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Detai l  reports display thresholds in  a Summary table and a Data table. The Summary table is a summary of 
raw data col lected from a load test. The defined threshold l im its, the percentage of fai lures for the 
threshold, and the total violat ions are displayed. In the Data table, the fai led points are shown in red. 

 

 

Creating Thresholds 

Define thresholds to show the expected warning and cri t ical l im its for a counter or checkpoint. 

To creat e Thresholds: 

1. Select Tem plate>Th resholds. The Th resholds dialog box appears. 

2. Click the appropriate group in the Workspace. Data with in each group is l isted in  a tree-view. 

3. Highl ight a counter or checkpoint and drag i t  to the Th reshold dialog box.  

Note: You can drag ent ire groups or individual i tems to the Th reshold dialog box.  

4. Click Edit  to name the threshold and set the threshold l im its and condit ions. 

5. Do one of the fol lowing: 

!  Click the check box in  the Act i ve column for the thresholds you want to use, then cl ick Apply.  

!  Click Act i vate Al l  to use al l  of the thresholds, then cl ick Apply. 

 

Editing Thresholds 

Once you create the threshold, set the threshold propert ies using the Edi t  funct ion. 

To edi t  Thresholds: 

1. In  the Th resholds dialog box, do one of the fol lowing: 

!  Double-cl ick the threshold you want to edit .  

!  Highl ight the appropriate threshold and cl ick Edi t . 

The Th reshold Propert i es dialog box appears. 

2. In  the Th reshold Label  field, type a name for the threshold. This is opt ional. 
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3. In  the Lim i t  field, type the number for the threshold. This is used with the Condi t i on  you select to 
calculate violat ions. 

4. In  the Lim i t  Condi t ion  sect ion, choose how the threshold violat ions are calculated. You can 
select: 

!  Greater than the threshold l im it  you defined (>) 

!  Equal to the threshold l im it  you defined (=) 

!  Less than the threshold l im it  you defined (<) 

5. Click OK. The Th reshold dialog box appears showing the l im it and condit ion you specified. 

 

Viewing Thresholds 

Threshold in formation displays in  graphs and detai l  reports in  the detai l  data view .  

Note: The data displayed and the groups avai lable may vary, depending on the type of data that is 
col lected during the load test. 

To view  t h resholds in  g raphs: 

1. In  the Workspace, cl ick the appropriate Timing Fi le tab. Data is l isted in  a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in  the graph. 
  

Note: You can select an ent ire group or individual data fi les. 

3. Click View > Graph  or right-cl ick and choose Graph  from the context menu.  

The selected data displays in  a l ine graph format in  the Data window.  Graphs show thresholds as 
horizontal l ines with the number of fai led points.  

To view  t h resholds in  det ai l  repor t s: 

1. In  the Workspace, cl ick the appropriate Timing Fi le tab. Data is l isted in  a tree-view. 

2. Click the group to view, and select the appropriate checkpoints or counters to display in  the detai l  
report .  

Note: You can select an ent ire group or individual data fi les. 

3. Click View > Detai l  or right-cl ick and choose Detai l  from the context menu.  

The detai l  report  for the selected data displays. Detai l  reports display thresholds in  a Summary table and a 
Data table. The Summary table is a summary of raw data col lected from a load test. In  the Data table, the 
fai led points are shown in red. 

Creat ing a Chart  or Graph 

Analyze Graph Types 

The fol lowing basic graph types are avai lable in  QALoad Analyze.   

Line Graph  

A l ine graph plots response t imes versus elapsed t imes for the selected checkpoints. It  provides a good 
representat ion of how much fluctuat ion there is in  response t imes over the course of a test. 
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Bar Graph  

A bar graph shows the median, mean, or percent i le response t imes for the selected checkpoints. 

Transact ion  Th rough put  Graph  

This type of graph shows the cumulat ive number of t ransact ions that occurred with in the user-specified 
t ime range over the durat ion of the test. 

Respon se Tim e Dist r i but ion  Graph  

This type of graph shows the percentage of checkpoint t im ings that fal l  with in a part icular response t ime 
range. A response t ime distribut ion graph shows i f response t imes tend to fal l  with in a range or are widely 
dispersed. A response t ime distribut ion graph only shows results for a single checkpoint, al though i t  can 
compare results from mult iple t im ing fi les. 

Cum ulat i ve Respon se Tim e Dist r i but ion  Graph  

This type of graph shows the percentage of t ransact ions for a single checkpoint that have a response t ime 
equal to or less than a specified value. 

Vi rtual  User Dist r i but ion  Graph  

This type of graph shows the value of checkpoint t im ings grouped by a user-specified range of virtual users 
running the script  at  that point in  the test. A virtual user distribut ion graph shows i f t im ings degraded 
when the number of virtual users ramped up during a load test. The virtual user distribut ion graph only 
shows results for a single checkpoint and is only val id for tests where the number of virtual users running 
the script  ramped up during the load test. 

Graphing QALoad Timing Data 

Start ing in  the Workspace of the Analyze spl i t  window view, you can graph t im ing data in  a number of 
formats and styles.  

Tip: A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  
an unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single 
graph. Detai ls 

Select  t he group t o graph: 

In the Workspace, with the appropriate Timing Fi le tab selected, cl ick the group for which to create a 
graph.  

Note: If the test aborts, complete data may not be avai lable for al l  checkpoints and counters. 

The fol lowing groups are avai lable, depending on the t im ing fi le: 

Checkpoints 

Counters 

Server Monitoring 

Player Performance Counters 

Expert  User 
Note: For each Group except Checkpoints and Expert User, the graph type is a l ine graph. For 

graphing mult iple checkpoints or expert  users, the graph type is either a l ine or bar graph. For graphing 
a single checkpoint only, in  addit ion to l ine and bar graphs, you can also create Response Time 
Distribut ion and Cumulat ive Response Time Distribut ion graphs. 
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Thinning Data Before Graphing 

Test results may contain more data than can reasonably be graphed. Thinning data before graphing 
provides a clearer and more manageable graph. 

To t h in t im ing dat a in  Conduct or : 

1. With your test session ID fi le open, cl ick the Scri pt  Assignm en t  tab. 

2. For each script  for which you would l ike to th in your test data, cl ick the button in  the Tim ing 
Opt ions column. 

3. On the Timing Options dialog box, cl ick the Enable Tim ing Data Th inn ing check box. 

4. In  the Th in  Every... field, type the number of t ransact ions to average. The average is sent to the 
Conductor for inclusion in  the t im ing fi le, rather than every value. 

5. Click OK. 

6. Save your changes to your test session ID fi le by choosing Fi l e>Save from the Conductor menu. 

For more detai ls about the Timing Options dialog box, see Timing Options. 

To set  up dat a t h inning  in  Analyze: 

1. With a t im ing fi le open, cl ick Tools>Opt ions. 

2. Click the Data Th inn ing tab. 

3. Type the number of data points to plot on each graph and select the method by which to graph the 
data points. 

4. Click OK. 

For a descript ion of the opt ions on th is dialog box, see Options Dialog Box - Data Thinning Tab.  

Graphing Checkpoints in Analyze 

A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  an 
unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single graph. 
Detai ls 

Note: Use the Graphs view of the runt ime Conductor to create real-t ime graphs of checkpoint 
response t imes during script  execut ion. 

To graph checkpoin t s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. In  the Workspace, cl ick the Checkpoin ts group. 
Checkpoint data is l isted in  a tree-view. 

2. Select the checkpoints to graph. 

3. From the View  menu, choose Graph . The Graph Type dialog box appears.  

4. In  the Graph Type drop-down l ist , select from the fol lowing: 

!  Line (response t imes versus elapsed t imes for the selected data.) 

!  Bar (median, mean, or a percent i le response t ime of the selected checkpoints.) 
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Note: The BAR graph displays only one data point for each selected counter. The data point 
represents the mean, median, or percent i le response t ime. When you select a LINE graph after a BAR 
graph through the BAR graph’s context menu, the LINE graph displays the data of the BAR graph, not 
the data from the tree control on the left  pane. Since there is only one data point per selected counter, 
the l ine graph does not display a l ine. This display is different from the LINE graph that you request 
from the tree control, which displays al l  the data points for each selected counter.  
The fol lowing graph types are only avai lable when graphing a single checkpoint: 

!  Response Time Distribut ion (The distribut ion of response t imes of a single checkpoint.) 

!  Cumulat ive Response Time Distribut ion (The percentage of checkpoint t im ings that were equal 
to or less than a specified value.) 

!  Virtual User Distribut ion (The distribut ion of checkpoint t im ings based on the number of 
virtual users running the script  at  that point in  the test.)  

Data for the selected checkpoint(s) is graphed in the Data window in the format selected in  step 4. 

Graphing Counters 
Note: A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  

an unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single 
graph. Detai ls 

To graph count er s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. In  the Workspace, cl ick the Coun ters group. 
Counter data is l isted in  a tree-view. 

2. Select the counter(s) to graph. 

3. From the View  menu, choose Graph . Data for the selected counter(s) is graphed in a l ine graph 
format in  the Data window. 

Graphing Player Performance Counters 
Note: A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  

an unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single 
graph. Detai ls 

To graph Player  per f orm ance count er s: 

1. Open the appropriate .t im  fi le in  QALoad Analyze. Select the Player Perform ance Coun ters group. 

2. In  the Workspace, select the performance counter(s) to graph. 

3. Click the View  Graph  but ton or right-cl ick and choose Graph  from the context menu. Data for the 
selected Agent(s) is graphed in a l ine graph format in  the Data window. 

Graphing Server Monitoring Data 

Monitoring servers is a method of load test ing. QALoad provides performance counter data through three 
server monitoring methods: 

!  Remote M onitoring - Performs the monitoring of performance counters from a machine under test 
without the use of agent software on the machine. 
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!  ServerVantage - An Avai labi l i ty Management appl icat ion complementary to QALoad for service 
level monitoring of performance counters for appl icat ions, servers, and databases during 
product ion. ServerVantage also provides not i ficat ion, event management, and report ing features. 

Graphing Expert  User Data 
Note: A t im ing fi le can potent ial ly contain enough data that graphing al l  of i t  at  one t ime results in  

an unreadable graph. Before beginning, consider th inning the amount of data to be shown on a single 
graph. Detai ls 

To graph exper t  user  dat a: 

1. Open the appropriate .t im  fi le in  QALoad Analyze.  

2. Select the Expert  User group in the Workspace tree-view. 

3. In  the Workspace, select the data point(s) to graph. 

4. Click the View  Graph  but ton or right-cl ick and choose Graph  from the context menu. Data for the 
selected Agent(s) is graphed in a l ine graph format in  the Data window. 

Creat ing a Scat ter Chart  

To creat e a scat t er  char t : 

1. Click the View  Graph  but ton ( ) or choose Graph  from the View  menu. The Graph Type dialog 
box appears. 

2. Select the Line graph type.  

3. Click OK. Data for the selected checkpoints is presented in a l ine graph format in  QALoad Analyze’s 
data window. 

4. Right-cl ick anywhere in  the graph, and select Gal lery from the menu. The gal lery of graph types 
displays. 

5. Click the Scatter  type graph.  

6. Right-cl ick anywhere in  the graph.  

7. Select Propert i es from the menu. The Chart FX Propert ies dialog box displays. 

8. Click the Series tab. 

9. In  the Show  every: field, cl ick the up or down arrow to increase or decrease the number of data 
points displayed, for example, show every 5th point. 

10. In  the Size: field, cl ick the up or down arrow to increase or decrease the size of the scatter points.   

11. Click Apply. 

12. In  the Shape: field, cl ick the arrow and select the shape for the scatter points. 

13. Click Apply, then cl ick OK. 
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Customizing a Chart  or Graph 

Customizing a Graph 

Change the style and appearance of a graph using opt ions avai lable from either of the Graph toolbars. The 
Graph toolbars contain buttons for standard Windows operat ions as well  as for customizing a graph's 
appearance. Display the Graph toolbars by right-cl icking in  an open area of a graph and choosing 
Toolbars>Toolbar or An notate Toolbar from the shortcut menu. 

The fol lowing features can be customized from the Graph toolbar. Cl ick on any feature in  the fol lowing 
l ists for addit ional in formation or instruct ions: 

Graph Type 

Color 

Grid Orientat ion (horizontal and vert ical) 

Legend Box 

Dimension (3D or 2D) 

Rotat ion 

Z-Cluster 

Font  

Text/Object 

Adding Text  or an Object  to a Graph 

To create explanatory text  or an object on a graph, use any of the text or object buttons on the Graph 
Annotate toolbar.   

To add a not e or  object  t o a graph t em plat e: 

1. Display the Annotate toolbar. 

2. Add text and/or an object  to the graph.  

Storing a Note or Object in a Template 

You can add explanatory text or objects to a graph to be ut i l ized as part  of a template when the template is 

appl ied to future t im ing fi les. For text, use the Tex t  Box  or the Bal loon  w i th  Tex t  button . To 

create an object, use the Rectangle or Ci rcle button .  

Note: These are the only objects that can be stored in  a template.  

To save t he in f orm at ion  in  a t em plat e: 

1. Complete the steps above for adding a note or object. 

2. Follow the instruct ions for Creat ing a New Template. The saved note or object is avai lable when 
the template is appl ied to future t im ing fi les.  
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Viewing Reports 

Automated Report ing 

After you complete a series of performance tests, you can prepare h igh-level and detai led reports in  QALoad 
Analyze.  

You can create a base report  framework, which for example, can assist  you in determin ing whether your 
tested appl icat ions are ready for product ion. You can include key sect ions in  the report  which can be 
populated with text and graphics you determine. This report  can be customized further after in i t ial  
creat ion to more accurately reflect the results of your test ing.  

The generated report  is a M icrosoft  Word document, created from a series of XML documents which 
include the t im ing fi le data. Your machine must have a val id version of M icrosoft  Word residing on i t  for 
th is feature to work. 

To view  t he generat ed repor t : 

1. Open a t im ing fi le in  Analyze. 

2. From the Tools menu, choose Generate Report  and select a t im ing fi le. M icrosoft  Word opens and 
a generated report  appears, ready for edit ing.  

Pre-Defined Reports 

QALoad Analyze provides pre-defined reports for viewing load test results 
without t ime-consuming data manipulat ion. 

In  the Workspace, select the Reports group and cl ick the appropriate 
report . The reports are in  HTML generated by XSL fi les. View them in 
QALoad Analyze, or direct ly in  a Web browser.  

Note: Compuware provides each of the avai lable pre-defined reports as 
convenience to view the results of a load test without any data 
manipulat ion. In  addit ion , create customized versions of these reports by 
select ing the appropriate group and creat ing detai l  reports and graphs. 

The fol lowing reports are avai lable. Cl ick a report  name for detai ls. 

Summary 

Session 

Concurrent Users 

Response Time Analysis 

Output 

Cl ient Throughput 

Transact ion Throughput 

Top Ten Longest Checkpoint Durat ions 

Worst Performing Checkpoints and Counters 

Player Performance  

Appl icat ion Vantage 
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Expert User 

 

Summary Report  

The Summary report  is the primary output from each test run, one of the pre-defined reports QALoad 
Analyze makes avai lable. When you open a t im ing fi le, QALoad Analyze automatical ly displays the Load 
Test Summary in  the Data window. It  presents t im ing in formation for each transact ion in  the t im ing fi le 
and the min imum, maximum, and median response t imes for each checkpoint. The output is divided into 
two sect ions.  

The first  sect ion presents the Summary Test In formation, Test Time information, and Data Thinning and 
Time Range information. The second sect ion presents the Script In formation for each script . It  shows 
t im ing Summaries and Checkpoint in formation for each script . 

With the Summary Report open in Analyze, cl ick a heading in  the Test In formation area to display detai led 
in formation on scripts, errors, and messages. When you enable data th inning, the number of errors and 
messages is th inned, accordingly. 

Note: There is a l im it  of 3000 errors processed for each script  and 3000 messages processed for each 
group with in a script . When you cl ick # Errors or #Messages for detai led in formation, any script  or group 
with in the script  that exceeds the l im it  does not display. A script  or group can fal l  with in the l im it  when 
data is th inned but exceed the l im it  when data is not th inned. This means that more scripts may appear 
in  the Error sect ion and more groups may appear with in scripts in  the Script Message sect ion when data 
is th inned. 

Sample Summary Report 

For a brief descript ion of each report  sect ion, scrol l  down and cl ick a sect ion heading in  the fol lowing 
sample. 
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Session Report  

Provides summary in formation about the test session. The information in  th is report  was obtained from 
the Conductor’s configurat ion sett ings when the load test was started. To view a summary of test sett ings 
that includes changes made while the test was running, see the Summary report .  



Using the Player, Script  Development Workbench, and Analyze 

308 

 



QALoad Online Help 

309 

For descript ions of the in formation provided in each sect ion, cl ick the sect ions in  the fol lowing image.  

 

 

 

 

Concurrent  Users Report  

Displays the total number of virtual users for the test, concurrent users vs. elapsed t ime, as well  as graphs 
for individual scripts that were part  of the test.  

Note: A totals graph wil l  not display i f the test contains only one script . 
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Response Time Analysis Report  

Provides an indicator of how well  a script  ran. The report  displays a graph of each script 's transact ion 
durat ion (response t ime vs. elapsed t ime) as well  as the fol lowing checkpoint summary data: 

#Tran s: Number of data points used to calculate the stat ist ics. 
#Recs: Number of data records. This value, i f di fferent from the value of #Trans, reflects the number of 
checkpoint records that are used for analysis after data th inning has been appl ied. 
M in : M in imum recorded response t ime. 
M ax : Maximum recorded response t ime. 
Std. Dev: Standard deviat ion of al l  response t imes. A large standard deviat ion indicates a wide variance in 
response t imes. 
M edian : Median response t ime, in  seconds. 
nth%: n percent of the responses have a value less than the value shown.  

 

 

Output  Report  

Provides a cumulat ive l ist  of al l  errors, sorted by script  and occurrence in t ime, that occurred during the 
course of a load test.  

Note: Fai led messages are included in the errors count that appears in  the Test In formation sect ion of 
the report , but are detai led in  the Script Messages sect ion. 
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Client  Throughput  Report  

Provides a graph of HTTP Reply analysis for key HTTP counters, HTTP counter vs. elapsed t ime. 

 

 

Transact ion Throughput  Report  

Provides the cumulat ive number of t ransact ions over elapsed t ime for each script  and for the total test.  
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Top Ten Longest  Checkpoint  Durat ions Report  

Provides graphs and l ists detai ls about checkpoints that had the longest checkpoint durat ion during the 
test. Checkpoints with longest durat ions are those that consumed the most amount of t ime during the test. 
This report  contains the fol lowing sect ions: 

!  A summary sect ion with overview information about the test.  

!  A bar graph of the ten longest checkpoint durat ions in  the test, fol lowed by detai ls for each 
checkpoint in  the graph. These checkpoints can originate in  any script  that was included in the 
test. 
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!  Bar graphs for each script  that show up to the ten longest checkpoint durat ions, fol lowed by detai ls 
for each checkpoint in  the script . 

The report  is generated by Analyze only i f each script  has at least one checkpoint other than the durat ion 
checkpoint. The data provided in the report  can be used as a start ing point to ident i fy performance 
problems. 

Note: Transact ion durat ion checkpoints are not included in the report . 
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Player Performance Report  

Displays transact ion durat ions in  a graph format by player machine. This report  helps ident i fy individual 
player machines that have poor test results. In  addi t ion to the bar graph that plots the average transact ion 
durat ion for each player machine, the report  also includes summary data for the overal l  test, and detai ls for 
each player machine. This report  is generated by Analyze only i f two or more player machines were used in 
the test.  

 

 

Worst  Performing Checkpoints and Counters Report  

This report  provides graphs and l ists detai ls about checkpoints and counters that had the worst 
performance during the test. Performance is based on the thresholds you define.  

Checkpoints with the worst performance are calculated using the average response t ime for each 
checkpoint. Counters with the worst performance are those that consume the most amount of t ime during 
the test. Checkpoints with the most errors and counters with the h ighest fai lure rates are l isted first . The 
data provided is a start ing point for ident i fying performance problems. 

Notes:  
!  The report  is generated by Analyze only i f a threshold is defined and i f the threshold is violated by 

the data. Thresholds that are not violated do not appear in  the report . 
!  Failure numbers may differ between th is report  and the Summary report  and detai l  reports. QALoad 

Analyze performs internal  data th inning when creat ing the Worst Performing Checkpoints and 
Counters report , so that VU data points with the same elapsed t ime are combined and displayed as 
one record. Since the Summary report  and the detai l  report  for checkpoints and counters display 
every data record in  the t im ing fi le, these reports may show a larger number of fai lures.  
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The bar graphs for each script  show up to ten of the longest checkpoint durat ions and are fol lowed by 
detai ls for each checkpoin t in  the graph. The checkpoints can originate in  any script  that was included in 
the test. The report  contains the fol lowing sect ions: 

!  A summary sect ion with overview information about the test.  

!  Bar graphs for checkpoints and bar graphs for counters showing the fol lowing:  

"  Sum m ary by percen tage of  violat i ons - Shows the number of points that exceeded the 
threshold divided by the total number of data points. For example, in  the report  for counters 
below, the total fai lure of 8 divided by the total records of 60, yields a fai lure rate of 13.3 
percent. 

"  Sum m ary by severi ty - Shows the percent of t ime during the test that the data is in  violat ion 
of the threshold. This calculat ion uses a weighted average to determine the percentage. For 
example, in  the report  for counters below, when the weighted average is used to calculate the 
severi ty, the fai lure rate is 7.6 percent and 6.5 percent.  

Since the first  method measures the fai lure rate by percentage of violat ions, and the second method 
measures fai lures by the amount of t ime the data is in  violat ion, the numbers can differ great ly between 
the two methods. It  is possible for a data set to have a 5 percent fai lure rate when calculated by percentage 
of fai lures, and an 80 percent fai lure rate when calculated by severi ty. This can indicate that an error 
deviat ing significant ly from the norm may be a more notable fai lure than a greater number of fai lures. 

In  the example below, the counter summary by percent of violat ions for Server Analysis shows a total of 8 
fai lures out of 60 records, for a fai lure rate of 13.3 percent. The percentage of violat ions for Remote 
Monitoring has a total of 3 fai lures in  41 records, for a fai lure rate of 4.2 percent.  

When measured by severi ty, however, the fai lure rate for Remote Monitoring is more serious than for 
Server Analysis. Here, the fai lure rate for Remote M onitoring is 7.6 percent compared to the rate 6.5 
percent for Server Analysis.  

Note: Transact ion durat ion checkpoints are not included in the report . 
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Expert  User Report   

Displays in formation on the scripts that ran on each player machine with the Expert  User opt ion enabled. 
It  provides a t im ing breakdown of the individual components, such as HTML, images, and objects, of the 
web pages that were requested during a test. The Expert User report  shows how much t ime i t  took to 
download a part icular component of a web page from the server. It  also shows the percentage of network 
and server t ime for the request. 

The Expert User report  contains a summary sect ion and a detai l  sect ion. The Summary sect ion at the top of 
the report  displays overview information about the test for each QALoad Player instance.  

The detai l  sect ion displays the main requests and each subrequest made when the script  executes. Main 
requests are made when Navigate_to(), Cl ick_On(), Post_to(), DO_http(), or DO_https() are executed in a 
WWW script. The subrequests, or Web components, that make up the main page can include html, css, js 
pages, and so forth. 

The percentage of server and network t ime displays in  the Average Server and Average Network fields, with 
a graphic representat ion in  the Server/Network field. This in formation can help you determine whether 
web pages with a h igh response t ime are having server- or network-related performance problems. If an  
except ional amount of t ime is being spent on the server, you can monitor the server that is under test 
using a server monitoring tool such as ServerVantage or QALoad's Remote M onitoring opt ions. If too much 
t ime is being spent on the network, you can monitor the network under test using a tool such as 
Appl icat ionVantage. 
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Applicat ionVantage Report  

Displays in formation on the scripts that ran on each player machine. It  contains a summary sect ion with 
overview information about the test, and a graph of the transact ion response t ime of the script  in  seconds. 

Note: If Expert  User data was col lected (WWW only), the Network and Server percentage data also is 
included. 

A detai l  sect ion displays the beginning and ending t ime for the trace fi les produced by the scripts running 
on the Appl icat ionVantage player machines. A separate sect ion appears for each Applicat ionVantage Player 
machine that ran during the test period, . 
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Van t age An alyzer  Rep or t  
In  QALoad Analyze, Vantage Analyzer reports are displayed in a dialog box with tabbed windows that 
display each type of report  you selected to generated on the Retrieve Vantage Analyzer Data dialog box. 
Vantage Analyzer reports display performance data col lected over a specified col lect ion t ime period. The 
fol lowing reports are avai lable.  

!  Top N M ethods—A graph that shows the throughput and response t ime for each of the top N 
methods. 

!  Top N SQL—A graph and table that shows the throughput and response t ime for each of the top N 
SQL statements. 

!  Top N Servlets—A graph that shows the throughput and response t ime for each of the top N 
servlets. 

!  Top N JSPs—A graph that  shows the throughput and response t ime for each of the top N JSPs. 

!  Top N En t i ty EJBs—A graph that shows the throughput and response t ime for each of the top N 
ent i ty EJBs. 

!  Top N Session  EJBs—A graph that shows the throughput and response t ime for each of the top N 
session EJBs. 

!  Top N M essage Dri ven  EJBs—A graph that shows the throughput and response t ime for each of 
the top N message-driven EJBs in a J2EE appl icat ion. 

!  Top N .NET ASPs—A graph that shows the throughput and response t ime for each of the top N 
ASPs in a .NET appl icat ion. 

!  Top N .NET Web Servi ces—A graph that shows the throughput and response t ime for each of the 
top N Web services in  a .NET appl icat ion. 

!  Top N .NET M ethods—A graph that shows the throughput and response t ime for each of the top N 
methods in a .NET appl icat ion. 

!  Top N Stal l ed Th read—A graph that shows the throughput and response t ime for each of the top 
N stal led threads. 

Refer to the onl ine documentat ion for Vantage Analyzer for more in formation  on Vantage Analyzer 
reports. 

  

Publishing or Sharing Test  Results 

Export ing Test  Data 

Convert test data in to three convenient formats for viewing or export ing: 

HTM L — Export data in  a detai l  view or graph to HTML fi les for convenient viewing in  a default  Web 
browser or for sending as attachments in  an email  message. See Export ing Data to HTML for instruct ions. 

RIP — Any t ime a user fai ls during load test ing, QALoad Analyze generates a RIP Fi le contain ing user errors. 
If a t im ing fi le has RIP fi le data, you can export  the RIP fi le to the working folder and view i t  in  QALoad 
Analyze or the QALoad Script Development Workbench. See Export ing RIP Fi le Data for instruct ions.  

Appl i cat ionVan tage (AV) t race f i l es - When a t im ing fi le has Appl icat ionVantage data, you can export  
the Appl icat ionVantage trace fi les to a working directory and view them with in Appl icat ionVantage. See 
Export ing Appl icat ionVantage Trace Fi les for instruct ions. 
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Export ing Data to HTML 

To expor t  dat a f rom  a det ai l  view  t o HTM L: 

1. Open a t im ing fi le. 

2. Generate a detai l  view or graph. 

3. Click anywhere in  the detai l  view or graph, making i t  act ive. 

4. From the Fi l e menu, choose Export>Data. The Save As dialog box appears. 

5. Navigate to the appropriate locat ion for saving the HTML fi le and name the fi le. 

6. Select Web Page (*.h tm ;*.h tm l ) as the fi le type and cl ick Save. 

 

Export ing RIP File Data 
Note: If a t im ing fi le does not contain any RIP data, then a RIP Fi les group wil l  not exist  in  the 

Workspace. 

To expor t  t he RIP f i le dat a t o t he w ork ing f older : 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the RIP Fi les group. 

3. In  the tree view, select the appropriate RIP fi les check box. 

4. Right-cl ick on the selected fi les and choose Export . The Browse For Folder dialog box appears. 

5. Select the folder you wish to export  the RIP fi le data to. The default  is the working folder. 

6. Click OK. Analyze exports the RIP fi le to the working folder. 

 

Export ing Applicat ionVantage Trace Files 

You can export  Appl icat ionVantage trace fi les to a working folder or to Appl icat ionVantage. 

Note: If a t im ing fi le does not contain any Appl icat ionVantage data, then the Appl icat ionVantage 
group does not exist  in  the Workspace. 

To expor t  t he Appl icat ionVant age dat a t o a w ork ing  f older : 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the Appl icat ionVantage group. 

3. In  the tree view, select the appropriate Appl icat ionVantage fi les check box. 

4. Right-cl ick on the selected fi les and choose Export  to Fi l e. The Browse For Folder dialog box 
appears. 

5. Select the folder you wish to export  the Appl icat ionVantage fi le data to. The default  is the working 
folder. 

6. Click OK. Analyze exports the Appl icat ionVantage fi le to the working folder. 
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To expor t  t he Appl icat ionVant age dat a t o App l icat ionVant age: 

1. Open a t im ing fi le. 

2. In  the Workspace, cl ick the Appl icat ionVantage group. 

3. In  the tree view, select the appropriate Appl icat ionVantage fi les check boxes. 

4. Do one of the fol lowing: 

!  Right-cl ick on the selected fi les and choose Export  to Appl i cat ionVan tage.  

!  Double-cl ick the fi le to export . 

The trace fi les are loaded into the Appl icat ionVantage database and then opened in 
Appl icat ionVantage.  

Sending Email Messages with Test  Data 

If you are using a M icrosoft  mail  program, QALoad Analyze can send an emai l  message with a t im ing fi le or 
pre-defined report  at tached. The recipient(s) of the message wil l  be able to open the fi les in  a Web browser. 

To em ai l  p re-def ined repor t s: 

1. Choose Fi le>Send. 

2. In  the Send dialog box, select reports, views, and t im ing fi les from their respect ive tabs and cl ick 
Add to add them to the l ist  of i tems you want to send.  

3. In  the Send To field, choose Em ai l  Recipien t .  

4. (opt ional) Cl ick the Zip to f i l e check box to send the fi les in  the compressed .zip format. Type a 
name for the .zip fi le in  the adjacent field. 

5. Click OK. Analyze creates a new Outlook email  message that contains al l  of the pre-defined reports, 
.xml, .xsl, and fi les associated with the t im ing fi le as attachments, or a single .zip fi le that contains 
those fi les as an attachment. Address the email , add message text, and send the message. 

 

Creat ing a Zip File of Rest  Results 

You can create a .zip fi le to convenient ly package al l  test data in to one fi le for sending to others or storing 
local ly. Analyze creates a f i le in  .zip format, which you can either save to a locat ion on your computer or 
send as an attachment to an email . 

To creat e a .zip f i le: 

1. Choose Fi le>Send. 

2. In  the Send dialog box, select reports, views, and t im ing fi les from their respect ive tabs and cl ick 
Add to add them to the l ist  of i tems you want to include in the .zip fi le.  

3. In  the Send To field, choose Em ai l  Recipien t  to email  the zip fi le or choose Fi le to save the fi le on 
your computer.  

4. Click the Zip to f i l e check box to send the fi les in  the compressed .zip format. Type a name for the 
.zip fi le in  the adjacent field. 
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5. If you chose Fi le in  step 3, type the path of the locat ion for the .zip fi le or cl ick the browse button 
[...] to select a locat ion. 

6. Click OK. Depending on which opt ion you chose in step 3, Analyze performs one of the fol lowing 
act ions: 

!  If you chose Em ai l  Recipi en t , Analyze creates a new Outlook email  message that contains al l  of 
the pre-defined reports, .xml, .xsl, and fi les associated with the t im ing fi le as a single, 
compressed .zip fi le attachment. Address the email , add message text, and send the message. 

!  If you chose Fi le, Analyze creates a single, compressed .zip fi le in  the locat ion you specified in  
step 5 that contains al l  of the pre-defined reports, .xml, .xsl, and fi les associated with the 
t im ing fi le. 

Viewing Reports 

View reports generated by QALoad Analyze on a machine with QALoad instal led or on any machine with a 
Web browser. In  order to save the contents of a t im ing fi le's working folder, when viewing reports, clear 
the Remove XML Working Folder opt ion. To properly set th is opt ion, see the Workspace tab on the 
Options dialog box. For more in formation, see Options Dialog Box - Workspace Tab.  

Viewing reports on a machine with QALoad Analyze 

To view reports in  QALoad Analyze, cl ick the Summary report  button or any of the pre-defined report  
buttons in  the QALoad Analyze Workspace. See Load Test Summary for a quick in troduct ion to viewing 
reports. 

Viewing reports on a machine without QALoad Analyze 

To view reports in  a Web browser, copy the ent ire working folder for the t im ing fi le onto the machine. The 
fol lowing fi les are required (where <Summary> represents the name of the report): 

!  <Summary>.htm 

!  <Summary>.xml 

!  <Summary>.xsl 

In  addit ion, the M icrosoft  XML version 4.0 parser (provided with QALoad ) is required to view QALoad 
reports. View any of the pre-defined reports by cl icking the <Summary>.htm fi le to launch a report  with the 
assistance of the associated XML and XSL support fi les. 

Other ways to view test data 

View not only pre-defined reports, but also t im ing fi le detai l  views and graphs by export ing or sending 
email  messages with test data to another machine. Cl ick the fol lowing l inks for more in formation:  

!  Export ing Test Data 

!  Sending Email  Messages with Test Data 

 

Viewing Test  Results in a Web Browser 

An important part  of the load test ing process is viewing and studying the results of a test. You can view the 
results of a load test not only on a machine where QALoad is instal led, but also on any machine with a 
Web browser. QALoad Analyze provides pre-defined reports as well  as .xml and .xsl fi les which can be 
customized to meet desired specificat ions. 

When you open a t im ing fi le, QALoad Analyze generates a working folder contain ing al l  support ing fi les, 
reports, and images generated from that t im ing fi le. This folder is located in  the directory \Program 
Files\Compuware\QALoad\TimingFiles\xxx.xml.source where <xxx> is the name of the t im ing fi le. 
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The fol lowing fi les are found in the working folder: 

Fi l e Nam e Descript i on  

<timingfile>.xml.source Working folder generated 
in  the Reports folder 
when opening a t im ing 
fi le. The working folder 
name is always the 
<name of the t im ing fi le> 
with a .xml.source 
extension. 

<timingfile>.xml Original t im ing fi le with 
just enough information 
to create the QALoad 
Analyze pre-defined 
reports. It  is a 
representat ion of the 
t im ing fi le, 
<t im ingfile>.t im. 

<timingfile>.complete.xml Original t im ing fi le 
contain ing al l  data 
col lected during a load 
test. It  can be an 
extremely large fi le. Use 
th is fi le i f creat ing a 
report  using XSL that 
required th is data. 

summary.htm Use th is HTM fi le to view 
the Summary report  (or 
any other avai lable pre-
defined report) in  any 
Web browser. 

summary.xml Generated XML fi le for 
the Summary report  (or 
any other avai lable pre-
defined report .) 

summary.xsl Generated XSL fi le for the 
Summary report  (or any 
other avai lable pre-
defined report .) 
Translates the .xml fi le 
specifying HTML as i ts 
output and generates the 
HTML report . Use th is fi le 
to customize the reports 
by writ ing in  .xsl. 

default.htm Report which provides a 
main screen to  launch 
any other pre-defined 



QALoad Online Help 

325 

reports. Uses nav.htm for 
the navigat ion frame. 

When closing a t im ing fi le, ei ther keep al l  of the reports generated from the t im ing fi le in  the working 
folder, or delete them. To set th is opt ion, see the Workspace tab on the Options dialog box. 

To view load test results in  a Web browser, cl ick: How to View Reports. 
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